
SCIEX 4500MD システム

システムユーザーガイド

IVD-IDV-05-6996-JA-D 2022 年 1 月



本書は SCIEX 機器をご購入され、実際に使用されるお客様にむけてのものです。本
書の著作権は保護されています。本書および本書の一部分を複製することは、SCIEX
が書面で合意した場合を除いて固く禁止されています。

本書に記載されているソフトウェアは、使用許諾契約書に基づいて提供されています。
使用許諾契約書で特に許可されている場合を除き、いかなる媒体でもソフトウェアを複
製、変更、または配布することは法律で禁止されています。さらに、使用許諾契約書で
は、ソフトウェアを逆アセンブル、リバースエンジニアリング、または逆コンパイルするこ
とをいかなる目的でも禁止することがあります。正当とする根拠は文書中に規定されて
いるとおりです。

本書の一部は、他の製造業者および/またはその製品を参照することがあります。これ
らには、その名称を商標として登録しているおよび/またはそれぞれの所有者の商標と
して機能している部分を含む場合があります。そのような使用は、機器への組み込みの
ため SCIEX により供給された製造業者の製品を指定することのみを目的としており、
その権利および/またはライセンスの使用を含む、または第三者に対しこれらの製造業
者名および/または製品名の商標利用を許可するものではありません。

SCIEX の保証は販売またはライセンス供与の時点で提供される明示的保証に限定さ
れており、また SCIEX の唯一かつ独占的な表明、保証および義務とされています。
SCIEX は、明示的・黙示的を問わず、制定法若しくは別の法律、または取引の過程ま
たは商慣習から生じるかどうかに関わらず、特定の目的のための市場性または適合性
の保証を含むがこれらに限定されない、他のいかなる種類の保証も行いません。これら
のすべては明示的に放棄されており、購買者による使用またはそれから生じる不測の
事態に起因する間接的・派生的損害を含め、一切の責任または偶発債務を負わないも
のとします。

In Vitro 診断用です。製品は一部の国では入手できません。詳細な情報については、
寄りの営業担当者にお問い合わせいただくか、または sciex.com/diagnostics を参

照してください。

Rx only.
国によっては、製品を入手できない場合があります。詳細については、お近くの販売代
理店にお問い合わせいただくか、sciex.com を参照してください。

ここに記載されている商標および / または登録商標は、関連するロゴを含め、米国およ
び / またはその他の特定の国における AB Sciex Pte. Ltd.、またはその該当する所有
者の所有物です(sciex.com/trademarks をご覧ください)。
AB Sciex™ はライセンスの下で使用されています。

© 2022 DH Tech. Dev. Pte. Ltd.

Leica Microsystems CMS GmbH
Ernst-Leitz-Strasse 17-37
35578 Wetzlar
Germany

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

SCIEX 4500MD システム
2/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



目次

第 1 章 : 操作上の予防措置および制限事項 ............................................................................ 10
一般的な安全情報 .............................................................................................................. 10
文書内の記号と規約 ........................................................................................................... 10
監督法規の遵守 ..................................................................................................................11

カナダ ............................................................................................................................ 11
欧州 ...............................................................................................................................11
米国 ...............................................................................................................................11
国際 ...............................................................................................................................12

電気系統に関する注意 ........................................................................................................12
装置主電源 ....................................................................................................................12
保護接地線 ....................................................................................................................13

化学物質に関する注意 ........................................................................................................13
システムに対して安全な液体 ..........................................................................................14

換気に関する注意事項 ........................................................................................................15
物理的な注意事項 .............................................................................................................. 16
環境に関する注意事項 ........................................................................................................16

電磁環境 ....................................................................................................................... 17
停止および廃棄 ............................................................................................................. 18

第 2 章 : 使用および機能 .........................................................................................................19
使用目的 ............................................................................................................................ 19

使用制限 ....................................................................................................................... 19
説明 ....................................................................................................................................19
資格のある技術者 ...............................................................................................................19
品質管理ガイドライン ...........................................................................................................19

ラボラトリープロセス ....................................................................................................... 20
品質管理サンプル ..........................................................................................................20
内部標準物質 ................................................................................................................ 20
参考資料 ....................................................................................................................... 21

機器の利用と変更 ...............................................................................................................21
検査室条件 .........................................................................................................................22

安全な環境条件 .............................................................................................................22
性能仕様 ....................................................................................................................... 22

第 3 章 : インストール手順および特別要件 ...............................................................................23
内蔵シリンジポンプ位置の調節 ............................................................................................23
ダイバーターバルブの配管 ..................................................................................................27

インジェクターモードでのダイバーターバルブ配管 ............................................................28
ダイバーターモードでのダイバーターバルブ配列 ............................................................. 29

イオン源の取り付け .............................................................................................................31

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
3/293



取り付けの準備 ..............................................................................................................31
プローブの取り付け ........................................................................................................32
イオン源チューブの接続 ................................................................................................. 34
質量分析装置へのイオン源の取り付け ........................................................................... 34

第 4 章 : 動作原理 ...................................................................................................................37
システム概要 ...................................................................................................................... 37

質量分析装置の概要 ..................................................................................................... 38
イオン源の概要 ..............................................................................................................41
Analyst MD ソフトウェアの概要 ..................................................................................... 47

動作原理 ........................................................................................................................... 52
ESI モード ......................................................................................................................54
APCI モード ................................................................................................................... 54
データの取り扱い ........................................................................................................... 54

動作原理 - ソフトウェア ........................................................................................................55
Analyst MD ソフトウェアウィンドウ .................................................................................. 55
Analyst MD ソフトウェアモード ........................................................................................56
定量分析 ....................................................................................................................... 57
解析 ...............................................................................................................................58
結果表 ...........................................................................................................................58
キャリブレーションカーブ .................................................................................................58
回帰の種類 ....................................................................................................................59

第 5 章 : 性能特性および仕様 ..................................................................................................60
質量分析装置の仕様 .......................................................................................................... 60

第 6 章 : 使用説明—サンプルワークフロー ...............................................................................63

第 7 章 : 使用説明 — 質量分析装置とイオン源 ........................................................................68
システムの起動 ...................................................................................................................68
イオン源の 適化 ............................................................................................................... 69

TurboIonSpray プローブの 適化 ..................................................................................69
APCI プローブの 適化 ................................................................................................. 74
適化に関するヒント ..................................................................................................... 79

質量分析装置のキャリブレーション手順 ...............................................................................79
質量分析装置のリセット .......................................................................................................80
システムのシャットダウンと大気開放 ....................................................................................80

第 8 章 : 取扱説明書 — ハードウェアプロファイルおよびプロジェクト .........................................82
ハードウェアプロファイル ..................................................................................................... 82

ハードウェアプロファイルの作成 ......................................................................................82
ハードウェアプロファイルにデバイスを追加 ......................................................................87
ハードウェアプロファイルのデバイスの編集 .....................................................................88
ハードウェアプロファイル有効化のトラブルシューティング ................................................ 89

プロジェクトおよびサブプロジェクト ....................................................................................... 90
サブプロジェクトについて ................................................................................................ 90

目次

SCIEX 4500MD システム
4/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



プロジェクトおよびサブプロジェクトの作成 ....................................................................... 91
サブプロジェクトの作成 ...................................................................................................91
サブプロジェクトのコピー .................................................................................................92
プロジェクトとサブプロジェクトの切り替え .........................................................................92
インストールされるプロジェクトフォルダ ........................................................................... 93

第 9 章 : 使用説明—チューニングとキャリブレーション ..............................................................94
チューニングとキャリブレーションについて ............................................................................94
API 機器フォルダのバックアップ .......................................................................................... 95
装置パラメータのバックアップ .............................................................................................. 95
装置パラメータの復元 ......................................................................................................... 95
自動チューニングおよびキャリブレーション ...........................................................................95
装置のパフォーマンスの検証 ...............................................................................................96
Verifying or Adjusting Performance ダイアログ .................................................................. 98
結果概要 ............................................................................................................................ 98
API 機器フォルダの回復 ..................................................................................................... 99

第 10 章 : 使用説明—自動 適化 ......................................................................................... 100
自動 適化について ......................................................................................................... 101

サンプル導入の種類 .................................................................................................... 101
注入を使用した分析試料の自動 適化 ............................................................................. 102

化合物の存在を確認 ....................................................................................................102
既知のプレカーサーイオンおよび未知のプロダクトイオンの注入を使用して自動 MS お

よび MS/MS 適化を実行 ......................................................................................104
適化結果のレビュー ..................................................................................................107

フローインジェクション分析を使用し、自動的に分析試料を 適化 .......................................108

第 11 章 : 使用説明—測定メソッド ..........................................................................................114
測定メソッドエディタを用いて測定メソッドを作成 ..................................................................114

LC メソッドについて ...................................................................................................... 115
質量分析法メソッドの作成 .............................................................................................115
測定メソッドからのデバイスの追加と削除 ......................................................................122
測定メソッドの変更 ....................................................................................................... 127

スキャンの技術 ................................................................................................................. 129
四重極モードスキャン種類 ............................................................................................130
LIT モードスキャンタイプ ...............................................................................................130
スペクトルデータ収集について ......................................................................................131

第 12 章 : 使用説明—バッチ ..................................................................................................132
バッチの作成および提出 ................................................................................................... 132

キューオプションの設定 ................................................................................................ 132
バッチの作成および提出 .............................................................................................. 133
サンプルまたはサンプルセットの提出 ............................................................................137
サンプル順序の変更 .................................................................................................... 138
Locations タブを使用してバイアルの位置を選択する（オプション） ................................. 138
バッチエディタで定量詳細を設定（オプション） ................................................................141

目次

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
5/293



システムの平衡化 ........................................................................................................ 141
データの取得 ............................................................................................................... 141
バッチファイルのインポート ........................................................................................... 142
バッチおよび Acquisition Method Editor のヒント ..........................................................144
バッチトラブルシューティングのヒント .............................................................................144
サンプル測定の停止 .................................................................................................... 145

第 13 章 : 使用説明－データの分析と探索 .............................................................................146
スペクトルデータおよびクロマトグラムデータの概要 ............................................................146
データの分析 .................................................................................................................... 147

データファイルを開く ..................................................................................................... 147
データファイル内のサンプル間ナビゲーション ................................................................147
実験条件の表示 ...........................................................................................................148
表内のデータを表示 ..................................................................................................... 148
基本定量データの表示 .................................................................................................150

スペクトル ......................................................................................................................... 151
クロマトグラム ................................................................................................................... 151

スペクトルから TIC を表示 ............................................................................................152
TIC からスペクトルを表示 .............................................................................................152
XIC..............................................................................................................................153
BPC............................................................................................................................ 156
しきい値の調整 ............................................................................................................ 157
TWC の生成 ................................................................................................................157
XWC の生成 ................................................................................................................158
Show DAD Data..........................................................................................................158
ACD データの表示 .......................................................................................................159

グラフィックデータ処理 .......................................................................................................159
データの管理 ............................................................................................................... 159
グラフのズームイン ...................................................................................................... 161
グラフのラベリング ........................................................................................................161
スペクトルまたはクロマトグラムの重ね表示および集約 ..................................................162

バックグラウンド減算の実行 .............................................................................................. 164
スペクトルに対するバックグラウンド減算の実行 ............................................................ 164
範囲のロック解除 ......................................................................................................... 165

アルゴリズムのスムージング ............................................................................................. 166
スムーズアルゴリズム .................................................................................................. 166
ガウシアンスムーズアルゴリズム .................................................................................. 166

データのスムージング ....................................................................................................... 167
スムーズアルゴリズムを用いたデータのスムージング ....................................................167
ガウシアンスムーズを用いたデータのスムージング ....................................................... 167

データのセントロイド .......................................................................................................... 168
処理済みのデータファイルの保存およびオープン ...............................................................170

処理済みのデータファイルを保存する ........................................................................... 170
処理済みデータファイルを開く .......................................................................................170

等高線図での作業 ............................................................................................................ 170
等高線図の表示 ...........................................................................................................171
等高線図の領域の選択 ................................................................................................171
等高線図内の強度および吸光度の設定 ....................................................................... 171

目次

SCIEX 4500MD システム
6/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



等高線図の色の変更 ................................................................................................... 172
フラグメント解釈 ................................................................................................................ 172

フラグメント解釈ツールでの作業 ................................................................................... 172
フラグメントの数式の差異の表示 .................................................................................. 174

ライブラリデータベース ...................................................................................................... 174
既存のライブラリデータベース間での切り替え ............................................................... 175
ローカルライブラリデータベースとの接続 .......................................................................177
サーバーライブラリデータベースへの接続 .....................................................................178
ライブラリ記録での作業 ................................................................................................180
類似したスペクトルの検索 ............................................................................................ 181
ライブラリ検索に関するヒント ........................................................................................ 184

第 14 章 : 使用説明－定量データの分析および処理 .............................................................. 186
定量分析 .......................................................................................................................... 186
定量化メソッド ................................................................................................................... 186

Build Quantitation Method.......................................................................................... 187
定量化ウィザード ..........................................................................................................187
Quick Quant................................................................................................................187
定量化メソッドと結果表 .................................................................................................187
Results Table のレイアウトの指定 ................................................................................192
結果表のデータのソート ............................................................................................... 193

ピークレビューとピークの手動積分 .................................................................................... 196
ピークのレビュー .......................................................................................................... 196
手動でピークを積分 ......................................................................................................200

キャリブレーションカーブ ....................................................................................................201
キャリブレーションカーブの表示 .................................................................................... 202
キャリブレーションカーブのオーバーレイ ....................................................................... 203

サンプル統計 .................................................................................................................... 204
標準溶液および QC に対する統計の表示 .................................................................... 204

メトリックプロット ................................................................................................................ 204
メトリックプロットの生成 .................................................................................................205

第 15 章 : Reporter ソフトウェア ............................................................................................209
Analyst Reporter ユーザーインターフェース ...................................................................... 210
レポートの生成 ..................................................................................................................212

第 16 章 : サービスおよびメンテナンス情報 — 質量分析装置 .................................................214
推奨メンテナンススケジュール ........................................................................................... 214
表面のクリーニング ........................................................................................................... 217
イオン源排気ドレインボトルを空にする ...............................................................................217
フロントエンドのクリーニング ..............................................................................................219

汚染の兆候 ..................................................................................................................219
必要な道具 .................................................................................................................. 220
クリーニングのベストプラクティス ...................................................................................220
質量分析装置の準備 ................................................................................................... 222
カーテンプレートのクリーニング .....................................................................................223
オリフィスプレート前面のクリーニング ............................................................................224

目次

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
7/293



質量分析装置の運転再開 ............................................................................................ 224
保管と取り扱い ................................................................................................................. 224
粗引きポンプのオイルレベルの点検 .................................................................................. 225
サービスおよびメンテナンス — イオン源 ............................................................................ 225

イオン源の取り扱い ......................................................................................................227
イオン源の取り外し .......................................................................................................228
表面のクリーニング ...................................................................................................... 228
プローブのクリーニング ................................................................................................ 228
プローブの取り外し .......................................................................................................229
電極の交換 ..................................................................................................................229
コロナ放電ニードルの交換 ............................................................................................231
サンプルチューブの交換 ...............................................................................................233

第 17 章 : 質量分析装置のトラブルシューティング .................................................................. 234

付録 A : SCIEX 4500MD システムのパラメータ ..................................................................... 240

付録 B : イオン源パラメータおよび電圧 .................................................................................. 244
TurboIonSpray プローブのパラメータ ................................................................................ 244
APCI プローブのパラメータ ............................................................................................... 245
プローブポジション .............................................................................................................245
溶媒組成 .......................................................................................................................... 245

付録 C : キャリブレーションイオンと溶液 .................................................................................247

付録 D : ツールバーアイコン .................................................................................................. 249

付録 E : 動作原理 — イオン源 ...............................................................................................259
エレクトロスプレーイオン化モード .......................................................................................259
APCI モード ...................................................................................................................... 260

APCI イオン化領域 ...................................................................................................... 262

付録 F : 手動での化合物 適化 ............................................................................................ 265
手動での化合物 適化について ........................................................................................266
スキャン種類について ....................................................................................................... 266
分析試料の手動 適化 .....................................................................................................266

化合物の存在を確認 ....................................................................................................266
MS 特異パラメータの 適化 .........................................................................................268
適化のためのプロダクトイオンを決定 ........................................................................ 270

各プロダクトイオンの衝突セル出口電位を 適化する ................................................... 271
イオン源とガスパラメータの手動 適化 ............................................................................. 272

イオン源の準備 ............................................................................................................272
イオン源パラメータの 適化 ......................................................................................... 272

拡張パラメータ .................................................................................................................. 273

目次

SCIEX 4500MD システム
8/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



AF2 の 適化 ..............................................................................................................273
衝突エネルギーの広がり（CES） .................................................................................. 273

付録 G : 右クリックメニュー .................................................................................................... 275
Batch Editor..................................................................................................................... 275
キュー状態とデバイス状況 ................................................................................................ 276

キュー状態 ...................................................................................................................276
機器およびデバイスステータスアイコンを表示 ............................................................... 277

キュー ...............................................................................................................................278
Contour Plot ペインの右クリックメニュー ............................................................................279
Show File Information ペインの右クリックメニュー .............................................................280
スペクトルペイン ................................................................................................................280
クロマトグラムペイン ..........................................................................................................281
Results Table................................................................................................................... 282
ピークレビュー ...................................................................................................................283
キャリブレーションカーブ ....................................................................................................284

付録 H : シンボルについての用語集 ...................................................................................... 285

付録 I : 警告についての用語集 .............................................................................................. 291

お問い合わせ先 .....................................................................................................................293
お客様のトレーニング ........................................................................................................293
オンライン学習センター ..................................................................................................... 293
SCIEX サポート ................................................................................................................ 293
サイバーセキュリティ ......................................................................................................... 293
ドキュメント ........................................................................................................................293

目次

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
9/293



操作上の予防措置および制限事項 1
注: システムを操作する前に、本ガイドのすべてのセクションを注意してお読みください。

本項には、一般の安全関連の情報が含まれており、規制対応の情報が提供されています。また、
システムに関する潜在的な危険および関連する警告および危険を 小限にするために採るべき予
防措置も説明されています。

ラボ環境、システムおよび本文書内で使用されている記号と約束事に関する情報については、本項
に加えて、シンボルについての用語集を参照してください。装置主電源、イオン源排気、換気、圧縮
空気、窒素、および粗引きポンプの要件などの施設要求事項については、設置計画概要書を参照
してください。

一般的な安全情報
人身傷害またはシステムの損傷を防ぐために、本書、メーカーの化学薬品安全性データシート
（SDS）、および製品ラベル情報に記載されているすべての安全に関する注意事項および警告を読
み、理解し、それに従ってください。ラベルは、国際的に認められたシンボルで表示されています。こ
れらの警告に従わない場合、重傷に至る可能性があります。

この安全情報は、連邦、州、地方、および地域環境、衛生および安全 （EHS） 規制を補足するもの
です。ここで提供される情報には、本システムの操作に適用されるシステム関連の安全情報が含ま
れています。実践すべき安全手順がすべて掲載されているわけではありません。 終的に、連邦、
州、地方、そして地域の EHS 規則等の遵守、および安全なラボ環境の維持に対する責任は、ユー
ザーと組織にあります。

適切なラボの参考資料と標準作業手順書を参照してください。

文書内の記号と規約
このガイド内では以下のシンボルと規約が適用されます。

危険! 「危険」は致命傷や死を引き起こす行動を指します。

警告! 「警告」は、注意点を守らなかった場合に人身傷害を引き起こす可能性のある行動を
指します。

注意: 「注意」は注意点を守らなかった場合にシステム損傷やデータ損失を引き起こす可能性のあ
る行動を指します。

注: 「注」は手順および説明内の重要な情報を指します。

操作上の予防措置および制限事項
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ヒント! 「ヒント」は本文記載の技術および手順の応用に役立つ情報です。特別なニーズがある場
合、手順を短縮する場合の補足事項として使用ください。手順を完了するために必須のものではあ
りません。

監督法規の遵守
本システムは、本セクションに記載されている規制および標準に準拠しています。引用規格は、シス
テムおよび個々のシステムコンポーネント同梱の適合宣言書を参照してください。適応ラベルはシ
ステムに貼られています。

カナダ

• 電磁妨害（EMI）： CAN/CSA CISPR11。この ISM 機器は、カナダ ICES-001 に適合していま
す。次のセクションを参照してください：電磁妨害。

• 安全性：

• CAN/CSA C22.2 No.61010-1

• CAN/CSA C22.2 No 61010-2-061

• CAN/CSA C22.2 No. 61010-2-101

欧州

• インビトロ診断機器(IVD): インビトロ診断規制 2017/746

• 電磁両立性 （EMC）：以下の標準で実行されている電磁両立性指令 2014/30/EU：

• EN 61326-1

• EN 61326-2-6

• EN 55011（Class A）

電磁両立性を参照してください。

• 安全: 以下の標準で実行されている低電圧指令 2014/35/EU:

• EN 61010-1

• EN 61010-2-061

• EN 61010-2-101

• 廃棄物、電気および電子機器（WEEE）：廃電気電子機器指令 2012/96/EEC（EN 40519 で実
施される通り）。廃電気電子機器指令を参照してください。

• 梱包および梱包廃棄物（PPW）：梱包および梱包廃棄物指令 94/62/EC

• RoHS 有害物質制限指令： RoHS 指令 2011/65/EU および 2015/863/EU

米国

• 無線送信妨害規制： 47 CFR 15（FCC Part15 で実施される通り（クラス A））
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• 安全性： 職業安全衛生法、29 CFR 1910（以下の標準で実施される通り）：

• UL 61010-1

• IEC 61010-2-061

• IEC 61010-2-101

国際

• 電磁両立性（EMC）：

• IEC 61326-1

• IEC CISPR 11（クラス A）

• IEC 61000-3-2

• IEC 61000-3-3

次のセクションを参照してください：電磁両立性。

• 安全性：

• IEC 61010-1

• IEC 61010-2-061

• IEC 61010-2-101

電気系統に関する注意

警告! 感電の危険。カバーを取り外さないでください。カバーを取り外すと、傷害または
システムの故障が発生する場合があります。定期的なメンテナンス、点検、または調整
のためにカバーを取り外す必要はありません。カバーを取り外す必要がある修理につい
ては、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

• 電気安全作業習慣に従ってください。

• ケーブルの管理慣行の実行により、ケーブルを管理してください。これにより、つまずく危険が軽
減します。

システムの電気仕様については、性能特性および仕様または設置計画概要書を参照してください。

装置主電源

本ガイドの指示の通り、システムを互換性のある主電源に接続します。

警告! 感電の危険。すべての電気機器および接続器の設置は必ず有資格者が実施
し、すべての設置が現地規制および安全規格に従うようにしてください。

操作上の予防措置および制限事項
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警告! 感電の危険。緊急時にはシステムを主電源コンセントから外せるようにしてくだ
さい。主電源コンセントの周囲に物を置かないでください。

警告! 感電の危険。システムに同梱された主電源ケーブルのみを使用します。このシ
ステムの操作にとって適切な定格ではない主電源ケーブルは使用しないでください。

外部線状変成器は質量分析装置、オプションベンチ、または粗引きポンプには不要です。

保護接地線

装置主電源には、保護接地（アース）が正常に組み込まれていなければいけません。システムを接
続する前に、資格のある技師により必ず保護接地線（アース）を設置または点検してください。

警告! 感電の危険。保護接地線を意図的に妨害しないでください。保護接地線の妨
害が生じると、感電の危険が発生します。

警告! 感電の危険。保護接地線（接地ケーブル）がサンプルループとイオン源の適切な
接地点の間に接続されていることを確認します。この補足的な接地は、SCIEX によっ
て指定された安全構成を強化するものです。

化学物質に関する注意

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。クリ
ーニングやメンテナンス前に、汚染除去が必要かどうかを判断します。放射性物質、生
物学的病原体、または有害化学物質が質量分析装置に使用された場合、お客様はク
リーニングまたはメンテナンス前にシステムに対して汚染除去を行う必要があります。

警告! 環境の危険。システムコンポーネントを一般廃棄物として処分しないでください。
コンポーネントを処分する際は、現地規制に従います。

警告! 生物学的危険、有害化学物質の危険。漏れを防ぐために、ドレインチューブを
質量分析装置とイオン源排気ドレインボトルに正しく接続します。

• サービスや定期メンテナンスの前に、システムに使用された化学物質を特定してください。化学
物質について従うべき安全衛生対策については、Safety Data Sheet を参照してください。保管
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については、分析証明書を参照してください。SCIEX 安全性データシートまたは分析証明書を見
つけるには、sciex.com/tech-regulatory にアクセスしてください。

• 割り当てられた個人用保護具を常に着用してください。これにはパウダーフリーの手袋、安全メ
ガネ、および白衣が含まれます。

注: ニトリルまたはネオプレンの手袋をお勧めします。

• 通気性の良いエリアまたは換気フード内で作業を行ってください。

• イソプロパノール、メタノール、その他可燃性溶媒などの可燃性物質を用いて作業を行う際に
は、発火源を避けてください。

• 化学物質の使用および廃棄については十分注意してください。化学物質の取り扱いおよび廃棄
について正しい手順が守られない場合には、人身傷害の危険があります。

• クリーニングの間、および使用後の手洗いの際には化学物質が肌に触れないようにしてくださ
い。

• すべての排気ホースがしっかりと接続され、すべての接続が設計通りに機能していることを確認
します。

• 使用済み液体をすべて回収し、有害廃棄物として処分します。

• 生物学的危険のある物質、毒性物質、および放射性物質の保管、取り扱い、廃棄については、
すべての現地規制を遵守してください。

• （推奨）粗引きポンプ、溶剤ボトル、および廃棄物コンテナの下に、化学物質がこぼれた場合に
受け止めることができる、二次的な封じ込め用トレイを置いてください。

システムに対して安全な液体

以下の液体は、本システムで安全に使用できます。安全な洗浄液については、必要な道具を参照
してください。

注意: ダメージを与える恐れ。他の液体は、SCIEX によって危険がないことが確認されるま
で、使用しないでください。これは完全なリストではありません。

注: LC　移動相には、新たに調製した　LC-MS　グレード以上の溶剤だけを使用してください。

• 有機溶剤

• LC-MS グレードアセトニトリル、 大 100%

• LC-MS グレードメタノール、 大 100%

• LC-MS グレードイソプロパノール、 大 100%

• LC-MS　グレード以上の水、 大　100%

• バッファ

• 酢酸アンモニウム; 100mM　未満

• ギ酸アンモニウム; 100mM　未満

操作上の予防措置および制限事項
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• 酸と塩基

• ギ酸　1%　未満

• 酢酸　1%　未満

• トリフルオロ酢酸（TFA） 1%　未満

• ヘプタフルオロ酪酸（HFBA） 1%　未満

• アンモニア／水酸化アンモニウム　1%　未満

換気に関する注意事項
ガスの換気や廃棄物の処理は必ず連邦政府、州、区域、地域の保健規制や安全規制を遵守してく
ださい。地域の衛生法規や安全規制に準拠して空気の品質を維持することは、お客様の責任で
す。

イオン源排気システムおよび粗引きポンプは、必ず専用の検査室用ドラフトチャンバまたは外部排
気システムに通気してください。

警告! 火災の危険。可燃性蒸気がイオン源に溜まるのを防ぐため、イオン源排気システム
が接続され機能していることを確認してください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。排気
ガスを専用のラボ用ガス換気フードまたは排気システムで通気するように注意して、換
気チューブがクランプで固定されていることを確認します。ラボは実施される作業に適
切な換気が行われるようにしなければなりません。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。イオ
ン源排気管や粗引きポンプ排気ホースがラボ換気システムに適切に接続されていない
場合、質量分析装置を操作しないでください。定期的に排気チューブを点検し、漏れが
ないことを確認してください。適切なシステムの換気をせずに質量分析装置を使用する
と、健康を害し、重度の傷害を引き起こす恐れがあります。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。イ
オン源で使用する有害物質や障害性物質の適正使用、汚染、排気に関する知識や
訓練なしに、イオン源を使用しないでください。
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警告! 尖った部分により怪我をする危険、イオン化放射線障害の危険、生物学的危
険、または有害化学物質の危険。イオン源のウィンドウがひび割れたり破損したりし
た場合、イオン源の使用を中止して、SCIEX フィールドサービスエンジニア（FSE）に
お問い合わせください。装置に入り込んだ有害物質や障害性物質は、イオン源排気
出力に混入します。装置からの排気は室外に換気してください。認定を受けたラボ
安全手順に従い、鋭利物を処分します。

物理的な注意事項

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。

警告! 吊り上げ時の危険性。質量分析装置を持ち上げたり移動したりする際は機械式昇降
装置を使用します。質量分析装置を手動で移動させなければならない場合、この装置を安
全に動かすには少なくとも 6 人が必要です。認定を受けた安全吊り上げ手順に従います。
専門の移動サービス業者に依頼することを推奨します。 システムコンポーネントの重量に
ついては、設置計画概要書を参照してください。

環境に関する注意事項
送電線、加熱装置、換気装置、配管の供給および固定などのインストールについては資格のある
担当者にお問い合わせください。すべての設置が地方条例および有害物質規制を遵守していること
を確認してください。システムの環境条件への要求事項に関する情報は、設置計画概要書を参照し
てください。

システムのセットアップを行う際には、機器の周囲にアクセス空間を確保してください。

危険! 爆発の危険。爆発性ガスを含む環境でシステムを操作しないでください。システムは
爆発の危険がある環境での操作を意図していません。

警告! 生物学的危険。生物学的危険のある物質を使用する場合、危険性評価、制御、およ
び危険物取り扱いに関する現地規制を必ず遵守します。本システム、あるいはそのいかな
る部分も、生物学的封じ込めとして機能することを意図していません。

警告! 環境の危険性。生物学的危険、有毒性、放射性がある廃棄物、および電子廃棄
物の処分に関しては確立された手順に従ってください。化学物質、廃油および電子部品
を含む危険物質の廃棄については、お客様が地域の法律および規制に従って行う責任
があります。

注意: 質量シフトの可能性。周辺温度を安定した状態に保ってください。温度の変化が毎時 2°C を
超えると、分解能と質量較正に影響する可能性があります。
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注意: システム汚染の可能性。ガス発生装置をコンプレッサと一緒に使用する際の詳細について
は、ガス発生器に同梱されているメーカーのドキュメントを参照してください。たとえば、ガス発生装
置とコンプレッサを併用した場合、炭化水素が環境に存在すると質量分析装置に入る可能性があり
ます。

電磁環境
電磁両立性

基本的電磁環境：公共メインネットワークからの低電圧で直接供給されているという特徴がある場
所に存在する環境。

性能基準 A（基準 A）：機器は、テスト中またはテスト後に性能の低下なしおよび機能の損失なしに
想定どおりに操作できるものとします。

性能基準 B（基準 B）：機器は、テスト中に機能を損失（1 つ以上）する場合があるが、テスト後に性
能がいくらか低下して機能が自己回復可能で想定どおりに操作できるものとします。

性能基準 C（基準 C）：機器は、テスト中に機能を損失（1 つ以上）する場合があるが、テスト後に性
能がいくらか低下して機能がオペレータによって回復可能で想定どおりに操作できるものとします。

機器は、基本的電磁環境での使用を前提としています。

電磁環境耐性条件における予想される性能損失は、総イオンカウント（TIC）の変化が 20%未満で
す。

注意: 結果が不正確になる可能性。電磁（EMC）放射線によって適切な操作が妨げられる可能性
があるため、強 EMC 放射線源（シールドされていない意図的な RF 源など）のすぐ近くでこの装置
を使用しないでください。

装置と互換性のある電磁環境が整備されており、装置が想定どおりに操作できることを確認してく
ださい。電源ラインの電気的ノイズが大きい場合は、サージ保護装置を取り付けてください。

電磁妨害

グループ 1 機器： この機器は、内部動作に RF エネルギーを使用する可能性のある産業・科学・医
療（ISM）用機器に分類されます。

クラス A 機器：家庭用施設および住宅用に使用される建物に供給する低電圧電源供給ネットワー
クに直接接続する施設以外のすべての施設内での使用に適する機器。[CISPR 11:2009, 5.3 より
派生] クラス A 機器はクラス A の制限を満たすものとします。

注意: 電波障害の恐れ。この機器は住宅環境での使用を意図したものではなく、そのような環境で
は無線受信に対する適切な保護が得られない恐れがあります。

この装置はクラス A デジタル機器の制限に準拠したテストを行っており、FCC（Federal
Communications Commission：連邦通信委員会）コンプライアンス規制パート 15 の基準を満たし
ています。

これらの制限は、装置が商業環境下で用いられた場合に、妨害行為から装置を適切に保護する必
要性を考慮したものです。この装置は高周波エネルギーの生成、使用および放出を行います。オペ
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レーターズマニュアルに従ってインストールおよび使用が行われなかった場合は、ラジオ通信に障
害を発生させる恐れがあります。

住宅地域でのこの装置の操作は、発生した場合に自己負担で妨害を修正する必要がある有害な
妨害を引き起こす恐れがあります。製造業者によって認可のない変更や調節を行った場合、装置を
使用する権限が無効になる場合があります。

停止および廃棄

警告! 環境の危険性。生物学的危険、有毒性、放射性がある廃棄物、および電子廃棄
物の処分に関しては確立された手順に従ってください。化学物質、廃油および電子部品
を含む危険物質の廃棄については、お客様が地域の法律および規制に従って行う責任
があります。

停止の前に、現地規制に従ってシステム全体に対して汚染除去を行います。

システムをサービスから外す際は、国または地域の換気用規制に従って、異なる素材を分別および
リサイクルしてください。保管と取り扱い を参照してください。

注: SCIEX は汚染除去フォームの記入のない場合、システムの引き取りはお受けしかねます。フォ
ームのコピーが必要な場合は、フィールドサービスエンジニア（FSE）にお問い合わせください。

分別していない一般廃棄物としてコンピュータの部品を含むシステムのコンポーネントおよびサブア
センブリを廃棄しないでください。

廃電気電子機器指令

廃棄物、電気および電子機器（WEEE）の環境への影響を軽減するための適切な廃棄規定につい
ては、地域の一般廃棄物命令に従ってください。この機器を安全に廃棄するために、お近くのカスタ
マーサービスに連絡し、無料の機器引き取りおよびリサイクルをご利用ください。

操作上の予防措置および制限事項
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使用および機能 2
使用目的
4500MD システムはヒトの標本から無機、有機化合物を識別するための液体クロマトグラフィータン
デム質量分析（LC-MS/MS）システムです。調査対象の化合物をイオン化し、結果として生じたイオ
ンを質量に応じて電解分離にかけるという方法を用います。In Vitro 診断用。

使用制限

4500MD システムは、資格のある検査技師による、臨床検査室での専門的使用のみを前提として
います。

説明
4500MD システムには、以下のコンポーネントが含まれています。

• TurboIonSpray プローブまたは大気圧化学イオン化（APCI）プローブのいずれかを使用する
Turbo V イオン源、粗引きポンプ、および圧縮空気と窒素の供給源を備えた SCIEX Triple
Quad 4500MD 質量分析計または QTRAP 4500MD 質量分析計。

• SCIEX 供給のコンピュータとモニター、および装置の 適化、測定メソッドの開発、およびデータ
収集用の Analyst MD ソフトウェア、および処理用の MultiQuant MD ソフトウェア。

注: 中国の場合、トリプル四重極質量分析装置のみが提供されます。これらのシステムは、リニアイ
オントラップ（LIT）のスキャン種類に対応していません。

資格のある技術者
資格のある SCIEX エンジニアのみが、装置の設置、検査、およびサービスを行うようにしてくださ
い。システムのインストール後、フィールドサービスエンジニア（FSE）はカスタマー習熟チェックリスト
を使用し、お客様にシステムの動作、クリーニング、基本のメンテナンスを説明します。SCIEX の承
認を受けていない技術者が修理を行った場合、SCIEX による保証の対象外となることがあります。

装置のメンテナンスは、製造業者が認定した技術者のみが行うようにしてください。ラボで指定され
た者は、有資格保守要員（QMP）とともに設置時の手順について習熟度を深めることもできます。
QMP とは、ラボの機器へのサービスに関連する電気および化学物質のリスクに関して適切な意識
のある担当者です。

品質管理ガイドライン
4500MD システムはオペレータの研修、分析開発および検証、検査室での分析パフォーマンスに
関する外部監査などの目的で、臨床検査室において使用されることを前提としています。

使用および機能
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ラボラトリープロセス

レポート結果 2、5 を臨床用に実施する前にメソッドを検証してください。同様に、分析前、分析中、分
析後プロセスにおいて意図した使用 3 と異なることがないように、分析方法のための標準作業手順
（SOP）を確立してください。たとえば、少なくとも以下の内容についての SOP が必要です：3、4

• サンプル収集メソッド

• サンプル準備メソッド

• 液体クロマトグラフィー設定および初期条件

• 質量分析装置のセットアップおよびキャリブレーション初期条件

• 液体クロマトグラフィーおよび質量分析装置のメンテナンス

• 質量分析装置の測定メソッド

• サンプルバッチリスト準備メソッド

• データ分析メソッド

• データレビュー

• データ分析完了後のプロトコルリリース

生データの品質、および Analyst MD ソフトウェアによって実行されたピーク積分の正確性を確保
するために、すべての積分結果を手動で確認することを推奨します。クロマトグラムのピークのレビ
ューは、必ず訓練を受けた専門担当者が行ってください。Analyst MD ソフトウェアがクロマトグラム
のピークを正しく積分できない場合、その原因は近くの溶出ピーク、ピーク分離、ノイズデータ、また
は高バックグラウンド信号の存在である可能性があり、分析手法についてのラボの標準作業手順
書（SOP）に従って、ピーク積分を修正する必要があります。

品質管理サンプル

品質管理（QC）サンプルは分析手法のパフォーマンスに対するフィードバックを提供し、ラン中に分
析される不明なサンプルの完全性および正当性を評価します 2。QC サンプルデータは毎日監視し
ます。分析ランに QC サンプルを含める場合は、適切なガイダンスに従ってください。

QC サンプルは適切な文書により商業的供給源により入手するか、特徴がはっきりした患者サンプ
ルの備蓄から入手できます 2。患者サンプルの分析ラン毎に、少なくとも 2 点の QC サンプルが含
まれていることを推奨します 1、2。QC サンプルが分析手法のための事前設定限度内であることを
確認するために、データ見直しプロセスを使用します。分析ランにより取得された QC のデータが、
事前設定限度外の場合は、無効の可能性があります 2。検査室の SOP を参照してください。

内部標準物質

内部標準物質とは、構造的な類似物質である分析試料、または安定的で、同位体的に分類される
分析試料であり、定量を容易にするために、設定された一定の濃度ですべてのサンプル種類（標準
溶液、ブランク、品質管理、未知物質）に追加されます 3。内部標準物質の信号強度は分析メソッド
の統合性や個々のサンプルの妥当性を確認するため、分析ランを通してモニタリングされます。

SOP には内部標準物質の分析試料の評価および品質管理サンプルの判断基準が含まれていな
ければなりません。基準外のサンプルはメソッド、システム、またはサンプルのパフォーマンスで問

使用および機能

SCIEX 4500MD システム
20/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



題を引き起こす可能性があります 2、5。重要決定を伴う測量は、内部標準物質（同位体的に分類さ
れた分析試料）を用いて行ってください。早い段階でこれらの問題を特定することで、検査室での調
査、修正、および再分析を必要に応じて行うことができます 2、5。

参考資料

1. 業界向けガイダンス：生物分析法の検証; 米国食品医薬品局; 獣医用医薬品評価（CDER）セ
ンター（CVM）、2001 年 5 月、BP センター

2. CLSI 標準 C50-A-27 巻、No.24—臨床検査での質量分析：一般原則とガイダンス：承認され
たガイドライン

3. ISO 170252005—試験および校正機関の能力に関する一般要求事項

4. ISO 15189:2012—臨床検査室-品質と能力に関する特定要求事項

5. CLSI 文書 C62-A：液体クロマトグラフィー、質量分析法、承認文書 34 巻、No.16、2014 年 10
月

機器の利用と変更

警告! 人身傷害の危険。製品の設置、調整、または移設が必要な場合は、SCIEX の担当
者にお問い合わせください。

警告! 感電の危険。カバーを取り外さないでください。カバーを取り外すと、傷害または
システムの故障が発生する場合があります。定期的なメンテナンス、点検、または調整
のためにカバーを取り外す必要はありません。カバーを取り外す必要がある修理につい
ては、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

警告! 人身傷害の危険。SCIEX が推奨する部品のみを使用してください。SCIEX が推奨し
ない部品を使用したり、用途以外の目的で部品を使用すると、測定者が危険にさらされた
り、システムの性能に悪影響を及ぼしたりする可能性があります。

警告! 吊り上げ時の危険性。質量分析装置を持ち上げたり移動したりする際は機械式昇降
装置を使用します。質量分析装置を手動で移動させなければならない場合、この装置を安
全に動かすには少なくとも 6 人が必要です。認定を受けた安全吊り上げ手順に従います。
専門の移動サービス業者に依頼することを推奨します。 システムコンポーネントの重量に
ついては、設置計画概要書を参照してください。

警告! 挟み込みの危険性。重いものを動かす際は安全靴を履いてください。

システムは、質量分析装置設置計画概要書で推奨されている環境条件下にある屋内の検査室内
で使用してください。

システムが製造業者の規定に反した環境および方法で使用された場合、機器に備わっている性能
や保護機能が損なわれる可能性があります。
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システム上で認定外の変更や動作を行ったために人身傷害や機器の破損が発生した場合は、保
障が適用されない可能性があります。システムが推奨環境条件の範囲外で使用された場合、およ
び認定外の変更を行った場合のどちらであっても、正常でないデータが生成されることがあります。
システムサービスに関する情報は、FSE にお問い合わせください。

保証条件は、sciex.com/warranty ページから入手できます。4500MD システムの期待寿命は製造
日から 7 年間です。スケジュールされたメンテナンス手順に従った場合、この耐用年数は延長され
る可能性があります。

検査室条件

安全な環境条件

システムは次の条件下で安全に動作するように設計されています。

• 室内

• 高度：海抜 2,000 m（6,560 フィート）以下

• 周辺温度：5 °C（41 °F） ~ 40 °C（104 °F）

• 相対湿度：20 % ~ 80 %、結露なし。

• 装置主電源電圧変動：通常電圧の ± 10%

• 過渡過電圧：過電圧カテゴリ II レベルまで

• 装置主電源の一時的過電圧

• 汚染度 2

性能仕様

システムは次の条件下で仕様に適合するように設計されています。

• 設置環境温度 15 °C～30 °C（59 °F～86 °F）

温度は常に、4 °C （7.2 °F）の範囲を維持し、毎時間 2 °C （3.6 °F）以上の変化がないようにし
ます。この制限を超えて環境温度が変化すると、スペクトルの質量シフトを引き起こす可能性が
あります。

• 相対湿度 20～80%、結露なし。

使用および機能

SCIEX 4500MD システム
22/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D

https://sciex.com/warranty


インストール手順および特別要件 3
SCIEX フィールドサービスエンジニア（FSE）がシステムをインストールおよび設定します。

このセクションでは、システムのハードウェアおよびソフトウェアの接続および設定の手順が示され
ています。システムの移動、再配管または再構成の必要がある場合は、このセクションの手順を参
照してください。

警告! 感電の危険。緊急時にはシステムを主電源コンセントから外せるようにしてくだ
さい。主電源コンセントの周囲に物を置かないでください。

Analyst MD ソフトウェアのインストールについては、ソフトウェアインストールガイドを参照してくださ
い。

内蔵シリンジポンプ位置の調節

警告! 尖った部分により怪我をする危険。シリンジの取り扱いに注意してください。シ
リンジチップは非常に尖っています。

警告! 尖った部分により怪我をする危険。シリンジがシリンジポンプに適切に固定され、
自動シリンジポンプストップが適切に調整されて、ガラス製シリンジを損傷や破損から守
っているかを確認します。シリンジが破損した場合、鋭利物の廃棄に関する認定を受け
た安全手順に従います。

質量分析装置のシリンジポンプの位置については、質量分析装置の概要を参照してください。

1. シリンジカバーを開きます。

2. ベースを下げるために、シリンジポンプ右面の Release ボタンを押してください。そして、シリン
ジを挿入してください。

インストール手順および特別要件
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図 3-1 : シリンジを下げる

項目 説明

1 シリンジプランジャー

2 Release ボタン。ベースを上げ下げするために押してください。

3. シリンジの端がベースと同じ高さで、シリンジのシャフトがカットアウトで動かないことを確認して
ください。

4. シリンジプランジャーがガラスのシリンジの底に当たる前に自動シリンジ停止がかかるように、
ポストを調節してください。
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図 3-2 : 自動シリンジ停止

項目 説明

1 自動シリンジ停止。ポストが自動シリンジ停止に当たったあと、シリンジポン
プは停止します。

2 ポスト。サンプル注入の間、シリンジプランジャーがシリンジを打つのを防ぐた
めに高さを調整してください。

3 ロックネジを取り付けてください。ポストの高さを調節したあと、ネジを締めてく
ださい。

5. シリンジポンプのねじを回してシリンジを固定します。
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図 3-3 : シリンジポンプネジ

6. 質量分析装置と内蔵シリンジポンプをソフトウェアで確実に作動させます。

注: 以降の手動使用では、質量分析装置が Ready 状態になったら、シリンジの右側にある質
量分析装置のボタンを押してフローを開始します。シリンジポンプの使用中には、ボタン横の
LED が点灯します。シリンジポンプの流量は Analyst MD ソフトウェアで自動的に制御するこ
ともできます。
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図 3-4 : シリンジポンプ LED

項目 説明

1 シリンジポンプ ON/OFF ボタン

2 シリンジポンプステータス LED

7. Analyst MD ソフトウェアの Navigation バーで Manual Tuning をクリックします。

8. Start Syringe をクリックします。

9. シリンジポンプを停止するには、Stop Syringe をクリックします。

ダイバーターバルブの配管
イオン源の横にある内蔵ダイバーターバルブは、インジェクターモードまたはダイバーターモードで
配列することができます。バルブを構成するには、Configuration タブを開き、Use integrated
injector/diverter valve チェックボックスがオンになっていることを確認します。ハードウェアプロフ
ァイルにデバイスを追加を参照してください。

注意: 結果が不正確になる可能性。運転中、ダイバーターバルブボタンを押さないでください。デー
タが不正確になる場合があります。
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インジェクターモードでのダイバーターバルブ配管

バルブが位置 A の場合、サンプルが外部ループを流れます。バルブが位置 B へ切り替わった場
合、サンプルが注入されます。

インジェクターモードのバルブを配列します。

図 3-5 : ダイバーターバルブ：インジェクターモード位置 A
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図 3-6 : ダイバーターバルブ：インジェクターモード位置 B

項目 説明

1 サンプルイン

2 排出

3 サンプルループ（ポート 3 および 6）

4 移動相イン

5 カラムへ、またはカラムが取り付けられていない場合は質量分析装置へ

ダイバーターモードでのダイバーターバルブ配列

バルブが位置 A の場合、サンプルフローは質量分析装置側に流れます。バルブを位置 B に切り換
えると、流量は無駄になります。

ダイバーターモードのバルブを配列します。
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図 3-7 : ダイバーターバルブ：ダイバーターモード位置 A

図 3-8 : ダイバーターバルブ：ダイバーターモード位置 B

項目 説明

1 質量分析装置へ
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項目 説明

2 カラムから

3 排出

イオン源の取り付け

警告! 感電の危険。この手順の 終手順として、イオン源を質量分析装置に取り付
けます。イオン源を設置する際、高圧が発生しています。

注意: ダメージを与える恐れ。イオン源を片手で持ち上げたり、運んだりしないでください。イオン源
は、両手（イオン源の各面に 1 つ）で持ち上げたり持ち運んだりできるように設計されています。

イオン源が真空インターフェースに接続され、2 つのイオン源ラッチで保持されます。イオン源の内
部は、イオン源の側面と前面のウィンドウから確認できます。

イオン源が取り付けられている場合、ソフトウェアがイオン源を認識して、イオン源同定を表示しま
す。

このガイドでは、質量分析装置を制御するソフトウェアを制御ソフトウェアと呼びます。

必要な資材

• イオン源

• TurboIonSpray プローブまたは APCI プローブ

• 赤の PEEK チューブ（0.005 インチ口径）

取り付けの準備

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。

ヒント! 空のパッケージを捨てないでください。イオン源を使用していないときの保管用として使用し
ます。

プローブ上の電極調整ナットを調整して、電極チップを電極チューブ内で移動します。図 4-4 および
図 4-5 を参照してください。

適な安定性と性能を確保するために、電極チップがプローブ終端よりも 0.5 mm ～ 1.0 mm 先に
伸びていなくてはなりません。TurboIonSpray プローブポジションの 適化 または APCI プローブ
ポジションの 適化を参照してください。

インストール手順および特別要件
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プローブの取り付け

警告! 感電の危険。続行する前に、質量分析装置からイオン源が完全に取り外され
ているかを確認します。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。

注意: ダメージを与える恐れ。電極チップ突出部またはコロナ放電ニードルがイオン源ハウジングに
一切触れないようにして、プローブを損傷から守ります。

注意: ダメージを与える恐れ。TurboIonSpray プローブを使用している場合は、コロナ放電ニード
ルチップを必ずアパチャ（開口部）から離してください。

実施前提手順

• イオン源の取り外し.

プローブはイオン源に事前にインストールされていません。プローブを交換する前に、質量分析装
置からイオン源を必ず取り外します。

注: プローブがイオン源に適切に取り付けられていない場合、質量分析装置とイオン源排気システ
ムの高電圧電源はオフになります。

インストール手順および特別要件
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図 3-9 : イオン源コンポーネント

項目 説明

1 サンプルチューブ

2 電極調整ナット

3 止めリング

4 プローブタワー

5 コロナ放電ニードル調整ネジ

6 プローブを水平軸上で移動して、イオン源感度調整を行うために使用するマイ
クロメータ

7 ウィンドウポート

8 イオン源を質量分析装置に固定する 2 つのイオン源ラッチのうちの 1 つ

インストール手順および特別要件
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項目 説明

9 接地継手部、イオン源カバーの下にあります

10 プローブを垂直軸上で移動して、イオン源感度調整を行うために使用するマイ
クロメータ

1. コロナ放電ニードルチップがカーテンプレートアパチャから離れていることを確認してください。
コロナ放電ニードルのポジションの調整を参照してください。

2. プローブをタワーに挿入します。プローブの穴をイオン源の 上部にあるコロナ放電ニードル
調整ネジに合わせます。イオン源コンポーネントを参照してください。

3. プローブをゆっくりと押し下げて、接点をタワーの接点と噛み合わせます。

4. プローブの止めリングを回して押し下げ、リングのネジとタワーのネジを噛み合わせてから、リ
ングを手できつく締めます。

5. APCI プローブについてのみ、コロナ放電ニードルチップがカーテンプレートアパチャの方を指
しているかを確認します。コロナ放電ニードルのポジションの調整を参照してください。

イオン源チューブの接続

警告! 感電の危険。接地継手部の接続を省略しないでください。接地継手部は、質量
分析装置とサンプル導入装置の間を接地します。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。こ
の装置を操作する前に、サンプルチューブナットが適切に締められているかを確認
して、漏れを防ぎます。

イオン源コンポーネントを参照してください。

1. 30 cm の赤い PEEK チューブをサンプルチューブナットに挿入します。

2. サンプルチューブナットをプローブ 上部のポートに取り付け、サンプルチューブナットを手でき
つく締めます。

3. チューブの反対の端部をイオン源の接地継手部に接続します。

質量分析装置へのイオン源の取り付け

警告! 感電の危険。イオン源を質量分析装置に取り付ける前に、プローブをイオン源
に取り付けます。

警告! 指挟みの危険性。イオン源を設置する際は、イオン源と真空インターフェースの間に
指を挟まないように注意してください。

インストール手順および特別要件
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注意: ダメージを与える恐れ。電極チップ突出部またはコロナ放電ニードルがイオン源ハウジングに
一切触れないようにして、プローブを損傷から守ります。

注: プローブがイオン源に適切に取り付けられていない場合、質量分析装置とイオン源排気システ
ムの高電圧電源はオフになります。

前提条件

• 真空インターフェースにすべての O リングが取り付けられていることを確認します。

図 3-10 : 真空インターフェースの O リング

項目 説明

1 カーテンプレート

2 O リング

1. イオン源の両側面にあるイオン源ラッチが 12 時の位置にあることを確認します。イオン源コン
ポーネントを参照してください。

2. イオン源と真空インターフェースを位置合わせして、イオン源のガイドピンが真空インターフェー
スのソケットの位置に合っていることを確認します。

3. イオン源を真空インターフェースに軽く押し当て、イオン源ラッチを下向きに回してイオン源を所
定の位置に固定します。
質量分析装置がイオン源を認識し、イオン源の識別情報が制御ソフトウェアに表示されます。
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4. サンプル供給デバイスの赤の PEEK チューブをイオン源の接地継手部の反対側に接続しま
す。
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動作原理 4
システムは、ヒト標本内の無機物また有機物の化合物を確認することを意図しています。

このシステムは、生理学的サンプル内の小分子の分析を行うように設計されています。分析物の特
性、または開始サンプルの複雑性に従い、溶液内の分析物抽出に先立って、サンプルの準備に様
々な抽出、またはろ過を行う必要がある場合があります。サンプルは液体クロマトグラフで分離しま
す。分離された画分は、質量分析装置に導入され、化合物の特定の分子量に基づいてさらに分離
されます。

コンピュータおよびソフトウェアの詳細は、ソフトウェアのソフトウェアインストールガイドを参照してく
ださい。

システム概要
4500MD システムには、次のコンポーネントが含まれています：

• 粗引きポンプと圧縮空気および窒素源を装備した SCIEX Triple Quad 4500MD または
4500MD QTRAP 質量分析装置。

• Turbo V イオン源で、TurboIonSpray プローブまたは大気圧化学イオン化（APCI）プローブを使
用するもの。

• SCIEX 供給のコンピュータとモニター、および機器の 適化、測定メソッド開発、データ収集と処
理のための Analyst MD ソフトウェア。コンピュータの仕様および要件については、Analyst MD
ソフトウェアのソフトウェアインストールガイドを参照してください。
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質量分析装置の概要

図 4-1 : 正面図

項目 説明 主要な材料 次を参照

1 パネルシンボル プラスチック パネルシンボル。

2 シリンジポンプ ペイント済みスチール（本
体）、ステンレススチール
（レール）、ブロンズ、
Cu、Sn、Pb（ベアリング）

内蔵シリンジポンプ位置
の調節

3 イオン源 該当なし イオン源の概要

4 ダイバーターバルブ ステンレススチール ダイバーターバルブの配
管。

パネルシンボル

次の表は、質量分析装置のステータス LED の意味を示しています。

表 4-1 : パネルシンボル

LED 色 名称 説明

緑 Power システムに電源が入ったときに点灯しま
す。

動作原理
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表 4-1 : パネルシンボル (続き)

LED 色 名称 説明

緑 真空 動作時の真空レベルに達したときに点灯し
ます。動作時の真空レベルでない場合（ポ
ンプダウンおよび通気中）には点滅しま
す。

緑 準備完了 システムが準備完了状態にあるときに点
灯します。システムは作動準備ができた状
態である必要があります。

青 スキャニング システムがデータを取得しているときに点
滅します。

赤 障害 システムに障害が発生した場合に点灯しま
す。

システムがオンにされた後、すべての LED が点灯します。電源 LED は点灯したままになります。
他の LED は 2 秒間点滅してから消灯します。真空の LED が点滅します。動作時の真空レベルに
到達すると、この LED は点灯したままになります。

接続

次の図は、RESET ボタンと VENT ボタンの位置、質量分析装置のコンビニエンススイッチの位置
など、質量分析装置の接続位置を示しています。

警告! 人身傷害の危険：圧縮ガスラインで作業中の注意を実行します。失敗した場合、個人
レベルの傷害が生じる可能性があります。
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図 4-2 : 後面および側面の外観

項目 説明 主要な材料 詳細な情報については

1 粗引きポンプの真空接続 アルミニウム（ホース接
続部）、亜鉛メッキスチー
ル（ホースクランプ）

フィールドサービスエンジ
ニア（FSE）にお問い合わ
せください。この接続は
ユーザー作業対象外で
す。

2 空気供給（ガス 1/ガス 2） プラスチック 『設置計画概要書』を参
照してください。

3 イオン源排気供給 プラスチック イオン源排気システム お
よび設置計画概要書を
参照してください。

4 イオン源通信接続 アルミニウム フィールドサービスエンジ
ニア（FSE）にお問い合わ
せください。

5 RESET ボタン プラスチック 質量分析装置のリセット
を参照してください。

動作原理

SCIEX 4500MD システム
40/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



項目 説明 主要な材料 詳細な情報については

6 主電源系の接続 アルミニウム/プラスチッ
ク

システムの起動またはシ
ステムのシャットダウンと
大気開放を参照してくだ
さい。

7 質量分析装置のコンビニ
エンススイッチ

• 上 = ON

• 下 = OFF

プラスチック システムの起動またはシ
ステムのシャットダウンと
大気開放を参照してくだ
さい。

8 Aux 入出力接続 板金（亜鉛メッキ） 周辺装置セットアップガイ
ドを参照してください。

9 イーサネット接続。質量
分析装置とコンピュータ
を接続します

板金（亜鉛メッキ） フィールドサービスエンジ
ニア（FSE）にお問い合わ
せください。

10 VENT ボタン プラスチック システムの起動またはシ
ステムのシャットダウンと
大気開放を参照してくだ
さい。

11 イオン源排気排出。イオ
ン源排気ドレインボトル
へ

ステンレススチール 設置計画概要書を参照
してください。

12 窒素ガス供給（Curtain
Gas™供給、CAD ガス）

ステンレススチール 設置計画概要書を参照
してください。

イオン源の概要

Turbo V イオン源は、エレクトロスプレーイオン化（ESI）または大気圧化学イオン化（APCI）に使用
できます。

TurboIonSpray プローブは、ESI モードで稼働する場合に使用します。 APCI プローブは、APCI モ
ードで稼働する場合に使用します。

動作原理
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イオン源コンポーネント

図 4-3 : イオン源コンポーネント

項目 説明 主要な材料

1 サンプル供給デバイスからのサンプルチューブ 赤の PEEK

2 電極調整ナット ポリオキシメチレン

3 止めリング PEEK

4 プローブタワー ステンレススチール

5 コロナ放電ニードル調整ネジ PEEK

6 プローブを水平軸上で移動して、イオン源感度
調整を行うために使用するマイクロメータ

ガラス

動作原理
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項目 説明 主要な材料

7 ウィンドウポート ステンレススチール

8 イオン源を質量分析装置に固定する 2 つのイ
オン源ラッチのうちの 1 つ

ステンレススチール

9 接地継手部、イオン源カバーの下にあります ステンレススチール

10 プローブを垂直軸上で移動して、イオン源感度
調整を行うために使用するマイクロメータ

ポリオキシメチレン

プローブ

TurboIonSpray および APCI プローブは、幅広いサンプルテスト機能を備えています。 サンプル中
の化合物に も適したプローブとメソッドを選択します。

表 4-2 : イオン源仕様

仕様 TurboIonSpray プローブ APCI プローブ

温度範囲 周囲温度から 750 ℃ まで（液
体流量によって異なる）

周囲温度から 750 ℃ まで（液
体流量によって異なる）

液体流量注入口 5 µL/min ～ 3,000 µL/min 200 µL/min ～ 3,000 µL/min

イオン源ガス 1 / イオン源ガス
2

質量分析装置の設置計画概要書を参照してください

質量分析装置ソフトウェアはインストールされて取り付けられているプローブを認識し、対応するユ
ーザーコントロールを使用可能にします。イオン源を使用して測定したデータはすべて、そのデータ
の測定に使用されたプローブの略称によって識別されます（TurboIonSpray プローブの場合は
TIS、APCI プローブの場合は HN）。

TurboIonSpray プローブ

TurboIonSpray プローブは、外径（o.d.）300 μm（0.012 インチ）のステンレススチールチューブで構
成されています。 このプローブは中央に位置しており、2 つのターボヒーターが両側にそれぞれ 45
度の角度で配置されています。TurboIonSpray プローブから導入されたサンプルは、高電圧
（IonSpray Voltage）の印加により、チューブ内でイオン化されます。そして、ターボヒーターからの
高温の乾燥したゼログレードエアのジェット噴射によって噴霧され、高い電荷を帯びた小さい液滴の
ミストになります。イオン源流出物とターボスプレーからの加熱ドライガスの混成物が、イオンパスに
対して 90 度の角度で発射されます。動作原理 — イオン源を参照してください。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。

動作原理

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
43/293



図 4-4 : TurboIonSpray プローブの部品

項目 説明

1 電極チップの拡張量を調整する電極調整ナット（黒のカラー）

2 プローブをイオン源ハウジングのプローブタワーに固定する止めリング

3 イオン源のサンプルインレット領域にサンプルをスプレー噴射する電極チップ

APCI プローブ

APCI プローブは、内径 100 μm（0.004 インチ）のステンレススチールチューブであり、チューブの
周囲をネブライザガス（ガス 1）が流れます。液体サンプルストリームがスプレーを通って汲み上げら
れ、ヒーターを内蔵したセラミックチューブ内でネブライズ化されます。セラミックチューブの内壁は、
温度範囲 100 ℃ ～ 750 ℃ に維持することができ、ヒーターに内蔵されたセンサーによってモニタ
ーされます。

高速ジェット噴射されたネブライザガスが電極チップの周囲を流れ、サンプルを微粒子のミストとし
て拡散します。サンプルはセラミック気化ヒーターを通ってイオン源の反応領域に移動し、コロナ放
電ニードルを通過します。サンプル分子はここで、イオン源ハウジングを通過するときにイオン化さ
れます。動作原理 — イオン源を参照してください。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。
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図 4-5 : APCI プローブの部品

項目 説明

1 電極チップの拡張量を調整する電極調整ナット（黒のカラー）

2 プローブタワー内のプローブを固定する止めリング

3 イオン源のサンプルインレット領域にサンプルをスプレー噴射する電極チップ

ガスおよび電気の接続

ガス接続部と低電圧および高電圧の電気接続部は、真空インターフェースのフロントプレートに装
備されており、イオン源ハウジングに内部接続されています。質量分析装置にイオン源を取り付け
ると、すべての電気およびガスの接続が完了します。

イオン源検出回路

イオン源検出回路は、次の条件下で、質量分析装置とイオン源排気システムへの高圧電源供給を
無効にします。

• イオン源が取り付けられていないか、正しく取り付けられていない場合。

• プローブがインストールされていない場合。

• 質量分析装置がガス不良を検出する場合。

• ターボヒーターが故障した場合。

• イオン源が過熱している場合。
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イオン源排気システム

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。サン
プル蒸気の排気をラボ環境から安全に除去するために、イオン源排気システムが接続
され機能していることを確認してください。装置からの排気物は、一般の建物の排気口
に排出され、ラボのワークスペースに排気されないようにする必要があります。イオン源
排気システム要件については、設置計画概要書のドキュメントを参照してください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。有
害蒸気がラボ環境に侵入するのを防ぐために、イオン源排気システムに専用のラボ
用ドラフトチャンバまたは外部換気システムのいずれかの通気口を設けます。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。LC
システムが質量分析装置と併用される場合、およびイオン源排気システムが機能して
いない場合は、イオン源排気システムの機能が回復するまで LC システムをシャットダ
ウンします。

警告! 火災の危険。イオン源に可燃性の溶剤を 3 mL/分以上向けないでください。LC コン
ポーネントは 大 5 mL/分の流量を提供しますが、 大流量を上回ると、溶剤がイオン源
に蓄積する可能性があります。イオン源とプローブが正しく設置されているときにイオン源排
気システムが無効で機能していない場合は、イオン源を使用しないでください。

注: 装置の排気が室内に入ってくる可能性を低減させるために、すべての排気チューブがしっかりと
接続されていることを確認します。

イオン源がサンプルと溶媒蒸気の両方を生成します。これらの蒸気は、ラボ環境に潜在的に有害で
す。イオン源排気システムは、安全に取り外せて、サンプルと溶媒蒸気を適切に取り扱うことができ
るよう設計されています。イオン源が取り付けられている場合、イオン源排気システムが作動してい
ない限り質量分析装置は作動しません。

イオン源排気検出回路内に取り付けられた真空スイッチが、イオン源内の真空を測定します。プロ
ーブが取り付けられているときに、イオン源の真空がセットポイントを上回ると、システムは排気障
害（準備中）状態になります。

作動中の排気システムは、化学ノイズを発生させることなく、ドレインポート経由でイオン源排気（ガ
ス、溶媒、サンプル蒸気など）を除去します。ドレインポートはドレインチャンバとイオン源排気ポンプ
を経由してドレインボトルに接続し、ここから顧客供給の排気換気システムに接続されています。イ
オン源排気システムの換気要件に関する詳細は、設置計画概要書を参照してください。
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注: イオン源排気システムは定期的に点検して、排気チューブに損傷がなく、排気が室内に漏れて
いないことを確認します。

Analyst MD ソフトウェアの概要

Analyst MD ソフトウェアは、質量分析装置、液体クロマトグラフィー（LC）システム、および関連する
ファームウェアとともに作動し、システムをコントロールしデータ収集します。システムの動作中、取
得されたデータは Analyst MD ソフトウェアへ送信されます。そこでデータは完全な質量分析スペク
トル、単一または複数の対時間イオンまたは対時間の合計イオンカウントとして表示することができ
ます。

さまざまなデータビュー
MS パラメータ

加工パラメータとは、現在使用されている一連の質量分析装置(MS)パラメータです。

化合物パラメータおよびソースとガスパラメータはメソッドで保管されます。分解能および検出器パ
ラメータは質量分析装置によって異なり、機器データとして保管されます。Tune and Calibrate モー
ドがメソッドの作成で使われている場合は、機器の性能が 大化するように加工パラメータを 適
化できます。あるいは、実験サイクル中に各パラメータを 1 つずつ上げます。

• ソースおよびガスパラメータ：これらのパラメータは使用するイオン源によって異なることがありま
す。

• 化合物パラメータ：これらのパラメータはイオンパスの電圧がほとんどを占めます。化合物依存
性パラメータの 適値は分析する化合物によって異なります。

• 分解能パラメータ：これらのパラメータは分解能およびキャリブレーションに影響を及ぼします。

• 検出器のパラメータ：これらのパラメータは検出器に影響を及ぼします。

図 4-6 : イオン光学パスとパラメータ
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場所 パラメータ パラメータ種
類

使用 スキャンタイ
プ

1 IonSpray 電
圧（IS）

ソースとガ
ス

IS パラメータは ESI プローブの電極に
印加された電圧を調整し、イオン源のサ
ンプルをイオン化します。このパラメータ
は極性に依存しており、スプレーの安定
性および感度に影響します。このパラメ
ータは化合物に依存している場合があ
り、化合物ごとに 適化する必要があり
ます。

すべて

1 ネブライザ
電流（NC）

ソースとガ
ス

NC パラメータは、APCI プローブ内のコ
ロナ放電ニードルに印加される電流を制
御します。放電により溶媒分子がイオン
化され、それに次いでサンプル分子もイ
オン化されます。

すべて

1 イオン源ガ
ス 1（GS1）

ソースとガ
ス

GS1 パラメータで、ESI プローブと APCI
プローブ双方のネブライザガスを制御し
ます。

すべて

1 イオン源ガ
ス 2（GS2）

ソースとガ
ス

GS2 パラメータで、ESI プローブのヒータ
ーガスを制御します。

すべて

1 温度 (TEM) ソースとガ
ス

TEM パラメータで、ESI プローブと APCI
プローブのヒーターガスの温度を制御し
ます。

すべて

1 カーテンガ
ス（CUR）

ソースとガ
ス

CUR パラメータは、Curtain Gas インタ
ーフェースのガスの流量を制御します。
Curtain Gas インターフェースは、カーテ
ンプレートとオリフィスの間に配置されて
います。これにより、イオン光学の汚染を
防ぎます。

すべて
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場所 パラメータ パラメータ種
類

使用 スキャンタイ
プ

1 デクラスタリ
ング電位
（DP）

化合物 DP パラメータにより、オリフィスと QJet
イオンガイドの間のイオンをクラスター分
離する能力を制御しているオリフィスの
電圧を制御します。これは、真空チャン
バに入った後にサンプルイオンに残る可
能性がある溶媒クラスターを 小化し、
必要に応じてフラグメント化させるために
使用します。電圧が高くなるほど、イオン
に加えられるエネルギーは高くなります。
DP パラメータが高過ぎる場合、不要なフ
ラグメンテーションが発生する場合があ
ります。

プリセット値を使用し、化合物を 適化し
ます。

すべて

2 エントランス
電位（EP）

化合物 EP パラメータにより、Q0 と接地の間の
電位差を制御します。エントランス電位
は、Q0 領域へイオンを高圧で誘導し、
集中させます。

プリセット値を使用します。

すべて

2 Q0 トラップ 化合物 Q0 トラップパラメータにより、Q0 領域の
イオンの保管状況を制御します。イオン
がリニアイオントラップから大量に選択さ
れて排出される一方で、Q0 領域内でイ
オンをため込むことで、感度とデューティ
サイクルを上げるために使用します。こ
のパラメータにより、固定の充填時間を
使用します。

実験での必要性から、特徴を選択または
消去します。

20 ms 以上の固定充填時間の使用を推
奨します。

EMS、EPI、
ER、および
MS/MS/MS

動作原理
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場所 パラメータ パラメータ種
類

使用 スキャンタイ
プ

3 CAD ガス ソースとガ
ス

CAD ガスパラメータにより、Q3、
MS/MS、および LIT（リニアイオントラッ
プ）スキャンの間、衝突セル内の CAD
ガスの圧力を制御できます。Q3 スキャ
ンの場合、衝突ガスは、イオンが Q2 衝
突セルを通過するときにイオンを集中さ
せるのに役立ちます。CAD ガス用のプリ
セット値は固定モードになっています。
MS/MS スキャンタイプの場合、CAD ガ
スは、プレカーサーイオンを集めるのに
役立ちます。前駆体イオンが衝突ガスと
衝突すると、それぞれが分離してプロダ
クトイオンとなります。LIT（リニアイオント
ラップ）スキャンタイプの場合、衝突ガス
はリニアイオントラップ内でイオンを集中
させ、内部にためこむ働きをします。

プリセット値を使用し、化合物を 適化し
ます。

Q3 MI、Q3
MS、MRM、
Prec、NL、
EMS、ER、
EPI、および
MS/MS/MS

3 衝突エネル
ギー（CE）

化合物 CE パラメータにより、Q0 領域と Q2 衝
突セルの間の電位差を制御します。これ
は MS/MS スキャンタイプでのみ使用し
ます。このパラメータは、Q2 衝突セル内
へと加速しているときにプレカーサーイオ
ンが受け取ったエネルギーの総数です。
このとき、ガス分子およびフラグメントと
衝突しています。

プリセット値を使用し、化合物を 適化し
ます。

EPI、
MS/MS/MS
、MRM、
MS2、
Prec、NL、
および LIT

3 衝突エネル
ギー拡散
(CES)

化合物 CES パラメータは CE パラメータと合わ
せて、CES を使用する場合に拡張製品
イオン(EPI)または MS/MS/MS(MS3)ス
キャンで、どの 3 つの個別の衝突エネル
ギーをプレカーサー質量に適用するかを
決定します。衝突エネルギー拡散値を入
力するとき、CES は自動的に ON になり
ます。

プリセット値を使用し、化合物を 適化し
ます。

EPI および
MS/MS/MS

動作原理
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場所 パラメータ パラメータ種
類

使用 スキャンタイ
プ

3 衝突セル出
口電位
(CXP)

化合物 CXP パラメータを使用するのは Q3 と
MS/MS スキャンタイプの場合のみで
す。このパラメータにより、イオンを Q3
四重極へ送ることができます。

プリセット値を使用し、化合物を 適化し
ます。

Q3、MRM、
MS2、
Prec、NL

4 Q3 エントリ
ーバリア

化合物 Q3 エントリーバリアパラメータを使用し
て、リニアイオントラップの Q2 衝突セル
からイオンを移動します。

プリセット値を使用します。

EMS、
EPI、ER、および MS/MS/MS

5 MS/MS/MS
フラグメンテ
ーション励
起時間

化合物 MS/MS/MS フラグメンテーション時間パ
ラメータにより、励起エネルギーが適用さ
れる時間量を制御します。これは、励起
エネルギーと結合して使用し、隔離され
た第 2 のプレカーサーイオンを分解しま
す。

プリセット値を使用します。

MS/MS/MS

6 固定 LIT 充
填時間

化合物 固定 LIT 充填時間パラメータにより、LIT
がイオンで充填される時間量を制御しま
す。

プリセット値を使用し、サンプル濃度に応
じて望ましい信号応答が得られるように
調整します。

EMS、EPI、
ER、および
MS/MS/MS
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場所 パラメータ パラメータ種
類

使用 スキャンタイ
プ

6 動的充填時
間（DFT）

化合物 DFT パラメータにより、受信するイオンシ
グナルに基づき、イオンがリニアイオント
ラップの中で収集される時間量を動的に
算出できます。DFT を ON にすると、シ
グナルは感度を上げるため、または空間
電荷を 小化するために 適化されま
す。

実験に基づき、特徴を選択または削除し
ます。

Tools > Settings > Method Options
ダイアログボックスで、DFT 設定はデフ
ォルトのスキャン速度用に 適化されま
す。これらの設定は、他の LIT（リニアイ
オントラップ）スキャン速度にも適してい
ます。

EMS、EPI、
ER、および
MS/MS/MS

7 CEM 検出器 CEM パラメータにより、検出器に適用さ
れる電圧を制御します。この電圧は、検
出器の反応を制御します。

すべて

動作原理
質量分析法は、イオンの質量電荷比を測定することにより、不明な成分を識別し、既知の成分を定
量化し、分子の構造特性および化学的性質についての情報を提供します。

質量分析装置は、四重極フィルターのシリーズを持ち、質量電荷比（m/z）にしたがってイオンを伝達
します。その中で 初の四重極となるのが QJet イオンガイドで、オリフィスプレートと Q0 領域の間
に位置しています。QJet イオンガイドはイオンを濾過しませんが、Q0 領域に入る前にイオンにフォ
ーカスします。QJet イオンガイドは、Q0 領域へのイオンのフォーカスを支援します。Q0 領域におい
て、イオンは Q1 四重極に入る前に再度フォーカスされます。

動作原理
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図 4-7 : イオンパス

項目 説明

1 カーテンプレートとオリフィスプレート

2 QJet イオンガイド

3 Q0 領域

4 Q1 四重極

5 Q2 衝突セル

6 Q3 四重極

7 検出器

Q1 四重極は Q2 衝突セルに入る前にイオンを選別する四重極フィルターです。Q2 衝突セルでは、
ガス分子との衝突によってイオンの内部エネルギーが増加され、分子結合の破壊によるプロダクト
イオンの生成に至ります。この技術によりユーザーがプロダクトイオンの m/z を測定し、親イオンの
成分を決定する実験を設計できます。

Q2 衝突セルを通過後、イオンは追加のフィルターのために Q3 四重極に入り、その後検出器に入
ります。検知器においては、イオンは電圧パルスに変換される電流を生成します。検出器から出る
電圧パルスは、検出器に入ったイオン量に直接に比例します。システムはこれらの電圧パルスを監
視し、情報をシグナルに変換します。シグナルは特定の m/z 値についてのイオン強度を表し、シス
テムは質量スペクトルとしてこの情報を表示します。

リニアイオントラップ（LIT）機能性により、多数の強化モードでの操作が可能です。強化モードの共
通要因は、イオンが Q3 四重極リージョン中に捕捉され、次いでスキャンアウトされて完全なスペク
トルデータを生成する点です。多くのスペクトルが短時間に高速で収集され、比較可能な標準四重
極モードの操作で収集されたスペクトルよりはるかに強力なものです。

収集段階ではイオンは CAD ガスがイオンを Q3 領域へ集中させる Q2 衝突セルを通過します。
Q3 四重極はメイン RF 電圧だけを適用して操作されます。イオンは Q3 四重極を通過できず、また
直流障壁電圧が適用される出口側レンズによって反射して戻されます。充填時間（ユーザーによっ
て定義されるか、ダイナミック充填時間機能によって決定される時間）が経過した後、直流障壁電圧
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は Q3 入口側レンズ（IQ3）に適用されます。この電圧により、収集されたイオンが Q3 領域に閉じ
込められ、追加のイオンが侵入できなくなります。四重極ロッドに適用された入口側と出口側レンズ
の直流電圧障壁および RF 電圧が Q3 領域内にイオンを閉じ込めます。

スキャンアウト段階では、出口側レンズの電圧および補助 RF 電圧はメイン RF 電圧と同時に傾斜
し、四重極スキャンタイプと比較して分解能および感度が増加します。補助交流周波数が Q3 四重
極に適用されます。メイン RF 電圧振幅は低値から高値へ傾斜します、これにより連続して質量を
補助交流周波数と共振させます。イオンが交流周波数との共振状態となる時、それらは出口側レン
ズバリアを乗り越えるのに十分な軸流速度を取得し、質量分析装置イオン検出器の方へ軸方向に
放出されます。完全なスペクトルデータは高速でメイン RF 電圧をスキャンすることにより Q3 領域
中に収集されたイオンから取得できます。

ESI モード

ESI は、ニードル内を流れるサンプル流出物に高電圧を印加することによって、サンプルに含まれ
る分析試料の気相イオンを生成します。ESI は、加熱されたガスフローにより、単一イオンおよび多
価イオンを比較的温和な条件下で生成するため、薬物や殺虫剤などの小分子や、ペプチド、タンパ
ク質、その他の生体高分子などの大型分子を含む幅広い化合物に適しています。感度は、分析試
料の化学的性質、ガス流量、温度、電圧、移動相組成によって異なります。

ESI 法は、ペプチド、タンパク質、熱的に不安定な医薬品などの不安定化合物に十分使用できる温
和な手法です。ESI は 5 µL/min ～ 3,000 µL/min の流量で機能し、100% 水性溶媒から 100% 有
機溶媒までを気化させます。

エレクトロスプレーイオン化モードを参照してください。

APCI モード

APCI モードは以下に適しています。

• 溶液にすぐにイオンを形成しない化合物のイオン化。これらは通常、非極性化合物です。

• LC-MS/MS 実験の単純な APCI スペクトルの生成。

• 複雑で汚れているサンプルの高スループット分析。イオン抑制効果に対する感度は比較的低く
なります。

• LC カラムありまたはなしの流量注入による急速なサンプル導入。

APCI 法は揮発性化合物や熱に不安定な化合物に使用でき、熱分解を 小限に抑えます。液滴お
よび同伴分析試料の急速な脱溶媒と蒸発作用によって熱分解が 小限に抑えられ、コロナ放電ニ
ードルによるイオン化の分子同定が保持されます。バッファは大きな汚染を受けずにイオン源にす
ぐに許容され、スプレー噴射された流出物が瞬時蒸発することで 大 100%の水を使用できます。
APCI プローブは、流出物全体を分岐せずに、広口径カラムを介して流量 200 µL/min ～ 3,000
µL/min で受け入れることができます。

APCI モードを参照してください。

データの取り扱い

Reporter ソフトウェア
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Analyst MD ソフトウェアは、データの取得および処理を行いますが、臨床決定を行うわけではあり
ません。Reporter ソフトウェアにより、Analyst MD ソフトウェアで使用可能なレポート機能を拡張で
きます。Reporter ソフトウェアはカスタムレポート作成にもご使用いただけます。

MultiQuant MD ソフトウェア

MultiQuant MD ソフトウェアは、定量データ処理ソフトウェアで、同時に複数の分析試料およびサン
プルの処理を実行することができます。Analyst MD ソフトウェアと一緒にインストールされます。
MultiQuant MD ソフトウェアは、臨床決定を行うものではありません。レポート機能は MultiQuant
MD ソフトウェアで使用でき、カスタムレポートの作成に使用できます。

Cliquid MD ソフトウェア

Cliquid MD ソフトウェアは、質量分析ワークフローを簡単に使用できるようにするもので、
Analyst MD ソフトウェアと連動します。Cliquid MD ソフトウェアは、質量分析装置をコントロールす
るものでも、直接データを処理するものでもありません。むしろ、Analyst MD ソフトウェアと直接交
信し、データ収集中に質量分析装置と交信し、測定データを処理するほか、ピークレビューを実行し
ます。Cliquid MD ソフトウェアは、臨床決定を行うものではありません。

動作原理 - ソフトウェア
このセクションでは、ソフトウェアで使用される概念について説明します。

Analyst MD ソフトウェアウィンドウ

図 4-8 : Analyst MD ソフトウェアウィンドウ
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項目 説明

1 ナビゲーションバー：ナビゲーションバーにより、さまざまなソフトウェアモード
にアクセスできます。ユーザーは Navigation バーの要素のいくつかを好みに
合わせてカスタマイズすることができます。たとえば、ユーザーはサイズ変更、
移動、または適所に固定することができます。Navigation バーを非表示にす
るには、右上隅の×をクリックします。Navigation バーを表示するには、View
> Navigation Bar をクリックします。

ナビゲーションツリーの 上位レベルには、各ソフトウェアモードを表すアイコ
ンが表示されます。特定のモードのアイコンをダブルクリックすると、ツリーを
広げたり折りたたんだりできます。これにより、選択されたモード内での利用可
能な機能のアイコンが表示または非表示されます。

2 メニューバー：モードごとに異なります。切り取り、コピー、貼り付けなどの一部
のオプションはすべてのモードで同じです。その他のオプションはモードに固
有なもので、他のモードでは利用できません。

3 モードリスト：クリックするとモードを変更できます。モードごとに異なるツール
バーアイコンが用意されています。

4 プロジェクトリスト：クリックすると、データを保存するプロジェクトを変更できま
す。

5 装置および周辺装置の状態：この状態バーには現在の活動についての情報
が表示されます。装置の状態が次の色別に表示されます。緑色（準備完了）、
黄色（アイドル）、赤色（エラー）、白色（ローカル装置ワークステーションなし）。
1 つのアイコンはリモート装置の状態を示します。アイコンをダブルクリックす
ると、デバイスステータスウィンドウが開きます。

6 コンパニオンソフトウェア：本ソフトウェアから開くことができる、インストール済
みのコンパニオンソフトウェアが含まれます。

Analyst MD ソフトウェアモード

このソフトウェアはモードを切り替えることができます。モードは個別の機能領域であり、メインタスク
に関連する一連の活動を行うことができます。ユーザーは Navigation バーあるいはツールバーの
Mode リストからモードにアクセスでき、作業内容を失うことなくモード間を切り替えることができま
す。

表 4-3 : Analyst MD ソフトウェアのモード

名前 説明

Configure (構成)このモードを用いると、機器およびシステム設定を構成することができま
す。ハードウェア構成とレポートテンプレートの設定を含む、ソフトウェアの種々の
オプションやパラメータを設定します。
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表 4-3 : Analyst MD ソフトウェアのモード (続き)

名前 説明

Tune and
Calibrate

(チューニングとキャリブレーション)このモードを使用して、 適な結果を保証する
ために装置を調整するためのオプションを設定します。このモードでは、ユーザー
は次のことが可能です。

• 装置 適化の実施

• 手動チューニングの実施

• グラフ型ビューの表示方法の変更、ファイル情報を開いたときに表示する情報
の種類の選択、リンクオプションやその他の外観オプションの設定を行います。

• 処理オプションの変更

Acquire (取得)このモードを用いると、サンプルの収集方法を決定するためのオプションが
設定できます。このモードでは、ユーザーは次のことが可能です。

• IDA Method Wizard を用いた IDA 測定メソッドの作成

• Acquisition Method Editor による測定メソッドの作成

• バッチエディタによるバッチの作成

• Queue Manager によるキューの表示

• 測定状態のモニタリング

Explore (Explore)このモードを用いると、サンプルの定性分析ができます。このモードで
は、ユーザーは次のことが可能です。

• グラフの表示

• クロマトグラムの表示

• スペクトルの表示

• バッチ測定中にリアルタイムでのデータ表示

Quantitate (定量)このモードを用いると、収集データの分析ができ、定量メソッドを構築して
Results Table を生成することができます。Results Table を用いて、バッチ内の
分析試料および内部標準それぞれのピークすべてを手動でレビューし、キャリブ
レーションカーブ、サンプル統計、およびメトリックプロットを表示します。

定量分析

定量分析はサンプル中の特定の物質の濃度を発見するために使用されます。未知のサンプルを分
析して標準サンプル、つまり既知の濃度の同じ物質を含むサンプルと比較することにより、ソフトウ
ェアは未知のサンプルの濃度を計算できます。このプロセスでは、標準のシグナル応答または応答
比を使用してキャリブレーションカーブを作成し、未知のサンプルの濃度を計算します。すべてのサ
ンプルの算出濃度が結果テーブルに追加されます。
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定量分析は、 も一般的には、複数反応モニタリング（MRM）スキャンを使用して実行されます。
MRM スキャンでは、プレカーサーイオンと特徴的なプロダクトイオンを使用して、分析試料に非常
に特異的な MRM トランジションを定義します。液体クロマトグラフィー内の分析試料の保持時間と
関連する MRM トランジションによって、定量に必要な特異性がもたらされます。

定量化は、検証済みの MRM LC-MS/MS 測定メソッドを使用し、標準キャリブレーションカーブを取
得し、目的の化合物に関連するピークを後に統合することによって達成されます。シグナル応答と
濃度とのキャリブレーションカーブの関連性を用いて、未知のサンプル中の特定の分析試料の量を
測定します。

解析

LC-MS/MS データでは、解析とは、特定の化合物に関連したピークのカーブ下にあるエリアを取得
することを意味します。トランジション、予期される保持時間、内部標準、積分、および回帰パラメー
タを指定するメソッドを使用して、ソフトウェアは所定のサンプルセットでのピークを自動的に積分で
きるようになっています。

結果表

結果表は、キャリブレーションカーブに基づき、各未知のサンプルの分析試料の算出濃度をまとめ
たものです。結果表には、キャリブレーションカーブと結果の統計も含まれます。ユーザーは、結果
表をカスタマイズし、結果表をレイアウトで閲覧できます。

結果表のデータは txt ファイルにエクスポートし、Microsoft Excel などの他のアプリケーションで使
用できます。ユーザーは、データを表形式またはカラムに記載の形でエクスポートすることもできま
す。

結果表が作成されたら、データファイル名は変更しないことを推奨します。

結果表の右クリックメニューの使い方については、Results Table を参照してください。

キャリブレーションカーブ

キャリブレーションカーブは、標準濃度カーブとも呼ばれ、不明のサンプルと濃度が分かっている標
準サンプルを比較することにより、未知のサンプル内の物質濃度を決定する方法です。キャリブレ
ーションカーブは、装置が分析試料（測定が行われる物質）の濃度の変化にどう反応するか（分析
信号）に関するプロットです。オペレータは、未知のサンプル内の分析試料の予想濃度に近い濃度
範囲の一連の標準液を準備します。

キャリブレーション標準は、キャリブレーションカーブの形成に使用されます。キャリブレーションサン
プルの正確でない読み取り、または読み取りの欠如は、分析ランに問題があることを示唆している
場合があります。文書に記載されている許容される方法、および規制当局のガイダンスに従ってキ
ャリブレーションカーブを作成してください。キャリブレーションカーブの準備におけるグッドプラクティ
スの例には、以下が含まれます。

• 分析試料の測定を行うブランクのマトリクスにキャリブレーション標準を準備します。

• 測定する各分析試料に対し、キャリブレーションカーブを生成します。

• 代表的標本、および非定型標本を含め、分析試料の推定濃度範囲を網羅するようにします。

• カーブの生成に、6～8 の標準を使用します。
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これは包括的なリストではありません。ラボにおけるキャリブレーションカーブの作成に関するベスト
プラクティスを決定する際には、他のガイダンスも参照する必要があります。

注: 分析ランにおいて、1 点キャリブレーション標準が使用される場合もあります。1 点キャリブレー
ションは、マトリクスブランクサンプル、および 1 つの標準濃度を使用して実行します。装置の反応
および分析試料濃度の間の関係は、これら 2 つの点で作成される線によって決定されます。収集メ
ソッドおよび定量化メソッドは、用途への許可を得る前に確認を行う必要があります。

回帰の種類

• 線形 (y = mx + b)

• ゼロ点を通る線形 (y = mx)

• 二次式 (y = a2 + bx + c)
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性能特性および仕様 5
このセクションでは、SCIEX Triple Quad 4500MD LC-MS/MS システムおよび QTRAP 4500MD
LC-MS/MS システムの特性や仕様について説明します。

質量分析装置の仕様
表 5-1 : 質量分析装置と粗引きポンプの仕様

感度（MRM モード） カラム上のレセルピン 200 fg S/N、2000 超

CV 5% 未満

大スキャンスピード 12,000 Da/ 秒

大リニアイオントラップスキャ
ン速度(QTRAP システムのみ）

20,000 Da/ 秒

極性切り替え Scheduled MRM モードで 50 msec および MRM モードで 50
msec 以上

小 MRM 滞留時間 1 msec

質量範囲（m/z） 5 Da～2000 Da

リニアイオントラップ質量範囲
（m/z）（QTRAP システムのみ）

50 Da～2000 Da

レセルピン 609/195 のクロスト
ーク

2 msec の滞留時間および 3 msec のインター MRM 休止時間
で、0.5% 未満のクロストークを検出可能

質量安定性
（スキャンスピード 10 Da/sec
で、Q1 スキャンおよびプロダク
トイオンスキャンを使用して評
価した質量安定性）

24 時間にわたって 0.1 Da

スキャン種類 Q1 と Q3 の両方でのフルスキャン MS および選択イオン MS、
プロダクトイオンスキャン、プレカーサーイオンスキャン、ニュート
ラルロスまたはゲインスキャン、複数反応モニタリング（MRM）ス
キャン、および予定した MRM スキャンタイプ。QTRAP システム
のみの場合は、強化 MS スキャン、強化プロダクトイオンスキャ
ン、強化分解能スキャン、および MS3 スキャン。

動的範囲 4 桁

重量

積み重ね可能 – 質量分析装置
上部の 大重量

77.5 kg（171 ポンド）
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表 5-1 : 質量分析装置と粗引きポンプの仕様 (続き)

重量 – 質量分析装置 130 kg （287 ポンド）

重量 – 粗引きポンプ 34 kg（75 ポンド）

寸法

質量分析装置
（幅 × 奥行き × 高さ）

79 cm × 79cm × 59cm

32 インチ x 32 インチ x 24 インチ

粗引きポンプ
（幅 × 奥行き × 高さ）

12 インチ x 17 インチ x 9 インチ

装置専用ベンチ
（幅 × 奥行き × 高さ）

100 cm × 84 cm × 78 cm

表 5-2 : プローブの仕様

パラメータ TurboIonSpray プローブ APCI プローブ

イオン源温度範囲 周辺温度から 750 °C までのプ
ローブ温度は、液体流量に左
右されます。

周辺温度から 750 °C までのプ
ローブ温度は、液体流量に左
右されます。

流量適合性 5 µL/ 分～ 3 mL/ 分 200 µL/ 分～ 3 mL/ 分

注意: ダメージを与える恐れ。 大流量を超えないようにしてくだ
さい。 大流量を超えると、システムのパフォーマンスの低下や
損傷が発生する場合があります。

ガス 1

ガス 2

• ゼログレードエア、またはガス入力オプションについては、
SCIEX にお問い合わせください。

• 大 22 リットル/分のフローで 100 psi（6.89 bar）~105 psi
（7.25 bar）の吐出圧力

設置計画概要書を参照してください。

表 5-3 : 電気系仕様

質量分析装置

公称入力電圧 200～240VAC

入力電圧変動 ± 10%（公称）

周波数 50Hz または 60Hz

大入力電流 10 A
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表 5-3 : 電気系仕様 (続き)

大入力電力 1,000 VA

粗引きポンプ

公称入力電圧 200～240VAC

入力電圧変動 ± 10%（公称）

周波数 50Hz または 60Hz

大入力電流 4.2 A（50 Hz）、4.7 A（60 Hz）

大入力電力 1420 VA（50 Hz）、1250 VA（60 Hz）

コンピュータ

公称入力電圧 100～240VAC

入力電圧変動 ± 10%（公称）

周波数 50Hz または 60Hz

大入力電流 8 A（50 Hz）、6 A（60 Hz）

大入力電力 460 W

モニター

公称入力電圧 100～240VAC

周波数 50Hz または 60Hz

大入力電流 2.5 A
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使用説明—サンプルワークフロー 6
表 6-1 : 装置の設定ワークフロー

ステップ： 実行する作業 詳細情報 作業内容

1 ハードウェアプロフ
ァイルを作成しま
す。

ハードウェアプロフ
ァイルの作成

各ハードウェアプロファイルには質量分
析装置および LC システムなどのその
他の機器が含まれる必要があります。
有効なハードウェアプロファイルに含ま
れる機器のみが、測定メソッドを作成す
る際に使用できます。

2 プロジェクトを作成
してデータを保存し
ます。

プロジェクトおよび
サブプロジェクトの
作成

プロジェクトおよびサブプロジェクトを用
いることで、データ管理が容易になり、
結果を簡単に比較することができます。

3 質量分析装置を
適化します。

装置のパフォーマ
ンスの検証

これは、分解能および質量分析装置の
パラメータを 適化し、システムから
良の感度および性能を得るために質量
分析装置のキャリブレーションを行うプ
ロセスです。

表 6-2 : ルーチン分析ワークフローの例

ステップ： 実行する作業 詳細情報 作業内容

1 メソッドに適用可能
なハードウェアプロ
ファイルを有効化し
ます。

ハードウェアプロフ
ァイルの作成

各ハードウェアプロファイルには質量分
析装置および LC システムなどのその
他の機器が含まれる必要があります。
有効なハードウェアプロファイルに含ま
れる機器のみが、測定メソッドを作成す
る際に使用できます。

2 プロジェクトを作成
してデータを保存し
ます。

プロジェクトおよび
サブプロジェクトの
作成

プロジェクトおよびサブプロジェクトを用
いることで、データ管理が容易になり、
結果を簡単に比較することができます。

3 バッチを作成して
提出します。

セットとサンプルを
バッチに追加およ
びサンプルまたは
サンプルセットの提
出

測定メソッドの作成後、測定バッチを作
成し、測定キューにそのバッチを書き込
んでサンプルを実行します。

4 システムの平衡化
を行います。

システムの平衡化 データ収集前のシステムの平衡化。平
衡化されないシステムのデータは不良
である可能性があります。
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表 6-2 : ルーチン分析ワークフローの例 (続き)

ステップ： 実行する作業 詳細情報 作業内容

5 サンプルを実行し
てデータを取得し
ます。

データの取得 サンプルの実行には、測定用キュー、モ
ニタリング装置、および機器ステータス
の管理が必要です。サンプルの提出お
よびデータ取得には、Queue Manager
を用います。Queue Manager にはキュ
ー、バッチ、およびサンプルステータス
が表示され、キュー内のサンプルおよび
バッチの管理を簡単に行うことができま
す。

6 Explore モードで
データを分析しま
す（オプション）。

使用説明－データ
の分析と探索

Explore モードでは、多くのツールが提
供されており、取得データの表示および
処理が可能です。グラフはピークラベル
やキャプションでカスタマイズすることが
でき、等高線図を表示し、スペクトルをラ
イブラリに保存することができます。

• MultiQuant MD ソフトウェアを使った定量分析を行う場合は、ステップ 7 ～ 8 を実行します。よ
り大きなデータセットには、MultiQuant MD ソフトウェアを推奨します。

• Analyst MD ソフトウェアを使った定量分析を行う場合は、ステップ 9 ～ 10a を実行します。

• Analyst MD ソフトウェアを使った定性分析を行う場合は、ステップ 9 ～ 10b を実行します。

7 MultiQuant MD ソ
フトウェアで定量デ
ータを分析します。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：第 7、
8、10、11、12、
13、14 章

結果表を生成および使用して、バッチ内
の分析試料および内部標準それぞれの
ピークすべてを手動でレビューし、キャリ
ブレーションカーブ、サンプル統計、およ
びメトリックプロットを表示します。

8 MultiQuant MD ソ
フトウェアでレポー
トを作成します。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：付録 C

生成およびレビューされた結果用に提
供されたレポートテンプレートを用いて
レポートを作成します。

9 Analyst MD ソフト
ウェアで定性（また
は定量）データを分
析します。

使用説明－定量デ
ータの分析および
処理

結果表を生成して、バッチ内の分析試
料および内部標準それぞれのピークす
べてを手動でレビューします。定量分析
の場合、キャリブレーションカーブ、サン
プル統計、およびメトリックプロットもレビ
ューします。

10a Reporter ソフトウ
ェアでレポートを作
成します。

レポートの生成 生成およびレビューされた結果用に提
供されたレポートテンプレートを用いて
レポートを作成します。定性分析のみの
レポートについては、ライブラリ検索中
のラベル付きのレポートテンプレートの
一式を用いてください。
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表 6-2 : ルーチン分析ワークフローの例 (続き)

ステップ： 実行する作業 詳細情報 作業内容

10b ライブラリを選択
し、Reporter ソフト
ウェアでレポートを
作成します。

レポートの生成 結果に適切な MS/MS スペクトルライブ
ラリを選択します。生成およびレビューさ
れた結果用に提供された、ライブラリ検
索のラベル付きのレポートテンプレート
を用いてレポートを作成します。定性分
析のみのレポートについては、ライブラ
リ検索のラベル付きのレポートテンプレ
ート一式を用いてください。

表 6-3 : メソッドディベロッパーワークフローの例

ステップ： 実行する作業 詳細情報 作業内容

1 ハードウェアプロフ
ァイルを作成しま
す。

ハードウェアプロフ
ァイルの作成

各ハードウェアプロファイルには質量分
析装置および LC システムなどのその
他の機器が含まれる必要があります。
有効なハードウェアプロファイルに含ま
れる機器のみが、測定メソッドを作成す
る際に使用できます。

2 プロジェクトを作成
してデータを保存し
ます。

プロジェクトおよび
サブプロジェクトの
作成

プロジェクトおよびサブプロジェクトを用
いることで、データ管理が容易になり、
結果を簡単に比較することができます。

3 化合物の自動 適
化

または

ステップ 4 - 化合
物を手動で 適化
します。

使用説明—自動
適化

ソフトウェアにより、化合物の 適化お
よび対象化合物のための質量分析装置
のパラメータが自動 適化されます。

4 化合物を手動で
適化します。

手動での化合物
適化

ユーザーは手動で、化合物を 適化
し、対象化合物のための質量分析装置
のパラメータを 適化します。手動での
適化では、経験を積んだユーザーが
適化プロセス中により大きな制御を行

うことができます。

5 測定メソッドを作成
します。

使用説明—測定メ
ソッド

サンプルの分析のために、質量分析装
置および任意の LC 機器用の測定メソ
ッドを作成します。測定メソッドにより、
使用する周辺装置、その機器でのデー
タ収集時期、および関連パラメータが示
されます。
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表 6-3 : メソッドディベロッパーワークフローの例 (続き)

ステップ： 実行する作業 詳細情報 作業内容

6 バッチを作成して
提出します。

セットとサンプルを
バッチに追加およ
びサンプルまたは
サンプルセットの提
出

測定メソッドの作成後、測定バッチを作
成し、測定キューにそのバッチを書き込
んでサンプルを実行します。

7 システムの平衡化
を行います。

システムの平衡化 データ収集前のシステムの平衡化。平
衡化されないシステムのデータは不良
である可能性があります。

8 サンプルを実行し
てデータを取得し
ます。

データの取得 サンプルの実行には、測定用キュー、モ
ニタリング装置、および機器ステータス
の管理が必要です。サンプルの提出お
よびデータ取得には、Queue Manager
を用います。Queue Manager にはキュ
ー、バッチ、およびサンプルステータス
が表示され、キュー内のサンプルおよび
バッチの管理を簡単に行うことができま
す。

9 Explore モードで
データを分析しま
す（オプション）。

使用説明－データ
の分析と探索

Explore モードでは、多くのツールが提
供されており、取得データの表示および
処理が可能です。グラフはピークラベル
やキャプションでカスタマイズすることが
でき、等高線図を表示し、スペクトルをラ
イブラリに保存することができます。

• MultiQuant MD ソフトウェアを使った定量分析を行う場合は、ステップ 10 ～ 12 を実行しま
す。より大きなデータセットには、MultiQuant MD ソフトウェアを推奨します。

• Analyst MD ソフトウェアを使った定量分析を行う場合は、ステップ 13 ～ 15 を実行します。

• 定性分析の場合にはサポートにご連絡ください。

• Analyst MD ソフトウェアを使った定量分析を行う場合は、ステップ 14 ～ 15 を実行します。一
般的なガイダンスが必要な場合は、サポートにお問い合わせください。

10 MultiQuant MD ソ
フトウェアで定量メ
ソッドを作成しま
す。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：定量化
メソッドエディタ

ソフトウェアでさまざまな定量メソッド作
成ツールを用いると、収集データの分析
ができ、定量メソッドを構築して結果表
を生成することができます。

11 MultiQuant MD ソ
フトウェアで定量デ
ータを分析します。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：第 7、
8、10、11、12、
13、14 章

結果表を生成および使用して、バッチ内
の分析試料および内部標準それぞれの
ピークすべてを手動でレビューし、キャリ
ブレーションカーブ、サンプル統計、およ
びメトリックプロットを表示します。
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表 6-3 : メソッドディベロッパーワークフローの例 (続き)

ステップ： 実行する作業 詳細情報 作業内容

12 MultiQuant MD ソ
フトウェアでレポー
トを作成します。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：付録 C

生成およびレビューされた結果用に提
供されたレポートテンプレートを用いて
レポートを作成します。

13 Analyst MD ソフト
ウェアで定量メソッ
ドを作成します。

MultiQuant MD ソ
フトウェアリファレ
ンスガイド：定量化
メソッドエディタ

ソフトウェアでさまざまな定量メソッド作
成ツールを用いると、収集データの分析
ができ、定量メソッドを構築して結果表
を生成することができます。

14 Analyst MD ソフト
ウェアで定性（また
は定量）データを分
析します。

使用説明－定量デ
ータの分析および
処理

結果表を生成して、バッチ内の分析試
料および内部標準それぞれのピークす
べてを手動でレビューします。定量分析
の場合、キャリブレーションカーブ、サン
プル統計、およびメトリックプロットもレビ
ューします。

15 Analyst Reporter
でレポートを作成し
ます。

レポートの生成 生成およびレビューされた結果用に提
供されたレポートテンプレートを用いて
レポートを作成します。定性分析のみの
レポートについては、ライブラリ検索中
のラベル付きのレポートテンプレートの
一式を用いてください。
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使用説明 — 質量分析装置とイオン源 7
警告! 人身傷害の危険。システムを使用する際は、ドキュメントに記載された指示に従ってく
ださい。SCIEX が指定した方法で装置を使わない場合、装置による保護機能が損なわれる
ことがあります。

システムの起動

警告! 感電の危険。緊急時にはシステムを主電源コンセントから外せるようにしてくだ
さい。主電源コンセントの周囲に物を置かないでください。

注: 装置を操作する前に、操作上の予防措置および制限事項に記載されている安全性に関する情
報をお読みください。

前提条件

• 設置計画概要書に規定されている施設要求事項に適合していること。設置計画概要書には、
主電源および接続、圧縮空気、窒素、粗引きポンプ、換気、排気、施設の清掃の各要件に関す
る情報が掲載されています。設置計画概要書のコピーが必要な場合は、SCIEX にお問い合わ
せください。お問い合わせ先については、sciex.com/contact-us でご確認ください.

• イオン源排気ガス、圧縮空気、窒素ガスが質量分析装置に接続されていること。

• 4 L イオン源排気ドレインボトルが、質量分析装置の背面にある排気排出接続、およびラボ換
気システムに接続されていること。

• イオン源排気ホースが質量分析装置、イオン源排気ドレインボトル、換気連結部にしっかりと固
定されていること。

• 質量分析装置のコンビニエンススイッチがオフになっていて、主電源ケーブルが質量分析装置
に接続されていること。

• 質量分析装置および粗引きポンプの主電源ケーブルが 200 VAC～240 VAC 主電源に接続さ
れていること。

• イーサネットケーブルが質量分析装置およびコンピュータの両方に接続されていること。

1. 粗引きポンプの電源を入れます。

2. 5 分後に質量分析装置のコンビニエンススイッチの電源を入れます。図 4-2 を参照してくださ
い。

3. コンピュータの電源を入れます。

4. 制御ソフトウェアを開きます。
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イオン源の 適化

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。イ
オン源で使用する有害物質や障害性物質の適正使用、汚染、排気に関する知識や
訓練なしに、イオン源を使用しないでください。

警告! 火災の危険。イオン源に可燃性の溶剤を 3 mL/分以上向けないでください。LC コン
ポーネントは 大 5 mL/分の流量を提供しますが、 大流量を上回ると、溶剤がイオン源
に蓄積する可能性があります。イオン源とプローブが正しく設置されているときにイオン源排
気システムが無効で機能していない場合は、イオン源を使用しないでください。

警告! 尖った部分により怪我をする危険、イオン化放射線障害の危険、生物学的危
険、または有害化学物質の危険。イオン源のウィンドウがひび割れたり破損したりし
た場合、イオン源の使用を中止して、SCIEX フィールドサービスエンジニア（FSE）に
お問い合わせください。装置に入り込んだ有害物質や障害性物質は、イオン源排気
出力に混入します。装置からの排気は室外に換気してください。認定を受けたラボ
安全手順に従い、鋭利物を処分します。

分析試料、流量または移動相組成に変化があるごとにイオン源を 適化します。

イオン源に依存するパラメータを 適化する際には、サンプル導入の方法としてフローインジェクシ
ョン分析（FIA）またはティー注入を用い、サンプル分析時に使用される流量でサンプルを導入しま
す。イオン源に依存するパラメータを 適化する前に、イオン源の位置を 適化します。

複数のパラメータがイオン源の性能に影響を及ぼします。既知の化合物を注入中、および既知のイ
オンシグナルをモニタリング中に性能を 適化します。マイクロメータパラメータ、ガスパラメータ、電
圧パラメータを調節して、シグナル対ノイズ比とシグナルの安定性を 大化します。

TurboIonSpray プローブの 適化または APCI プローブの 適化を参照してください。

TurboIonSpray プローブの 適化

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。イオ
ン源排気システムが接続され機能していること、およびラボ全体が良好に換気されて
いることを確認してください。ラボでの適切な換気は、溶剤やサンプル排気の制御と、
システムを安全に操作する上で必要です。

警告! 火災の危険。イオン源に可燃性の溶剤を 3 mL/分以上向けないでください。LC コン
ポーネントは 大 5 mL/分の流量を提供しますが、 大流量を上回ると、溶剤がイオン源
に蓄積する可能性があります。イオン源とプローブが正しく設置されているときにイオン源排
気システムが無効で機能していない場合は、イオン源を使用しないでください。

使用説明 — 質量分析装置とイオン源

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
69/293



警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。電
極がプローブチップよりも先まで突出して、有害蒸気がイオン源から排出されないよう
にします。電極は、プローブ内部に配置してはなりません。

注意: ダメージを与える恐れ。質量分析装置に接続されている LC システムがソフトウェアによって
制御されていない場合は、操作中に質量分析装置から目を離さないでください。質量分析装置がス
タンバイ状態に入ると、LC システムがイオン源をあふれさす可能性があります。

注: システムを清潔かつ 適な性能に保つために、流量を変更する際にプローブ位置を調整しま
す。

ヒント! シグナルおよびシグナル対ノイズ比を 適化するときは、フローインジェクション分析を使用
する方がオンカラム注入法を使用するよりも簡単です。

注: IonSpray Voltage が高過ぎる場合、コロナ放電が発生する可能性があります。コロナ放電は
プローブの先端で青く光るため、目視で確認できます。コロナ放電によって、シグナルの感度と安定
性が低下します。

流量およびイオン源温度

サンプル導入流量およびサンプル溶媒組成は、TurboIonSpray プローブ温度の 適化に影響を及
ぼします。流量が多いほど、または水分含有量が多いほど、 適温度は高くなります。

TurboIonSpray プローブは、多くの場合、サンプル流量 5 µL/ 分 ～ 1000 µL/ 分で使用されます。
蒸発速度を速めるため、熱が利用されます。これにより、イオン化効率が向上し、感度が高まりま
す。流量が極度に少ない高有機溶媒の場合は通常、温度を上げる必要はありません。イオン源パ
ラメータおよび電圧を参照してください。

次の表に、さまざまな流量に対応した標準的なイオン源温度を示します。ユーザーは必ず、特定の
用途用にイオン源温度を 適化する必要があります。

表 7-1 : 流量および通常温度

流量（µL/ 分） 通常のイオン源温度（°C）

1 ～ 20 0 ～ 100

20 ～ 100 150 ～ 350

100 ～ 300 300 ～ 400

300 ～ 1000 400 ～ 500
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メソッド

液体サンプルストリームは、LC ポンプまたはシリンジポンプによってイオン源に運ばれます。LC ポ
ンプでサンプルを送る場合、フローインジェクション分析（FIA）またはティー注入を使用して移動相
に直接注入するか、シリンジポンプを介して注入するか、またはループインジェクタもしくはオートサ
ンプラーを使用して分離カラム経由で注入できます。シリンジポンプで導入する場合、サンプルはイ
オン源に直接注入されます。注入の 適化は、イオンパスの 適化と MS/MS フラグメント選定に
使用することができます。

システムの準備
特定の化合物のために 適化するためのメソッドを作成するには、手動での化合物 適化を参照
してください。

1. Analyst MD ソフトウェアを起動します。

2. Navigation バーの Tune and Calibrate モードの下にある Manual Tuning をダブルクリック
します。

3. 前回 適化したメソッドを開くか、化合物に合わせてメソッドを作成します。

4. イオン源の熱を冷まされている場合、次の操作を行います。

a. イオン源温度を 450 に設定します。

b. イオン源を 30 分そのままにして温めます。

この 30 分間の温め行程で、溶媒蒸気が冷たいプローブ内で固体化するのを防ぎます。

5. 溶媒フローとサンプル注入を開始します。

開始条件の設定

1. Tune Method Editor で、正しい Scan Type と適切な化合物パラメータが選択されていること
を確認してください。

2. Ion Source Gas 1 の開始値を入力します。

LC ポンプの場合、40 ～ 60 の値をガス 1 に使用します。

3. Ion Source Gas 2 (GS2) の開始値を入力します。

LC ポンプの場合、30 ～ 50 の値をガス 2 に使用します。

注: ガス 2 は多めの流量で、通常 LC システムと使用され、温度の上昇と連動しています。

4. IonSpray Voltage (IS) フィールドに 4500 と入力します。

5. Curtain Gas (CUR) フィールドに 20 と入力します。

6. 測定を開始します。
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TurboIonSpray プローブポジションの 適化

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。電
極がプローブチップよりも先まで突出して、有害蒸気がイオン源から排出されないよう
にします。電極は、プローブ内部に配置してはなりません。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。

プローブを 適化したら、微調整だけで済みます。プローブを取り外した場合、または分析物、流
量、溶媒組成が変更された場合は、 適化手順を繰り返します。

イオン源コンポーネントを参照してください。

1. イオン源のウィンドウ越しに、プローブポジションを確認します。

2. 前回の水平および垂直マイクロメータ設定を使用するか、これらの設定を 5 にして開始ポジシ
ョンとして設定します。

3. 分析試料のシグナルまたはシグナル対ノイズ比を制御ソフトウェアでモニターします。

4. 水平マイクロメータを使用してプローブポジションを少しずつ調整して、 適なシグナルまたは
シグナル対ノイズ比を達成します。

プローブをアパチャのどちらかの側に若干寄せた方が 適となる可能性もあります。

ヒント! 水平マイクロメータ設定を調節して、TurboIonSpray プローブから出る液体噴射の方向
をアパチャからそらして、アパチャの汚染、シグナルの不安定化をもたらす Curtain Gas インタ
ーフェースの流量の浸透、液体混入による電気ショートを防ぎます。

5. 垂直マイクロメータを使用してプローブポジションを少しずつ調整して、 適なシグナルまたは
シグナル対ノイズ比を達成します。

注: プローブの垂直ポジションは流量に左右されます。流量が低くなると、プローブがアパチャ
（開口部）に接近します。流量が高くなると、プローブがアパチャ（開口部）から遠ざかります。

6. プローブ上の黒の電極調整ナットを調整して、電極チューブをプローブの内側または外側へと
移動します（突起を調整します）。

注: 電極チップがプローブ終端よりも 0.5 mm ～ 1.0 mm 先に伸びていなくてはなりません。

電極チップの 適な設定値は化合物に左右されます。電極チップの突出距離がスプレーコー
ンの形状に影響を及ぼし、スプレーコーンの形状が質量分析装置の感度に影響を及ぼしま
す。
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図 7-1 : 電極チップ拡張部の調整

項目 説明

1 プローブ

2 電極

イオン源/ガスパラメータおよび電圧の 適化

適なシグナル安定性と感度が得られるよう、イオン源ガス 1（ネブライザガス）を 適化します。イ
オン源ガス 2（ヒーターガス）は溶媒の蒸発を助け、サンプルのイオン化を促進します。

温度が高すぎると、TurboIonSpray プローブで溶媒が早期に蒸発する可能性があります（これは特
に、プローブの突出が大きすぎる場合によく起こります）。その結果シグナルが不安定になり、化学
的バックグラウンドノイズが高くなります。同様に、ヒーターガス流量を多くすると、ノイズの多いシグ
ナルまたは不安定なシグナルが生じる可能性があります。

注: IonSpray Voltage が高過ぎる場合、コロナ放電が発生する可能性があります。コロナ放電は
プローブの先端で青く光るため、目視で確認できます。コロナ放電によって、シグナルの感度と安定
性が低下します。

1. 適なシグナルまたはシグナル対ノイズ比が得られるよう、イオン源ガス 1 とイオン源ガス 2
を 5 単位で調整します。

2. シグナルが減少し始めるまで、Curtain Gas インターフェースのガス流量を増やします。
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注: 汚染を防ぐために、Curtain Gas インターフェースのガス流量は、感度を犠牲にしない範囲
で、できるだけ大きな値を使用してください。流量を表の値未満に設定しないでください：表
7-2。これにより、ノイズの多い信号を発生させる Curtain Gas インターフェースのガスの流れ
が浸透するのを防ぎ、アパチャ（開口部）の汚染を防ぎ、全体のシグナル対ノイズ比を高めるこ
とができます。

表 7-2 : CUR パラメータ値

質量分析装置 開始値

4500MD システム 20

3. IonSpray Voltage (IS) スプレー電圧の値を 500 V 単位で調整して、シグナル対ノイズ比を
大化します。

ターボヒーター温度の 適化

適なヒーター温度は、化合物、流量、および移動相の組成によって異なります。流量が多くなる
と、または水分組成が高くなると、 適温度も高くなります。

イオン源温度を 適化する際には、イオン源が新規設定温度で平衡状態に達しているかを確認し
ます。

適なシグナルまたはシグナル対ノイズ比が得られるよう、イオン源温度を 50 ℃ ～ 100 ℃ 単位
で調整します。

APCI プローブの 適化

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。イオ
ン源排気システムが接続され機能していること、およびラボ全体が良好に換気されて
いることを確認してください。ラボでの適切な換気は、溶剤やサンプル排気の制御と、
システムを安全に操作する上で必要です。

警告! 火災の危険。イオン源に可燃性の溶剤を 3 mL/分以上向けないでください。LC コン
ポーネントは 大 5 mL/分の流量を提供しますが、 大流量を上回ると、溶剤がイオン源
に蓄積する可能性があります。イオン源とプローブが正しく設置されているときにイオン源排
気システムが無効で機能していない場合は、イオン源を使用しないでください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。電
極がプローブチップよりも先まで突出して、有害蒸気がイオン源から排出されないよう
にします。電極は、プローブ内部に配置してはなりません。
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注意: ダメージを与える恐れ。質量分析装置に接続されている LC システムがソフトウェアによって
制御されていない場合は、操作中に質量分析装置から目を離さないでください。質量分析装置がス
タンバイ状態に入ると、LC システムがイオン源をあふれさす可能性があります。

注: APCI プローブにサポートされる 小流量は、200 µL/min です。APCI プローブのパラメータの
完全なリストについては、APCI プローブのパラメータ を参照してください。

ヒント! シグナルおよびシグナル対ノイズ比を 適化するときは、フローインジェクション分析を使用
する方がオンカラム注入法を使用するよりも簡単です。

注: APCI プローブを使用する際には、コロナ放電ニードルがアパチャ（開口部）の方を指しているか
を確認します。

システムの準備
特定の化合物のために 適化するためのメソッドを作成するには、手動での化合物 適化を参照
してください。

1. Analyst MD ソフトウェアを起動します。

2. Navigation バーの Tune and Calibrate モードの下にある Manual Tuning をダブルクリック
します。

3. 前回 適化したメソッドを開くか、化合物に合わせてメソッドを作成します。

4. イオン源の熱を冷まされている場合、次の操作を行います。

a. イオン源温度を 450 に設定します。

b. イオン源を 30 分そのままにして温めます。

この 30 分間の温め行程で、溶媒蒸気が冷たいプローブ内で固体化するのを防ぎます。

5. 溶媒フローとサンプル注入を開始します。

開始条件の設定

1. Tune Method Editor で、正しい Scan Type と適切な化合物パラメータが選択されていること
を確認してください。

2. Ion Source Gas 1 (GS1)フィールドに 30 と入力します。

3. Curtain Gas (CUR) フィールドに 20 と入力します。

4. Nebulizer Current (NC) フィールドに 1 と入力します。

5. Compound タブの Declustering potential (DP)フィールドで、100を入力します。

6. 測定を開始します。

イオン源 / ガスパラメータの 適化

1. 適なシグナルまたはシグナル対ノイズ比が得られるよう、イオン源ガス 1 を 5 単位で調整し
ます。
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2. Curtain Gas インターフェースのガス流量を、シグナルが減少し始めるまで増やしていきます。

注: 汚染を防ぐために、Curtain Gas インターフェースのガス流量は、感度を犠牲にしない範囲
で、できるだけ大きな値を使用してください。流量を表の値未満に設定しないでください：表
7-3。これにより、ノイズの多い信号を発生させる Curtain Gas インターフェースのガスの流れ
が浸透するのを防ぎ、アパチャ（開口部）の汚染を防ぎ、全体のシグナル対ノイズ比を高めるこ
とができます。

表 7-3 : CUR パラメータ値

質量分析装置 開始値

4500MD システム 20

コロナ放電ニードルのポジションの調整

警告! 感電の危険。この手順に従い、コロナ放電ニードル、カーテンプレート、および
ターボヒーターに印加された高電圧に触れないようにします。

必要な資材

• 絶縁マイナスドライバー

APCI プローブを使用する際には、コロナ放電ニードルがアパチャ（開口部）の方を指しているかを
確認します。TurboIonSpray プローブを使用する際には、コロナ放電ニードルがアパチャから離れ
た方を指しているかを確認します。

1. 絶縁マイナスドライバーを使用して、ニードルの 上部にあるコロナ放電ニードル調整ネジを回
します。

2. ガラスウィンドウ越しに、ニードルチップがアパチャの方を向いた形で配置されているかを確認
します。

APCI プローブポジションの 適化

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。電
極がプローブチップよりも先まで突出して、有害蒸気がイオン源から排出されないよう
にします。電極は、プローブ内部に配置してはなりません。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。
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カーテンプレートアパチャが、常に溶媒や溶媒液滴のない状態に保たれていることを確認します。

スプレーノズルのポジションが感度とシグナル安定性に影響を及ぼします。プローブポジションは必
ず少しずつ調整してください。流量が少ない場合は、プローブをアパチャに近づけます。流量が多い
場合は、プローブをアパチャから遠ざけます。プローブを 適化したら、微調整だけで済みます。プ
ローブを取り外した場合、または分析物、流量、溶媒組成が変更された場合は、 適化手順を繰り
返します。

図 7-2 : スプレーノズルポジション

項目 説明

1 コロナ放電ニードル

2 カーテンプレート

3 APCI プローブ

1. 前回の水平および垂直マイクロメータ設定を使用するか、これらの設定を 5 にして開始ポジシ
ョンとして設定します。

注: 質量分析装置の性能低減を回避するために、アパチャ（開口部）内に直接スプレー噴射し
ないでください。

2. 制御ソフトウェアで、分析試料のシグナルまたはシグナル対ノイズ比をモニターします。

3. 水平マイクロメータを使用してプローブを少しずつ調整して、 適なシグナルまたはシグナル対
ノイズ比を達成します。
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4. 垂直マイクロメータを使用してプローブポジションを少しずつ調整して、 適なシグナルまたは
シグナル対ノイズ比を達成します。

5. プローブ上の黒の電極調整ナットを調整して、電極チューブをプローブの内側または外側へと
移動します（突起を調整します）。

注: 電極チップがプローブ終端よりも 0.5 mm ～ 1.0 mm 先に伸びていなくてはなりません。

電極チップの 適な設定値は化合物に左右されます。電極チップの突出距離がスプレーコー
ンの形状に影響を及ぼし、スプレーコーンの形状が質量分析装置の感度に影響を及ぼしま
す。

図 7-3 : 電極チップ拡張部の調整

項目 説明

1 プローブ

2 電極

ネブライザ電流の 適化

イオン源は電圧ではなく電流で制御されています。イオン源の選択位置に関係なく、測定メソッドに
適した電流を選択します。

ネブライザの電流値の開始値を 3 として値を増減し、 適なシグナルまたはシグナル対ノイズ比が
得られるよう調整します。

コロナ放電ニードルに印加されるネブライザ電流の 適値は、通常、どちらの極性でも
1 µA ～ 5 µA です。電流を上げてもシグナルに変化が見られない場合は、 高のシグナルまたは
シグナル対ノイズ比が得られる 小値にしておきます。

APCI プローブ温度の 適化

溶媒の容量と種類が、 適な APCI プローブ温度に影響を及ぼします。流量が多くなると、 適温
度が高くなります。
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適なシグナルまたはシグナル対ノイズ比が得られるよう、イオン源温度を 50 ℃ ～ 100 ℃ 単位
で調整します。

適化に関するヒント

イオン源を 適化すると、イオン源および真空インターフェースコンポーネントのクリーニングの必要
性が 小限に抑えられます。

• 化合物を 適化する際、可能な限り も高い温度を使用します。多くの化合物にとって一般的な
温度は 700 °C です。高温にすることによりイオン源を清潔に保ち、バックグラウンドノイズを削
減します。

• Curtain Gas インターフェースのガス流量には、感度を損なわない範囲で可能な限り高い値を使
用します。これにより、次のことが可能になります。

• Curtain Gas インターフェースのガス流の貫通を防ぐ。これはノイズの多いシグナルを生成す
る可能性があります。

• アパチャを汚染から守ります。

• 全体のシグナル対ノイズ比を向上させます。

• 次の目的で、水平マイクロメータを調整して、プローブからの液体スプレーをアパチャから離れる
方向に向けます。

• アパチャを汚染から守ります。

• Curtain Gas インターフェースのガス流の貫通を防ぐ。これは不安定なシグナルを生成する
可能性があります。

• 液体混入による電気ショートを回避します。

そのためには、垂直マイクロメータを用いて、プローブを上に向けます。

• シグナルを損なわない範囲で可能な限り低い IonSpray 電圧を使用します。シグナルだけでは
なく、シグナル対ノイズ比にも着目します。

• APCI モードで 2 mL/min を超える流量を用いる場合は、液体フローを開始する前に質量分析装
置が平衡状態となるまで待ち、噴霧温度に達していることを確認します。

質量分析装置のキャリブレーション手順
質量較正は時間経過に伴い変化する可能性があります。質量較正は定期的に検証してください。
設置時、質量分析装置の 高の感度と性能を得るためにシステムは質量較正を行い、単位および
高分解能（ポジティブとネガティブの両方のモード）でスペクトルのピークの分解能が 適化されま
す。質量較正は、イオン化合物から発信されたシグナルが真の m/z 値で記録されることを保証しま
す。1 m/z スケールは、既知の純度と質量の化合物を用いてキャリブレートされます。分解能の 適
化には、ピーク幅とピーク形状の調整が伴います。質量スペクトル分解能は（m/z）/Width で表さ
れ、ここで、Width は既定の m/z 値でのスペクトルピークのピーク幅です。 1 ピーク幅は、通常強度
が半分のピーク高さの点で測定されます。

1 CLSI 標準 C50-A-27 巻、No.24 — 臨床検査での質量分析：一般原則とガイダンス：承認されたガイドライン.
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注: 分解能が高くなると、感度が下がります。感度と分解能の要件の均衡をとることが重要です。

Analyst MD ソフトウェアの Instrument Optimization モジュールは、質量較正と分解能の 適化
に使用します。システムが正常に機能していることを確認するため、毎週、または機器をクリーニン
グした後に、質量較正と分解能を確認してください。一般に、トリプル四重極質量分析装置のキャリ
ブレーションと分解能は、システムが真空を失わなければ 3〜6 か月間安定しています。システム
が真空を失う場合、システムを使用する前にキャリブレーションと分解能を確認します。使用説明—
チューニングとキャリブレーション を参照してください。

注意: 結果が不正確になる可能性。システムがキャリブレーションされていることを確かめてくださ
い。システムが適切にキャリブレーションされていない場合、質量の同定や定量化が不正確になる
ことがあります。

操作上の予防措置および制限事項およびキャリブレーションイオンと溶液を参照してください。

質量分析装置のリセット
1. 質量分析装置で継続しているスキャンを中断した後、サンプルフローを停止します。

2. 制御ソフトウェアを閉じます。

3. Reset ボタンを 5 秒間押します。
リレーが有効になるとクリック音が聞こえます。約 three 分後、質量分析装置が動作圧力に達
します。

システムのシャットダウンと大気開放
一部の手順では、システムをシャットダウンする必要があります。その他にも、大気開放が必要にな
る場合があります。以下の手順に従ってシステムをシャットダウンし、必要に応じて大気開放しま
す。

注意: ダメージを与える恐れ。ターボポンプの回転が止まるまで、粗引きポンプを停止させないでく
ださい。

注: インプットガス供給を外す必要がある場合、外す前にガスラインの圧力を開放します。

ヒント! 質量分析装置を延長期間使用しない場合は、イオン源をすぐ使用できる状態にしたまま
Standby 状態にしておいてください。質量分析装置をシャットダウンさせるには、次の手順に従って
ください。

1. 継続中のスキャンを完了させるか、停止してください。

注意: ダメージを与える恐れ。システムをシャットダウンする前に、サンプルフローを停止しま
す。

2. システムのサンプルフローを停止します。

3. ソフトウェアを閉じます。
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4. （必要に応じて）以下の手順に従ってシステムを大気開放します。

注: 真空インターフェースのフルクリーニング実行前、Q0 領域のクリーニング前、および粗引き
ポンプオイルの交換前にシステムを大気開放してください。詳細な情報については、有資格保
守要員（QMP）またはフィールドサービスエンジニア（FSE）にお問い合わせください。

a. Vent ボタンを 3 秒間押します。
真空 LED が素早く（ポンプ停止時よりも速く）点滅し始めます。ターボポンプの回転速度が
徐々に落ちます。

b. システムを 15 分間ベントしてから、粗引きポンプの電源を切ります。

5. 質量分析装置のコンビニエンススイッチを切ります。

6. 質量分析装置の主電源ケーブルを、主電源コンセントから取り外します。

7. （システムを大気開放する場合）粗引きポンプの電源供給ケーブルを、主電源コンセントから取
り外します。
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取扱説明書 — ハードウェアプロファイル
およびプロジェクト 8
ハードウェアプロファイル
ハードウェアプロファイルは、質量分析装置および機器がどのように構成され、コンピュータに接続
されているかをソフトウェアに伝えます。複数のハードウェアプロファイルを設定することができます
が、随時アクティブにできるのは 1 つのプロファイルだけです。

Hardware Configuration Editor でハードウェアプロファイルを作成する場合、周辺装置はソフトウ
ェアと通信できるように構成する必要があります。周辺機器の設定には、次の 2 つの手順が必要で
す。

• 物理的な接続を行う手順。機器への物理的接続の設定については、周辺装置セットアップガイド
を参照してください。

• 周辺機器と通信するためにソフトウェアを設定する手順。対応デバイスの一覧は、Analyst MD
ソフトウェアのソフトウェアインストールガイドを参照してください。

ソフトウェアをインストールするときに、各周辺装置に必要なドライバもインストールされます。周辺
装置を物理的にコンピュータに接続した後、適切な構成情報を設定します。

各ハードウェアプロファイルには質量分析装置が含まれている必要があります。測定メソッドを作成
する前に、メソッドに使用する全機器がハードウェアプロファイルに含まれていることを確認します。
有効なハードウェアプロファイルで構成し、Add/Remove Device Method ダイアログボックスで選
択した機器は、Acquisition method ペインでアイコン表示されます。有効なハードウェアプロファイ
ルに含まれる周辺装置のみが、測定メソッドの作成に使用できます。

ハードウェアプロファイルの作成

ユーザーは複数のハードウェアプロファイルを作成することができますが、随時アクティブにできる
のは 1 つのプロファイルだけです。

1. Navigation バーの Configure の下にある Hardware Configuration をダブルクリックしま
す。
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図 8-1 : Hardware Configuration Editor ダイアログ

2. New Profile をクリックします。
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図 8-2 : Create New Hardware Profile ダイアログ

3. Profile Name フィールドに名前を入力します。

4. Add Device をクリックします。
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図 8-3 : Available Devices ダイアログ

Available Devices ダイアログの Mass Spectrometer フィールドでは、Device Type がプリ
セット値となっています。

5. Devices リストで適切な質量分析装置を選択し、OK をクリックします。

6. Create New Hardware Profile ダイアログで Setup Device をクリックします。

7. （オプション）内蔵シリンジポンプを使用する質量分析装置を構成するには、Configuration タブ
で Use integrated syringe pump チェックボックスをオンにします。
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図 8-4 : シリンジポンプが構成された Configuration タブ

8. （オプション）ダイバーターバルブに対する質量分析装置を構成するには、Configuration タブ
で Use integrated injector/diverter valve を選択します。

9. （オプション）必要であれば Configuration および Communication タブでさらなる特性を選択し
ます。

10. OK をクリックします。

11. Create New Hardware Profile ダイアログで Add Device をクリックし、質量分析装置で使用
する各デバイスを追加して設定します。 ハードウェアプロファイルにデバイスを追加を参照して
ください。

12. Create New Hardware Profile ダイアログで OK をクリックします。

13. Hardware Configuration Editor で有効化対象のハードウェアのプロファイルをクリックします。

14. Activate Profile をクリックします。
チェックマークが緑色に変わります。赤い×印が現れる場合は、ハードウェアプロファイルの有
効化に問題が生じています。

ヒント! ハードウェアプロファイルは、別のプロファイルが有効化されるまでは無効化する必要
はありません。ハードウェアプロファイルをクリックし、次に Activate Profile をクリックします。
有効なプロファイルは自動的に無効化されます。
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15. Close をクリックします。

注: 有効なハードウェアプロファイルの現在の動作モードは、Analyst MD ソフトウェアウィンド
ウの右下のセクションで質量分析装置アイコンをダブルクリックすると、装置の Detailed
Status ダイアログに表示されます。

ハードウェアプロファイルにデバイスを追加

デバイスは、ソフトウェアが通信できるように構成する必要があります。ソフトウェアをインストールす
ると、各デバイスに必要なドライバもインストールされます。デバイスを設定する前に、デバイスをコ
ンピュータに物理的に接続する必要があります。詳細な情報については、周辺装置セットアップガイ
ドを参照してください。

1. Hardware Configuration Editor を開いてください。

2. Hardware Profiles リストで、ハードウェアプロファイルを無効にします。

3. Edit Profile をクリックします。

4. Add Device をクリックします。
Available Devices ダイアログが開きます。

5. Device Type リストでデバイスを選択し、OK をクリックします。

図 8-5 : Available Devices ダイアログ

6. OK をクリックします。

7. Devices リストでデバイスを選択してから、OK をクリックします。
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8. Setup Device をクリックします。
デバイスの構成値を含むダイアログが開きます。

9. （オプション）Communication タブの Alias フィールドで、デバイスの名称または他の識別子を
入力します。

注: シリアル通信を使用するデバイスでは、選択したシリアルポートが、デバイスが物理的に接
続されているデバイスのシリアルポートと一致していることを確認してください。

注: Alias フィールドは Name ボックスとして参照されることもあり、Alias の下にある他のタブ
に位置しています。

• デバイスが Serial Port を通信インターフェースとして使用する場合は、COM Port
Number リストでデバイスを接続している COM ポートを選択します。

• デバイスが Ethernet を通信インターフェースとして使用する場合は、管理者によりデバイ
スに割り当てられた IP Address を入力するか、対応するアドレスの Host Name を使用し
ます。

• デバイスが GPIB Board を通信インターフェースとして使用する場合は、GPIB ボードの設
定を変更しないでください。

デバイスの残りのプリセット値は、適切だと考えます。これらの値を変更しないでください。
Configuration タブおよび Communication タブについての詳細は、ヘルプを参照してくださ
い。

10. デバイスのプリセット値を回復するには、Communication タブで、Set Defaults をクリックしま
す。

11. 構成を保存するには、OK をクリックします。

12. ステップ 4 からステップ 11 を各デバイスについて繰り返します。

13. Create New Hardware Profile ダイアログで OK をクリックします。

14. ハードウェアプロファイルを有効にするには、以下の手順に従います。

a. Hardware Configuration Editor で、ハードウェアプロファイルをクリックします。

b. Activate Profile をクリックします。

チェックマークが緑色に変わります。赤い×印が現れる場合は、ハードウェアプロファイルの有
効化に問題が生じています。詳細な情報については、ハードウェアプロファイル有効化のトラブ
ルシューティングを参照してください。

ヒント! 他のハードウェアを有効にするために有効なハードウェアプロファイルを無効化する必
要はありません。有効でないハードウェアプロファイルをクリックし、Activate Profile をクリック
します。他のプロファイルは自動的に無効化されます。

15. Close をクリックします。

ハードウェアプロファイルのデバイスの編集

1. Hardware Configuration Editor を開きます.
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2. Hardware Profiles リストで、ハードウェアプロファイルを無効にします。

3. Edit Profile をクリックします。

4. 適切なデバイスを選択して Setup Device をクリックします。

デバイス構成ダイアログが開きます。

5. 構成を編集して OK をクリックします。

6. OK をクリックします。

7. Activate Profile をクリックします。
チェックマークが緑色に変わります。赤い×印が現れる場合、ハードウェアプロファイルの有効
化に問題が生じています。詳細な情報については、ハードウェアプロファイル有効化のトラブル
シューティングを参照してください。

ヒント! 他のハードウェアを有効にするために有効なハードウェアプロファイルを無効化する必
要はありません。有効でないハードウェアプロファイルをクリックし、Activate Profile をクリック
します。他のプロファイルは自動的に無効化されます。

8. Close をクリックします。

ハードウェアプロファイル有効化のトラブルシューティング

ハードウェアプロファイルが有効にならない場合、プロファイルのどのデバイスが有効化に失敗した
かを示すダイアログボックスが開きます。通信エラーでデバイスが有効にならないおそれがありま
す。

1. 生成されたエラーメッセージをお読みください。メッセージによって、機器自体、または通信のセ
ットアップ方法に問題があるかどうかが分かります。

2. デバイスが主電源に接続され、電源が入っていることを確認します。

3. デバイスに割り当てられた COM ポートまたは IP アドレスが正しいことを確認します。

ヒント! コンピュータ上には 2 つのビルトインシリアルポートがあります。ケーブルに P1 と記さ
れていても、シリアルポート拡張カードの 初のポートは通常 COM3 です。

4. デバイスとの通信設定（たとえば、デュアルインラインパッケージ（DIP）スイッチの設定）が正し
く行われていて、Communication タブの設定と一致していることを確認します。

5. 機器の電源を切ってください。

6. 10 秒間待ってください。

7. 機器の電源を入れてください。
すべての機器のパワーアップアクティビティが終了するまで待ってから、ハードウェアプロファイ
ルをもう一度有効にします。いくつかの機器は、パワーアップアクティビティを終了するのに 30
秒以上かかる場合があります。

8. ハードウェアプロファイルを有効にします。

9. まだ問題が続くようであれば、失敗しているプロファイルを削除し、新たに作成してください。

10. それでも問題が解決しない場合は、sciex.com/request-support に進みます。
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プロジェクトおよびサブプロジェクト
実験開始前に、実験関連ファイルの保管場所を決めます。各実験にプロジェクトやサブプロジェクト
を用いて、データを効果的に管理し結果を比較します。例えば、サブプロジェクトを用いて特定日の
結果を保存します。

サブプロジェクトについて

サブプロジェクトとは、プロジェクト内のフォルダのサブセットです。サブプロジェクトはすべて同じフォ
ルダを含む必要があります。サブプロジェクトは、データの整理にきわめて有用です。例えば、異な
るラボが同じ測定メソッドを用いて、さまざまな化合物のサンプルを実行する場合、ラボごとの結果
の保存用にサブプロジェクトを用いつつ、測定メソッドフォルダはプロジェクトフォルダに保存すること
ができます。こうすることで、測定メソッドはサブプロジェクトやラボで利用可能になります。その他、
サンプルが数週間にわたって実行される場合には、日別の結果を別々のサブプロジェクトに保管す
ることができます。

図 8-6 : プロジェクトとサブプロジェクトのフォルダ構造の例
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プロジェクトおよびサブプロジェクトの作成

サブプロジェクト構造をプロジェクト内で使用するには、プロジェクト作成時にサブプロジェクト構造を
作成します。

1. Tools > Project > Create Project. をクリックします。

図 8-7 : Create New Project/Subproject ダイアログ

注: 新規のサブプロジェクトは、 初にサブプロジェクト付きで作成されなかったプロジェクトに
は作成することができません。

2. Project name フィールドにプロジェクト名を入力します。

3. （オプション）サブプロジェクトを使用する場合は、以下の手順に従います。

a. 必要なフォルダを選択し、矢印ボタンを押して Subproject folders リストに移動します。

b. Subproject name フィールドに 初のサブプロジェクト名を入力するか、既存の日付を使
用します。

4. （オプション）すべての新規プロジェクトに対して、このプロジェクトおよびサブプロジェクトのフォ
ルダ組織を使用するには、Set configuration as default for new projects チェックボックス
をオンにします。
すべての新規プロジェクトはこのフォルダ構成で作成されます。

5. OK をクリックします。

サブプロジェクトの作成

サブプロジェクトは、既存のサブプロジェクト構造を有するプロジェクトのみで作成されます。
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1. Project ツールバー上で、Project リストからプロジェクトを選択します。

2. Tools > Project > Create Subproject をクリックします。

3. Subproject name ボックスで、サブプロジェクト名を入力するか既存の日付を使用します。

4. OK をクリックします。

サブプロジェクトのコピー

サブプロジェクトは、現存するサブプロジェクトを持つ別のプロジェクトからコピーが可能です。コピー
するサブプロジェクトがコピー先のプロジェクトフォルダにも存在するフォルダを含む場合、ソフトウェ
アはプロジェクトレベルのフォルダを使用します。

1. Tools > Project > Copy Subproject. をクリックします。
Copy Subproject ダイアログが開きます。

2. Browse をクリックして、サブプロジェクトのソースを参照します。

3. OK をクリックします。

4. Source Subproject リストからサブプロジェクトを選択します。

5. Browse をクリックして、サブプロジェクトのコピー先を参照します。

6. Target Subproject フィールドに名前を入力します。

7. OK をクリックします。

8. 次のいずれかの操作を行います。

• Subproject Source から Subproject Destination にすべてのフォルダとファイルをコピ
ーするには、Copy Contents チェックボックスをオンにします。

• Subproject Destination に同じ構造でフォルダのみをコピーするには、Copy Contents
チェックボックスがオフになっていることを確認します。

9. Copy をクリックします。

プロジェクトとサブプロジェクトの切り替え

ソフトウェアツールバー上で、プロジェクトリストから必要なプロジェクトまたはサブプロジェクトをクリ
ックします。

図 8-8 : プロジェクトリスト
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この図のプロジェクトリストには、フォルダ API Instrument、Default、および Example が表示さ
れます。

インストールされるプロジェクトフォルダ

ソフトウェアをインストールすると、Default、API Instrument、Example という 3 つのプロジ

ェクトフォルダがインストールされます。

API 機器フォルダ

API Instrument フォルダは唯一、質量分析装置の機能を修正することができる重要なフォルダで
す。API Instrument フォルダには質量分析装置のチューニングおよびキャリブレーションに必要な
情報が含まれています。この情報は、以下を含みます。

• パラメータ設定ファイル

• 参照ファイル

• キャリブレーションと分解能の情報を含む装置データファイル

• 自動チューニング中に使用する測定メソッド

API Instrument フォルダにはまた、Start ボタン（Acquire ボタンではありません）を使用して実行
した手動チューニングのデータファイルも含まれています。これらのデータファイルは、作成された日
時を名前にして、自動的に API Instrument\Tuning Cache フォルダに保存されます。

Tuning Cache フォルダは定期的に自動削除されます。

初期設定フォルダ

Default フォルダには新規プロジェクトが含まれ、新規プロジェクトのテンプレートとしての役割を果
たします。

実例フォルダ

Example フォルダには、サンプルのメソッドとデータファイルが含まれます。ユーザーは、サンプル
データファイルを使用して、Explore または Quantitate モード での作業を練習することができます。
実例ファイルは、質量分析装置の種類とアプリケーション領域によってサブフォルダにソートされま
す。
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使用説明—チューニングとキャリブレー
ション 9
Verify instrument performance オプションを毎週または質量分析装置の洗浄後に実行し、シス
テムが正常に作動しているかを確認してください。一般に、トリプル四重極システムでは、キャリブレ
ーションおよび分解能調整は、システムが真空を失わない限り、3 ～ 6 カ月間で十分です。QTRAP
システムでは、分解能調整は 3～6 カ月で十分ですが、システムはおおよそ毎月キャリブレーション
が必要です。システムが真空を失う場合、システムを使用する前にキャリブレーションと分解能を確
認します。調整とキャリブレーションに関する詳細は、上級ユーザーガイドおよび手動チューニング
チュートリアルを参照してください。

ヒント! 定期的にメンテナンス作業を実行し、質量分析装置が 適に機能していることを確認してく
ださい。

前提条件

• スプレーは安定しており、正しいチューニング溶液が使用されています。

• プリンタが構成されています。

必要な資材

• システムとともに出荷された標準化学物質キットで供給されたチューニング溶液。必要に応じ
て、SCIEX から新しいキットをご注文いただけます。 キャリブレーションイオンと溶液を参照し
てください。

• 5 mL、1 mL および 250 µL シリアルガスタイトシリンジ

• 赤色の PEEK サンプルチューブ

チューニングとキャリブレーションについて
装置のチューニングとは、分解能と装置パラメータを 適化することで、質量分析装置の感度と性
能を 大限に高めるプロセスです。分解能の 適化では、ピーク幅とピーク形状の調整が必要で
す。装置のチューニングとキャリブレーションは自動または手動で実行できます。

注意: キャリブレーションエラーが発生する可能性があります。温度が 2 °C 以上変化すると、分解
能と質量校正に影響する可能性があります。

ヒント! 四重極の帯電（対象イオンに対する感度が短期的に大幅に低下する可能性があります）を
小限に抑えるため、Q0 領域は定期的にクリーニングしてください。有資格保守要員（QMP）また

は FSE にお問い合わせください。
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自動チューニング: ソフトウェアは、Instrument Optimization ウィザードを使って分解能の 適化と
質量校正を行います。LIT 機器の場合、MS3 適化もまた実行されます。

手動チューニング：装置の分解能の 適化やキャリブレーションの多くは、ユーザーが手動で実行
できます。

API 機器フォルダのバックアップ
API Instrument フォルダを定期的に、および定期メンテナンス後にバックアップします。

API Instrument フォルダをコピーし、別の場所（別のコンピュータを推奨）に貼り付けます。その

後フォルダ名を変更してください。複数の質量分析装置がある場合は、フォルダ名を付ける際に日
付と質量分析装置のリファレンスを使用します。たとえば、API Instrument_instrument
model3_010107 のように指定します。

装置パラメータのバックアップ
1. Navigation バーの Tune and Calibrate の下にある Instrument Optimization をダブルク

リックします。

2. Instrument Optimization ダイアログの File > Backup Instrument Settings Files をクリッ
クします。

3. ファイル名を入力し、Save をクリックします。

4. Exit をクリックします。

装置パラメータの復元
1. Navigation バーの Tune and Calibrate の下にある Instrument Optimization をダブルク

リックします。

2. Instrument Optimization ダイアログの File > Restore Instrument Settings Files をクリッ
クします。

3. 復元対象の装置設定に移動して、Open をクリックします。

4. Exit をクリックします。

自動チューニングおよびキャリブレーション
Instrument Optimization は、四重極モードと LIT モードの双方をチューニングし、質量較正を実行
するための自動装置チューニングソフトウェアです。四重極モードでは、分解能オフセットが調整さ
れます。LIT モードでは、AF3 と EXB が 適化されます。MS3 では、励起係数と分離係数が調整
されます。次のいずれかの装置パフォーマンスオプションを選択します。

• Verify instrument performance：装置のパフォーマンスをテストしますが、装置の設定は変更
されません。テスト終了時にレポートが生成されます。このオプションは毎週実行し、装置の性能
を確認します。
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• Adjust mass calibration only：質量較正を自動的に確認し、調整します。質量較正に変更が
加えられた場合は、本ソフトウェアによって修正されます。 このオプションは、必要に応じて質量
較正を点検して調整するために LIT 機器に対して毎週または毎月使用できます。

• Adjust instrument settings：装置の設定や質量較正を確認し、調整します。装置の設定が、
現在の設定から 適な設定へと更新されます。このオプションは、装置の性能やピーク形状が
良好でない場合に使用してください。装置の設定は、熟練したユーザー以外は調整しないでくだ
さい。

注: 古い LIT メソッドは、新しい設定で更新する必要があります。Advanced MS タブで LIT 速度
を切り替えた後、メソッドを保存します。

• Reset selected scan modes to default values and adjust instrument settings：装置の
値を工場出荷時のプリセット値にリセットします。このオプションは、装置の主要コンポーネントを
交換した場合、または初回インストール後に選択してください。この機能は FSE のみが使用して
ください。

後日復元の必要が生じた場合に備え、現在の装置パラメータをバックアップします。装置パラメータ
のプリセットされた場所は、<drive>:\Analyst Data\Projects\API Instrument\Instrument
Optimization\Instrument Settings Backups\User Created Backups です。

装置のパフォーマンスの検証
この手順は、質量分析装置のパフォーマンスを確認または調整するために使用します。他の機器
のパフォーマンスオプションを使用する際の詳細については、ヘルプを参照してください。

前提条件

• シリンジポンプがハードウェアプロファイルで有効である。シリンジポンプが有効でない場合は、
ハードウェアプロファイルを編集します。ハードウェアプロファイルにデバイスを追加を参照して
ください。

• API Instrument フォルダが選択されている。

1. Navigation バーの Tune and Calibrate の下にある Manual Tuning をダブルクリックしま
す。

2. シリンジポンプを起動し、Duration フィールドに 5 を入力してから、キャリブレーションメソッド
を実行します。トータルイオンクロマトグラム（TIC）が安定しており、対象となるピークがスペクト
ルに存在することを確認します。
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図 9-1 : 安定した TIC と対象となるピークの例

3. Navigation バーの Tune and Calibrate の下にある Instrument Optimization をダブルク
リックします。
Instrument Optimization ダイアログが開きます。

4. Verify instrument performance をクリックします。

5. Next をクリックします。
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6. Approved Tuning をクリックします。

7. Next をクリックします。

8. リストから Tuning Solution を選択します。

選択したソリューションに従って、異なるモードが利用可能となります。

a. 極性をクリックします。

b. （利用可能な場合）Quad セクションで Q1 および Q3 をクリックします。

c. （利用可能な場合）必要なスキャン速度をクリックします。

d. （利用可能な場合）LIT セクションでスキャン速度をクリックします。

e. （利用可能な場合） MS/MS/MS セクションで Excitation をクリックします。

9. Next をクリックします。

10. Select a mode ページが開いた場合は、Automatic を選択します。

11. Next をクリックします。

12. GO をクリックします。
Verifying or Adjusting Performance ダイアログが開きます。プロセスが完了したら、Results
Summary が開きます。詳細な情報については、ヘルプを参照してください。

13. （選択されたオプションにより該当する場合）プロンプトが表示されたら、異なるスキャンタイプ
や極性用に溶液を変更します。

Verifying or Adjusting Performance ダイアログ
左上隅に、調整されている装置の一部が表示されます。

ソフトウェアの結果がインタラクティブモードに表示されているとき、現在のスペクトルのグラフには、
現在のスキャンのスペクトル、ソフトウェアによって選択された 適なスキャンまたは現在のパラメ
ータ値のスキャンが表示されます。

グラフ右上にある装置の 適化決定プロットでは、現在 適化されているパラメータの強度 - 電圧
の曲線が動的に表示されます。

結果概要
Results Summary は、Instrument Optimization ウィザードを用いて行われたすべての機器設定
変更の記録です。

Results Summary には、データと機器設定のバックアップファイルの場所、 適化中の変更と結果
のステップバイステップの記録が含まれています。

Results Summary にはまた、検証報告も含まれます。この報告は、適合する各質量に対する質量
スペクトルをスキャンモードで検証したスナップショットを示したものです。スペクトルはターゲット質
量、その質量の発見場所、質量シフト、ピーク幅、ピーク強度などで分類されています。このスペクト
ルはピークの形やスキャンモードのパフォーマンスを記した視覚的記録としても用いられます。スペ
クトルの状態に従って、結果要約表が作成されます。
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Results Summary は、以下のパスに自動的に保存されます：
<drive>:\Analyst Data\Projects\API Instrument\Data\Instrument
Optimization\yyyy-mm-dd\results.pdf。ここで yyyy-mm-dd は、レポートが作成された

日付です。ユーザーは Results Summary の印刷、および以前に保存された Results Summary
の閲覧が可能です。

API 機器フォルダの回復
API Instrument フォルダを定期的に、および定期メンテナンス後にバックアップします。

1. 現在の API Instrument フォルダの名前を変更します。

2. バックアップフォルダを Projects フォルダにコピーします。

3. バックアップフォルダの名前を API Instrument に変更します。
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使用説明—自動 適化 10
特定の化合物のための機器パラメータを調整するには、次のステップに従うことを推奨します。4 つ
の化合物の混合物は手順内の各ステップを説明するために使用されます。ユーザーは、対象とな
る分析に適切な化合物を使用する際、同じ手順を適用する必要があります。

このセクションは次の作業方法を説明しています。

• Compound Optimization ウィザードを使用して分析試料を自動で 適化します。

• 注入分析およびフローインジェクション分析（FIA）のいずれかを選択します。

• パラメータの 適化：

• 注入分析が選択された場合、注入メソッドを用いて化合物依存性パラメータを 適化します。

• FIA 分析が選択された場合、FIA を用いて化合物依存性パラメータおよびイオン源依存性パ
ラメータを 適化します。

この手順では、化合物の例として、ミノキシジル、トルブタミド、レセルピン、およびレシンナミンを用
います。その他の化合物も使用できますが、それに応じてメソッドを調整する必要があります。

ユーザーは手動で化合物を 適化することもできます。質量分析装置のシステムユーザーガイドを
参照してください。

前提条件

• 質量分析装置のチューニング、キャリブレーションが完了していること。

• （FIA 分析の場合）測定メソッドテンプレートを入手できる。

• （FIA 分析の場合）LC ポンプとオートサンプラーが接続されており、ハードウェアプロファイル内
で構成されている。

• 内蔵シリンジポンプがハードウェアプロファイル内で構成されている。

• すべての必須周辺装置（必要に応じて LC コンポーネントを含む）がハードウェアプロファイル
内で構成されている。
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必要な資材

• レセルピン、ミノキシジル、トルブタミド、レシンナミンで構成された 4 化合混合物（10 ng/mL）で
す。溶液は注入および FIA に使用できます。濃度はシステムに依存します。50％脱イオン水お
よび 0.1％ギ酸を希釈剤としたアセトニトリル 49.9％の溶剤を使用します。

注: これはデモンストレーション用の混合物の一例となります。ユーザーはアプリケーション開
発時に、適切な溶媒内に独自の化合物を作成することになります。ここでは単一化合物の溶液
が推奨されます。化合物を混合する際には、化合物が互いに干渉しないよう、または分子量が
同一にならないよう確認します。

• シリンジには 1.0 mL シリンジが推奨されます。

• （FIA 分析の場合）移動相：アセトニトリルと水（１：１）＋ 2 mM の酢酸アンモニウム ＋ 0.1％の
ギ酸。

注: ユーザーは化合物の実験特性に基づき、さまざまな移動相を選択できます。

• LC ポンプとオートサンプラー。

• （FIA 分析の場合）オートサンプラーバイアル。

自動 適化について
自動 適化を行う際はまず化合物の有無について確認します。各種イオンパスパラメータの電圧が
徐々に上昇あるいは低下し、各イオンの Q1 スキャンの 大信号強度が特定されます。 適化の
プロセス中に、テキストファイルが作成、表示されます。本ファイルは実行された実験、および各パラ
メータの 適値を記録します。また、実施されたすべての実験を含むファイルフォルダも作成されま
す。これらは、Explore モードでデータファイルフォルダを開くことで閲覧できます。実施された各試
験について測定メソッドが作成され、Acquisition Method フォルダに保存されます。

自動 適化プロセス中に、プレカーサーイオンおよび対応するプロダクトイオンの選択方法を選択し
ます。

サンプル導入の種類
注入

注入では、シリンジポンプを使用してサンプルをイオン源へ低流量で連続的に流します。注入 適
化プロセス中に、ソフトウェアは、プレカーサーとプロダクトイオンを選択し、デクラスタリング電位、
および衝突エネルギー、衝突セル出口電位に対して 適化することができます。イオンパスパラメ
ータの電圧は、プレカーサーおよびプロダクトイオンのための 大信号強度を得るために徐々に増
加または減少します。

LC-MS/MS 分析時に使用する流量よりもはるかに低い流量で、化合物依存性パラメータのみを
適化するために、注入 適化を使用します。
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FIA
FIA は、LC システムを使用してオートサンプラーで質量分析装置にサンプルを注入します。FIA 
適化プロセスの間、注入ごとに変更されるさまざまなイオン源依存性または化合物依存性パラメー
タのために、複数のサンプル注入が実行されます。FIA 化合物 適化は、連続したループ実験の
実行により、パラメータを 適化します。ひとつの化合物依存性パラメータはまず 適化され、次の
化合物依存性パラメータに続きます。FIA は各値に一度の注入を行うことで、イオン源依存性パラメ
ータを 適化します。

化合物パラメータは、少なくともあと 2 回の FIA サイクルを使用して範囲を絞り込む必要がありま
す。

LC システムを使用してより高い流量で化合物依存性およびイオン源依存性パラメータの両方を
適化するには、FIA 適化を使用してください。

表 10-1 : サンプル導入メソッド間の差異

メソッド 必要な機器 パラメータ 一般流量範囲

注入 シリンジポンプ 化合物依存性 5 µL/ 分 ～ 25 µL/ 分

FIA LC ポンプおよびオートサ
ンプラー

イオン源および化合物依存性 25 µL/ 分 ～ 1000 µL/
分

適化の間、テキストファイルが作成され表示されます。本ファイルは実行された実験、および各パ
ラメータの 適値を記録します。すべてのデータファイルを含むファイルフォルダも作成されます。ま
た、実施された各試験について測定メソッドが作成され、Acquisition Methods フォルダに保

存されます。

注入を使用した分析試料の自動 適化
この手順を使用して、既知のプレカーサーイオンおよび未知のプロダクトイオンの注入を使用した自
動 MS/MS 適化を実行します。

化合物の存在を確認

自動 適化を続行する前に、対象となる化合物の存在を確認します。

1. Analyst MD ソフトウェアで、プロジェクトを作成します。

2. ハードウェアプロファイルを有効にします。

3. サンプルを調製:

a. 化合物溶液をシリンジに吸引して、シリンジから空気を抜きます。

b. 特別な接続器の付いたチューブを用いて、質量分析装置にシリンジを接続します。

c. 内蔵のシリンジポンプにシリンジを取り付けます。

4. 5 µL/分から 10 µL/分の量で溶液に化合物を注入します。

5. Navigation バーの Tune and Calibrate の下にある Manual Tuning をダブルクリックしま
す。
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6. メソッドリストフィールドで、Syringe Pump Method をクリックしてください。

7. シリンジポンプメソッドのプロパティタブに、適切なパラメータ値を入力します。表 10-2 を参照し
てください。

表 10-2 : Syringe Pump Method Properties タブ

パラメータ 標準値

Syringe Diameter シリンジ依存：1.0 mL シリンジは 4.610 mm で
す

Flow Rate 5 ～ 10

Unit µL/ 分

図 10-1 : Syringe Pump Method Properties タブ

8. Start Syringe Pump をクリックします。

9. メソッドリストで MS Method をクリックします。

10. MS タブで、表 10-3 に示されるパラメータを入力します。

表 10-3 : MS タブ

パラメータ 値

スキャンタイプ Q1 MS (Q1)

開始（Da） 200

停止（Da） 700

スキャン速度（Da/s）（可能な場合） 200

時間 (分) 3

11. Start をクリックします。

12. 均等な TIC が左側に表示され、ピークが右側に表示されるまで待ってから、Stop をクリックし
ます。

13. MCA チェックボックスをオンにします。
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14. Cycles フィールドに 10 と入力します。

15. Start をクリックします。

10 スキャンが完了すると、グラフにイオンなど 4 つの化合物の質量が表示されます。

注: 化合物の強度は 小のノイズピークよりもはるかに高くなりますが、ノイズピークが全く見ら
れないほどの高さではありません。 初のケースでは、ピークは本当の化合物ではない可能
性があります。後者のケースでは、ソフトウェアを適切に 適化するには濃度が高すぎる可能
性があります。

図 10-2 : 複イオン

既知のプレカーサーイオンおよび未知のプロダクトイオンの注入を
使用して自動 MS および MS/MS 適化を実行

MS/MS 分析の自動 適化により、1 つ以上の MRM 遷移に対するある種の化合物依存性パラメ
ータが 適化されます。ソフトウェアが対象のイオンを見つけたら、化合物の 大感度を得るための
化合物依存性パラメータを 適化します。ソフトウェアは、すべてのプロダクトイオン選択基準に適
合するために、CE を傾斜させ、 も強いフラグメントを取り出します。

初の Q1 スキャンシグナルが高すぎる場合、ソフトウェアは CEM を下げてイオンを検出器範囲
に維持できるように試みます。CEM を下げてもシグナルが高すぎる場合、プロセスが停止し、エラ
ーメッセージが表示されます。溶液を希釈し、 適化を再開してください。注入ラインは必ず洗浄し
てください。

後の定量 適化のパラメータは保管されます。

1. シリンジポンプに正しい濃度の溶液が入れられ、そのシリンジポンプが始動されたことを確認し
ます。
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シリンジポンプは、化合物の 適化開始前に、Manual Tune ウィンドウで始動させる必要があ
ります。

内蔵シリンジポンプが利用可能で、それが始動すると、シリンジポンプのステータス LED は点
滅します。

2. Navigation バーの Tune and Calibrate の下にある Compound Optimization をダブルク
リックします。
Instrument Settings ページが開きます。

3. Inlet セクションで Infusion をクリックします。

4. Mass Spectrometer セクションで MS/MS Analysis をクリックします。

5. Next をクリックします。
Ions to use in MS/MS Analysis ページが開きます。

6. 適切なパラメータ値を選択します。表 10-4 を参照してください。

表 10-4 : MS/MS Analysis ページで使用する Example Parameters

パラメータ 値

MW Ion: Search Window 2.500

Resolution 単位

Polarity 正または負（ターゲット化合物の特性に応じて）

Product Ion 自動選択

Resolution 単位

注: 適化アルゴリズムが、指定された検索ウィンドウの 高強度ピークを検索します。そのウ
ィンドウの 高強度ピークが対象となる質量でない場合、ソフトウェアは誤ったイオンを 適化
します。

7. Auto Select オプションの横にある Criteria をクリックします。
Product Ion Auto Selection Criteria ダイアログが開きます。

8. 適切なパラメータ値を入力します。表 10-5 を参照してください。

表 10-5 : Product Ion Auto Selection Criteria ダイアログパラメータの例

パラメータ 値 説明

From the Most
Intense (peaks)

3 適化するフラグメントピーク数。MCA モードで CE が傾
斜している間、アルゴリズムはプロダクトイオンスキャンス
ペクトルを生成します。この例では、アルゴリズムによっ
て、3 つの も強いフラグメントイオンがスペクトルから取
り出され、それらのフラグメントのみに対して MS/MS
適化が継続されます。

未知の化合物の場合は、選択するピークを増やします。
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表 10-5 : Product Ion Auto Selection Criteria ダイアログパラメータの例 (続き)

パラメータ 値 説明

Build final
method using
(most intense
peaks)

2 自動的に測定メソッドに含まれる、プレカーサーイオン
（標的化合物）当たりのフラグメントイオン数です。指定し
た数値により、メソッドの各ターゲット化合物のために関
与する MRM トランジションの数が定義されます。優先順
位は、フラグメントイオンの強度に基づきます。

通常 2 つのプロダクトイオンが定量に必要であるため、1
より 2 の方が開始値として望ましいとされています。2 つ
の 良値の 1 つに問題がある場合は、3 から開始してく
ださい。戻ると第 3 が既に同定されています。

未知の化合物の場合は、干渉の際に使用するために選
択するピークを増やします。

Exclude
Product Ions
within ± (Da of
Precursor Ion
m/z)

20.000 プレカーサーイオン周囲の除外ウィンドウを定義する Da
値です。このウィンドウ内に収まるフラグメントイオンは、
MRM 適化の対象に選択されません。たとえば、m/z
値が 500 のプレカーサーイオンに± 5 Da と入力した場
合、m/z 値が 495 ～ 505 の範囲内のフラグメントイオン
がすべて除外されます。これにより、プレカーサーイオン
がプロダクトイオンとして 適化されるのを防ぎます。

Min. Mass for
Product Ion
(Da)

60.000 適化を考慮すべき も低いフラグメント質量。このオプ
ションは、プレカーサー質量から考慮するフラグメントイオ
ンを含むウィンドウのサイズを増減するために使用しま
す。

Threshold for
Product Ion
(cps)

100.000 プロダクトイオンの 小カウント数が考慮されます。

9. 選択基準への変更を保存するには、OK をクリックしてください。

10. Next をクリックします。
Target Components ダイアログが開きます。

11. 適切なパラメータ値を入力します。表 10-6 を参照してください。

注: 化合物名は、各化合物またはトランジションに一意でなければなりません。

表 10-6 : Target Compounds ダイアログのパラメータ例

ターゲット化合物 フィールド 値

レセルピン 化合物名 レセルピン

MW（Da）2 609.3

2 正確なイオン質量を入力してください。
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表 10-6 : Target Compounds ダイアログのパラメータ例 (続き)

ターゲット化合物 フィールド 値

電荷数 1

ミノキシジル 化合物名 ミノキシジル

MW（Da）2 210.2

電荷数 1

トルブタミド 化合物名 トルブタミド

MW（Da）2 271.1

電荷数 1

レシンナミン（IS） 化合物名 レシンナミン

MW（Da）2 635.3

電荷数 1

12. Finish をクリックして 適化プロセスを開始します。

テキストファイルウィンドウと測定ウィンドウという 2 つのウィンドウが表示されます。別のものを
閲覧するには、どれかを 小化する必要が生じる場合もあります。実施されている実験が、測
定ウィンドウの 上部に表示されます。X 軸は、各実験のために 適化されているパラメータ
を示します。結果が生成されると、テキストファイルウィンドウが更新されます。

適化が完了すると、MRM 測定ファイルが作成され、
<compound>_QOpt_FinalMRM_Pos.dam と名付けられます。<compound> は Target
Components ページの 初の化合物です。

適化結果のレビュー

適化が完了すると、 適化されたパラメータが測定メソッドに保存されます。 適化過程で作成さ
れた dam および wiff ファイルはすべて、プロジェクトの Acquisition Methods フォルダおよび

Data フォルダのサブフォルダにそれぞれ保存されます。サブフォルダの名前は化合物と日付を元

に作成されます。

1. 適化が完了したら、各化合物の 適化パラメータが含まれているテキストファイルを印刷しま
す。

2. File > Open をクリックし、Reserpine_QOpt_FinalMRM.POS.dam ファイルを選択しま

す。

3. テキストファイルと dam ファイルの値を比較します。

4. 次のフォルダの内容を確認します。

• Data： 適化中のすべての実施をレビューします。wiff ファイルをメソッドまたは印刷したパ
ラメータの 適化した値と比較します。
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• Acquisition Method： 適化中に作成された
Reserpine_QOpt_FinalMRM.POS.dam ファイルおよびその他の dam ファイル。

• Log： 適化プロセスで表示されるレポートファイル（rtf）です。

フローインジェクション分析を使用し、自動的に分析試
料を 適化

前提条件

• 化合物に必要なイオンを特定し、基本となる測定メソッドを保存します。

• オートサンプラーと LC ポンプを基本の測定メソッドに追加します。 適化に FIA を用いるに
は、これらのデバイスがハードウェアプロファイル内で有効でなければなりません。

• 開始前に Reserpine_QOpt_FinalMRM.POS.dam ファイルに基づいて LC-MS/MS の測定メ
ソッドを作成し、新しいメソッドをと名付けます。

注: フローインジェクション分析で化合物依存性パラメータの 適化を行うことができますが、 適な
パラメータ値を取得するために必要なサイクル数が多いため、この方法は一般的には用いられませ
ん。

1. オートサンプラーに 4 つの化合物を混合した希釈液を注入します。
各パラメータの各変数をレビューするために、十分な数のサンプルが必要です。サンプルは保
管しておくようにしてください。たとえば、300 °C、400 °C、500 °C の温度で注入量 10 µL の
場合の実行には、30 µL（3 × 10 µL 注入）の量が必要です。

2. メソッドで LC Sync が選択されていることをことを確認します。

注: LC Sync モードでは、データが適切に取得されるよう、質量分析装置は LC システムの動
作と連動します。

図 10-3 : LC Sync が選択された測定メソッド

3. 適化中に質量分析装置が汚染されない程度に、イオン源とガスパラメータが適度なレベルに
設定されていることを確認します。イオン源の 適化 を参照してください。

4. マイクロメータの水平目盛を 5 に設定します。
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5. マイクロメータの垂直目盛をイオン源の流量に合わせて設定します。開始点として、次の表の
パラメータを使用します。

表 10-7 : イオン源垂直パラメータ

流量 初期垂直パラメータ

1 µL/ 分～ 20 µL/ 分 10 mm

20 µL/ 分～ 250 µL/ 分 5 mm

250 µL/ 分～ 500 µL/ 分 2 mm

500 + µL/ 分 0 mm

6. LC システムに値を設定します。たとえば、オートサンプラーは注入量 10 µL のものを使用しま
す。注入実験には、同じ濃度か、より低い濃度で使用します。

LC ポンプはカラム無しのアイソクラティック実行に設定してください。正確なデータ取得のため
に、MS および LC 時間は同じにしてください。

流量、および移動相の割合はご使用の LC カラム、一般的なクロマトグラフィー、対象の化合
物が溶出する概算の移動相濃度に依存します。

7. Navigation バーの Tune and Calibrate の下にある Compound Optimization をダブルク
リックします。
Instrument Settings ページが開きます。

8. 使用する LC システムに応じて、適切なパラメータ値を入力します。表 10-8 を参照してくださ
い。

表 10-8 : 機器設定パラメータの例

パラメータ 値

Inlet FIA

Rack Code オートサンプラーの詳細

Rack Position オートサンプラーの詳細

Injection Volume 10 µL（分量例）

Mass Spectrometer MS/MS 分析

9. 適切なデフォルト測定メソッドを選択します。

10. Next をクリックします。

11. Int. Std. チェックボックスがオフになっていることを確認します。
チェックボックスへのチェックは、MRM が内部標準と一致していることを表します。内部標準は
適化プロセスで 適化されません。

12. Resolution グループで、Q1 Resolution と Q3 Resolution の両方のフィールドに対して
Unit を選択します。
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図 10-4 : Q1 および Q3 分解能フィールド

13. Next をクリックします。

14. FIA Source Parameters ページで、仕様の範囲で元の値よりも低いまたは高い数字を入力し
てください。

注: システムをクリーンな状態に保つために、数値が低くなりすぎないように注意します。開始
点として使用できるパラメータについては、表 10-9 を参照してください。

ヒント! 値を入力してから、チェックボックスをオンにします。

表 10-9 : FIA Source Parameters ページのパラメータ例

パラメータ Optimize チェックボックスを選
択？

適化の仕様値

Curtain Gas はい 20;40;55

Collision Gas いいえ —

IonSpray Voltage はい 1500;2000;3000;4000;5000

Temperature はい 300;400;500;600;700

Ion Source Gas 1 はい 40;50;60;70;80;90
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表 10-9 : FIA Source Parameters ページのパラメータ例 (続き)

パラメータ Optimize チェックボックスを選
択？

適化の仕様値

Ion Source Gas 2 はい 40;50;60;70;80;90

15. Replicate Injection for each Parameter の横にある 1 または 2 を選択します。
注入の合計回数とサンプルの合計量は、このダイアログの仕様書に基づいて計算されます。
必要なサンプルの合計量に注意してください。各変数は個別のメソッドであるため、 適化する
各パラメータの変数の数とともにサンプル量が増加します。

図 10-5 : 各パラメータフィールドへの繰り返し注入例

16. Next をクリックします。

17. 各分析試料の FIA Compound Parameters ページで、開始点として提供されるパラメータ値
の例を使用します。表 10-10 を参照してください。

注: 下表の値は推奨値です。詳細な情報については、ヘルプを参照してください。
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表 10-10 : FIA Compound Parameters ページの例

パラメータ Optimize チェックボックスを選
択？

適化の仕様値

Declustering Potential はい 60;80;100;120;200

Entrance Potential いいえ —

Collision Energy はい 20;30;40;50;70;80;100

Collision Cell Exit Potential はい 2;4;6;8;10;12

注入の合計回数と依存するサンプル量は、自動的に更新されます。イオン源パラメータは値と
繰り返しごとに注入が必要ですが、化合物依存性パラメータはパラメータ毎に 1 回の注入で済
みます。各パラメータにはループ実験が行われます。値は 1 回の注入内でスキャンごとに変更
されます。

注: 極端に多くの値を指定しないでください。値の数が多すぎると、パラメータの正確な評価が
できなくなります。

18. Compound リストを使って、別の化合物に動かし、 適化されるパラメータを入力します。

19. すべての化合物のパラメータが入力されるまでステップ 18 を繰り返します。

20. Mass Spec. Duration フィールドに 適化の期間を入力します。

注: この値は少なくとも、各注入に必要な時間幅に見合っていなければなりません。
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図 10-6 : Mass Spec.Duration フィールドの例

21. Finish をクリックして 適化プロセスを開始してください。

ソフトウェアは特定のイオン源および化合物依存性パラメータを 適化し、化合物の MRM トラ
ンジションにおける 高感度を取得します。ソフトウェアは 適化を実行している間に、
Compound Optimization レポートを作成します。

22. 適化したパラメータを取得するには、この手順を繰り返します。

注: 一般的に、イオン源とガスパラメータは FIA サイクルを繰り返し、絞り込む必要がありま
す。

23. 後に 適化された FIA メソッド「*_FIA_sample_1.」を開きます。

注: ソフトウェアによって数種の測定メソッドが生成されます。

24. このメソッドを分かりやすい名前で保存します。
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使用説明—測定メソッド 11
測定メソッドは、実験と期間で構成されています。Acquisition Method Editor を使用して、質量分析
装置およびアクティブなハードウェアプロファイル内の任意のデバイスを対象とする期間および実験
のシーケンスを作成します。

メソッドの作成に熟練したユーザーのみが、測定メソッド / 定量化メソッドを作成または修正すること
を推奨します。ロールとセキュリティの詳細な情報については、ラボ管理者ガイドを参照してくださ
い。

測定メソッドエディタを用いて測定メソッドを作成

ヒント! ユーザーが既存のファイルから新規の測定メソッドファイルを作成する場合、測定メソッドに
含まれる周辺装置メソッドのいくつか、またはすべての使用が必要となる可能性があります。

有効なハードウェアプロファイルで設定したデバイスのみが Acquisition method ペインに表示され
ます。ハードウェアプロファイルに追加したすべてのデバイスは、既存の測定メソッドにも追加する
必要があります。デバイスについての詳細は、周辺装置セットアップガイドを参照してください。

1. 質量分析装置と周辺装置を含むハードウェアプロファイルが有効になっていることを確認してく
ださい。

2. Navigation バーの Acquire の下にある Build Acquisition Method をダブルクリックしま
す。

3. Acquisition Method Properties タブの Synchronization Mode を選択します。

4. （オプション）Auto-Equilibration チェックボックスをオンにして、必要な平衡時間を分単位で
入力します。

5. Acquisition Method ペインで Mass Spec アイコンをクリックします。

6. MS タブで Scan type を選択します。

7. 必要に応じて、その他のフィールドに値を入力します。

8. Advanced MS タブで、必要なフィールドに値を入力します。

9. MS タブの Edit Parameters をクリックします。

10. Source/Gas タブで、必要なフィールドの値を決定してください。

11. Compound タブで、必要なフィールドの値を指定します。

12. OK をクリックします。

13. デバイスアイコンをクリックし、デバイスのパラメータを設定します。

14. 追加の期間や実験があれば追加します。実験を追加および期間を追加を参照してください。

15. File > Save. をクリックします。
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LC メソッドについて

LC システムなどの周辺装置を用いた測定メソッドの作成では、対象装置の操作パラメータを設定し
ます。既存ファイルから新規の測定メソッドファイルを作成する場合、周辺装置メソッドのいくつか、
またはすべてがその測定メソッドで使用することができます。

質量分析法メソッドの作成

Acquisition Method Editor を用いて、質量分析装置（MS）測定メソッドを作成します。構成される質
量分析装置の種類および選択されるスキャン種類に応じて、さまざまなフィールドやオプションが利
用可能になります。Acquisition Method Editor により、パラメータ入力時に設定内容が検証されま
す。

次のメソッドの 1 つを作成して、それを用いてデータを取得します。バッチの作成および提出

• Q1 MS スキャン種類を用いた測定メソッドの作成

• Q1 MI スキャン種類を用いた測定メソッドの作成

• MRM スキャン種類を用いた測定メソッドの作成

Q1 MS スキャン種類を用いた測定メソッドの作成

以下に示す手順に従って、Q1 MS スキャンを用いてメソッドを作成します。イオン強度はスキャン範
囲の中で必要な質量毎に戻されます。

前提条件

• 有効なハードウェアプロファイルに、質量分析装置とシリンジポンプが含まれていることを確認
します。

• ソフトウェアツールバー上で、適切なプロジェクトが選択されるようにしてください。

1. Navigation バーの Acquire の下にある Build Acquisition Method をダブルクリックしま
す。
Acquistion Method Editor には有効なハードウェアプロファイルに基づくメソッドテンプレートが
表示されます。

2. Acquisition Method ペインで Acquisition Method をクリックします。

3. Acquisition Method Properties タブの Synchronization Mode リストで、No Sync が選択
されていることを確認します。同期モードの詳細については、ヘルプを参照してください。

4. Acquisition Method ペインで Mass Spec アイコンをクリックします。

5. MS タブの Scan type リストで、Q1 MS (Q1) を選択します。

6. Polarity セクションで Positive をクリックします。

7. Center/Width および Parameter Range を選択している場合はクリアします。

8. 質量範囲の表に、次の表に示す値を入力します。
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図 11-1 : MS タブパラメータ値

表 11-1 : MS タブパラメータ値

フィールド 例

Start (Da) 200

Stop (Da) 700

Time (sec) 2.5

Scan rate (Da/s) 200

Duration (min) 3

9. Advanced MS タブで、Scan mode が Profile に設定され、Step size が 0.1 になっているこ
とを確認します。
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図 11-2 : Advanced MS タブ

この例では、四重極（Q1）が 500 Da の範囲を 0.1 Da ステップでスキャンしています。すなわ
ち、質量範囲全体で 5000 ステップあります。スキャンに 2.5 秒かかるとすると、滞留時間は 1
ステップあたり 0.5 ms です。これは通常、標準的なキャリブレーション手順で Q1 または Q3
をスキャンする際の 速の時間です。Q1 または Q3 がこれより速くスキャンされる場合、質量
較正を適切に検討する必要があります。

注: ステップサイズおよびスキャン時間によって、スキャンの 1 ステップあたりの滞留時間が決
まります。滞留時間は、スキャンの各ステップでのシグナルの収集に費やされた時間の長さで
す。

10. MS タブの Edit Parameters をクリックします。
Parameter Table ダイアログが開きます。

11. Source/Gas タブで次の値を入力します。

表 11-2 : Source/Gas タブパラメータ

イオン源 / ガスパラメータ 標準値

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

12. Compound タブをクリックし、Declustering Potential (DP) を 90 に設定し、Entrance
Potential (EP) を 10 のままにします。
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90 という値は質量分析装置には 適ではない場合がありますが、DP の開始としては適して
います。

13. OK をクリックします。

14. Acquisition Method ペインで Harvard Syringe Pump アイコンまたは Integrated Syringe
Pump アイコンをクリックします。

図 11-3 : Harvard Syringe Pump Method Properties タブ

15. シリンジポンプメソッドを編集して、Syringe Diameter、Flow Rate、Unit を含むようにしま
す。

16. 測定メソッドを保存します。
次のステップ：その測定メソッドを使用して、予備的分析用のデータを取得します。バッチの作
成および提出については、バッチの作成および提出を参照してください。

Q1 MI スキャン種類を用いた測定メソッドの作成

以下に示す手順に従って、Q1 MI スキャンを用いてメソッドを作成します。特定の質量についての
みイオン強度の増減をモニターすることができます。

前提条件

• 有効なハードウェアプロファイルに、質量分析装置とシリンジポンプが含まれていることを確認
します。

• ソフトウェアツールバー上で、適切なプロジェクトが選択されるようにしてください。

1. Navigation バーの Acquire の下にある Build Acquisition Method をダブルクリックしま
す。
Method Editor には有効なハードウェアプロファイルに基づくメソッドテンプレートが表示されま
す。

2. Acquisition method ペインで Acquisition Method をクリックします。

3. Acquisition Method Properties タブの Synchronization Mode リストで、No Sync が選択
されていることを確認します。同期モードの詳細については、ヘルプを参照してください。

4. Acquisition Method ペインで Mass Spec アイコンをクリックします。

5. MS タブの Scan type リストで、Q1 Multiple Ions (Q1 MI) を選択します。

6. Polarity セクションで Positive をクリックします。
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7. 質量範囲の表に、次の表に示す値を入力します。

図 11-4 : MS タブパラメータ値

表 11-3 : MS タブパラメータ値

フィールド 値

Q1 Mass (Da) 609

Time (msec) 100

8. Edit Parameters をクリックします。
Parameter table ダイアログが開きます。

9. Source/Gas タブで次の値を入力します。

表 11-4 : Source/Gas タブパラメータ

イオン源 / ガスパラメータ 標準値

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. Compound タブをクリックし、Declustering Potential (DP) を 90 に設定し、Entrance
Potential (EP) を 10 のままにします。
90 という値は質量分析装置には 適ではない場合がありますが、DP の開始としては適して
います。
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11. OK をクリックします。

12. Acquisition Method ペインで Harvard Syringe Pump アイコンまたは Integrated Syringe
Pump アイコンをクリックします。

図 11-5 : Harvard Syringe Pump Method Properties タブ

13. シリンジポンプメソッドを編集して、Syringe Diameter、Flow Rate、Unit を含むようにしま
す。

14. 測定メソッドを Save します。

次のステップ：この測定メソッドを含むバッチを作成し、提出します。バッチの作成および提出に
ついては、バッチの作成および提出を参照してください。

MRM スキャン種類を用いた測定メソッドの作成

以下に示す手順に従って、MRM スキャンを用いてメソッドを作成します。このスキャンタイプは定量
用途に用いられます。MRM スキャンを用いて、サンプル中の化合物の含有量を測定することがで
きます。薬物動態解析に用いられており、市場での応用やスクリーニング目的での使用がますます
増えています。

前提条件

• 有効なハードウェアプロファイルに、質量分析装置とシリンジポンプが含まれていることを確認
します。

• ソフトウェアツールバー上で、適切なプロジェクトが選択されるようにしてください。

1. Navigation バーの Acquire の下にある Build Acquisition Method をダブルクリックしま
す。
Acquistion Method Editor には有効なハードウェアプロファイルに基づくメソッドテンプレートが
表示されます。

2. Acquisition Method ペインで Acquisition Method をクリックします。

3. Acquisition Method Properties タブの Synchronization Mode リストで、No Sync が選択
されていることを確認します。同期モードの詳細については、ヘルプを参照してください。

4. Acquisition Method ペインで Mass Spec アイコンをクリックします。

5. MS タブの Scan type リストで、MRM (MRM) を選択します。

6. Polarity セクションで Positive をクリックします。
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7. 質量範囲の表に、次の表に示す値を入力します。

図 11-6 : MRM スキャン種類

表 11-5 : 質量範囲および滞留時間

Q1 質量（Da） Q3 質量（Da） Time (msec)

609 397.2 100

8. MS タブの Edit Parameters をクリックします。
Parameter Table ダイアログが開きます。

9. Source/Gas タブで次の値を入力します。

表 11-6 : Source/Gas タブパラメータ

イオン源 / ガスパラメータ 標準値

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. Compound タブで Declustering Potential (DP) を 90 に設定し、Entrance Potential (EP)
を 45 のままにします。

11. OK をクリックします。

12. Acquisition Method ペインで Harvard Syringe Pump アイコンをクリックします。
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図 11-7 : Harvard Syringe Pump Method Properties タブ

13. Syringe Pump タブでシリンジポンプメソッドを編集して、Syringe Diameter、Flow Rate、
Unit を含むようにします。

14. 測定メソッドを Save します。

次のステップ：この測定メソッドを含むバッチを作成し、提出します。バッチの作成および提出に
ついては、バッチの作成および提出を参照してください。

測定メソッドからのデバイスの追加と削除

Acquisition Method Editor を用いて、LC 周辺装置メソッドを追加 / 削除することで、測定メソッドを
カスタマイズできます。必要な装置アイコンが Acquisition Method Browser ペインに表示されない
場合は周辺装置を追加できますが、その装置がアクティブなハードウェアプロファイルに含まれてい
る場合に限ります。

注: LC デバイスで使用可能なパラメータはメーカーごとに異なります。

LC デバイスの追加または削除

1. Acquisition method ペインの Acquisition Method Editor でメソッドファイルを開いたまま、
Acquisition Method を右クリックした後、Add/Remove Device Method をクリックします。

2. デバイスメソッドの横にあるチェックボックスを選択またはクリアして、デバイスメソッドを追加ま
たは削除します。

3. OK をクリックします。

4. LC デバイスを選択した場合、Acquisition Method Properties タブの Synchronization モ
ードの LC sync を選択します。

LC ポンプの特性の修正

各デバイスを対象のメソッドで正しく機能するように、メソッド内で修正します。

1. メソッドファイルが Acquisition Method Editor で開いた状態で、Acquisition Method ペインで
LC デバイスアイコンをクリックします。
Acquisition Method Editor ペインで LC Pump Gradient タブが開きます。
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図 11-8 : SCIEX DX ポンプパラメータ

2. 実験の要件どおりに LC ポンプメソッドを編集します。

3. メソッドを保存します。

オートサンプラーのプロパティの設定

1. メソッドファイルを Acquisition Method Editor で開いた状態で、Acquisition Method ペインで
Autosampler デバイスをクリックします。
Acquisition Method Editor ペインで Autosampler Properties タブが開きます。

図 11-9 : SCIEX DX Autosampler のパラメータ

2. 必要な場合は、注入や洗浄の詳細を編集します。

3. メソッドを保存します。

Column Oven プロパティの設定

1. メソッドファイルを Acquisition Method Editor で開いた状態で、Acquisition Method ペインで
Column Oven デバイスをクリックします。

Acquisition Method Editor ペインで Column Oven Properties タブが開きます。
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図 11-10 : SCIEX DX Column Oven パラメータ

2. カラムオーブンまたはカラムオーブンのコンパートメントの温度を摂氏で入力します。

3. ファイルを保存します。

内蔵のシリンジポンプの構成

この手順は内蔵シリンジポンプのためのものです。

1. 内蔵シリンジポンプがハードウェアデバイスプロファイル内で選択されていることを確認します。

2. Acquisition method ペインで Syringe Pump アイコンをクリックします。
Acquisition Method Editor の Syringe Pump Method Properties タブが開きます。

図 11-11 : Syringe Pump Properties タブ

3. Syringe Diameter (mm) フィールドにシリンジの直径を入力します。

4. Flow Rate フィールドに流量を入力します。

5. Unit リストから流量の単位を選択します。

ダイバーターバルブの特性の設定

スイッチングバルブは、ダイバーターバルブまたは注入バルブとして使用できます。

1. Acquisition Method Editor でメソッドファイルが開いた状態で、Acquisition method ペインに
ある Valve アイコンをクリックします。
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Acquisition Method Editor ペインで Valve Properties タブが開きます。

図 11-12 : 内蔵 Falco バルブ

2. 必要に応じて、ポジションの名前をプリセット名から変更します。

スイッチングバルブは時に、溶媒の流れを廃棄物容器、または別のカラムに切り替えるために
用いられることもあります。位置名のプリセット値は A と B になっています。

• Change Position Names リストで、ポジションを選択します。

• Change Position Names リストでプリセットされた位置名である A と B を、バルブがどの
ように配列されるかに応じて Inject と Divert、または Column と Waste に変更します。
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3. Total Time (min) カラムでセルをクリックし、バルブがこの位置に維持される合計時間を入力
します。

4. Position カラムでセルをクリックし、Position リストでバルブの位置を選択します。

5. 測定中に必要となるバルブのスイッチごとに上記のステップ 3 と 4 を繰り返します。

6. ファイルを保存します。

ダイオードアレイ型検出器の特性の設定

1. メソッドファイルを Acquisition Method Editor で開いたままで、Acquisition Method ペインで
Diode Array Detector (DAD)アイコンをクリックします。
DAD Method Editor タブが Acquisition Method Editor ペインで開きます。

図 11-13 : DAD Method Editor タブ

2. 次のいずれかの操作を行います。

• 1～5 種の波長をスキャンするには、Operating Mode セクションで Signal Data をクリック
し、データ要件を編集します。

• 波長範囲全体をスキャンするには、Operating Mode セクションで Spectral Data をクリッ
クし、データ要件を編集します。

3. ファイルを保存します。

Analog to Digital Converter プロパティの設定

1. メソッドファイルが Acquisition Method Editor で開かれた状態で、Acquisition Method ペイン
で Analog to Digital Converter (ADC)アイコンをクリックします。
Acquisition Method Editor ペインに Analog/Digital Convertor Properties タブが開きます。
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図 11-14 : Analog to Digital Converter Properties タブ

2. Sample セクションの Rate (pts/sec)フィールドに、速度を入力します。

注: 間隔と速度は互いに比例しています。速度が変更されると、間隔が自動的に再算出されま
す。

3. 次のことを実行してチャネルの詳細を設定します。

• Channels フィールドで、チャネル名をクリックしてから、その横のチェックボックスを選択しメ
ソッドに設定します。

• Interpreted Value @ Full Scale フィールドに、適切な値を入力します。

• Interpreted Unit フィールドに、適切な単位を入力します。

ハードウェアプロファイルの ADC をセットアップする場合、利用可能なチャネルの番号が指定
されます。

4. ファイルを保存します。

測定メソッドの変更

Acquire モードでは、期間や実験の既存の測定メソッドに対する追加または削除が可能です。

期間

期間には、1 つまたは複数のループ実験を含めることができます。複数期間の取得方法では、実験
は指定された時間実行され、ソフトウェアは別の実験セットに切り替わります。期間は、LC ラン内の
化合物の溶出時間が判明している場合に便利です。質量分析装置では、化合物の溶出のタイミン
グに合わせて、さまざまな実験を実施し、同一のランにおいて情報を 大限に取得することができ
ます。

次の図は、3 期間の方法を示しています。
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図 11-15 : 複数の期間にわたる実験の例

実験

実験には MS スキャン中の質量分析装置設定およびスキャン種類が含まれます。特定の時間にわ
たって実行される MS スキャンのセットは「期間」と呼ばれます。全期間にわたって MS パラメータと
アクションが変化しない測定メソッドは「単一期間/単一実験メソッド」と呼ばれます。

ループ実験においては、MS 設定はスキャンごとに変化します。たとえばサンプルに A と B の 2 種
類の化合物が含まれている場合、化合物 A の MS/MS 実験を化合物 B の MS/MS 実験にループ
させることで、同一のランにおいて双方の化合物の情報を取得したいような状況が考えられます。
質量分析装置のメソッドは、2 つのスキャン種類間で交互に切り替わります。ループ実験の他の例
として、同一のランにおいて正および負 モードで交互に切り替える状況や、データ依存型取得
（IDA）メソッドなどが挙げられます。

実験を追加

1. Acquisition method ペインで、実験を追加する期間を右クリックしてから、Add experiment
をクリックします。

図 11-16 : Add Experiment

実験は、期間の 後の実験の下に追加されます。
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注: 実験、IDA Criteria、または期間の途中に実験を入れることはできません。期間の 後に
のみ、実験を追加できます。

2. MS タブで適切なパラメータを選択します。

実験を期間にコピー

1. 多重期間メソッドを開きます。

2. Acquisition method ペインで Ctrl を押し、実験を期間にドラッグします。
実験は、期間の 後の実験の下にコピーされます。

期間内に実験をコピー

ほとんどの、またはすべてのパラメータが同じ場合には、この手順を使用して同一または類似の実
験を期間に追加できます。

実験を右クリックして、Copy this experiment をクリックします。

実験のコピーは 後に作成された実験の下に追加されます。

期間を追加

Acquisition method ペインで、Mass Spec アイコンを右クリックし、Add period をクリックします。
期間は、 後に作成された期間の下に追加されます。

注: ユーザーは、IDA の実験で複数の期間を使用することはできません。

スキャンの技術
MS：MS スキャン（単一 MS スキャンとも称される）では、イオンはそれらの質量対電荷比（m/z）に
従って分離されます。単一 MS スキャンは化合物の分子量を決定するために使用される場合があ
ります。単一 MS スキャンはサーベイスキャンと称される場合もあります。MS スキャンは質量以外
にイオンの化学的組成に関して何の情報も提供しません。MS/MS または MS/MS/MS スキャンを
実行すると、イオンに関してより多くの情報を取得します。

MS/MS：MS/MS スキャンは、構造情報を決定するために使用されます。

• トリプル四重極システムでの MS/MS スキャンの場合、選択されたイオンは Q2 衝突セルに入
り、衝突して活性化されてフラグメント化し、特徴的なプロダクトイオンを生成します。

• QTRAP システムの MS/MS スキャンの場合、プレカーサーイオンのフラグメンテーションが、Q2
衝突セルまたはリニアイオントラップで発生する可能性があります。

十分なエネルギーが使用される場合、プレカーサーイオンは断片化して特有のプロダクトイオンを
生成します。

MS/MS/MS：リニアイオントラップ（LIT）システムの MS/MS/MS スキャンは、MS/MS スキャンの 1
ステップ先に進みます。衝突セルで生成される断片は LIT でさらに断片化し、分子イオンに関する
より多くの構造的情報を提供します。
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四重極モードスキャン種類

トリプル四重極装置は、定量実験において要求される高感度の複数反応モニタリング（MRM）能力
を備えています。さらに、プレカーサーイオンや中性損失スキャンなど、特異性の高いスキャン種類
を有しており、サンプルのコンポーネントにおけるより前進的な調査が可能になります。

Q1 MS (Q1)：一段目の四重極（Q1）を使用したフルスキャン種類。イオン強度はスキャン範囲の中
で質量ごとに戻されます。

Q1 Multiple Ions (Q1 MI)：Q1 四重極を使用した選択スキャン種類。特定の質量についてイオン
強度の増減をモニターできます。

Q3 MS (Q3)：三段目の四重極（Q3）を使用したフルスキャン種類。イオン強度はスキャン範囲の中
で質量ごとに戻されます。

Q3 Multiple Ions (Q3 MI)：Q3 四重極を使用した選択スキャン種類。特定の質量についてイオン
強度の増減をモニターできます。

MRM (MRM)：ユーザー定義のイオンが Q1 四重極で分離され、Q2 衝突セル内でフラグメントとな
る MS/MS スキャンです。次に、Q3 四重極を使用して、検出器によって記録されたユーザー定義の
フラグメントイオンを分離します。このスキャン種類は定量分析のために主に使用されます。

Product Ion (MS2)：Q1 四重極を使用して特定のプレカーサーイオンを分離および送信し、Q3 四
重極スキャンが定義された質量範囲をスキャンする MS/MS フルスキャンです。このスキャンタイプ
は、特定のプリカーサーイオンのすべてのフラグメントイオンを識別するために使用されます。

Precursor Ion (Prec)：Q3 四重極が特定の m/z 値で固定されて特定のプロダクトイオンを透過
し、Q1 四重極が質量範囲をスキャンする MS/MS スキャンです。このスキャン種類は、プレカーサ
ーイオンの存在を確認したり、より一般的には、共通のプロダクトイオンを共有する化合物を特定す
るために使用されます。

Neutral Loss (NL)：Q1 四重極および Q3 四重極スキャンの両方が、固定質量を除いて、質量範
囲をスキャンする MS/MS スキャンです。特定された固定質量である中性損失を失うことにより、イ
オンが Q1 四重極フラグメントにより選ばれた場合は、反応が観察されます。このスキャン種類はプ
レカーサーイオンの有無の確認のため、またはより一般的に共通の中性損失を共有する成分の識
別に使用されます。

LIT モードスキャンタイプ

LIT モードスキャンは、Q3 四重極をリニアイオントラップとして使用します。イオンは、スキャンする
前に Q3 四重極に捕捉・保存され、感度を向上させます。さらに、MS/MS/MS 分析はリニアイオント
ラップで実行することができ、サンプルについての詳細を提供します。LIT モードスキャン種類は、通
常定性的な測定に使用されます。

注: 中国の場合、トリプル四重極質量分析装置のみが提供されます。これらのシステムは、リニアイ
オントラップ（LIT）のスキャン種類に対応していません。

Enhanced MS (EMS)：Q1 四重極でイオンをスキャンし、線形イオントラップで収集します。これら
のイオンは、MS 型シングルスペクトルを生成するために Q3 四重極からスキャンされます。
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Enhanced Product Ion (EPI)：特定のイオンの高品質な MS/MS スペクトルを得るためのスキャ
ンタイプです。フラグメンテーションは Q2 衝突セルで行われるため、衝突活性化解離の典型的情
報が豊富な MS/MS スペクトルを提供します。このスキャンモードでは、フラグメント化するプレカー
サーイオンを 初に Q1 四重極で 1 Da から 4 Da の幅の質量ウィンドウで選択し、他のすべての
イオンをフィルタリングします。プレカーサーイオンは、Q2 衝突セルの CAD ガスによってフラグメン
ト化されます。生成されたフラグメントイオンは、リニアイオントラップで捕捉され、必要なフラグメント
イオン分解能に応じて、3 つのスキャン速度のいずれかでスキャンされます。

IDA 実験に関しては、Product Of フィールドは既定で 30 Da に設定されています。この値は変更
しないでください。

Enhanced Resolution (ER)：このスキャンタイプは EMS スキャンと似ていますが、プレカーサー
質量を中心に 30 Da の小さな質量ウィンドウを、 も遅いスキャンレートで線形イオントラップから
スキャンして、 も分解能の高いスペクトルの狭いウィンドウを生成する点が異なります。

MS/MS/MS (MS3)：プレカーサーイオンは、Q1 四重極で選択され、Q2 衝突セルの衝突活性化解
離でフラグメント化しています。結果として得られるプロダクトイオンは、その後 1 つのプロダクトイオ
ンが孤立するリニアイオントラップに、すべて送られます。孤立したイオンがリニアイオントラップでさ
らにフラグメント化され、結果として得られるプロダクトイオンは、3 つのスキャン速度のいずれかで
トラップからスキャンされます。あらゆるトラップにおける衝突誘起解離（CID）の技術と同様に、 小
質量フラグメントとプレカーサーがトラップで同時に安定している必要があるため、2 番目の MS/MS
ステップには低質量カットオフがあります。QTRAP システムでは、結果として MS3 実験中に前駆
イオンの質量の 28% より低いイオンの損失が生じます。この現象は 3 分の 1 カットオフルールと
呼ばれます。

スペクトルデータ収集について

スペクトルデータを測定できるモードの説明については、表 11-7 を参照してください。

表 11-7 : スペクトルデータ

モード 説明

Profile プリセット値は 0.1 Da です。プロファイルデータは質量分析装置で生成され、
一連の均等間隔の個別の質量値で記録された強度に対応します。たとえば、
100 Da ～ 200 Da の質量範囲で、ステップサイズが 0.1 Da の場合、質量分
析装置は 99.95 ～ 100.95（値 100 として記録）、100.05 ～ 101.05（値 101
として記録）…199.95 ～ 200.05（値 200 として記録）をスキャンします。

Peak Hopping プリセット値は 1.0 Da です。ピークホッピングは、大型ステップ（約 1 Da）を作
成する質量分析装置の運用モードです。これには速度が速い（より少ないデ
ータステップ）というメリットがありますが、ピークシェイプ情報が消失します。

Centroid 質量分析装置はプロファイルモードと同様のスキャンを行いますが、データの
セントロイドを作成し、現在のピークに換えて各ピーク重力の強度中心点を取
り込みます。セントロイドデータは、ファイルサイズを著しく小さくすることがメリ
ットです。デメリットとしては、ピークシェイプ情報が消失し、データがセントロイ
ドとして収集された場合、変更できません。プロファイルモードとデータの収集
後にセントロイドを使用することを推奨しています。
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使用説明—バッチ 12
注意: ダメージを与える恐れ。質量分析装置に接続されている LC システムがソフトウェアによって
制御されていない場合は、操作中に質量分析装置から目を離さないでください。質量分析装置がス
タンバイ状態に入ると、LC システムがイオン源をあふれさす可能性があります。

バッチとは、分析対象のサンプルに関する情報を収集したものです。サンプルは通常、提出を容易
にするためにセットにグループ化されます。サンプルをセットとしてグループ化することで、手動入力
が必要なデータの量も削減されます。セットは単一または複数のサンプルで構成されている場合が
あります。バッチ内のセットに対しては、いずれも同一のハードウェアプロファイルが用いられます
が、他の測定メソッドを適用することも可能です。バッチは測定用コンピュータからのみ提出できま
す。

バッチには次の情報が含まれます。

• サンプル情報（名前、ID、コメントなど）

• オートサンプラーラック情報、バイアル位置、注入量

• 測定メソッド

• 処理メソッド（オプション）

• 定量情報（オプション）

• カスタムサンプルデータ（オプション）

• セット情報

バッチの作成および提出
バッチは分析対象のサンプルに関する情報を収集したものです。バッチは、サンプルを分析する順
序をソフトウェアに伝達します。バッチのインポートについての情報に関しては、『アドバンスドユー
ザーガイド』を参照してください。

キューオプションの設定

ソフトウェアは、キューにあるサンプルのリストを 1 つずつ調べ、選択した測定メソッドで各サンプル
を測定します。全サンプルの測定が終了した後に、キューオプションで設定した Max. Idle Time が
経過すると、測定が停止し、質量分析装置がスタンバイ状態になります。スタンバイ状態では、LC
ポンプが停止し、いくつかの装置の電圧がオフになります。

ユーザーは、 後のサンプルを測定してからスタンバイ状態に移行するまでの時間を変更すること
ができます。Queue Options ダイアログの他のフィールドの情報については、ヘルプを参照してくだ
さい。

1. Navigation バーで Configure をクリックします。

2. Tools > Settings > Queue Options. をクリックします。
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図 12-1 : Queue Options ダイアログ

3. Max. Num. Waiting Samples フィールドで、キューに提出するサンプルの数より大きい値に
サンプルの 大数を設定します。

4. Max. Idle Time フィールドに、測定完了後にソフトウェアがスタンバイ状態に入るまでに待機
する時間の長さを入力します。事前設定値は 60 分です。

高圧ガス容器を使用している場合、シリンダー内ガスが使い果たされていないことを確認する
ためにこの時間を調整します。

LC メソッドを使用する場合、実行を開始する前に、すべてのサンプルのリザーバーに十分な溶
媒があり、初期流量、 大アイドル時間で作動していることを確認してください。

5. 分析が完了した後、質量分析装置の実行を維持するために Leave Mass Spec on in
Standby チェックボックスを選択してください。

この機能により、ヒーターおよびガスは、機器がアイドル状態となった後でも作動し続け、イオン
源と質量分析装置への入り口は、汚染物質のない状態で保たれます。

6. Fail Whole Batch in Case of Missing Vial チェックボックスをオンにすると、バイアルが欠
損したときにバッチ全体が失敗するようになります。

このオプションを選択していない場合は、現在のサンプルが失敗し、ソフトウェアは次のサンプ
ルに進みます。

バッチの作成および提出

このワークフローを用いてバッチを作成します。

Quick Quant 機能を使用してサンプル種類および濃度をデータファイルに保存する場合、自動的に
生成された Quick Quant メソッドを使って定量化を実施しないでください。この定量化メソッドは、ピ
ークの選択用に 適化されている化合物およびサンプル固有積分パラメータを使用しません。
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セットとサンプルをバッチに追加

セットは単一または複数のサンプルで構成されている場合があります。

注: 定量情報をバッチに追加する詳細は、上級ユーザーガイドを参照してください。

1. Navigation バーの Acquire の下にある Build Acquisition Batch をダブルクリックします。

図 12-2 : バッチエディタダイアログ

2. Sample タブの Set リストで名前を入力します。

3. Add Set をクリックします。

4. Add Samples をクリックして、サンプルを新規セットに追加します。

使用説明—バッチ

SCIEX 4500MD システム
134/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



図 12-3 : Add Sample ダイアログ

5. Sample name セクションの Prefix フィールドで、このセットのサンプル用の名前を入力しま
す。

6. サンプル名の末尾に増分番号付けを追加するには、Sample number チェックボックスを選択
してください。

7. Sample number チェックボックスが選択されている場合、Number of digits フィールドにサ
ンプル名に含めるべき桁数を入力します。
例えば、3 が入力された場合、サンプル名は samplename001、samplename002 および
samplename003 になります。

8. Data file セクションの Prefix フィールドで、サンプル情報を格納するデータファイルの名前を
入力します。

9. Set name チェックボックスを選択して、セット名をデータファイル名の一部として使用します。

10. Auto Increment チェックボックスを選択して、データファイル名を自動的に増分します。

質量分析装置が in vitro の診断デバイスとして使用される時は、データファイル毎に 1 つのサ
ンプルだけを取得することが推奨されます。

注: 各サンプルのデータは同じか個別のデータファイルに格納することができます。データファ
イルの名前には、1 から始まる数値添え字があります。

11. Sub Folder フィールドに名前を入力します。
フォルダは現在のプロジェクト用の Data フォルダに格納されます。Sub Folder フィールドが

ブランクのままである場合、データファイルは Data フォルダに格納され、またサブフォルダは

作成されません。
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12. New samples セクションの Number フィールドに、追加する新規サンプルの数を入力します。

13. OK をクリックします。
サンプル表にはサンプル名およびデータファイル名が記入されます。

ヒント! 単一カラムの見出しまたはカラムの複数行が選択された後にメニューを右クリックすると
Fill Down および Auto Increment オプションが利用できます。

14. Sample タブの Acquisition セクションで、リストからメソッドを選択します。
システムのセットアップの仕方に応じて、オートサンプラー用の個別情報を入力する必要があり
ます。注入量がメソッドで設定されている場合でも、ユーザーは注入量のカラムで値を変更する
ことによって 1 つ以上のサンプルの注入量を変更することができます。

注: このセットでサンプル用にさまざまなメソッドを使用するには、Use Multiple Methods チェ
ックボックスを選択してください。Acquisition Method カラムが Sample 表に表示されます。
このカラムで各サンプル用に測定メソッドを選択してください。

15. Sample リストの Set タブでセットを選択してください。

16. セット内の各サンプルについて、必要に応じて次の手順を行ってください。

• Rack Code カラムでラック種類を選択します。

• Rack Position カラムで、オートサンプラーのラック位置を選択します。

• Plate Code カラムでプレートタイプを選択します。

• Plate Position カラムでラック上のプレート位置を選択します。

• Vial Position カラムでプレートまたはトレイのバイアル位置を選択します。

注: Locations タブからサンプルに自動記入を行うには、Shift キーを押しながらセット内の
初と 後のバイアルをクリックします。これらのバイアルは赤い円で表示されます。Locations
タブで、バイアルの場所をクリックしながら Ctrl キーを押すことにより同一のバイアルからの複
数の注入を行うことができます。赤い円は緑に変わります。

17. または、Locations タブを使ってバイアル位置を選択する場合は、Locations タブを使用してバ
イアルの位置を選択する（オプション）を参照してください。

18. （オプション）必要に応じて、表 12-1 の手順を使用します。

表 12-1 : バッチエディタの手引き

目的の作業 実行する操作

カラムのすべての値を同時に変更するには カラム見出しをクリックした後、右クリックしま
す。メニューから、Auto Increment および Fill
Down コマンドを使用してカラムの値を変更し
ます。

この機能は同じカラムの複数のセルにも有効で
す。
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表 12-1 : バッチエディタの手引き (続き)

目的の作業 実行する操作

既存の測定メソッドを変更するには メソッドを選択し、次いでリストから Method
Editor をクリックしてください。新規の測定メソ
ッドを作成するには、リストから None を選択
し、次いで Method Editor をクリックします。こ
の機能は熟練したユーザーだけが使用するよ
うにしてください。

Use Multiple Methods オプションが選択され
ている場合は、この機能を使用しないでくださ
い。

以前に作成した定量化メソッドを適用するには Quantitation リストからメソッドを選択してくだ
さい。

一度に 1 個以上のウェルまたはバイアルを選
択するには

Shift キーを押しながら、その範囲にある 初
と 後のウェルまたはバイアルをクリックしま
す。

19. （オプション）バッチ提出前に定量詳細を定義するには、バッチエディタで定量詳細を設定（オプ
ション）を参照してください。

20. Submit タブを開きます。

注: サンプルの順番は、サンプルをキューに送る前に編集できます。サンプルの順番を変更す
るには、Submit タブの表の左端にある数字のいずれかをダブルクリックし（小さなボックスが表
示されます）、希望の位置にドラッグします。

21. Submit Status セクションの中にバッチのステータスに関するメッセージが入っている場合は、
次のいずれかの操作を行います。

• バッチの提出準備ができていることをメッセージが示している場合は、ステップ 22 に進みま
す。

• バッチの提出準備ができていないことを示すメッセージであれば、メッセージが示す通りに
変更を行ってください。

22. バッチに関する情報がすべて正しいことを確認した後、Submit をクリックします。
対象のバッチがキューに提出され、Queue Manager に表示することができます。

23. ファイルを保存します。

サンプルまたはサンプルセットの提出

注: サンプル測定中に異常な終わり方をした場合は、サンプルをもう一度実行してください。停電に
よって異常な終わり方をした場合、オートサンプラーのトレイの温度が持続されず、サンプルの完全
性が損なわれる恐れがあります。

1. 1 つのサンプルまたはサンプルのセットを選択します。
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2. Batch Editor の Submit タブを開きます。

3. Submit Status グループの中にバッチのステータスに関するメッセージが入っている場合は、
次のいずれかの操作を行います。

• バッチの提出準備ができていることについてのメッセージであれば、次のステップに進みま
す。

• バッチの提出準備ができていないことを示すメッセージであれば、メッセージが示す通りに
変更を行ってください。

4. Submit をクリックします。

サンプル順序の変更

サンプルの順番は、サンプルを Queue に送る前に変更できます。

Submit タブでは、表（かすかに表示されている正方形のボックス）の左端の数字のいずれかをダブ
ルクリックし、新しい場所にドラッグします。

Locations タブを使用してバイアルの位置を選択する（オプション）

1. Batch Editor で、Locations タブを開きます。

2. Set リストで、セットを選択します。

3. Autosampler リストからオートサンプラーを選択します。

4. ラックに関連付けられているスペースで右クリックし、ラックの種類を選択します。
プレートまたはトレイがラックに表示されます。

5. ラックタイプのラベルのついた白いスペースをダブルクリックします。サンプルラックが視覚的に
レイアウト表示されます。
オートサンプラーのラックスペースの適切な数が、グラフィックラックビューで表示されます。
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図 12-4 : 視覚的なサンプルの場所

6. 四角形の 1 つをダブルクリックします。
プレートまたはトレイのウェルまたはバイアルを描いた円が表示されます。

ヒント! グラフィック表示内で対応するバイアル番号を確認するには、サンプル位置にカーソル
を合わせます。この情報を用いて、ソフトウェアでのバイアル位置がオートサンプラー内のバイ
アル位置と一致することを確認してください。
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図 12-5 : Locations タブ

注: ご使用のオートサンプラーによっては、追加カラムへの情報入力は不要です。

7. サンプルを行またはカラムのどちらでマークするかどうかを選択するには、Row/Column
selection セレクターボタンをクリックします。
ボタンが赤色の横線を表示する場合、Batch Editor は行でサンプルを示します。ボタンが赤色
の縦線を表示する場合、Batch Editor はカラムでサンプルを示します。

8. サンプルウェルまたはバイアルを分析する順番にクリックします。

ヒント! 選択したウェルまたはバイアルをクリアするには、もう一度クリックします。

ヒント! サンプルへの充填を自動的に行うには、セット内の 初と 後のバイアルをクリックしな
がら Shift を押します。同じバイアルから複数の注入を実行するには、キーを押して、バイアル
の場所をクリックしながら Ctrl を押します。赤い円は、緑色の円に変わります。
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バッチエディタで定量詳細を設定（オプション）

バッチで定量化メソッドが使用されており、ユーザーが後に定量詳細を選択しない場合は、定量詳
細（サンプルの種類、サンプルの濃度）をバッチ提出前に定義する必要があります。

適切な Internal Standard および Standard 列は、Sample タブで選択された定量化メソッドに応
じて Quantitation タブに表示されます。

1. Batch Editor ウィンドウでバッチファイルを開き、Quantitation タブを開いてください。

2. サンプルを含むセットを選択してください。

3. セルのリストからすべてのサンプルの Quant Type、Dilution Factor、Weight/Volume を選
択してください。

4. （必要に応じて）Analyte 列に、分析試料の濃度を入力します。

5. （必要に応じて）Internal Standard 列に、内部標準濃度を入力します。

6. バッチの各セットごとにこの手順を繰り返してください。

システムの平衡化

システムの平衡化を行ってから、バッチの提出を行います。平衡化は、次のサンプルまたはバッチ
のために、質量分析装置をウォームアップさせ、準備を行います。

1. Equilibrate（ ）をクリックします。
Equilibrate ダイアログが開きます。

2. 提出されたバッチに用いられる測定メソッドを選択します。

3. Time (min)フィールドに、平衡時間を分単位で入力します。

4. OK をクリックします。システムの平衡化が始まります。
平衡化が完了すると、システム状態は Ready に変わります。

ヒント! 平衡化が期待どおりに完了しない場合、または平衡化の完了後にシステムの状態が
Ready に変化しない場合は、次の条件が満たされていることを確認してください。

• 有効化されたハードウェアプロファイルが測定メソッドに適していること

• LC システムの電源がオンであること

• LC システムとソフトウェアとの通信が正しく確立されていること

データの取得

サンプル測定が開始した後で、ソフトウェアを Tune and Calibrate モードに切り替えないでくださ
い。また、システムを当日その前に運転していて、スタンバイ状態に設定していない場合、サンプル
測定は自動的に開始します。

1. カラムオーブンの温度に到達していることを確認します。
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2. Reserve Instrument for Tuning（ ）アイコンが押されていないことを確認します。

3. Navigation バーで Acquire をクリックします。

4. View > Sample Queue. をクリックします。
Queue Manager が開き、提出されたサンプルがすべて表示されます。

図 12-6 : Queue Manager

項目 説明

1 Reserve Instrument for Tuning アイコンは押し込まないでください。

2 キューの状態は準備完了である必要があります。

3 Queue Server の状態は Normal である必要があります。 キュー状態を参
照してください。

5. Acquire > Start Sample. をクリックします。

注: サンプル測定中に異常停止した場合は、サンプルをもう一度実行することを推奨します。

バッチファイルのインポート

ユーザーはバッチ情報を含むテキストファイルをインポートできます。Batch Editor でバッチを作成
する必要はありません。すべて/のサンプルの詳細がスプレッドシートにある場合、スプレッドシート
にデータを再配置してインポートする方が、Batch Editor でデータを手動で入力するよりも高速で
す。

テキストファイルからバッチ情報をインポートする前に、ファイル内のデータが正しく整理、フォーマッ
トされていることを確認してください。特に、スプレッドシートのカラム見出しは Batch Editor のカラム
見出しと一致している必要があります。テキストファイルに適切な見出しが付いていることを確認す
るには、Batch Editor を用いてバッチ作成し、これをテキストファイルとしてエクスポートしてから、
Spreadsheet Editor で適切な値を入力し、次にファイルを Batch Editor に再度インポートして戻し
ます。

適切にフォーマットされたファイルの例については、Example プロジェクトの Batch フォルダを参照
してください。

バッチファイル内の情報は、Microsoft Excel や Microsoft Access、ならびに一部のラボ情報管理
システム(LIMS)ソフトウェアといった、他のアプリケーション用にエクスポートすることもできます。
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テキストファイルとしてバッチビルドを行う

前提条件

有効なハードウェアプロファイルが、サンプルを取得するために使用するすべての機器を含んでい
ることを確認します。

テキストファイルに適切な見出しが付いていることを確認するには、Batch Editor を用いてバッチ作
成し、これをテキストファイルとしてエクスポートしてから、Spreadsheet Editor で適切な値を入力
し、次にファイルを Batch Editor に再度インポートして戻します。ユーザーは少なくとも 1 つのサン
プルについて 1 セットを含む時に限り、バッチをエクスポートすることができます。保存したテキスト
ファイルはテンプレートとして再度使用することができます。

1. Batch Editor においては、シングルセット、シングルサンプルバッチを作成します。

2. File > Export.をクリックします。
Save As ダイアログが開きます。

3. File name フィールドにテキストファイル名を入力し、Save をクリックします。

4. Excel のようなスプレッドシートプログラムでテキストファイルを開きます。

5. サンプルの詳細を入力するか、コピーおよび貼り付けを行います：一行につきサンプルは 1 つ
とし、適切な項目の下に詳細を入力してください。

注: いずれの列も削除しないでください。スプレッドシートのカラムはバッチエディタの列に一致
させるようにしてください。

6. 修正したテキストファイルを txt または csv ファイルとして保存し、スプレッドシートプログラムを
閉じます。
これでテキストファイルを Batch Editor にインポートする準備が完了しました。

テキストファイルからのバッチのインポート

1. Batch Editor の Sample タブを右クリックし、その後 Import From > File.をクリックします。
Open ダイアログボックスが開きます。

2. 必要なテキストファイルをクリックして Open をクリックします。
オートサンプラーを使用している場合は、Select Autosampler ダイアログが開きます。

注: 保存されたテキストファイルが Files of type リスト上にない場合は、Microsoft Text
Driver (*.txt; *.csv) を選択します。フィールド上に拡張子.txt のファイルが表示されます。

3. オートサンプラーリスト上でオートサンプラーを選択し、OK をクリックします。
サンプルテーブルに、テキストファイルから読み込まれた詳細が表示されます。

4. バッチを送信します。
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バッチおよび Acquisition Method Editor のヒント

実行する作業 実行する操作

表内の値を変更するには （たとえば、サンプル名を変更するには）セルを
クリックして新しい値を入力します。

カラムのすべての値を同時に変更するには カラム見出しをクリックした後、右クリックしま
す。表示されたメニューから、Auto Increment
および Fill Down コマンドを選択してカラムの
値を変更します。

この機能は同じカラムの複数のセルにも有効で
す。

既存の測定メソッドを変更するには リストからメソッドを選択した後、Method
Editor をクリックします。新規の測定メソッドを
作成するには、リストから None を選択し、次い
で Method Editor をクリックします。この機能
は熟練したユーザーだけが使用するようにして
ください。

Use Multiple Methods オプションをお使いの
場合は、この機能を使用しないでください。

以前に作成した定量化メソッドを適用するには Quantitation メニューからメソッドを選択しま
す。

一度に 1 個以上のウェルまたはバイアルを選
択するには

Shift キーを押して、選択対象範囲内の 初と
後のウェルまたはバイアルをクリックします。

Batch Editor の右クリックメニューの使い方については、Batch Editor を参照してください。

バッチトラブルシューティングのヒント

症状 考えられる原因 修正アクション

Analyst MD ソフトウェアのバッ
チエディタで、注入量（uL）カラ
ムに -1 が表示される。

バッチの測定メソッドが選択さ
れていません。

バッチ用の正しい測定メソッド
を選択します。

選択した測定メソッドの LC デ
バイスが、ハードウェアプロファ
イルの LC デバイスと一致しま
せん。

意図する測定メソッドを開きレ
ビューします。LC デバイスの
情報を正しく修正してから、メソ
ッドを保存します。
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症状 考えられる原因 修正アクション

有効化されたハードウェアプロ
ファイルには LC デバイスが含
まれていないか、別の LC デバ
イスが含まれています。

Hardware Configuration
Editor を開いた後、ハードウェ
アプロファイルを無効化しま
す。ハードウェアプロファイルを
編集し、LC デバイスの情報を
正しく修正してから、ハードウェ
アプロファイルを有効化しま
す。

サンプル測定の停止

サンプル測定を停止する場合、ソフトウェアは測定を停止する前に現在のスキャンを完了させます。

1. Queue Manager で、測定を停止した地点の後に来るキュー上のサンプルをクリックしてくださ
い。

2. Navigation バーで Acquire をクリックします。

3. Acquire > Stop Sample. をクリックします。
選択したサンプルの現在のスキャンの測定後、測定が停止します。Queue Manager (Local)
ウィンドウのサンプル状態が Terminated に変化し、キューに続くその他のサンプルは、
Waiting となります。

4. バッチ処理を継続するには、Acquire > Start Sample. をクリックします。
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使用説明－データの分析と探索 13
一般的な分析および処理ツールを使用してデータの閲覧および分析を行う方法については、
Example フォルダにインストールされたサンプルファイルを活用してください。以下のトピックに関す
る詳細は、上級ユーザーガイドを参照してください。

• グラフのラベリング

• スペクトルまたはクロマトグラムの重ね表示および合計

• バックグラウンドサブトラクションの実行

• アルゴリズムのスムージング

• スムージングされたデータでの作業

• セントロイドされたデータでの作業

• 等高線図での作業

• フラグメント解釈ツールでの作業

• ライブラリデータベースおよびライブラリ記録での作業

スペクトルデータおよびクロマトグラムデータの概要
スペクトルデータからは化合物の質量固有の情報が得られます。クロマトグラムはデータの全体像
を把握するためのものですが（LC カラムの使用時にはたいてい時間に依存したものとなります）、
ピークのコンポーネントに関する情報は何ら得られません。しかし、スペクトルは特定のピークに注
目したものであり、対応する化合物の分子量が示されます。これは、より具体的な情報を得るため
に使用できます。例えば、クロマトグラムにピークが 1 つしか表示されていない場合でも、そのピー
クが複数の化合物（つまり質量が異なること）を表す場合があります。スペクトルには、各質量の強
度など、ピークを構成するすべての質量が示されます。

特定のサンプルでクロマトグラフィーの状態が変化した場合、クロマトグラフィーのデータは時間と強
度の両面で変化する場合があります。スペクトル強度は変化する場合がありますが、化合物の質
量は変化しないため、質量は一定です。

スペクトルデータを生成する方法は、次の 2 通りがあります。

• スキャンが 1 つしか取得されていない場合、そのデータはデフォルトでスペクトルとして表示され
ます。

• クロマトグラムから生成されます。

一般的なスペクトルは分子量とともに表示され、質量電荷比（m/z）のラベルが付けられて X 軸に示
されます。強度は Y 軸に示されます。
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データの分析
データファイルが開かれると、実施する実験の種類に応じて異なるペインが表示されます。ソフトウ
ェアによって、データは wiff 拡張子付きでファイルに保管されます。wiff ファイルは、複数サンプル
のデータを収納できます。wiff ファイルだけでなく、txt ファイルも開くことができます。しかし、txt ファ
イルの場合は、収納できるデータは 1 サンプルのみです。

データファイルに含まれる情報は、表形式またはグラフ形式で参照することができます。グラフ形式
のデータはクロマトグラムまたはスペクトルとして示されます。これらのうちいずれかのデータをデー
タポイントの表として表示でき、データにさまざまなソート操作を行うことができます。

ユーザーは既存のデータや現在収集されているデータを含むファイルを開くことができます。さらに
実験関連データすべてを表形式で参照することができます。表ペインは、2 つのタブ、すなわち
Data List タブおよび Peak List タブからなります。Data List タブには、実験関連情報、例えば、収
集時間およびスキャン強度などが含まれます。Peak List タブでは、ピーク関連情報、例えば、ピー
ク高、ピーク領域およびベースラインの種類などが表示されます。

データに複数の実験の結果が含まれている場合、ユーザーは各実験に個別の TIC（トータルイオン
クロマトグラム）を作成し、さらに全実験の合計を表す TIC を作成することができます。

全実験の合計を表すプリセットされた TIC は、X 軸の中心の下のスプリッタツールで表示されます。

データファイルを開く

ヒント! 質量スペクトルの自動更新を停止するには、質量スペクトルを右クリックし、Show Last
Scan をクリックします。Show Last Scan にチェックが付いている場合、スペクトルはリアルタイム
で更新されます。

1. Navigation バーの Explore 下にある Open Data File をダブルクリックします。
Select Sample ダイアログが表示されます。

2. Data Files リストで開きたいデータファイルを特定し、サンプルを選択して OK をクリックしま
す。
サンプルから取得されたデータが表示されます。データ取得中は、質量スペクトル、DAD/UV ト
レース、TIC の自動更新は継続されます。

データファイル内のサンプル間ナビゲーション

注: サンプルがそれぞれ別のデータファイルに保存されている場合は、各ファイルを個別に開いてく
ださい。

この手順で使用するナビゲーションアイコンの説明については、表 D-4 を参照してください。

複数のサンプルを含むデータファイルを開き、次のいずれかの操作を行います。

• データファイルの次のサンプルに移動するには、Show Next Sample アイコン（ ）をクリックし
ます。

• 連続しないサンプルにスキップするには、Go to Sample アイコン（ ）をクリックします。
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• Select Sample ダイアログの Sample リストからサンプルを選択して表示します。

• データファイルの前のサンプルに移動するには、Show Previous Sample アイコン（ ）をクリ
ックします。

実験条件の表示

データを収集するために使用される実験条件は、その結果と共にデータファイルに格納されます。
情報には、使用した測定メソッドの詳細が含まれます：MS 測定メソッド、すなわち装置パラメータを
含む期間数、実験数、サイクル数、および LC デバイスメソッド（LC ポンプ流量を含む）。さらに、サ
ンプルの測定に使用される MS 分解能および質量較正表も含まれています。ユーザーがファイル
情報を閲覧する際に利用できるソフトウェアの機能については、Show File Information ペインの右
クリックメニューを参照してください。

注: 複数サンプルから同一 wiff ファイルにデータが取得された場合、ファイル情報ペインはサンプ
ルのスクロール中に自動リフレッシュされません。ファイル情報ペインを閉じた後、再度開いて、wiff
ファイル中の次のサンプルの詳細を参照します。

Explore > Show > Show File Information. をクリックします。
グラフの下で File Information ペインが開きます。

ヒント! File Information ペインから測定メソッドを作成するには、File Information ペインを右クリッ
クし、その後 Save Acquisition Method をクリックします。

表内のデータを表示

1. データファイルを開きます。

2. Explore > Show > Show List Data. をクリックします。
データはグラフの下のペイン内に表示されます。
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図 13-1 : Peak List タブ（QTRAP システム）

表 13-1 : Spectral Peak List タブの右クリックメニュー

メニュー 機能

Column Options （カラムオプション）Select Columns for Peak List ダイアログを開
きます。

Save As Text （テキストとして保存）データを .txt ファイルとして保存します。

Delete Pane （ペインの削除）選択したペインを削除します。
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表 13-2 : Chromatographic Peak List タブの右クリックメニュー

メニュー 機能

Show Peaks in Graph （ピークをグラフに表示）ピークを 2 色でグラフに表示します。

IntelliQuan Parameters （IntelliQuan パラメータ）Intelliquan ダイアログを開きます。

Save As Text （テキストとして保存）データを .txt ファイルとして保存します。

Delete Pane （ペインの削除）選択したペインを削除します。

基本定量データの表示

1. データファイルを開きます。

2. Explore > Show > Show List Data をクリックします。

図 13-2 : List Data

3. Peak List タブで右クリックし、Show Peaks in Graph を選択します。
ピークが 2 色で表示されます。

4. ピーク検出アルゴリズム設定を変更するには、右クリックして Analyst Classic Parameters
または Intelliquan Parameters のうち、有効になっているものを選択します。

5. （オプション）色つきピークを削除するには、Peak List タブで右クリックし、Show Peaks in
Graph をクリアします。
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スペクトル
スペクトルとは質量分析装置から直接取得されたデータであり、通常は特定の質量電荷比（m/z）で
検出されたイオンの数を表します。スペクトルは、m/z 値を示す X 軸と強度（cps）を示す Y 軸のグ
ラフとして表示されます。スペクトルの取り扱い方法については、表 G-4 を参照してください。

MS/MS データの場合、強度は 2 種類の質量、つまりプレカーサーイオン質量（Q1）とプロダクトイ
オン質量（Q3）に関連付けられています。

クロマトグラム
クロマトグラムはサンプル分析から得られるデータをグラフ表示したものです。シグナル強度が時間
またはスキャン番号を示す軸に沿ってプロットされます。クロマトグラムで使用できるソフトウェアの
機能、およびクロマトグラムペインの右クリックメニューの使用方法の詳細については、クロマトグラ
ムペインを参照してください。

1 秒当たりのカウント（cps）で表した強度が Y 軸に、時間が X 軸に表示されます。設定されたしき
い値を上回るピークは、自動的にラベル付けされます。LC-MS の場合、多くの場合クロマトグラム
は時間の関数として表示されます。クロマトグラムの種類については、表 13-3 を参照してください。

使用可能なアイコンの使い方については、表 13-5 を参照してください。

表 13-3 : クロマトグラムの種類

クロマトグラムの
種類

目的

トータルイオンク
ロマトグラム
（TIC）

時間またはスキャン数に対するスキャン内のすべてのアイコンの強度のプロ
ッティングにより生成されたクロマトグラムです。

データファイルが開いている場合、TIC として開くよう事前設定されています。
実験にスキャンが 1 回のみ使用される場合、スペクトルとして表示されます。

データファイルの取得中に MCA チェックボックスを選択した場合、データファ
イルは質量スペクトルに対して開きます。MCA チェックボックスを選択してい
ない場合、データファイルは TIC として開きます。

Extracted Ion
Chromatogram
(XIC)

一連の質量スペクトルスキャンにおいて、単一または複数の質量値あるいは
質量範囲の強度値によって作成されたクロマトグラムです。これは、該当する
質量または質量範囲の振る舞いを時間の関数として示したものです。

ベースピーククロ
マトグラム（BPC）

スキャン対時間またはスキャン数内で も強いイオンを示すクロマトグラムで
す。

トータル波長クロ
マトグラム（TWC）

取得した波長範囲の吸光度すべての合計および時間に対する値のプロッティ
ングによって作成されるクロマトグラムです。クロマトグラムペインで、時間に
対してプロットされたスキャンに含まれる全イオンの吸光度の合計値で構成さ
れています。

抽出波長クロマト
グラム（XWC）

TWC のサブセット。XWC は、単一の波長の吸光度または一定の範囲の波
長の吸光度の合計を示します。
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表 13-3 : クロマトグラムの種類 (続き)

クロマトグラムの
種類

目的

Diode Array
Detector (DAD)

1 つ以上の波長で溶出する化合物の吸収スペクトルを示すクロマトグラムで
す。

スペクトルから TIC を表示

実例データファイルを閲覧する際は、Example プロジェクトが選択されていることを確認してくださ

い。

LIT スペクトルを表示するには、LIT フォルダを開き、Reserpine.wiff ファイルを開きます。

Explore > Show > Show TIC. をクリックします。
TIC が新しいペインを開きます。

ヒント! スペクトルを含むペイン内で右クリックし、Show TIC をクリックします。

Spectra Panes の右クリックメニューの使い方については、スペクトルペインを参照してください。

TIC からスペクトルを表示

TIC は、一連の質量スキャンから得られたすべてのイオンの強度寄与を合計することで作成されま
す。TIC を使用して、データセット全体を単一のペインで表示します。TIC は、クロマトグラムのペイ
ンの時間に対してプロットされたスキャンのすべてのイオンの強度の合計で構成されています。デ
ータに複数の実験結果が含まれている場合、すべての実験の合計を表す TIC の下に、各実験の
TIC を作成することができます。

データファイルが開いている場合は TIC として表示されるように事前設定されています。ただし、実
験に 1 スキャンしか含まれていない場合は、スペクトルとして表示されます。データファイルの取得
前に MCA チェックボックスをオンにした場合、データファイルは質量スペクトルとして開きます。
MCA チェックボックスがオフの場合、データファイルは TIC として開きます。

Spectra Panes の右クリックメニューの使い方については、スペクトルペインを参照してください。

1. TIC を含んでいるペインで、範囲を選択してください。

2. Explore > Show > Show Spectrum. をクリックします。
スペクトルは新しいペインで開きます。

ヒント! スペクトルを示すため特定の時間に、TIC ペイン内でダブルクリックしてください。
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図 13-3 : TIC の例

XIC
XIC は、単一かつ離散した質量の値、あるいは一連の質量スペクトルスキャンにおけると口の質量
範囲をもとに作成された抽出イオンクロマトグラムです。これは、特定の質量（または質量範囲）の
作用を時間関数で示したものです。クロマトグラフペインに、イオン強度（または特定の範囲内に存
在する全イオンの合計強度）がプロットされます。

XIC の生成

XIC は単一期間、単一試験クロマトグラム、あるいはスペクトルからのみ生成できます。複数期間ま
たは複数実験データから XIC を作成する場合、X 軸の下の△をクリックしてデータを別のペインに
分けます。使用可能なアイコンの使い方については、表 13-5 を参照してください。

イオンを抽出して XIC を生成するには、クロマトグラムかスペクトルを使用するかによっていくつか
のメソッドがあります。クロマトグラムとスペクトルで使用できるメソッドの概要については、次の表を
参照してください。

表 13-4 : XIC 生成メソッドの概要

メソッド クロマトグラムで
使用

スペクトルで使用 抽出

選択範囲 × 〇 イオンをスペクトルで選択した範囲か
ら抽出します。
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表 13-4 : XIC 生成メソッドの概要 (続き)

メソッド クロマトグラムで
使用

スペクトルで使用 抽出

大 × 〇 イオンを、選択した範囲内の 大ピー
クを用いて、スペクトルで選択した範
囲から抽出します。このオプションに
より、選択したスペクトルの範囲から
の 大質量を用いて XIC が生成され
ます。

ベースピーク質量 〇 〇 ベースピーククロマトグラム（BPC）で
のみ使用できます。Use Base Peak
Masses コマンドを用いて、質量ごと
に異なる色が付いたトレースで表示さ
れる XIC 内のイオンの結果を抽出し
ます。選択に複数のピークが含まれる
場合、結果として生じる XIC は各質
量に 1 種の色が付いたトレースと同じ
数になります。

特定の質量 〇 〇 スペクトルまたはクロマトグラムのい
ずれかの種類からイオンを抽出しま
す。スタートおよびストップ質量を 10
まで選択し、それに対する XIC を生
成します。

選択範囲を使用して XIC を生成

1. スペクトルを含むデータファイルを開きます。

2. 範囲の開始位置でマウスの左ボタンを押し、カーソルを範囲の終了位置までドラッグして、マウ
スの左ボタンを放して、範囲を選択します。
選択範囲は青色で表示されます。

3. Explore > Extract Ions > Use Range. をクリックします。
選択した XIC がスペクトルペイン下のペインで開きます。ペイン上部の実験情報には、秒毎に
カウントされた質量範囲と質量強度が示されます。

大ピークを使用して XIC を生成

1. スペクトルを含むデータファイルを開きます。

2. スペクトル内範囲を選択します。
選択範囲は青色で表示されます。

3. Explore > Extract Ions > Use Maximum. をクリックします。
選択した 大ピークの XIC が、スペクトルペインの下に開きます。ペイン上部の実験情報に
は、秒毎にカウントされた質量範囲と質量強度が示されます。
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ベースピークの質量を使用して XIC を生成

1. スペクトルを含むデータファイルを開きます。

2. BPC で、イオンを抽出するためのピークを選択します。
選択範囲は青色で表示されます。

3. Explore > Extract Ions > Use Base Peak Masses. をクリックします。
指定した選択範囲の XIC が、スペクトルペインの下に開きます。ペイン上部の実験情報は、毎
秒カウント数で質量範囲と 大強度を示します。

質量を選択してイオンを抽出

1. スペクトルまたはクロマトグラムを開きます。

2. Explore > Extract Ions > Use Dialog.

図 13-4 : Extract Ions ダイアログ

3. 作成する各 XIC の値を入力します。

• Start フィールドで、質量範囲の開始値（低い方の値）を入力します。

• Stop フィールドで、質量範囲の停止値（高い方の値）を入力します。

注: 停止値が入力されていない場合は、開始値で範囲を規定します。

4. OK をクリックします。
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選択した XIC がクロマトグラムペインの下に開きます。ペイン上部の実験情報は、質量および
秒あたりカウントで示される 大強度が含まれます。

BPC
BPC は、各スキャンにおける 高強度イオンの強度がスキャン数または保持時間として示されま
す。これは、TIC のノイズの量があまりに多いために大きなオフセットが存在し、クロマトグラムのピ
ークを区別するのが困難な場合に便利です。また、共溶出成分を区別するのにも役立ちます。BPC
は単一期間の単一実験データのみから生成されます。

グラフでは 2 色が用いられ、ベースピークの質量の変化が変化するたびに色が切り替わります。色
の変化は、データに対してスクロールまたはズーム操作を実行した際にも維持されます。グラフで使
用する色を選択する方法については、ヘルプを参照してください。

BPC の生成

BPC は単一期間および単一実験のデータのみから生成されます。

1. データファイルを開きます。

2. TIC 内の領域を選択します。
選択範囲は青色で表示されます。

3. Explore > Show > Show Base Peak Chromatogram. をクリックします。
選択範囲は Start Time および End Time フィールドに表示されます。

図 13-5 : Base Peak Chromatogram オプション

4. Mass Tolerance フィールドに、ピーク取得に必要な質量範囲を示す値を入力します。
ソフトウェアは入力値の 2 倍値を使用してピークを求めます（±質量値）。
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5. Minimum Intensity フィールドに、アルゴリズムが無視するピークの強度を入力します。

6. Minimum Mass フィールドに、スキャン範囲の先頭の質量を入力します。

7. Maximum Mass フィールドに、スキャン範囲の終端の質量を入力します。

8. 開始および終了時間を設定するには、Use Limited Range チェックボックスをオンにし、次の
操作を行います。

• Start Time フィールドに、実験の対象範囲を開始する時刻を入力します。

• End Time フィールドに、実験の対象範囲を終了する時刻を入力します。

9. OK をクリックします。
BPC が新しいペインに生成されます。

しきい値の調整

しきい値は、グラフ上の X 軸に平行にひかれた目視不可の線で、ソフトウェアがスペクトルにピーク
を含まない下限です。この線には、Y 軸の左に青の△で示されたハンドルがあります。青の△をクリ
ックしてしきい値を示す点線を表示します。しきい値は上げたり下げたりできますが、しきい値を変更
してもデータは変更されません。しきい値より下の領域にあるピークについては、ソフトウェア上に表
示されません。

1. データファイルを開きます。

2. 次のいずれかの操作を行います。

• しきい値を上げるには、Y 軸で青の△を上にドラッグします。

• しきい値を下げるには、青の△を下にドラッグします。

• Explore > Set Threshold. をクリックします。Threshold Options ダイアログが開いたら、
しきい値を入力して OK をクリックします。

• Explore > Threshold. をクリックします。

グラフが更新され、新しく設定したしきい値が表示されます。ピークラベルおよびピークリストも
更新されます。

ヒント! 現在のしきい値を表示するには、しきい値ハンドル上にポインタを移動させます。

TWC の生成

TWC は使用頻度の低いクロマトグラムです。このクロマトグラムでは合計吸光度（mAU）が時間の
関数として示されます。TWC により、データセット全体を単一ペインに表示することができます。クロ
マトグラムで、時間に対してプロットされたスキャンに含まれる全イオンの吸光度の合計値で構成さ
れています。データに複数の実験結果が含まれている場合、すべての実験の合計を表す TWC の
下に、各実験の TWC を作成することができます。

TWC は X 軸の時間に対してプロットされた Y 軸上の全吸光度（mAU）を示します。使用可能なア
イコンの使い方については、表 13-5 を参照してください。

1. DAD スペクトルを含むデータファイルを開きます。
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2. Explore > Show > Show DAD TWC. をクリックします。
TWC は DAD スペクトル下部のペインに表示されます。

ヒント! DAD スペクトルを含むペイン内で右クリックし、Show DAD TWC をクリックします。

XWC の生成

XWC は単一の波長の強度値を採用することで、あるいは（複数の波長が含まれる）範囲が持つ吸
光度を合計することで作成される波長クロマトグラムです。 大 3 範囲を、DAD スペクトルから抽
出して XWC を生成できます。使用可能なアイコンの使い方については、表 13-5 を参照してくださ
い。

1. DAD スペクトルを含むデータファイルを開きます。

2. ペインの任意の場所を右クリックし、Extract Wavelengths をクリックします。

図 13-6 : Extract Wavelengths ダイアログ

3. Start と Stop の値を入力します。

4. OK をクリックします。
XWC は DAD スペクトル下部のペインに表示されます。

Show DAD Data
DAD データは質量分析装置のデータのように、クロマトグラムまたはスペクトル形式で見ることがで
きます。DAD スペクトルは単一の時点にて、あるいはトータル波長クロマトグラム（TWC）として一
定の時間範囲にわたって表示できます。

1. DAD で取得されたデータを含むデータファイルを開きます。
TIC に相似の TWC は、TIC 下部のペインで開きます。

2. TWC ペインでは、ポイントをクリックしてある時間のシングルポイントを選ぶか、スペクトルのエ
リアをハイライトして時間範囲を選ぶことができます。

3. Explore > Show > Show DAD Spectrum.
DAD スペクトルは TWC 下部のペインで開きます。Y 軸は吸光度を示し、X 軸は波長を示しま
す。

ヒント! TWC のペインが閉じた場合には、TWC の任意のポイントをクリックして再度開いてくだ
さい。Explore > Show > Show DAD TWC.
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ACD データの表示

アナログからデジタルへのコンバータ（ADC）は、セカンダリ検知器（たとえば、ADC カードを通した
UV 検知器）から取得され、質量分析装置データの比較に有益です。ADC データを利用するために
は、ADC データと質量分析装置のデータを同時に取得する必要があります。そして、両方のデータ
が同じファイルに保存されます。

1. ADC データが保存されているプロジェクトフォルダを選択していることを確認します。たとえば、
Example フォルダをクリックします。

2. Navigation バーの Explore の下にある Open Data File をダブルクリックします。

Select Sample ダイアログが開きます。

3. Data Files フィールドで、サブデータフォルダをダブルクリックし（該当する場合）、開くデータフ
ァイルをクリックします。たとえば、Example フォルダで Devices をダブルクリックし、

Adc16chan.wiff をクリックします。

4. Samples リストでサンプルを選択してから、OK をクリックします。

5. Explore > Show > Show ADC Data をクリックします。

図 13-7 : Select ADC Channel ダイアログ

6. Channel リストからチャネルを選択した後、OK をクリックします。

アクティブなペインの下に、ADC データが新たなペインに表示されます。

グラフィックデータ処理
グラフィックデータはさまざまな方法で処理が可能です。このセクションには、 も一般的に使用され
るツールの幾つかの使用法についての情報と手順が示されています。

ユーザーはグラフの一部を拡大して特定のピークまたはスペクトルとクロマトグラムの両方において
より詳細な領域を閲覧できます。ユーザーはさらに小さいピークを表示するために繰り返し拡大する
こともできます。

データの管理

次のメニューオプションまたはアイコンを使用してグラフ内のデータを管理します。
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表 13-5 : グラフのオプション

実行する作業 このメニューオプションを使用します あるいはこのアイコ
ンをクリックします

グラフを新しいウィン
ドウにコピーします

コピーするグラフを選択します。Explore >
Duplicate Data > In New Window. をクリックし
ます。

グラフの元のサイズ
への調整

グラフを選択します。Explore > Home Graph. を
クリックします。

ペインの移動 • グラフを選択します。Window > Move Pane.
をクリックします。

• ペインまたはウィンドウを選択し、新しい位置へ
ドラッグします。この位置は同じウィンドウ内か別
のウィンドウ内となります。

カーソルがアクティブなウィンドウまたはペインの境
界上にある場合、4 方向を示す矢印が表示されま
す。

• ペインが目標ペインの上部あるいは下部にある
場合、ペインはその各ペインの上あるいは下へ
移動します。

• ペインが目標ペインの左あるいは右にある場
合、目標ペインはそれぞれペインの左あるいは
右へ移動します。

• ペインが他の位置にある場合、ペインは目標行
へ移動します。ペインが移動する際、ペインのド
ロップシャドウが新しい位置を示します。

ペインのリンク a. 2 つのグラフが開いている場合、1 つをクリック
してペインを有効にします。

b. Explore > Link をクリックしてもう 1 つのペイ
ンをクリックします。

リンクを解除 ペインの 1 つを閉じます。Explore > Remove
Link. をクリックします。

ペインの削除 グラフを選択します。Window > Delete Pane. を
クリックします。

ペインの固定 グラフを選択します。Window > Lock Panes. をク
リックします。

ペインの非表示 グラフを選択します。Window > Hide Pane. をクリ
ックします。
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表 13-5 : グラフのオプション (続き)

実行する作業 このメニューオプションを使用します あるいはこのアイコ
ンをクリックします

ペインの 大化 グラフを選択します。Window > Maximize Pane.
をクリックします。

Tile panes グラフを選択します。Window > Tile all Panes. を
クリックします。

グラフのズームイン

グラフの一部を拡大して特定のピークや、スペクトルおよびクロマトグラム双方の特定の領域を詳細
に閲覧できます。小さなピークを表示するには、拡大を繰り返します。

Y 軸をズームイン

1. Y 軸の左側のポインタを拡大させる領域のいずれかの側に動かします。その後、マウスの左ボ
タンを押した状態で開始点から垂直方向にドラッグします。
Y 軸に沿って、新しいスケールを表すボックスが表示されます。

注: ベースラインをズームする場合は注意してください。ズームの可能領域を超えてしまうと、
ズームインボックスが閉じられます。

2. 新しいスケール上でグラフを描く場合は、マウスボタンを放してください。

ヒント! グラフの Y 軸を元の縮尺に戻すには、どちらかの軸をダブルクリックします。グラフ全体
を標準のスケールに戻すには、Explore > Home Graph. をクリックしてください。

X 軸をズームイン

1. X 軸の下部においたポインタを拡大させる領域のいずれかの側へ動かします。その後、マウス
の左ボタンを押した状態で開始点から水平方向にドラッグします。

2. 新しいスケール上でグラフを描く場合は、マウスボタンを放してください。

ヒント! グラフの X 軸を元の縮尺に戻すには、X 軸をダブルクリックします。グラフ全体を標準
のスケールに戻すには、Explore > Home Graph. をクリックしてください。

グラフのラベリング

グラフとクロマトグラムのラベル用に事前設定されたスタイルはカスタマイズすることができます。ピ
ークと軸のラベルに使用するフォントおよびトレースに使用する色を選択します。軸ラベル、ラベル
の種類、およびピークの精度を追加します。

グラフへのキャプションの追加

キャプションを用いて、グラフ上の目的のピークや重要なポイントにラベルを付けることができます。
ピークのそばに配置したキャプションは、ピークがズームイン、ズームアウトされた場合にもピークの
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もとに留まります。ユーザーがデータファイル内のサンプル間を移動する場合でも、キャプションは
元のサンプルのもとにあります。キャプションはテキスト 1 行で 大 128 文字使用できます。

1. スペクトル上で右クリックし、Add Caption をクリックします。

Add Caption ダイアログが開きます。

2. Caption ボックス内に、テキストを入力します。

3. キャプションのサイズとスタイルを変更するには、Font をクリックします。

4. キャプションを配置するには OK をクリックします。

ヒント! キャプションの位置を変更する場合は、キャプションを別の位置にドラッグします。グラフ
がズームイン/ズームアウトされても、キャプションは X 軸と Y 軸に対して同じ位置に維持され
ます。キャプションを編集または削除するには、キャプションを右クリックし、該当するコマンドを
クリックします。

グラフへのテキストの追加

テキストを用いて、複数行にわたる情報をグラフに追加します。特定のピークに付けられたキャプシ
ョンはグラフのズームに併せて移動しますが、テキストラベルはグラフがユーザーによってズームさ
れても元の位置に維持されます。テキストラベルは、データファイル内のサンプル間を移動した場
合、元のサンプルから離れます。

1. グラフ上で右クリックし、Add User Text をクリックします。

Add User Text ダイアログが開きます。

2. User Text フィールドにテキストを入力します。

3. テキストを中央ぞろえにするには、Center Text チェックボックスを選択します。

4. キャプションのサイズとスタイルを変更するには、Font をクリックします。

5. テキストを挿入するには OK をクリックします。

ヒント! テキストの位置を変更する場合は、テキストを別の位置にドラッグします。テキストを編
集または削除するには、テキストを右クリックし、該当するコマンドを選択します。

スペクトルまたはクロマトグラムの重ね表示および集約

2 セット以上のデータを視覚的に比較するには、同様の方法を用いて作成済みのグラフを重ね表示
します。スペクトルはそれぞれ、そのトレースの色によって識別されます。フルスキャンデータの場
合、ユーザーは数種のサンプルスペクトル間の差異を視覚化することができます。

2 つ以上のグラフが重ね表示されたら、グラフを集約して新しいトレースを取得します。新たなトレー
ス上の各ポイントはグラフのポイントの合計です。類似するデータの種類のいくつかの重ね表示を
集約することで、後に続く処理操作を容易かつ迅速に実施することができます。例えば、XIC 数種
の重ね表示および集約を行ってから、集約された重ね表示をスムーズにしてノイズを取り除きます。

重ね表示を集約することは、TIC の生成に類似しており、重ね表示対象のグラフを選択できる利点
があります。例えば、ユーザーが 10 種の実験を検討している場合、TIC では 10 種の実験をすべ
て合算することになります。重ね表示を集約する場合、ユーザーは 10 種の重ね表示されたグラフ
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のうちの 9 種のみを合算する選択ができます。これは、実験のうちの 1 回で収集されたデータがノ
イズのみであった場合に有用です。

グラフを重ねて表示する

類似した方法で作成されたグラフを重ねて表示（オーバーレイ）することで、2 セット以上のデータを
視覚的に比較できます。スペクトルはそれぞれ、そのトレースの色によって識別されます。フルスキ
ャンデータの場合、これによって複数のサンプルスペクトル間の差異を視覚化することができます。

複数のペインが選択された場合、それぞれの XIC が個々で開きます。

ヒント! 同一ペインに 3 つ以下のグラフを重ね表示するには、ペインで Ctrl を右クリックしてから、
Appearance Options をクリックします。Appearance Options ダイアログの複数のグラフオプショ
ンタブで、Spectrum および Chromatogram の Overlay Multiple Panes フィールドで Yes を選
択します。

1. 重ねて表示する 初のペインを選択します。

2. Explore > Overlay をクリックします。

3. 2 つ目のペインをクリックします。

グラフが重ねられ、2 つのトレースが異なる色で表示されます。

ヒント! 重ね表示されたグラフの色分けリストを表示するには、ペインのタイトルバーを右クリッ
クします。

重ね表示されたグラフ間の表示の切り替え

1. 重ね表示されたグラフを含むペインを選択します。

2. Explore > Cycle Overlays をクリックします。

表示が変わり、次の順番のグラフが 前面に表示されます。

Sum Overlays
1. 合算するグラフを重ね表示します。

2. Explore > Sum Overlays をクリックします。

重ね表示されたグラフは合算されます。

表 13-6 : Explore ツールバーのクイックリファレンス：グラフの重ね表示

アイコン 名称 機能

Home Graph（規定グラフ） クリックすると、グラフが標準のスケールに戻り
ます。

Overlay クリックするとグラフが重ね表示されます。

Cycle Overlays クリックすると、重ね表示されたグラフ間で表示
が切り替わります。
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表 13-6 : Explore ツールバーのクイックリファレンス：グラフの重ね表示 (続き)

アイコン 名称 機能

Sum Overlays クリックすると、グラフがひとつに統合されま
す。

バックグラウンド減算の実行
バックグラウンド減算はスペクトル中のノイズ量を減らすためのもので、ピークを含む範囲のノイズ
が含まれる 2 つの範囲のうちいずれか 1 つを減算します。対象の範囲を個別に移動するか、ロック
してグラフ内の 1 つのエンティティとして移動します。デフォルトでは Locked Background
Subtraction に設定されています。

Background Subtract：バックグラウンド減算を用いて目的のピークを分離します。ピークからの
大 2 つの選択範囲を強調表示してから減算します。対象範囲をロックした後、グラフ内で移動さ

せて、ピークの分離を 適化するか、別のピークを分離します。

スペクトルに対するバックグラウンド減算の実行

1. データファイルを開きます。

2. バックグラウンド範囲を選択します。
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図 13-8 : バックグラウンド範囲の選択

3. Shift キーを押しながら、もう一方のバックグラウンド範囲を選択します。

4. 減算範囲を設定するには、Explore > Background Subtract > Set Subtract Range をクリ
ックします。

5. 関心のあるピークを選択します。

6. Explore > Background Subtract > Perform Background Subtract をクリックします。

バックグラウンドがピークから除去され、新しいスペクトルが生成されます。

7. 別のピークを分離するには、クロマトグラム内でロック範囲をドラッグし、バックグラウンド減算を
繰り返します。

注: バックグラウンド減算範囲を選択解除するには、Explore > Background Subtract >
Clear Subtract Range をクリックします。

8. バックグラウンドが減算されたスペクトルを処理済みデータファイルとして保存するには、File >
Save をクリックします。

範囲のロック解除

選択した減算範囲はロック済みに設定されます。

• Explore > Background Subtract > Subtract Range Locked をクリックします。
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範囲はロック解除され、それぞれを別々に移動することができます。

表 13-7 : Explore ツールバーのクイックリファレンス：バックグラウンド減算

アイコン 名称 機能

Perform Background
Subtract

クリックすると、バックグラウンド範囲が選択され
た後、バックグラウンド減算が実行されます。

Subtract Range Locked クリックすると、選択されたバックグラウンド範囲
がロックされます。各範囲を個別に移動するに
は、バックグラウンド範囲をロック解除します。

アルゴリズムのスムージング
データセットをスムージングすると、ノイズにより引き起こされる可能性の高い局所的変化を取り除く
ことができます。いくつかのスムージングサイクルをデータに適用することができますが、ユーザー
は直近のスムーズのみを取り消すことができます。スムージングは MI/MRM スペクトルでは利用で
きません。デフォルトのスムージングとして、スムーズアルゴリズムあるいはガウシアンスムーズア
ルゴリズムを選択します。

スムーズアルゴリズム

このアルゴリズムをデータのスムージングに使用すると、「現在のポイント」、「前のポイント」、「次の
ポイント」の 3 つのデータポイントのポイント加重値が設定されます。スムーズアルゴリズムでは、割
り当てられた加重値によってデータポイントが乗算され、これらの値が合計された後、合計値がポイ
ント加重値の合計で除算されます。ガウシアンスムーズよりも穏やかなスムージングですが、ノイズ
が非常に多いデータの場合は処理に時間がかかります。

ガウシアンスムーズアルゴリズム

ガウシアンスムーズでは、各データポイントが、その両側に存在する複数のデータポイントの加重平
均に置き換えれます。新しいデータポイントごとの加重は、ガウス曲線にもとづいて算出されます。
スムーズアルゴリズムよりも荒いスムージングですが、ノイズが非常に多いデータに対して有効で
す。

ガウシアンスムーズメソッドの使用時には次の 2 つの値を設定します。

Gaussian filter width（ポイント間の 小距離の%）：この値は、隣接ポイントの加重を算出する際
に用いる値を示しています。この幅は、スキャンにおける 2 つのポイント間の距離の割合として述べ
られます。プリセット幅である 100%であれば、データポイント間の距離が可能な限り広く用いられた
分布が示されます。

Limit of Gaussian filter（ポイント間の 小距離の数）：この値はガウス曲線の限界に相当してお
り、ポイント間の距離の倍数として示されます。例えばプリセット値である 10 を用いて生成されたガ
ウス曲線では、中央の両側のデータポイント幅の数が 10 を超えた時点で切り取られます。
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データのスムージング
Analyst MD ソフトウェアスムーズ法またはガウシアンスムーズ法が選択できます。

ヒント! スムージングを取り消すには、Edit > Undo をクリックします。本ソフトウェアでは 1 レベル
の取り消しに対応しています。

スムーズアルゴリズムを用いたデータのスムージング

ヒント! スムージングを取り消すには、Edit > Undo をクリックします。本ソフトウェアでは 1 レベル
の取り消しに対応しています。

1. クロマトグラムまたはスペクトルを含むペインを選択します。

2. Explore > Smooth をクリックします。
Smoothing Options ダイアログが開きます。

図 13-9 : Smoothing Options ダイアログ

3. Previous Point Weight フィールドには、過去のデータポイントに適用させるための加重ファ
クターを入力します。

4. Current Point Weight フィールドには、中央データポイントに適用させるための加重ファクタ
ーを入力します。

5. Next Point Weight フィールドには、次のデータポイントに適用させるための加重ファクターを
入力します。

6. OK をクリックします。
データセットはスムージングされ、ペインの中の 新データが置き換えられます。

ガウシアンスムーズを用いたデータのスムージング

1. クロマトグラムまたはスペクトルを含むペインを選択します。

2. Explore > Gaussian Smooth をクリックします。

Gaussian smooth options ダイアログが表示されます。
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図 13-10 : Gaussian Smooth Options ダイアログ

3. Gaussian filter width フィールドに、隣接ポイントの加重を検出するために用いる幅を、2 つ
のポイント間の距離の割合として入力します。

4. Limit of gaussian filter フィールドに、ガウス曲線の限界を入力します。ポイント間の距離の
倍数として示されます。

5. データをスムージングするには、OK をクリックします。

データセットはスムージングされ、ペインの中の 新データが置き換えられます。

表 13-8 : Explore ツールバーのクイックリファレンス：データのスムージング

アイコン 名称 機能

Smooth クリックすると、スムーズアルゴリズムを用いて
データをスムージングできます。

Gaussian smooth クリックすると、ガウシアンスムーズを用いてデ
ータをスムージングできます。

データのセントロイド
セントロイドは、ピークの分布値を、そのピークを表す m/z と強度の単一の値に変換します。プロフ
ァイルモードで収集したデータをセントロイドすることで、データが簡素化され、ファイルサイズが縮
小します。またピークの割り当てがより正確になり、データ量も減少しますが、ピークの形状に関す
る情報は取り除かれます。

セントロイドアルゴリズムでは、強度を加重した平均値を用いてピークが単一の値に変換され、ピー
クの重心が算出されます。アルゴリズムの出力は、表 13-9 に示すようなパラメータを持つピークの
リストです。

表 13-9 : ピークパラメータ

パラメータ 定義

セントロイド値 セントロイドデータの値です（質量単位または時間単位）。

強度 各ピークの強度（cps）です。
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表 13-9 : ピークパラメータ (続き)

パラメータ 定義

幅 セントロイドピークの幅（amu）です。

データはライブラリに追加された時点または検索が実行された時点で、自動的にセントロイドされま
す。

1. スペクトルが含まれるペインを選択します。

データをセントロイドすると、既存のグラフの外観が変化します。結果を元のデータと比較する
には、セントロイドする前にグラフをコピーしておいてください。

2. Explore > Centroid をクリックします。

データはセントロイドされています。

図 13-11 : 分析試料のセントロイド位置

アイコン 名称 機能

Centroid クリックすると、データがセント
ロイドされます。
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処理済みのデータファイルの保存およびオープン
ユーザーは特定のレイアウトやキャプションなどの Explore モードでのみ再オープンできる処理デ
ータを保管することができます。これらのファイルには履歴情報も含まれており、Explore の有効ペ
インのデータのみを含む点を除けば、データファイルと同じです。このようなファイルには pdt 拡張
子がついており、現在のプロジェクト用の Data フォルダに格納されます。

処理済みのデータファイルを保存する

1. 保存したいデータのペインを選択します。

2. File > Save Processed Data File をクリックします。

3. File name フィールドに名前を入力します。

4. Save をクリックします。

処理済みデータファイルを開く

1. Explore モードで、File > Open Processed Data File をクリックします。

Load Processed Data File ダイアログが開きます。

2. ファイルを選択した後、Open をクリックします。

等高線図での作業
等高線図とは、完全データセットとなる色分けプロットであり、プロットの第三次元が色で示されてい
ます。TIC の等高線図では、X 軸は保持時間またはスキャン番号を、Y 軸は質量を、そして色はそ
の時点でのデータの強度を表します。DAD データ用の TWC の等高線図では、X 軸は保持時間ま
たはスキャン番号を、Y 軸は波長を、そして色は吸光度を表します。等高線図は測定後ツールであ
るため、リアルタイムでのスキャン測定では機能しません。

注: 等高線図は MI または MRM スキャンには対応していませんが、DAD スキャンには対応してい
ます。

色は等高線図の第三軸に付けられており、強度または吸光度を表します。等高線図の上のカラー
バーにあるコントロール用三角形を使用して、等高線図の強度または吸光度を高値/低値に変更し
ます。Contour Plot ペインの上部にあるパーセンテージパラメータは、低/高スライダーの値を示し
ています。実際の値は、選択した領域内の 大強度または 大吸光度の割合（パーセンテージ）に
もとづいたものとなります。この値は、Contour Plot ペインの右上に表示されます。

図 13-12 に示されているコントロールにより、等高線図の色が変化します。
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図 13-12 : 等高線図の色をコントロールするボタン

等高線図グラフの色は、コントラストを際立たせ、データ仕様が要件に合わせて表示されるよう指定
します。例えば、強度/波長を設定し、Below Low Data および Above High Data の値に色を付け
ることで、等高線図のバックグラウンドノイズを除去できます。

スライダーコントロールを動かすと、Below Low Data ボタンと Above High Data ボタンがカラーバ
ー上で拡大/縮小します。等高線図の色を変更すると、以降の全グラフにおいて新しい色がプリセッ
ト値となります。

等高線図の表示

ユーザーは測定後にのみ、等高線図を TIC、XIC、TWC、または XWC グラフで表示することがで
きます。TIC と XIC は wiff データファイルすべてで利用可能です。TWC と XWC は DAD によって
収集されたデータに対してのみ利用可能です。

1. Explore モードでは、データファイルを TIC、XIC、TWC、または XWC グラフとして開くことが
できます。

2. 範囲を強調表示して等高線図内に表示します。選択しない場合、全範囲が表示されます。

3. Explore > Show > Show Contour Plot をクリックします。
選択された領域の等高線図は別のペインに表示されます。

等高線図の領域の選択

特定の選択領域にズームインするか、またはその選択領域の該当質量スペクトルを表示すること
ができます。

次のいずれかの操作を行います。

• ボックス内で標準領域を選択するには、等高線図内でポインタをドラッグし、領域の周辺にボック
スを作成します。

• 垂直に選択するには、Ctrl キーを押しながらポインタを垂直にドラッグします。

• 水平に選択するには、スペースバーを押しながらポインタを水平にドラッグします。

等高線図内の強度および吸光度の設定

次のいずれかの操作を行います。

• 等高線図内の低強度/低吸光度の値を設定するには、等高線図の上にある色付きのバーの左
向きの三角形スライダーを必要な位置にドラッグします。

使用説明－データの分析と探索

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
171/293



等高線図は設定値より下の値の色に自動調節し、範囲を逸脱していることを示します。

• 等高線図内の高強度/高吸光度の値を設定するには、等高線図の上にある色付きのバーの右
向きの三角形スライダーを必要な位置にドラッグします。

等高線図は設定値より上の値の色に自動調節し、範囲を逸脱していることを示します。

等高線図の色の変更

1. Contour Plot ペインで、色ボタンのうちの 1 つをクリックします。
Color ダイアログが開きます。

2. 色をクリックしてから OK をクリックします。

グラフの色が変わり、変更が反映されます。

ヒント! Define Custom Colors パレットを用いて、等高線図内の色をカスタマイズします。

フラグメント解釈
フラグメント解釈ツールは、ユーザーによる MS/MS データの解釈に役立ちます。フラグメント解釈
ツールでは、分子構造に含まれる単結合/非環状結合の開裂をもとに、理論的フラグメント質量のリ
ストが生成されます。分子構造は他社製の描画プログラムで作成した後、mol ファイルとして保存す
ることができます。これにより、理論的リストを現在の質量スペクトルのピークと一致させることがで
きます。フラグメント解釈ツールでは、論理的フラグメントが Fragment リストに表示され、フラグメン
ト質量が質量スペクトルのピークと比較されます。強度しきい値を上回り、かつユーザーが定義した
フラグメント質量の質量許容値（ 大 2 Da）以内のピークのみが一致していると判断され、
Fragment リスト上で太字で表示されます。

注: フラグメント解釈ツールは、次のスキャン種類とは併用できません。

• プリカーサーイオン

• ニュートラルロス

• Q1 多重イオン

• Q3 多重イオン

• 複数反応モニタリング（MRM）

フラグメント解釈ツールでの作業

スペクトルペインが複数表示されている場合、フラグメント解釈ツールは有効なスペクトルに接続し
ます。データファイルにサンプルが複数ある場合、フラグメント解釈ツールは有効なスペクトルに接
続します。

このツールにより、単結合および非環状結合の開裂フラグメントが、mol ファイルをもとに自動的に
算出されます。フラグメント解釈ツールがスペクトルに接続されると、太字の理論的フラグメントで、
指定された質量許容値および強度閾値内のスペクトル中で一致するピークが示されます。
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分子構造内の単結合および非環状結合が選択されている場合、フラグメント解釈ツールは結合が
開裂される際に作成される 2 つのフラグメントを強調表示した後、接続されたスペクトル内で一致す
るピークを示します。

フラグメント解釈ツールのスペクトルへの接続

フラグメント解釈ツールの起動時にスペクトルが開いている場合、アクティブパネルは開いているス
ペクトルに自動的にリンクされます。

1. Explore > Show > Show Fragment Interpretation Tool をクリックします。

2. Fragment Interpretation ペインの右下にある接続ボタンをクリックします。
ポインタが接続ツールに変化します。

3. フラグメント解釈ツールの接続先となるスペクトルグラフをクリックします。

左下の接続済みグラフインジケータには、Fragment Interpretation ペインに接続されたグラフ
の名前が示されます。グラフまたはフラグメント解釈ツールのいずれかが閉じられると、接続は
解除されます。接続中の wiff ファイルに複数のサンプルが含まれている場合、ユーザーがサ
ンプル間をスクロールするのに併せて、Fragment Interpretation ペインが自動的に更新され
ます。

ピークとのフラグメントの一致

1. Explore > Show > Show Fragment Interpretation Tool をクリックします。

2. Fragment Interpretation ペイン内の mol ファイルで、Fragment List 内で太字表示されるセ
ルを選択します。

スペクトルには、ソフトウェアにより、Options タブ下で選択された色のスペクトルの一致するピ
ークが強調表示されます。分子構造では、結合が強調表示されます。

複数一致するフラグメントがあるカラムがクリックされた場合、そのモノアイソトピック質量に近
いスペクトルのピークが、Options タブで指定した色の質量スペクトル内で強調表示されます。

分子構造内の結合の選択

1. Explore > Show > Show Fragment Interpretation Tool をクリックします。

2. Fragment Interpretation ペインで mol ファイルを開いたまま、分子構造内の単結合および非
環状結合をクリックします。

結果として生じる 2 つのフラグメントは、フラグメントリストに強調表示されます。2 つのフラグメ
ントの質量が結合の片側に示されます。

スペクトルが接続される場合、Fragment Interpretation ツールはグラフ内の一致するピークを
すべて表示します。リスト内のフラグメントが選択されており、フラグメントがピークと一致する場
合、Fragment Interpretation ウィンドウで該当するピークがズームインされます。

アイソトープの表示

フラグメント解釈ツールでは、フラグメントリスト内のフラグメントピークマッチングの理論的アイソトー
プ分布を表示できます。

1. Explore > Show > Show Fragment Interpretation Tool をクリックします。
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2. Fragment Interpretation ペインで Options タブをクリックします。

3. Show Isotopes チェックボックスをクリックします。

4. Apply をクリックします。

5. Fragment List で、ピークと一致するフラグメントを選択します。
一致ピークのアイソトープ分布がスペクトル内に表示されます。

フラグメントの数式の差異の表示

2 つの関連する仮説のフラグメント間の数式とモノアイソトピック質量の差異を、ソフトウェアで表示
することができます。ピークを 2 つ選択すると、その数式の差異が示されます。数式およびモノアイ
ソトピック質量の差異が表示されるのは、2 つのフラグメントが選択されている場合、あるいは 2 つ
の単結合、非環状結合が選択されている場合です。

スペクトル内の数式の相違の表示

1. フラグメントピークをクリックします。

2. Shift を押してから、別のフラグメントピークをクリックします。

数式の違いがフラグメントリストのフラグメントと同一の場合、フラグメントがリスト内で強調表示
されます。そうでない場合、ピークにおける一致フラグメント間の化学式の差異がメッセージボ
ックスに示されます。

フラグメントリスト内の数式の相違の表示

1. 1 つのフラグメントの行番号をクリックします。

2. Shift を押してから、別のフラグメントピークをクリックします。

フラグメントが関連する場合、数式およびモノアイソトピック質量差異がメッセージボックスに表
示されます。

分子構造内の化学式の差異の表示

1. 単結合および非環状結合をクリックします。（2 つの強調表示されたフラグメントの）デフォルト
のフラグメントが選択されます。開裂結合の他方のフラグメントを選択するには、Ctrl キーを押
しながら結合をクリックします。

2. 2 つめの非環状結合を選択します。デフォルトのフラグメントを選択するには、Shift キーを押し
ながら結合をクリックします。開裂結合の他方のフラグメントを選択するには、Ctrl+Shift キー
を押しながら結合をクリックします。

フラグメント解釈では、ステップ 1 で選択したフラグメントとステップ 2 で選択したフラグメントが
関連している場合、これらの化学式/モノアイソトピック質量の差異が算出されます。化学式/モ
ノアイソトピック質量の差異がメッセージボックスに表示されます。

ライブラリデータベース
ライブラリ検索機能では、未知のスペクトルが（ライブラリデータベースに含まれる）既知の MS スペ
クトルと比較され、一致している可能性のある物質のリストが生成されます。

Library Search を用いて次の操作を行います。
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• ライブラリのコンテンツを未知のスペクトルと比較します。

• 記録をライブラリに追加します。

• 既存の記録を編集します。

ライブラリデータは次の場所に保存できます。

• ローカルデータベース上の MS Access

• MS SQL Server

ライブラリ検索機能を使用する前に、ライブラリデータが保存されている場所を確認し、コンピュータ
をその場所に接続します。ライブラリデータベースはコンピュータでローカルに、またはネットワーク
を介してネットワーク上に保存できます。

既存のライブラリデータベース間での切り替え

ユーザーは、設定済みのエイリアスが割り当てられたあらゆるデータベースに接続できます。

1. Tools > Settings > Optimization Options をクリックします。
Optimization Options ダイアログが開きます。

2. Library Manager タブをクリックします。
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図 13-13 : Library Manager タブ

3. Available Libraries セクションで接続したいデータベースのエイリアスをクリックし、Connect
をクリックします。

4. 他のユーザーがデータベースにアクセスできるようにするには、Available to all users of
this machine チェックボックスを選択します。

5. OK をクリックします。
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ローカルライブラリデータベースとの接続

1. Tools > Settings > Optimization Options をクリックします。
Optimization Options ダイアログが開きます。

2. Library Manager タブをクリックします。

3. Available Libraries セクションの New をクリックします。

図 13-14 : Add Library ダイアログ

4. ライブラリ名を入力します。

5. Database Information セクションで MS Access (local)を選択します。

6. データベースの場所を入力します。
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7. Security Information セクションで、このデータベースにアクセスする際にユーザー名とパス
ワードが必要な場合は、ユーザー名とパスワードを入力します。

8. Save をクリックします。

サーバーライブラリデータベースへの接続

1. Tools > Settings > Optimization Options をクリックします。
Optimization Options ダイアログが開きます。

2. Library Manager タブをクリックします。

3. Available Libraries セクションの New をクリックします。

4. ライブラリ名を入力します。

5. Database Information セクションで MS SQL Server (server)を選択します。
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図 13-15 : Add Library ダイアログ

6. データベースサーバーの名前を入力します。

7. データベースの名前を入力します。

8. Security Information セクションの次のいずれかの操作を行います。

• このデータベースにアクセスする際に特定のユーザー名とパスワードが必要な場合は、ユ
ーザー名とパスワードを入力します。

• Windows セキュリティが用いられている場合は、Use Windows integrated security オ
プションを選択します。

9. Save をクリックします。
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ライブラリ記録での作業

ライブラリのコンテンツが制約なしで検索される場合、全記録がリストされます。ライブラリのコンテ
ンツが制約付きで検索される場合、指定された制約と一致する記録のみがリストされます。表示さ
れる記録の数は、選択された制約数に依存します。選択された制約が多ければ、リストされる記録
はほとんどなくなります。

全ライブラリレコードの表示

Explore > Library Search > List をクリックします。
Librarian ダイアログが開き、データベース内のレコードがすべて表示されます。

制約のあるライブラリ記録の検索

1. Explore > Library Search > List With Constraints をクリックします。

図 13-16 : List Constraints ダイアログ

2. Field Name リストで、制約にしたいフィールドを選択します。

3. Relation リストで、フィールド名に適用する関係（オペレータ）を選択します。

4. Value フィールドに、関係に基づくフィールド名の値を入力します。
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5. Conditions リストに選択した制約を追加するには、Add をクリックします。

6. 必要に応じて、Conditions リストに制約を追加し続けます。

7. Conditions リスト内の個別の制約を組み合わせることで、検索を効果的にする、より具体的
な条件を設定することができます。

• 制約をグループ化するには、制約を選択してから、Group をクリックします。

• グループ化された制約を分離するには、該当するグループをクリックし、Ungroup をクリッ
クします。

8. 制約間の関係を変更するには、関係をクリックしてから、And または Or をクリックします。

9. 特定の元素の一定の原子数を含む化合物を除外するには、Elements Included 表にある元
素を選択または入力した後、その元素の 小および 大数を入力します。

注: 元素記号は大文字と小文字を区別します。例えば、水素は H であり、h ではありません。
ナトリウムは Na であり、NA でも na でもありません。

10. ある元素を含む化合物を除外するには、Excluded 表に元素を選択および入力します。

11. 基準に適合する化合物を検索するには、List をクリックします。
制約すべてと一致する記録は Records 表に示されます。リストにある制約は保存されます。

ライブラリへの記録の追加

1. アクティブスペクトルを右クリックし、Add a Record をクリックします。

スペクトルは、セントロイドされていない場合には、自動的にセントロイドされます。

Add a Record ダイアログが開き、スペクトルのデータが表示されます。

2. Mass Spectral Information タブの Compound Name フィールドに名前を入力します。化
合物名の入力は必須です。化合物を識別するため、ライブラリ内で固有の名前を付ける必要
があります。

3. 他のフィールドを任意で編集します。これらのフィールドの多くは、スペクトルに関連したデータ
をもとに自動的に入力されます。

4. General Information タブで必要なフィールドの値を編集し、OK をクリックしてください。

類似したスペクトルの検索

ユーザーは有効なスペクトルと一致する（あるいは類似した）スペクトル（およびその関連化合物の
情報）をライブラリから検索することができます。検索は制約の有無にかかわらず実行できます。検
索が制約付きで行われる場合、基準すべてに一致する記録だけがリストされます。検索結果はラン
ク分けされてリスト表示されます。 初にリストされるのは有効なスペクトルに も適合するもので
す。リスト内のより低順位のエントリは適合性が低くなります。

選択される制約が多いほど、リストはより精度が高く、絞り込まれ、関連性の高いものがリスト表示
されます。制約がひと通り定義されると、編集されることがなければ、後続の検索すべてに適用され
ます。

しきい値を超えるピークのみが検索に用いられます。制約付き検索を選択する場合、ピークを有効
なスペクトルに追加または有効なスペクトルから削除することができます。例えば、ピークがバック
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グラウンドまたはノイズスパイクと考えられる場合、結果が正しくなくなるおそれがあるため、検索に
は使用されません。

制約なしの検索を実行する場合、対象のスペクトルデータに具体的に一致させるものが少なくてす
むため、ライブラリからの推奨スペクトルは大量にリストされます。

類似したスペクトルの検索

1. アクティブスペクトルを右クリックし、Search With Constraints をクリックします。
必要な場合、スペクトルは自動的にセントロイドされます。
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図 13-17 : Search Constraints ダイアログ

2. Maximum Number of Match フィールドに、検索結果として表示する化合物の 大数を入力
します。

3. Preselect Constraints セクションで、適用したい制約のチェックボックスを選択します。

4. 選択した制約ごとに、Preset Tolerance セクションで許容値を入力します。

5. 必要に応じて、Result Sorted by リストで記録のソートメソッドを選択します。

6. 必要に応じて、Comment Contains フィールドにテキストを入力します。
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7. 必要に応じて、Keyword Contains フィールドにテキストを入力します。

8. ピークの追加/削除によってピーク制約を適用するには、Peak Constraints をクリックします。
Peaks Included 表が開きます。

9. 検索対象としたいピークをリストに追加するには、Add をクリックし、空のセルに m/z と該当す
る強度を入力します。

10. 検索に含まれないようピークを削除するには、検索の対象外になるようにピークを選択して
Remove をクリックします。

11. Search をクリックして制約を保存し、検索を開始します。

Search Results への化合物の表示

複数のスペクトルが未知のスペクトルと一致した場合、その他のスペクトルを表示し、未知のスペク
トルと比較することもできます。

1. Search Results ダイアログの化合物リストで、表示したい化合物の行番号を選択します。

2. 既知の化合物のいずれかのスペクトルペインをクリックします。
選択した化合物のスペクトルが開きます。

ライブラリ検索に関するヒント

実行する作業 実行する操作

ライブラリ検索：条
件のグループ化
の方法

グループ化条件を選択し、Group をクリックします。この機能は、数式の括弧
のように機能します。

ライブラリ検索：制
約を使用しない検
索方法

アクティブスペクトルを右クリックし、Search Library をクリックします。
Search Results ダイアログが開きます。

テーブル特有クエ
リ：テーブル全体
を再表示するに
は

Results Table の任意の場所を右クリックして、Query > Show All をクリック
します。これでクエリを再適用または編集できます。

結果表データの分析に用いられたクエリはすべて検証することを推奨します。

ピーク積分：ピー
クのレビュー方法

すべてのピークをレビューするには、すべてのサンプルが Results Table にリ
ストされていることを確認します。

Peak Review ウィンドウには、結果表にリストされているピークしか表示され
ません。一部のサンプルが表に表示されない状態（クエリが適用されている場
合など）では、これらはピークレビューでも非表示となります。

結果表データの分析に用いられたクエリはすべて検証することを推奨します。

ピーク積分：バッ
チ内の 初のピ
ークの移動方法

Peak Review ペインの任意の場所を右クリックし、Show First Page をクリッ
クします。バッチ内の 後のピークに移動するには、Peak Review ペインの
いずれかの場所を右クリックし、Show Last Page をクリックします。
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実行する作業 実行する操作

キャリブレーション
カーブを調べる方
法

カーブのいずれかの場所を右クリックし、Active Plot をクリックして、 上部
にプロットしたいカーブを選択します。

サンプルの統計レ
ビュー：個々のピ
ークのレビュー方
法

Display the Data Set(s) チェックボックスをオンにして、Data Point カラム
で、ピークを表すデータポイントをダブルクリックします。選択されたピークの
Peak Review ウィンドウが開きます。

Results Table：
Results Table を
元の順序に戻す
には

Results Table を右クリックして、Sort > Sort By Index をクリックします。

測定メソッド：file
information ペイ
ンから測定メソッ
ドを作成する方法

File information ペインを右クリックし、Save Acquisition Method をクリック
します。
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使用説明－定量データの分析および処
理 14
本項では、Analyst MD ソフトウェアを用いて、定量データを分析および処理する方法を説明しま
す。MultiQuant MD ソフトウェアを使用してデータを処理することもできます。MultiQuant MD ソフト
ウェアを使用してデータを定量化することをお勧めします。MultiQuant MD ソフトウェアに付属のド
キュメントを参照してください。

Example フォルダにあるサンプルファイルを使用して、定量サンプルの選択法、事前に設定された

クエリの選択および表特定のクエリの作成法、取得データの分析法を学んでください。以下のトピッ
クに関する詳細は、上級ユーザーガイドを参照してください。

Results Table のデータの分析に用いたクエリはすべて検証することを推奨します。

• メトリックプロット

• Results Table のレイアウト

定量分析
定量分析はサンプル中の特定の物質の濃度を発見するために使用されます。未知のサンプルを分
析して標準サンプル、つまり既知の濃度の同じ物質を含むサンプルと比較することにより、ソフトウ
ェアは未知のサンプルの濃度を計算できます。このプロセスでは、標準のシグナル応答または応答
比を使用してキャリブレーションカーブを作成し、未知のサンプルの濃度を計算します。すべてのサ
ンプルの算出濃度が結果テーブルに追加されます。

定量分析は、 も一般的には、複数反応モニタリング（MRM）スキャンを使用して実行されます。
MRM スキャンでは、プレカーサーイオンと特徴的なプロダクトイオンを使用して、分析試料に非常
に特異的な MRM トランジションを定義します。液体クロマトグラフィー内の分析試料の保持時間と
関連する MRM トランジションによって、定量に必要な特異性がもたらされます。

定量化は、検証済みの MRM LC-MS/MS 測定メソッドを使用し、標準キャリブレーションカーブを取
得し、目的の化合物に関連するピークを後に統合することによって達成されます。シグナル応答と
濃度とのキャリブレーションカーブの関連性を用いて、未知のサンプル中の特定の分析試料の量を
測定します。

定量化メソッド
定量化メソッドとは、サンプル内でピークを生成するために使用する一連のパラメータのことです。
定量化メソッドにはピークの位置設定および統合、標準カーブの生成、未知濃度の計算などを行う
パラメータが含まれています。以前に保存された定量化メソッドは、バッチの Quantitation メニュ
ーから選択できます。

定量化メソッドの作成には Quantitation ウィザード、Build Quantitation Method、Quick Quant の
3 つのツールが使用できます。
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Build Quantitation Method
Build Quantitation Method は、定量の結果表を生成しませんが、そのメソッドは次に定量化ウィザ
ードで使用して、結果表を作成することができます。Build Quantitation Method は、既存の定量化
メソッドの変更にも使用できます。これは、定量化メソッドを作成する も柔軟な方法といえます。定
量化メソッドエディタを使用したメソッドの作成を参照してください。

定量化ウィザード

定量化ウィザードを用いると、結果表が定量化メソッドと同時に生成されます。代わりに、既存の定
量化メソッドが異なるデータセットの定量化に使用されます。

Quick Quant
Quick Quant を結果の定量に用いることはお勧めしません。

Quick Quant は、Batch Editor の一部です。Quick Quant を使用して、データ取得前に化合物濃
度を追加します。サンプルを取得していないので、それぞれのサンプルの選択、およびピークのレビ
ューはできません。この機能では、メソッドのコンポーネントのみを定義します。

Quick Quant 機能を使用してサンプル種類および濃度をデータファイルに保存する場合、自動的に
生成された Quick Quant メソッドを使って定量化を実施しないでください。この定量化メソッドは、ピ
ークの選択用に 適化されている化合物およびサンプル固有積分パラメータを使用しません。

以前に保存された定量化メソッドを使用するには、バッチの Quantitation メニューから選択しま
す。バッチ作成の手順については、バッチの作成および提出を参照してください。

定量化メソッドと結果表

次の手順を行うにあたっては、Example/Triple Quad フォルダにインストールされたサンプル

データを使用してください。フォルダには、データファイル、Mix_Batch_1 および Mix_Batch_2 が含
まれます。これらのサンプルファイルは、問題のあるサンプルを分離するメトリックプロットの有益性
を示すために用いられます。スキャン対象のイオンはレセルピン（609.3/195.0）、ミノキシジル
（210.2/164.2）、トルブタミド（271.1/91.1）、また内部標準でもあるレシンナミン（635.3/221.2）です。
Mix_Batch_1 にはエラーはありませんが、Mix_Batch_2 には内部標準物質を 2 回添加した QC
サンプル（サンプル QC2）が含まれています。

定量化メソッドエディタを使用したメソッドの作成

注: 結果表のデータの分析に用いたクエリはすべて検証することを推奨します。

前提条件

• 定量対象のデータを含むプロジェクトまたはサブプロジェクトを選択します。プロジェクトとサブ
プロジェクトの切り替え

1. Example プロジェクトが選択されていることを確認します。
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2. Navigation バーの Quantitate の下にある Build Quantitation Method をダブルクリックし
ます。
Select Sample ダイアログが開きます。

3. Data Files リストの Triple Quad フォルダをダブルクリックします。

4. Mix_Batch_2. wiff を選択します。
選択したデータファイル内のサンプルは、Samples リストに表示されます。

注: 測定メソッドのサンプルと内部標準で Compound ID フィールドを入力した場合、Q1/Q3
フィールドで値を選択すると、Internal Standards 表の Name フィールドが自動的に入力され
ます。

5. バッチ全体に合う積分パラメータを選択するための検出可能なシグナルを出すサンプルを選択
してから、OK をクリックします。

6. Internal Standards 表の Name カラムで、rescinnamine を選択します。Q1/Q3 カラムで
635.3/221.2 を選択します。

7. Analytes 表で、次の操作を行います。

a. Name カラムで、210.2/164.188 の Q1/Q3 カラム質量には minoxidol を、
271.3/91.146 には tolbutamide を、609.4/195.039 には reserpine を選択します。

b. Internal Standard カラムで、リストから各分析試料に関連付ける内部標準として
rescinnamine を選択します。

c. Analytes 表の Q1/Q3 カラムから、635.4/221.185 を削除します。

注: 測定メソッドのサンプルと内部標準で Compound ID フィールドに入力した場合には、
Analytes 表の Name フィールドと Q1/Q3 フィールドが入力されます。

8. Integration タブを開きます。

プリセット積分パラメータはほとんどのピークに適しています。

9. 積分が適しない場合には、アルゴリズムを変更してください。 手動でピークを積分を参照してく
ださい。

10. 追加の積分アルゴリズムを表示するには、Show or Hide Parameters（ ）をクリックしま
す。

11. Calibration タブを開きます。
プリセットパラメータはこれらのサンプルに適しています。ユーザーはアプリケーションごとに、
フィッティング、重み付け、および特回帰パラメータを変更することができます。

12. 定量化メソッドを保存します。
Batch Editor でバッチが作成されたとき、または Quantitation Wizard が Results Table の作
成に使用された時に新しいメソッドが使用されます。

ヒント! 定量化メソッドは、他のプロジェクトにコピーしない限り、現在のプロジェクトにのみ使用
できます。そのためには、Tools > Project > Copy Data をクリックします。これを使用するた
めには、新規プロジェクトを作成および選択している必要があります。
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定量化ウィザードを用いて結果表を作成

注: 結果表のデータの分析に用いたクエリはすべて検証することを推奨します。

前提条件

• 定量対象のデータを含むプロジェクトまたはサブプロジェクトを選択します。プロジェクトとサブ
プロジェクトの切り替え

1. Navigation バーの Quantitate の下にある Quantitation Wizard をダブルクリックします。
Create Quantitation Set - Select Samples ページが開きます。

2. Available Data Files リストで Triple Quad フォルダをダブルクリックします。

3. Mix_batch_2. wiff を選択します。

4. Add All をクリックします。

注: 測定時に異常が生じたり、予期せずに中断したサンプルの結果については、処理やレポー
トの作成を行わないことを推奨します。

5. Next をクリックします。
Create Quantitation Set - Select Settings & Query ページが開きます。

6. Default Query セクションの Select Existing: Query をクリックします。

7. Query リストから Accuracy 15% を選択します。

注: 同時にクエリを作成するには、標準クエリの作成（オプション）を参照してください。

注: 特定のアプリケーションに使用するクエリの評価と検証は、ユーザーの責任において行っ
てください。

8. Next をクリックします。
Create Quantitation Set - Select Method ページが開きます。

9. Choose Existing Method をクリックします。

10. Method リストから PK Data_Mix.qmf を選択します。

11. Finish をクリックします。
Results Table が開きます。

ヒント! Results Table にサンプルを追加する、またはサンプルを削除するには、Tools >
Results Table > Add/Remove Samples. をクリックします。

12. サンプル種類、実際の濃度、ピーク積分、キャリブレーションカーブ、統計ペイン、内部標準の
ためのメトリックプロット、およびその他のデータ定量と関係する情報をレビューします。

13. 結果表を保存します。
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注: 結果表にデータファイル（wiff）からのサンプルが含まれる場合は、データファイルの名前を
変更しないことを推奨します。

ヒント! Reporter ソフトウェアを用いると、結果表から正確にフォーマットされたレポートが作成
されます。Reporter のテンプレートにクエリが使用されている場合は、結果を検証することを推
奨します。 Reporter ソフトウェアを参照してください。

標準クエリの作成（オプション）

アドバンスドユーザーはクエリおよび標準クエリをさまざまな方法で作成することができます。以下
に一例を示します。クエリ作成の詳細な情報については、ヘルプを参照してください。

Results Table のデータ分析に使用するクエリはすべて検証することを推奨します。

1. Navigation バーの Quantitate の下にある Quantitation Wizard をダブルクリックします。
Create Quantitation Set - Select Samples ページが開きます。

2. 定量セットの一部として使用するサンプルを選択します。

3. Next をクリックします。
Select Settings & Query ページが開きます。

4. Default Query セクションで、Create New Standard Query を選択します。

5. クエリ名を入力します。

図 14-1 : Create Quantitation Set — Select Settings & Query ページ

6. Next をクリックします。
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図 14-2 : Create Quantitation Set — Create Default Query ぺージ

7. Maximum Allowed Accuracy Variation for QCs (%) 表の Max. Variation カラムで、対
応する濃度と同じ行に、各 QC の 大許容精度変動率（例：5 は± 5%）を入力します。測定時
に濃度を指定しなかった場合は、表示されません。その場合は、Concentration カラムに入
力します。

8. Maximum Allowed Accuracy Variation for Standards (%) 表の Max. Variation カラム
で、対応する濃度と同じ行に、各標準溶液に対する 大許容変動率（例：10 は± 10%）を入力
します。測定時に濃度を指定しなかった場合は、表示されません。Concentration カラムに濃
度を入力します。

9. Next をクリックします。
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図 14-3 : Create Quantitation Set — Select Method ページ

10. メソッドを選択または作成します。

11. Finish をクリックします。
クエリは標準クエリとして適用されます。クエリの結果は、Pass または Fail のエントリとして結
果表の Standard Query Status カラムに表示されます。

ヒント! 全体表示に戻るには、右クリックして Full をクリックします。

Results Table のレイアウトの指定
結果表には既定ビューが用意されています。

結果表を右クリックし、次のいずれかをクリックします。

• フルレイアウトを表示するには、Full をクリックします。

すべての分析試料が表示されます。

• 概要レイアウトを表示するには Summary をクリックし、フィールド名をクリックします。

• 分析試料レイアウトを表示するには Analyte をクリックし、（複数の分析試料が存在する場合
は）対象の分析試料をクリックします。

• 分析試料グループレイアウトを表示するには Analyte Group をクリックし、対象の分析試料を
クリックします。

ヒント! 新しい分析試料グループは 初に作成する必要があります。これを行うには結果表を右クリ
ックし、Analyte Group > New をクリックします。
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ヒント! 全体表示に戻るには、右クリックして Full をクリックします。

表が選択したレイアウトで表示されます。

結果表のデータのソート

結果表のデータは次の方法でソートすることができます。

• いずれかの Sort ボタンを使用して、カラム 1～3 にもとづいて表をすばやくソート：このソート基
準は保存できません。

• 表に特有のソート基準を作成し、その時点の表のソート基準を保存：表特有のソート基準を用い
ることで、その時点の表をカラム 1～3 に基づいてソートし、その表に再び使用できるよう基準を
保存できます。

• 以前に作成したプリセットのソート基準を使用：ソート基準を作成および保存し、後で結果表に適
用することができます。

ヒント! ソート基準または他の表設定を保存するには、表を右クックして、Table Settings > Export
To New Table Settings をクリックします。これらのソート基準や他のパラメータは、その時点のプ
ロジェクトで使用できます。表設定を別のプロジェクトで使用するには、対象のプロジェクトにコピー
します。Tools > Project > Copy Data をクリックします。これを使用するためには、新規プロジェク
トが作成および選択されている必要があります。

結果表のソート

1. ソートする順に結果表のカラムから 3 つまで選択します。

2. 次のいずれかの操作を行います。

• 昇順にソートするには A-Z をクリックします。

• 降順にソートするには Z-A をクリックします。

結果表のソートおよびソート基準の保存

1. 結果表を右クリックしてから、Sort > New をクリックします。
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図 14-4 : Sort ダイアログ

2. Name フィールドに、新しいソートの名前を入力します。

3. ソートルールごとに、Sort By と Then By セクションで次の操作を行います。

• Group リストで、ソートの基準とするカラムの種類を選択します。

• Column リストで、ソートの基準とするカラムを選択します。

• ソート順（Ascending または Descending）を選択します。

4. 次のいずれかの操作を行います。

• ソートを実行するには、ソート基準を保存し、Sort ダイアログを閉じて、Save/Execute をク
リックします。

• ソート基準を保存せずに、Sort ダイアログを閉じソートを実行するには、Execute をクリック
します。

今後の結果表用のデフォルトのソート基準の保存

1. Tools > Settings > New Quantitation Results Table Settings をクリックします。
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図 14-5 : Table Settings ダイアログ

2. Table Settings フォルダを展開した後、Default フォルダをダブルクリックします。

3. 展開された Default フォルダから、Sorts フォルダを選択した後、New をクリックします。

図 14-6 : Sort ダイアログ
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4. Name フィールドに、新しいソートの名前を入力します。

5. ソートルールごとに、Sort By と Then By セクションで次の操作を行います。

• Group リストで、ソートの基準とするカラムの種類を選択します。

• Column リストで、ソートの基準とするカラムを選択します。

• ソート順（Ascending または Descending）を選択します。

6. 基準を保存し、Sort ダイアログを閉じるには、OK をクリックします。

7. Table Settings ダイアログを閉じるには、Done をクリックします。

事前設定の基準を用いた結果表のソート

• 結果表を右クリックし、Sort をクリックしてから、ソートの名称を選択します。

ピークレビューとピークの手動積分
ピークレビューを使用し、ソフトウェアが見極めたピークを分析し、その後、必要に応じて、ピークま
たは開始点および終了点を再定義します。

分析試料およびソフトウェアで見つけなければならない内部標準を確認した後、ソフトウェアはサン
プル内のピークを検索します。ソフトウェアがピークを確認すると、各分析試料と内部標準のクロマト
グラムが Standard Wizard ページの Create Quantitation Method: Define Integration または
Full Method Editor の Integration タブに表示されます。ユーザーは、発見されたピークを確認し、
ピークをよりうまく定義するために定量化メソッドを変更できます。ユーザーが手動ですべての解析
結果を閲覧することを推奨します。

Peak Review の右クリックメニューの使い方については、ピークレビューを参照してください。

ピークのレビュー

ピークレビューでは、ピークの全体像の閲覧およびベースラインの検証を行い、ソフトウェアがピー
クの開始･終了点を正確に捉えているかを判定します。自動ズーム機能もお使いいただけます。

ソフトウェアがピークを発見しやすいように、ピークの正確な開始点と終了点、およびバックグラウン
ドを手動で定義してください。これらの変更はグローバルメソッドが更新されない限り、個々のピーク
に対してのみ適用されます。

注: 手動解析結果を検証することを推奨します。

ヒント! 個々のピークをレビューするには、カーブ地点を右クリックし、Show Peak をクリックします。
ソフトウェアが選択されたピークの Peak Review ウィンドウを開きます。

1. 結果表の場所を右クリックして、Analyte をクリックします。

2. 分析試料を選択します。

3. Tools > Peak Review > Pane.をクリックします。
ピークは結果表の下部に表示されます。Results Table に記載のあるピークのみが対象となり
ます。
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図 14-7 : ピークレビュー

4. ペインを右クリックし、Options をクリックします。
Peak Review Options ダイアログが開きます。

5. Appearance セクションで、Num. rows を 1 に、Num. columns を 2 に変更します。

6. Automatic Zooming セクションで、Zoom Y axis to: 100% of largest peak をクリックして
ピーク全体を表示します。

使用説明－定量データの分析および処理

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
197/293



図 14-8 : Peak Review Options ダイアログ

項目 定義

1 行数

2 カラム（列）数

3 ピーク全体を表示するには、Zoom Y-axis to 100% of largest peak

7. OK をクリックします。

8. ピークを移動させるには、右矢印をクリックしてください。図 14-9 を参照してください。

9. 標準溶液 3 の第 2 注入を開始してください。
この例では Specify Parameters オプションを選択することで、ピークがベースラインにより近
い位置に統合されます。

ヒント! Peak Review ペインで特定のピークに移動するには、Results Table の対応する行を
選択してください。
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図 14-9 : Peak Review ペイン

項目 定義

1 矢印：クリックしてピークを移動

2 Show or Hide Parameters：クリックして積分パラメータを表示

3 積分パラメータ：クリックしてパラメータを変更

4 Noise Percentage：ノイズパーセンテージを入力

5 Apply：クリックしてパラメータを積分

10. Show or Hide Parameters を 2 回クリックします。

11. Specify Parameters - MQ III をクリックします。

12. Noise Percent の値を変更します。

13. Apply をクリックします。
ピークがベースラインにより近い位置に統合されます。

14. この変更を行ってもピーク解析が改善されない場合は、Noise Percent パラメータを 適値に
調整してください。

注: Update Method オプションは特定の分析試料（または内部標準）に対するアルゴリズム
値のみを更新するもので、すべての分析試料には適用されません。

15. すべてのピークに対してアルゴリズムを更新する場合は、ペインを右クリックして Update
Method をクリックしてください。
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図 14-10 : Update Method

手動でピークを積分

手動によるピーク積分は、個人間のばらつきを抑えるために、 後に行ってください。手動ピーク積
分は、アルゴリズムパラメータの調整および更新が完了した後にすべてのピークが発見できなかっ
た場合にのみ行います。特定のアプリケーションで手動積分が許容されるかどうかを判断するため
に、ユーザーが結果を検証することを推奨します。

注: 手動で解析されたピーク、またはアルゴリズムがそのピークのために変更された箇所は、結果
表の Record Modified カラムで識別することができます。分析試料グループ全体に適用されない
サンプルに対して、アルゴリズムのパラメータ変更が行われたピークも同様です。

1. Peak Review ペインの Manual Integration Mode をクリックします。

図 14-11 : ピークレビューペイン：手動背積分モード

2. ピークより 10% 低い値部分をズームインします。
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図 14-12 : ピークレビューペイン：ピークへの照準設定

3. 照準線をピークの開始点に合わせ、その後ピークの終了点にドラッグします。
ソフトウェアが、ピークの基準点と側面により決定されたエリアに陰をつけます。ピークパラメー
タが灰色なのは、適用されなくなったためです。これは、ピークが手動で描かれたためです。

4. 次のいずれかの操作を行います。

• この変更を恒久的にするには、Accept をクリックします。

• 変更を破棄するには、Manual Integration チェックボックスをクリアします。

ヒント! ピークが正しく選択されていた場合は、ピークを右クリックし、Revert to Method をクリ
ックします。

キャリブレーションカーブ
キャリブレーションカーブは、品質管理（QC）サンプルなど、サンプルの算出濃度を求めるために使
用します。品質管理サンプルはバッチ内標準溶液のデータ品質と精度を測るため、バッチに追加さ
れます。品質管理サンプルは検証済の分析試料濃度を保持していますが、測定濃度と実際の値を
比較するため、未知物質として扱われます。

キャリブレーションカーブは、標準溶液の濃度をその領域および高さを基準にプロットすることで生
成されます。内部標準を使用している場合は、標準溶液濃度または内部標準の割合を、内部標準
のピーク高または領域に対する標準溶液のピーク高または領域の割合を基準にプロットします。サ
ンプルの領域および高さの割合はカーブに適用され、求められたサンプル濃度が結果表に表示さ
れます。指定された回帰に応じて、このキャリブレーションカーブから回帰方程式が生成されます。
回帰方程式は未知サンプルの濃度を計算するために使用されます。

キャリブレーションカーブには線形回帰が推奨されます。
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キャリブレーションカーブがカバーする濃度範囲外となった定量値について、ユーザーは報告する
必要はありません。

Calibration Curve の右クリックメニューの使い方については、キャリブレーションカーブを参照してく
ださい。

キャリブレーションカーブの表示

ユーザーはキャリブレーションカーブを表示し、開いている結果表で回帰オプションを変更すること
ができます。2 つ以上の結果表が開いている場合、キャリブレーションカーブは重ねて表示されま
す。重ねて表示されたキャリブレーションカーブについては、表作成メソッドが同じであることを確認
してください。

キャリブレーションカーブをプロットして回帰に使用された曲線を閲覧します。Results Table 内の
Calculated Concentration カラムは、曲線を標準点に合わせた結果の変更を反映しています。

注: Results Table が開いているときにのみオプションが選択可能です。

1. Results Table を開きます。

2. Tools > Calibration > Pane. をクリックします。
キャリブレーションカーブを含む Calibration Curve ペインが開きます。

図 14-13 : キャリブレーションカーブ

3. 複数の分析試料がある場合は、次のステップを用いて他の分析試料のキャリブレーションカー
ブを表示します。

a. Analyte リストから分析試料を選択します。

b. 必要に応じて次のリストから Area あるいは Height を選択します。

4. キャリブレーションカーブの回帰オプションを変更するには、次の操作を行います。

a. Regression をクリックします。
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図 14-14 : 回帰オプションダイアログ

b. Fit リストから Linear を選択します。

c. Weighting リストから 1 / x を選択します。

d. OK をクリックします。

キャリブレーションカーブが開きます。ユーザーは曲線上にそれぞれのピークを表示したり、曲
線から点を削除することでより良い曲線が作成できます。

5. 必要に応じてこれらのステップを繰り返してより適切な曲線を作成します。

6. 変更を保存するには、Accept をクリックします。

キャリブレーションカーブのオーバーレイ

ヒント! 1 つの表に対するカーブをより詳細に調べるには、カーブを右クリックして Active Plot をク
リックします。上部にプロットするカーブを選択します。

1. Results Tables が 2 つ以上開いている場合は、いずれか 1 つの表に対するキャリブレーショ
ンカーブを表示します。

2. キャリブレーションカーブを右クリックし、Overlay をクリックします。

図 14-15 : Overlay ダイアログ

3. 現在のキャリブレーションカーブに重ねて表示する表を選択します。

4. OK をクリックします。
ソフトウェアは、同じグラフ上に表のカーブをプロットします。
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サンプル統計
Statistics ウィンドウを使用して、内部標準および品質管理（QC）など、サンプルの統計を閲覧しま
す。Results Table 内の各利用可能バッチからのデータが、グリッドとデータ列の表形式で開き、各
標準用または QC 濃度用に表示されます。

バッチ統計をレポートに含め、結果の妥当性を確認することを推奨します。

標準溶液および QC に対する統計の表示

複数の Results Table が表示されている場合、追加のバッチの標準と QC に関する統計情報を
Statistics ウィンドウに表示できます。これにより、標準または QC 内のバッチと傾向の特定間の結
果の比較が容易になります。

1. Results Table を開きます。

2. Tools > Statistics.をクリックします

3. Statistics Metric リストから Concentration を選択します。

4. Analyte Name フィールドから分析試料を選択します。

5. Sample Type フィールドの Standard を選択します。
結果が表示されます。

6. %CV カラムと Accuracy カラムを調べます。
%CV は、単一パラメータ間の変動係数（例：領域）を示します。Accuracy は、プロットした点
が補間値にどれくらい近いかを示します。

7. 必要に応じて、Display Low/High values チェックボックスを選択し、グリッドの各行の Low、
High 値、および Mean を調べます。それぞれの行は、濃度レベルが同じ標準物質を表してい
ます。

8. 他の分析試料を選択します。
結果は基本として分析試料ごとに表示されます。

9. 同じ濃度レベルの品質管理（QC）変動をチェックするには、Sample Type フィールドの QC を
選択します。

メトリックプロット
メトリックプロットとは、1 つの結果表カラムに含まれるデータを X 軸または Y 軸にプロットしたグラ
フ、あるいは 2 つのカラムに含まれるデータを互いにプロットしたグラフを指します。このセクション
ではメトリックプロットを生成して使用する方法について説明します。

既定のメトリックプロットもいくつか用意されています。

• Int_Std_Response（問題のサンプルの場所を特定）

• Analyte_Area versus Height（クロマトグラフィーの動作を検証）

• PK プロファイル（「濃度」対「時間」のプロット、サンプルクエリ後に実行）
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メトリックプロットの生成

メトリックプロットを用いて、与えられたカラム、例えば、Analyte Peak Area、Accuracy、Calculated
Concentration などを結果表からプロットします。2 種の結果表フィールドを互いにプロットすること
ができ、そのプロットは正常範囲を逸脱するポイントの調査に使用されます。メトリックプロットはた
いていクエリと併用されます。クエリの詳細な情報については、次のドキュメントを参照： Help。

メトリックプロットは次の方法で生成します。

• Plot ボタンを用いて、現在の結果表の 1 つまたは複数のカラムをプロットすることができます
が、プロット基準を保存することはできません。

• 現在の表とプロット基準を保存するには、表固有のプロットを作成します。

• 今後の結果表でも使用するプロット基準を保存するには、グローバルなプロットを作成します。

QC、未知物質、ブランク、ダブルブランク、または溶媒はキャリブレーションカーブには現れません
が、それらのメトリックプロットは生成することができます。

図 14-16 : メトリックプロットの例

項目 説明

1 ダブルブランク

メトリック一時プロットの作成

1. 結果表が開いた状態で、次のいずれかの操作を行います。

• データを Y 軸にプロットするには（X 軸はインデックスとして使用）、プロットしたいデータが
含まれるカラムの見出しをクリックします。

• 初に選択したカラムのデータを X 軸に、次に選択したカラムのデータを Y 軸にプロットす
るには、Ctrl キーを押しながら 2 つのカラムを選択してから、カラムの見出しをクリックしま
す。
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2. 結果表の上にある Metric Plot by Selection アイコンをクリックします。表 D-9 を参照してくだ
さい。

メトリックプロットが開きます。

3. プロットペインを右クリックし、Data Legend をクリックすると、プロットで用いられている色につ
いての説明が表示されます。

4. プロットペインを右クリックし、Point Legend をクリックすると、プロットで用いられているシンボ
ルについての説明が表示されます。

メトリックプロットの生成およびプロット基準の保存

1. 適切な Results Table を開きます。

2. Results Table を右クリックしてから、Metric Plot > New をクリックします。

図 14-17 : Metric Plot ダイアログ

3. Name フィールドに、新しいプロット基準の名称を入力します。

4. X 軸をインデックスとして用いて Y 軸のフィールドをプロットするには、X-Axis セクションの
Group リストで、Index を選択して Column リストをブランクのままにします。
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5. 相互に 2 つのカラムをプロットするには、Y-axis セクションの Group リストで、Internal
Standard を選択してから、Column リストで IS Peak Area を選択します。

6. 必要な場合、Regression リストで使用する回帰の種類を選択した後、適切な回帰設定を選択
します。

7. プロットを生成してプロット基準を保存するには、Save/Execute をクリックします。

メトリックプロットが開きます。詳細は、図 14-16 を参照してください。

8. プロットペインを右クリックし、Data Legend をクリックすると、プロットで用いられている色につ
いての説明が表示されます。

9. プロットペインを右クリックし、Point Legend をクリックすると、プロットで用いられているシンボ
ルについての説明が表示されます。

これで Results Table の右クリックメニュー内の Results Table のプロットを今後作成する際
に、この基準セットを使用できるようになります。プロット基準はユーザーが編集することも可能
です。

10. 問題のサンプルを参照するには、時間に対して未知物質の濃度をプロットするか、インデックス
に対して内部標準の面積をプロットしてみてください。

今後の結果表用のデフォルトのプロット基準の保存

1. 結果表を右クリックし、Table Settings > Export To New Table Settings をクリックします。
これにより、rdb から表設定がエクスポートされるため、プロジェクト内の他の定量ランで再利用
することが可能です。

2. 表設定を他のプロジェクトにエクスポートするには、Tools > Project > Copy Data をクリック
します。
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図 14-18 : Copy Data ダイアログ
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Reporter ソフトウェア 15
Reporter ソフトウェアを使うことで、Analyst MD ソフトウェアで提供されているレポート機能を拡張
できます。

注意: 潜在的に正しくない結果。不正確な結果を避けるために：

• 使用する前に、すべての Reporter クエリを検証してください。

• 変更された Reporter テンプレートまたはクエリを含むテンプレートが使用されている場合は、結
果を検証します。

• Reporter で検証が完了していることを確認してください

Reporter ソフトウェアでは、Microsoft Word および Excel（2013、2016、または Office 365）を使
用してカスタムレポートを作成できます。Reporter ソフトウェアには次の特徴があります。

• 結果表、ファイル情報、定量ピークレビューウィンドウからのデータを使用してさまざまな種類の
レポートを作成できます。

• MS/MS ライブラリ検索の結果を表示する様々なレポートを作成することができます。ユーザー
は、Analyst MD ソフトウェア（mdb）のフォーマットを使用する任意の MS/MS スペクトルライブラ
リに対して検索を行うように Reporter ソフトウェアを設定することができます。

• レポート生成時に必要なフォーマット情報を設定する際は、Microsoft Word テンプレートを使用
してください。これらのテンプレートを作成、修正することで、レポートフォーマットをカスタマイズ
することができます。Report Template Editor の作成または編集については、ヘルプを参照して
ください。

• ブランクの初期テンプレートはほぼ全てのレポート要件に対応しており、Reporter ソフトウェアの
編集環境でレポートテンプレートをデザインする際に活用できます。

• レポートの自動印刷、Adobe Portable Document Format（pdf）へのエクスポート、e メールでの
結果送信を行います。

• 入手可能な Analyst MD ソフトウェアプログラミングライブラリを使用して、カスタムソフトウェアア
プリケーションからレポートを生成します。

Reporter ソフトウェアは次の形でもご使用いただけます。

• Analyst MD ソフトウェア上で、単一および複数のレポートを手動で生成します。

• Analyst MD ソフトウェアを使用しないアプリケーションによります。
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Analyst Reporter ユーザーインターフェース

図 15-1 : Analyst Reporter

項目 オプション 説明

1 File > Exit プログラムを閉じてすべてのリソースを開放します。
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項目 オプション 説明

2 Settings > Select
Output
Language

レポートテンプレート内で言語タグの置換えに使用する言語
辞書を設定します。言語タグを含むテンプレートを使って、任
意の言語でレポートを作成することができます。言語タグは、
選択した言語の辞書ファイルの中でマッチングしたタグからテ
キストに置き換えられます。これらの辞書ファイルは次のフォ
ルダに入っています：
C:\Program Files\AB
SCIEX\AnalystReporter\Resources\Languages
（Windows 7、32 ビットオペレーティングシステム）または
C:\Program Files (x86)\AB
SCIEX\AnalystReporter\Resources\Languages
（Windows 7、64 ビットオペレーティングシステムまたは
Windows 10、64 ビットオペレーティングシステム）。

2 Settings > Select
Library

スペクトルライブラリを閲覧します。このライブラリは、MS/MS
スキャン種類を誘発するデータ依存型取得（IDA）からのデー
タを含む結果表からの MS/MS データのマッチングおよびス
コアリングのために使用されます。

2 Settings > Select
Template Folder

利用可能なテンプレートから読み出されるフォルダを設定し
ます。既定のテンプレートフォルダに戻るには、Default オプ
ションを選択します。

3 Help > About 現在インストールされている Reporter ソフトウェアのバージョ
ン情報を表示します。

4 Current Output
Language

現在選択されている、レポートテンプレート内で置き換える言
語タグに使用する言語辞書を表示します。言語辞書を選択
するには、Settings > Select Output Language. をクリッ
クします。

5 Current Spectral
Library

現在選択されている、スペクトルライブラリを表示します。ス
ペクトルライブラリを選択するには、Settings > Select
Library. をクリックします。

6 Available
Templates および
Description

利用可能なレポートテンプレートを表示します。テンプレート
を選択すると、テンプレートの説明が表示されます。利用可
能なテンプレートを読み込むフォルダを変更するには、
Settings > Select Template Folder > Browse. を選択し
ます。
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項目 オプション 説明

7 Output Format Reporter ソフトウェアにサポートされる出力フォーマットを示
します。選択されたレポートテンプレートと互換性がある形式
のみ利用可能です。

• Word：Microsoft Word 文書（docx）が作成されます。こ
の文書は Microsoft Word 2010 またはそれ以上のバー
ジョンで読むことができます。

• PDF：レポートが PDF フォーマットで直接作成されます。

• HTML：HTML ファイルの作成には Microsoft Word が使
用されます。関連画像ファイルは HTML ファイルと同じ名
前のフォルダに保存されます。

• Excel：標準テキストファイル（csv）が作成されます。コン
マで区切られた数値を含むレポートテンプレートは、各数
値が異なるセルに表示されるよう、Microsoft Excel で開く
ことができます。テキスト互換性有りと特別に記されたテン
プレートのみ、出力形式として使用することができます。

• Text：プレーンテキスト文書（txt）が作成されます。テキス
ト互換性有りと特別に記されたテンプレートのみ、出力形
式として使用することができます。

8 Print
Automatically

レポートが作成されると、選択されたプリンタで印刷されま
す。利用可能なプリンタを選択してください。

9 Create Report 選択されたレポートテンプレートを用いて、選択された出力フ
ォーマットでレポートを作成します。

10 Close プログラムを閉じてすべてのリソースを開放します。

レポートの生成
Reporter ソフトウェアは数値データを結果表から抽出し、wiff ファイルからサンプルおよび図形情報
を抽出します。

1. Results Table を開きます。

2. Companion Software の下で Reporter をダブルクリックします。
Analyst Reporter が開きます。

3. Available Templates フィールドで、該当するレポートテンプレートを選択します。

4. PDF 出力用フォーマットをクリックします。
Word オプションがあらかじめ選択されていて、レポートは現在のプロジェクトの Results フォル
ダに自動的に保存されます。PDF 出力フォーマットを選択しなかった場合、レポートは Word
で作成されて開くか、または選択したオプションで印刷されます。ただし、この場合レポートは保
存されません。そのため、元のレポートを保存する前にユーザーは Word でレポートを編集す
る必要があります。
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5. MS/MS スキャンタイプのトリガーとなるデータ依存型取得（IDA）からのデータを含む結果表が
用いられる場合のライブラリ検索（定性的）ワークフローのオプション：Settings > Select
Library をクリックして、該当の MS/MS ライブラリデータベース（mdb フォーマット）に進んだ
後、Open をクリックします。

6. （オプション）Print Automatically チェックボックスをオンにすると、事前選択したプリンタでレ
ポートを自動印刷することができます。
他のプリンタを選択しない限り、Windows で設定された初期設定プリンタが使用されます。
Reporter ソフトウェアでは、操作を終えてもプリンタの選択が維持されます。プリンタが PDF プ
リンタドライバに設定されている場合、Reporter ソフトウェアは作成されたレポートの PDF ファ
イル版を自動的に生成します。

7. Create Report をクリックします。
ソフトウェアがテンプレートを開き、結果表からテンプレートにデータを追加する際、画面にさま
ざまな進捗インジケーターが表示されます。数秒で生成されるレポートもありますが、通常はも
う少し長い時間を要します。多くの MRM トランジションや多量の図を含む大きなデータは、数
百枚ものレポートとなり、作成に何時間も要することがあります。
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サービスおよびメンテナンス情報 — 質
量分析装置 16
パフォーマンスを 適化するために、システムの定期クリーニングおよびメンテナンスを行ってくださ
い。

警告! 感電の危険。カバーを取り外さないでください。カバーを取り外すと、傷害または
システムの故障が発生する場合があります。定期的なメンテナンス、点検、または調整
のためにカバーを取り外す必要はありません。カバーを取り外す必要がある修理につい
ては、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。クリ
ーニングやメンテナンス前に、汚染除去が必要かどうかを判断します。放射性物質、生
物学的病原体、または有害化学物質が質量分析装置に使用された場合、お客様はク
リーニングまたはメンテナンス前にシステムに対して汚染除去を行う必要があります。

推奨メンテナンススケジュール
次の表に、システムのクリーニングとメンテナンスの推奨スケジュールを示します。

ヒント! 定期的にメンテナンス作業を実行し、システムが 適に機能していることを確認してくださ
い。

• 定期的なガス漏れ点検と一般的なメンテナンス点検を実施して、安全なシステム操作を心がけ
ます。

• システムを定期的にクリーニングして、良好な動作状態に保ちます。

• システムメンテナンス時は、装置に接続されたチューブを含む外部ガス供給システムの部品を注
意深く検査して、満足のいく状態であることを確認してください。ひびが入ったり、損傷していた
り、つぶれていたりするチューブは交換してください。

質量分析装置とイオン源のクリーニングまたはメンテナンスの実施頻度を決定する際には、次の要
素を考慮してください。これらの要素によって、質量分析装置の性能に変化が見られる可能性があ
り、メンテナンスの必要性を示唆します。

• テスト対象の化合物

• サンプルの清浄度と準備メソッド

• プローブがサンプルにさらされている時間

• システム総稼働時間
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チューニング頻度については、キャリブレーションイオンと溶液を参照してください。

消耗部品の注文や基本サービス、メンテナンス要件については、QMP にお問い合わせいただく
か、または部品および機器ガイドをご覧ください。その他のすべてのサービスおよびメンテナンス要
件については、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

表 16-1 : 質量分析装置のメンテナンス作業

コンポーネント 頻度 タスク 詳細な情報については

システム 毎日 漏れがないかど
うかを点検しま
す。

化学物質に関する注意を参照して
ください。

カーテンプレート 毎日 クリーニング カーテンプレートのクリーニングを
参照してください。

粗引きポンプオイル 毎週 レベルを点検 粗引きポンプのオイルレベルの点
検を参照してください。必要に応じ
て、現地の有資格保守要員
（QMP）またはフィールドサービス
エンジニア（FSE）にお問い合わせ
になりオイルを追加します。

粗引きポンプオイル 3 年ごと、また
は必要に応じ
て。

交換 お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

粗引きポンプオイル 必要に応じて 再充填 お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

オリフィスプレート（フロン
ト）

必要に応じて クリーニング オリフィスプレート前面のクリーニ
ングを参照してください。

オリフィスプレート（前面
および背面）

必要に応じて クリーニング お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

質量分析装置エアフィル
ター

必要に応じて 交換 お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

QJet イオンガイドおよび
IQ0 レンズ

必要に応じて クリーニング お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。
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表 16-1 : 質量分析装置のメンテナンス作業 (続き)

コンポーネント 頻度 タスク 詳細な情報については

Q0 ロッドセットおよび
IQ1 レンズ

必要に応じて クリーニング お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

機器の表面 必要に応じて クリーニング 表面のクリーニングを参照してくだ
さい。

イオン源排気ドレインボト
ル

必要に応じて 空にする イオン源排気ドレインボトルを空に
するを参照してください。

インターフェースヒーター 必要に応じて 交換 お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

表 16-2 : イオン源のメンテナンス作業

コンポーネント 頻度 タスク 詳細な情報については

TurboIonSpray および
APCI プローブ

必要に応じて 点検および交換 プローブの取り外し および プロー
ブの取り付け を参照してください。

TurboIonSpray および
APCI プローブ用電極

必要に応じて 点検および交換 電極の交換 を参照してください。

コロナ放電ニードル 必要に応じて 交換 コロナ放電ニードルの交換 を参照
してください。

ターボヒーター 必要に応じて 交換 お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニ
ア（FSE）にお問い合わせくださ
い。

サンプルチューブ 必要に応じて 交換 イオン源チューブの接続 を参照し
てください。

「必要に応じて」の作業については、次のガイドラインに従ってください。

• こぼれた後、または汚れた際に、質量分析装置の表面を清掃してください。

• イオン源排気ドレインボトルが満杯になる前に空にします。

• システムの感度が低下した場合は、オリフィスプレート、QJet イオンガイド、Q0 領域をクリーニン
グします。
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ヒント! 四重極とレンズへの充電の影響（短時間で対象イオン感度が大幅に損失）を 小限に抑
えるために、定期的に Q0 領域のクリーニングを行ってください。有資格保守要員（QMP）または
フィールドサービスエンジニア（FSE）にお問い合わせください。

• オイルシール式の粗引きポンプを使用しているシステムでは、オイルが 小オイルレベルを下回
ったらオイルを補充してください。

• すべての排気接続箇所を定期的に点検して、しっかり接続されていること、および排気がお客様
の研究室に入り込んでいないことを確認してください。

表面のクリーニング
溶液がこぼれたり、または汚れた場合には、質量分析装置の外面をクリーニングします。

注意: ダメージを与える恐れ。推奨されているクリーニング方法および材料のみを使用して、装置を
損傷から守ります。

1. 温かい石鹸水で湿らせた柔らかい布で外面を拭きます。

2. 水で湿らせた柔らかい布で外部表面を拭いて、石鹸の残留物を取り除きます。

イオン源排気ドレインボトルを空にする

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。
有害物質は、適切にラベルを貼った廃棄物容器に入れて処分し、その際は現地規
制に従い処分してください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。排気
ガスを専用のラボ用ガス換気フードまたは排気システムで通気するように注意して、換
気チューブがクランプで固定されていることを確認します。ラボは実施される作業に適
切な換気が行われるようにしなければなりません。

注: イオン源廃棄物ラインにねじれ、たるみ、ねじれがないことを確認してください。

イオン源排気ドレインボトルは定期的に確認し、満杯になる前に空にします。また、ボトルとその継
手に漏れがないか点検し、必要に応じて接続部を締め付けるかコンポーネントを交換します。ボトル
を空にするには、この手順のステップに従います。
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1. イオン源を除去します。

2. ホースをイオン源排気ドレインボトルのキャップに取り付けているクランプをゆるめます。

図 16-1 : イオン源排気ドレインボトル

項目 説明

1 換気口への接続

2 イオン源排気ドレインチューブ：内径 2.5 cm（1.0 インチ）

3 粗引きポンプ排気ホース：内径（i.d.）3.2 cm （1.25 インチ）

4 イオン源排気ドレインボトル
こぼれないようにボトルがしっかりと取り付けられていることを確認します。

5 質量分析装置へのイオン源排気接続：内径 1.6 cm（0.625 インチ）

注: ドレインボトル、質量分析装置、検査室通気口のイオン源排気ホースの接続部は、ホース
クランプで固定されています。

3. ドレインボトルをホルダーから取り出します。
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4. キャップからホースを外します。

5. ドレインボトルからキャップを取り外します。

6. ドレインボトルを空にし、ラボの手順と現地の廃棄規制に従って不用品を廃棄します。

7. ボトルにキャップを取り付け、ホルダーにボトルを取り付けます。

8. ホースをキャップにクランプでしっかりと取り付けます。

フロントエンドのクリーニング
次の警告は、本項の手順すべてに適用されます。

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。

定期クリーニングメソッドを使用し、質量分析装置のフロントエンドをクリーニングします。

• システムの予期せぬ故障を 小限に抑えることができます。

• 適な感度が維持できます。

• サービス人員の訪問が必要となるような大規模クリーニングを回避できます。

汚染が発生した場合は、初期の定期クリーニングを行ってください。オリフィスプレートの前面も忘れ
ずにクリーニングしてください。定期クリーニングを行っても感度の問題が解決しない場合は、フルク
リーニングが必要です。お近くの有資格保守要員（QMP）またはフィールドサービスエンジニア
（FSE）にお問い合わせください。

本項では、大気開放を要さない定期クリーニングを解説します。

注: 適用される現地規制に従ってください。健康と安全のガイドラインについては、化学物質に関す
る注意を参照してください。

汚染の兆候

次のいずれかが観察された場合、システムが汚染しているおそれがあります。

• 感度の著しい低下

• バックグラウンドノイズの増加

• フルスキャンまたはサーベイスキャン方式のサンプルの一部ではない追加のピーク

こうした問題が観察された場合、質量分析装置のフロントエンド部をクリーニングしてください。
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必要な道具

注: 消耗品の注文情報および問い合わせについては、『MD 装置ファミリーの部品および機器ガイ
ド』を参照してください。詳細な情報については、お近くのフィールドサービスエンジニア（FSE）にお
問い合わせいただくか sciex.com をご覧ください。

• パウダーフリーグローブ（ニトリルまたはネオプレンを推奨）

• 安全メガネ

• 実験用白衣

• 新鮮な LC-MS グレード水。古い水には不純物が含まれており、質量分析装置の汚染を進行さ
せる可能性があります。

• LC-MS グレードメタノール、イソプロパノール（2-プロパノール）、アセトニトリル

• 洗浄液は、次のうちひとつを使用してください。

• 100%メタノール

• 100%イソプロパノール

• 1：1 比のアセトニトリル：水の溶液（新規調製すること）

• 1：1 比のアセトニトリル：水に 0.1%酢酸を加えた溶液（新規調製すること）

• 洗浄液を準備するために、1 L または 500 mL のガラス製ビーカーを洗浄します。

• 使用済の溶剤を入れるための 1 L ビーカー

• 有機廃棄物容器

• 糸くずの出ない布。メーカーから入手可能なツールとサプライを参照してください。

• （オプション）ポリエステル綿棒

メーカーから入手可能なツールとサプライ

注: 部品番号は部品および機器ガイドのドキュメントを参照してください。

• 小型ポリスワブ（熱接着）。クリーニングキットにも同梱されています。

• 糸くずの出ない布（11 cm x 21 cm、4.3 インチ x 8.3 インチ）。クリーニングキットにも同梱されて
います。

• クリーニングキット。小さなポリスワブ、糸くずの出ない布、Q0 クリーニングツール、ストレート型
の QJet イオンガイドクリーニングブラシ、および Alconox が含まれています。

クリーニングのベストプラクティス

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。
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警告! 有害化学物質の危険があります。化学製品の安全性データシートを参照し、化学物
質の取り扱い、保管、処理についての推奨安全手順に従ってください。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。クリ
ーニングやメンテナンス前に、汚染除去が必要かどうかを判断します。放射性物質、生
物学的病原体、または有害化学物質が質量分析装置に使用された場合、お客様はク
リーニングまたはメンテナンス前にシステムに対して汚染除去を行う必要があります。

警告! 環境の危険。システムコンポーネントを一般廃棄物として処分しないでください。
コンポーネントを処分する際は、現地規制に従います。

• イオン源は、取り外す前にそのままにして熱を下げます。

• クリーニングを行う際は、常に清潔なパウダーフリーグローブ（ニトリル、あるいはネオプレンを推
奨）を着用してください。

• 質量分析装置コンポーネントのクリーニング後、再組立前に新しいグローブを着用してください。

• 本手順書で指定されるもの以外のクリーニング用品を使用しないでください。

• 可能な場合は、クリーニングの直前に洗浄液を準備してください。

• すべての有機溶液および有機含有溶液は、非常に清潔なガラス製品にのみ、準備保管してくだ
さい。プラスチックボトルは決して使用しないでください。汚染物質がこれらのボトルから浸出し、
質量分析装置を汚染します。

• 洗浄液の汚染を避けるため、溶液は布またはスワブに浸して使用してください。

• 布の中心部分のみが質量分析装置の表面に触れるようにしてください。切れ端は、繊維を残す
可能性があります。

ヒント! 熱結合されたポリスワブの周りに布を巻きつけてください。

図 16-2 : 例：布の折り方

• クロスコンタミネーションを避けるために、布やスワブは表面に一度でも触れたものは、廃棄して
ください。

• 必要に応じて、カーテンプレートなど、真空インターフェースの大部分に複数のワイプを使用し
て、複数のクリーニングを実行します。
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• 水または洗浄液を塗布する場合は、布またはスワブをわずかに湿らせる程度にしてください。有
機溶剤より頻繁に使用される水は、質量分析装置の残留物が残り、布を劣化させる可能性があ
ります。

• アパチャを布でこすらないでください。アパチャから拭き取り布の繊維が質量分析装置に入らな
いようにアパチャの周辺を拭いてください。

• カーテンプレートまたはオリフィスプレートのアパチャにブラシを挿入しないでください。

質量分析装置の準備

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。

注意: ダメージを与える恐れ。イオン源を取り外す際、イオン源ドレインに何も落とさないでください。

図 16-3 : 真空インターフェースのイオン源ドレイン

1. ハードウェアプロファイルを無効化します。ソフトウェアユーザーガイドを参照してください。

2. イオン源を除去します。イオン源の取り外し を参照してください。

イオン源を使用しないときは、正確な動作を維持するために保護された場所に保管し、破損の
ないようにしてください。
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カーテンプレートのクリーニング

注意: ダメージを与える恐れ。カーテンプレートやオリフィスプレートのアパチャ（開口部）先端部を下
側にして置かないようにしてください。カーテンプレートの円錐側が上になっているかを確認します。

注意: ダメージを与える恐れ。アパチャ（開口部）の損傷を防ぐため、カーテンプレート、オリフィスプ
レート、またはインターフェースヒーターのアパチャ（開口部）にワイヤーや金属製のブラシを挿入し
ないでください。

1. 真空インターフェース部からカーテンプレートを取り外し、円錐面を上側にして、清潔かつ安定
した面に置きます。

図 16-4 : カーテンプレート取外し

カーテンプレートはオリフィスプレートに配置された 3 つの球状キャッチで保持されています。

ヒント! オリフィスプレートからカーテンプレートをすぐに取り外せないときには、少し回転させな
がら（90 度以下）取り外し、球状バネラッチを開放してみてください。

2. 糸くずの出ない布を LC-MS グレード水に浸し、カーテンプレートの両側を拭いてきれいにしま
す。

注: 必要なだけワイプを使います。

3. 洗浄液を使用して、手順 2 を繰り返します。

4. クリーニング液に浸したワイプまたは小型ポリスワブを使ってアパチャをクリーニングします。

5. カーテンプレートが乾くのを待ちます。

6. カーテンプレートに溶媒や糸くずの付着がないかを確認し、残留物がある場合、清潔で軽く濡ら
した糸くずの出ない布で拭いてください。

注: しつこい染みやほこりや水などの薄い膜が、溶媒が汚染されているサインとなります。
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オリフィスプレート前面のクリーニング

注意: ダメージを与える恐れ。オリフィスプレートの表面をクリーニングするときに、インターフェース
ヒーターを取り外さないでください。インターフェースヒーターを頻繁に取り外すと、損傷の原因となる
可能性があります。定期クリーニングの際に、インターフェースヒーター表面を清掃してください。

注意: ダメージを与える恐れ。アパチャ（開口部）の損傷を防ぐため、カーテンプレート、オリフィスプ
レート、またはインターフェースヒーターのアパチャ（開口部）にワイヤーや金属製のブラシを挿入し
ないでください。

1. 糸くずの出ない布を LC-MS グレード水に浸し、インターフェースヒーターを含むオリフィスプレ
ートの前面を拭きます。

2. 洗浄液を使用して、手順 1 を繰り返します。

3. オリフィスプレートが乾燥するまでお待ちください。

4. オリフィスプレートに溶媒や糸くずの付着がないかを確認し、残留物がある場合、清潔で軽く濡
らした糸くずの出ない布で拭いてください。

注: しつこい染みやほこりや水などの薄い膜が、溶媒が汚染されているサインとなります。

質量分析装置の運転再開

1. カーテンプレートを取り付けます。カーテンプレートのドットが 12 時の位置にあることを確認し、
オリフィスプレートの穴にアライメントピンを差し込みます。

2. イオン源を質量分析装置にインストールします。質量分析装置へのイオン源の取り付け を参
照してください。

イオン源ラッチをロッキングポジションまでねじこみ、イオン源をしっかり閉めます。

3. 質量分析装置が LC システムに接続されたら、LC システムとの接続すべてを復元します。

4. ハードウェアプロファイルを有効にします。ソフトウェアユーザーガイドを参照してください。

保管と取り扱い

警告! 環境の危険。システムコンポーネントを一般廃棄物として処分しないでください。
コンポーネントを処分する際は、現地規制に従います。

質量分析装置を長期保管するか、出荷の準備をする必要がある場合は、SCIEX FSE に使用停止
情報についてお問い合わせください。質量分析装置から電源を外す際は、AC 主電源から主電源コ
ネクタを取り外してください。

注: イオン源と質量分析装置は、 –30 °C〜+60 °C（–22°F〜140 °F）の温度および 99％ を超えな
い相対湿度（結露なし）で輸送および保管する必要があります。システムは、海抜 2,000 m（6,562
フィート）を超えない場所で保管します。
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粗引きポンプのオイルレベルの点検
粗引きポンプのオイルレベル確認窓を点検して、オイルが 低レベルを上回っていることを確認し
ます。

オイルが 低レベルを下回っている場合は、有資格保守要員（QMP）または SCIEX フィールドサ
ービスエンジニア（FSE）に連絡してください。

図 16-5 : オイルレベル確認窓

サービスおよびメンテナンス — イオン源
このセクションに示すすべてのメンテナンス手順には、次の警告が適用されます。

警告! 高温面の危険。メンテナンス手順を開始する前に、Turbo V のイオン源を少なく
とも 30 分そのままにして熱を下げます。操作中、イオン源の表面の一部と真空インタ
ーフェースが熱くなります。

警告! 火災および有害化学物質の危険。引火性液体を炎や火花に近づけないでくださ
い。また、通気口付化学ガス換気フードまたは安全キャビネットの中のみで使用してく
ださい。
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警告! 有害化学物質の危険があります。白衣、手袋、保護メガネなどの身体保護具を着用
して、皮膚や目を危険物質にさらさないようにします。

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。化学
物質の流出が発生した場合は、製品安全性データシートを参照し、詳細な指示を確認し
てください。イオン源付近にこぼれたものを掃除する前に、システムがスタンバイ状態で
あることを確認してください。適切な個人用防護具と吸着布を使用して、流出を食い止
め、現地規制に従い処分してください。

警告! 感電の危険。操作中、イオン源に印加された高電圧に触れないようにします。サ
ンプルチューブやイオン源付近の他の装置を調整する前に、システムをスタンバイ状
態にします。

警告! 尖った部分により怪我をする危険、イオン化放射線障害の危険、生物学的危
険、または有害化学物質の危険。イオン源のウィンドウがひび割れたり破損したりし
た場合、イオン源の使用を中止して、SCIEX フィールドサービスエンジニア（FSE）に
お問い合わせください。装置に入り込んだ有害物質や障害性物質は、イオン源排気
出力に混入します。装置からの排気は室外に換気してください。認定を受けたラボ
安全手順に従い、鋭利物を処分します。

注意: ダメージを与える恐れ。イオン源を片手で持ち上げたり、運んだりしないでください。イオン源
は、両手（イオン源の各面に 1 つ）で持ち上げたり持ち運んだりできるように設計されています。

このセクションには、一般的なイオン源のメンテナンス手順が記載されています。イオン源のクリー
ニングまたはメンテナンスを実施する頻度を決定するには、次のことを考慮してください。

• テスト対象の化合物

• サンプルの清浄度とサンプル調製方法

• 待機中プローブがサンプルを含有する時間量

• システム総稼働時間

これらの要素によって、イオン源の性能に変化が見られる可能性があり、メンテナンスの必要性を
示唆します。

取り付けたイオン源が質量分析装置に対して完全に密閉されており、ガス漏れの形跡がないことを
確認します。定期的に、イオン源とその接続部に漏れがないか点検します。イオン源コンポーネント
を定期的にクリーニングして、イオン源を良好な動作状態に保ちます。

注意: ダメージを与える恐れ。推奨されているクリーニング方法および材料のみを使用して、装置を
損傷から守ります。
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必要な資材

• 1/4 インチオープンエンドレンチ

• マイナスドライバー

• LC-MS グレードのメタノール

• LC-MS グレードの脱イオン水

• 安全メガネ

• 呼吸マスクおよびフィルター

• パウダーフリーグローブ（ニトリルまたはネオプレンを推奨）

• 白衣

イオン源の取り扱い

操作中はイオン源の表面が高温になります。次の図は、比較的温度の低い面（青）と、高温の状態
が長時間続く面（赤）を示しています。イオン源の使用中や取り外し中は、赤で表示されている面に
触れないでください。

図 16-6 : イオン源の熱い表面（赤＝熱い、灰色=温かい、青＝取り扱いに注意）

項目 説明

1 前
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項目 説明

2 背面

イオン源の取り外し

注: 質量分析装置がオフであるか、またはイオン源がシステムから取り外された場合には、5.3
L/min の窒素が流れ続けます。質量分析装置を使用していない間、窒素ガスの消費を 小限に抑
え、装置を清潔に保つには、質量分析装置に取り付けられたイオン源をそのままにし、システムの
電源をオンのままにしておきます。

イオン源はツールなしで素早く簡単に取り外しできます。イオン源のメンテナンスやプローブの交換
を実施する前に、質量分析装置からイオン源を必ず取り外します。

1. 実行中のスキャンを停止します。

2. サンプルストリームをオフにします。

3. ヒーターを使用している場合は、イオン源 Temperature を 0 に設定します。

4. イオン源が冷えるまで、少なくとも 30 分待ちます。

5. 接地継手部のサンプルチューブを外します。

6. 2 つのイオン源ラッチを 12 時の位置まで回して、イオン源を取り外します。

7. イオン源を真空インターフェースからそっと引き抜きます。

注: 真空インターフェースに取り付けられた O リングを紛失しないように注意します。

8. イオン源を清潔で安全な表面に置きます。

表面のクリーニング

警告! 感電の危険。続行する前に、質量分析装置からイオン源が完全に取り外され
ているかを確認します。

サンプルをこぼしたり、汚れた場合、イオン源の表面をクリーニングします。

実施前提手順

• イオン源の取り外し

水を湿らせた柔らかい布でイオン源の表面を拭きます。

プローブのクリーニング

サンプルに使用した化合物の種類に関係なく、イオン源を定期的にフラッシュします。フラッシュ操
作専用の制御ソフトウェアでメソッドを設定して行います。

1. 1:1 の水:アセトニトリルまたは 1:1 の水:メタノールの移動相に切り替えます。
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2. プローブポジションを調整して、オリフィスからできるかぎり遠ざけます。

3. 制御ソフトウェアで次のことを実行します。

a. MS メソッドを作成します。

b. イオン源の温度を 500 ° C と 600 °C の間に設定します。

c. イオン源ガス 1 とイオン源ガス 2 を 40 以上に設定します。

d. Curtain Gas インターフェースの流量をできるだけ大きな値に設定します。

4. 設定した温度に達するまで待機します。

5. プローブとサンプルチューブがくまなくフラッシュされているかを確認します。

プローブの取り外し

警告! 感電の危険。この手順を開始する前に、質量分析装置からイオン源を取り外し
ます。すべての電気安全作業規範を遵守します。

注意: ダメージを与える恐れ。電極チップ突出部またはコロナ放電ニードルがイオン源ハウジングに
一切触れないようにして、プローブを損傷から守ります。

実施前提手順

• イオン源の取り外し。

プローブはツールを使わずに素早く簡単に取り外せます。プローブを交換またはプローブのメンテナ
ンスを実施する前に、質量分析装置からイオン源を必ず取り外します。

1. サンプルチューブナットを緩めて、サンプルチューブをプローブから外します。

2. プローブをイオン源ハウジングに固定している止めリングを緩めます。

3. タワーからプローブをまっすぐ上にそっと引き上げます。

4. プローブを安全で清潔な表面に置きます。

電極の交換

警告! 感電の危険。この手順を開始する前に、質量分析装置からイオン源を取り外し
ます。すべての電気安全作業規範を遵守します。

警告! 尖った部分により怪我をする危険。電極を取り扱うときは注意してください。電極チッ
プは非常に尖っています。
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実施前提手順

• イオン源の取り外し。

• プローブの取り外し。

プローブには電極が含まれています。性能の低下が見られるときは電極を交換します。

注: 電極交換後には、システム性能に対する影響を評価します。

この手順は、両方のプローブに適用されます。

1. 電極調整ナットを取り外してから、電極を取り外します。

2. ばねがプローブ内に留まるように先端を下に向けてプローブを持ち、サンプルフィッティングを
PEEK 継手部に取り付けて、手できつく締めます。

図 16-7 : プローブ、拡大表示

項目 説明

1 電極調整ナット

2 1/4 インチ止めナット

3 ばね

4 止めリング

5 スプレーチューブ

6 電極チップ

7 電極チューブ

8 PEEK 継手部

3. プローブから PEEK 継手部と接続された電極チューブを引っ張ります。
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4. PEEK 継手部からサンプル継手を外します。

5. 1/4 インチオープンエンドレンチを使用して、PEEK 継手部内に電極チューブを固定している止
めナットを取り外します。

6. 電極チューブを止めナットから取り外します。

7. 新しい電極チューブを止めナットに挿入してから、PEEK 継手部に挿入します。

電極チューブが PEEK 継手部に可能な限り奥まで挿入されていることを確認してください。電
極チューブと継手部内部の接触箇所の間に隙間があると、デッドボリュームが生じることがあり
ます。

8. 止めナットを締めてください。

止めナットを斜めにねじ込んで途中でとまった状態にしたり、締めすぎないでください。チューブ
に漏れが生じることがあります。

9. ばねがプローブ内部にまだあることを確認して、電極調整ナットを締めます。

10. 電極チューブとスプレーチューブの狭い開口部の位置を合わせ、PEEK 継手部と接続した電
極チューブをプローブに挿入します。電極チューブを折り曲げないよう注意します。

11. 電極調整ナットを取り付けて締め付けます。

12. プローブを取り付けます。プローブの取り付けを参照してください。

13. イオン源を質量分析装置にインストールします。イオン源の取り付けを参照してください。

14. サンプルチューブを接続します。イオン源チューブの接続を参照してください。

15. 電極チップ拡張部を調整します。TurboIonSpray プローブポジションの 適化または APCI プ
ローブポジションの 適化を参照してください。

コロナ放電ニードルの交換

警告! 感電の危険。この手順を開始する前に、質量分析装置からイオン源を取り外し
ます。すべての電気安全作業規範を遵守します。

警告! 尖った部分により怪我をする危険。ニードルの取り扱いは慎重に行います。ニードル
チップは非常に尖っています。

実施前提手順

• イオン源の取り外し.

• プローブの取り外し.

コロナ放電ニードルチップが腐食すると、手で取り外せなくなることがあります。取り外せない場合
は、ニードルチップを切断して取り除き、コロナ放電ニードル全体を交換します。

1. イオン源を回転して、開口部にアクセスしやすいようにします。
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図 16-8 : コロナ放電ニードル

項目 説明

1 排気チムニー

2 セラミックスリーブ

3 コロナ放電ニードルチップ

2. 片手の親指と人差し指でコロナ放電ニードル調整ネジをつまみ、もう一方の手でコロナ放電ニ
ードルを持って、コロナ放電ニードルチップを反時計回りに回して緩め、ゆっくりと取り外しま
す。イオン源コンポーネントを参照してください。

3. コロナ放電ニードルをゆっくりと下ろし、排気チムニーを通して取り除きます。

4. 排気チムニーから新しいニードルを入れ、セラミックスリーブに可能な限り奥まで挿入します。

5. 新しいチップを片方の手の親指と人差し指でつまみ、もう一方の手でコロナ放電ニードル調整
ネジを持って、コロナ放電ニードルチップを時計回りに回し、チップを取り付けます。

6. プローブを挿入して、イオン源を質量分析装置にインストールします。イオン源の取り付けを参
照してください。
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サンプルチューブの交換

警告! 感電の危険。この手順を開始する前に、質量分析装置からイオン源を取り外し
ます。すべての電気安全作業規範を遵守します。

実施前提手順

• サンプルフローを停止し、残留ガスがイオン源排気システムから除去されたことを確認します。

• イオン源を除去します。 イオン源の取り外しを参照してください。

サンプルチューブに詰まりがある場合、次の手順で交換します。

1. プローブと接地継手部からサンプルチューブを取り外します。

2. サンプルチューブを適切な長さのチューブと交換し、適切なチューブカッターで切断します。 イ
オン源チューブの接続を参照してください。

3. イオン源を取り付けます。イオン源の取り付けを参照してください。

4. サンプルフローを開始します。
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質量分析装置のトラブルシューティング 17
本項には、システム問題のトラブルシューティングのための情報が含まれています。特定の作業
は、ラボで SCIEX のトレーニングを受講した、有資格保守要員（QMP）のみが行うことができます。
高度なトラブルシューティングについては、SCIEX フィールドサービスエンジニア（FSE）にお問い合
わせください。

表 17-1 : システムの問題

症状 考えられる原因 修正アクション

QJet イオンガイドが極度に汚
れているか、頻繁に汚れます。

Curtain Gas インターフェース
のガス流量が少なすぎます。

Curtain Gas インターフェース
のガスの設定を点検し、必要に
応じて増加します。

真空圧力が高すぎるために、
システムエラーが発生しまし
た。

1. オイルレベルが低すぎま
す。

2. 液漏れがあります。

3. 誤ったオリフィスプレートが
設置されています。

1. 粗引きポンプのオイルレベ
ルを点検し、現地の QMP
または FSE に連絡してオ
イルを追加してください。
粗引きポンプのオイルレベ
ルの点検を参照してくださ
い。

2. 点検して液漏れを修理し
てください。

3. 正しいオリフィスプレートを
設置してください。

QPS エキサイタモジュールの
温度が高すぎるために、システ
ムエラーが発生しました。

1. 質量分析装置のエアフィ
ルターが詰まっています。

2. コイルボックスが調整され
ていません。

3. 室温が高すぎます。

1. お近くの有資格保守要員
（QMP）またはフィールド
サービスエンジニア（FSE）
にお問い合わせください。

2. 周囲温度の仕様について
は、システムの設置計画
概要書を参照してくださ
い。
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表 17-1 : システムの問題 (続き)

症状 考えられる原因 修正アクション

制御ソフトウェアによって、イオ
ン源が原因で質量分析装置が
故障状態にあると報告されま
す。

1. プローブが取り付けられて
いません。

2. プローブがしっかりと接続
されていません。

デバイス詳細ページの状態パ
ネルで故障を確認してくださ
い。

1. プローブを取り付けます。
プローブの取り付け を参
照してください。

2. プローブを取り外してから
取り付けます。止めリング
をしっかりと締めます。プロ
ーブの取り外し および プ
ローブの取り付け を参照
してください。

制御ソフトウェアは、APCI プロ
ーブが使用中でも、
TurboIonSpray プローブが取
り付けられていることを示して
います。

F3 ヒューズが飛びました。 フィールドサービスエンジニア
（FSE）にお問い合わせくださ
い。

スプレー噴射が均一ではありま
せん。

電極が詰まっています。 電極をクリーニングまたは交換
します。電極の交換 を参照して
ください。

インターフェースヒーターの準
備ができていません。

インターフェースヒーターが故
障しています。

お近くの有資格保守要員
（QMP）またはフィールドサービ
スエンジニア（FSE）にお問い
合わせください。

質量分析装置の分解能が低い
です。

質量分析装置が調整されてい
ません。

Instrument Optimization ウィ
ザードを使用して、質量分析装
置を 適化します。 ソフトウェ
アユーザーガイドまたはヘルプ
を参照してください。

質量分析装置のトラブルシューティング

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
235/293



表 17-1 : システムの問題 (続き)

症状 考えられる原因 修正アクション

質量分析装置の性能が低下し
ています。

1. イオン源状態が 適化さ
れていません。

2. サンプルが正しく用意され
なかったか、サンプルが劣
化しています。

3. サンプルインレット継手に
漏れがあります。

1. イオン源状態を 適化しま
す。TurboIonSpray プロ
ーブポジションの 適化
または APCI プローブポジ
ションの 適化 を参照し
てください。

2. サンプルが適切に用意さ
れたことを確認します。

3. 継手が正しいサイズとタイ
プであることを確認し、そ
れらがしっかりと締められ
ていることを確認します。
継手を締め付けすぎない
でください。漏れが続く場
合、継手を交換します。

4. 代替イオン源をインストー
ルして 適化します。

5. 問題が解決しない場合
は、フィールドサービスエ
ンジニア（FSE）にお問い
合わせください。

アーク放電またはスパーク放
電が発生します。

コロナ放電ニードルのポジショ
ンが正しくありません。

TurboIonSpray プローブが使
用中の場合は、コロナ放電ニ
ードルをカーテンプレートの方
に向けて、ヒーターガスの蒸気
から遠ざけます。コロナ放電ニ
ードルのポジションの調整 を参
照してください。

表 17-2 : 感度の問題

考えられる原因 修正アクション

感度が低下

イオン源パラメータが 適化されていません。 イオン源パラメータを 適化します。

質量分析装置が 適化されていません。 Instrument Optimization ウィザードを使用し
て、質量分析装置を 適化します。

カーテンプレートが汚れています。 カーテンプレートのクリーニングを行います。　カ
ーテンプレートのクリーニングを参照してくださ
い。
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表 17-2 : 感度の問題 (続き)

考えられる原因 修正アクション

オリフィスプレートが汚れています。 オリフィスプレート前面のクリーニングを参照す
るか、または現地の QMP か FSE に連絡してく
ださい。

QJet イオンガイドまたは IQ0 レンズが汚れてい
ます。

QJet イオンガイドと IQ0 レンズのクリーニング
を行います。お近くの有資格保守要員（QMP）
またはフィールドサービスエンジニア（FSE）にお
問い合わせください。

Q0 領域が汚れています。 Q0 領域の汚染についてテストします。お近くの
有資格保守要員（QMP）またはフィールドサー
ビスエンジニア（FSE）にお問い合わせください。

シリンジまたはサンプル通路に漏れがありま
す。

漏れがないかシリンジまたはサンプルラインを
点検し漏れが見つかった場合はそれを修理しま
す。すべての継手が正しいタイプとサイズである
ことを確認します。

サンプルが劣化、またはサンプル濃度が低い。 サンプル濃度を確認します。新しいサンプルを
使用します。

プローブが正しく取り付けられていません。 プローブを取り外して取り付けます。

イオン源が正しく取り付けられていないか故障し
ています。

ラッチが正しく固定されていることを確認しなが
ら、イオン源を取り外して取り付けます。これで
問題が解決されない場合、代替イオン源を取り
付けて 適化します。

真空インターフェースの 1 つ以上の O リングが
ありません。

イオン源に O リングがある場合、それらを真空
インターフェースに取り付けます。それらを紛失
した場合、交換します。

LC システムまたは接続に問題があります。 LC システムの問題を解決します。

デクラスタリング電位（DP）が 適化されていま
せん。

DP を 適化します。

電極が汚れているか、塞がれています。 電極を交換します。電極の交換 を参照してくだ
さい。

信号がないか、信号が不安定です。

チューブが詰まっています。 サンプルチューブを交換します。イオン源チュー
ブの接続 を参照してください。
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表 17-3 : バックグラウンドノイズの問題

考えられる原因 修正アクション

Temperature (TEM)、IonSpray 電圧（IS）、ま
たはヒーターガス流量（GS2）が高すぎます。

イオン源パラメータを 適化します。
TurboIonSpray プローブの 適化 または
APCI プローブの 適化 を参照してください。

シリンジまたはサンプル通路が汚れています。 シリンジまたはサンプル通路をクリーニングまた
は交換します。

カーテンプレートが汚れています。 カーテンプレートのクリーニングを行います。カ
ーテンプレートのクリーニングを参照してくださ
い。

オリフィスプレートが汚れています。 オリフィスプレートの前面のクリーニングを行い
ます。オリフィスプレート前面のクリーニングを参
照してください。

QJet イオンガイドまたは IQ0 レンズが汚れてい
ます。

質量分析装置のフロントエンドコンポーネントの
フルクリーニングを行います。お近くの有資格保
守要員（QMP）またはフィールドサービスエンジ
ニア（FSE）にお問い合わせください。

Q0 領域が汚れています。 Q0 領域のクリーニングを行います。有資格保
守要員（QMP）またはフィールドサービスエンジ
ニア（FSE）にお問い合わせください。

移動相が汚染されています。 移動相を交換します。

イオン源が汚染されています。 イオン源コンポーネントをクリーニングするか交
換してからイオン源とフロントエンドを次のように
調整します。
1. プローブを開口部から垂直および水平方向

に も離れた位置に移動します。

2. （Analyst MD ソフトウェア）インターフェース
ヒーターの電源が入っていることを確認しま
す。

3. ポンプ流量 1 mL/ 分でメタノール：水（50：
50）を注入します。

4. 制御ソフトウェアで、温度を 650、イオン源

ガス 1 〜 60、イオン源ガス 2 〜 60 に設

定します。

5. Curtain Gas インターフェースのガス流量
を 45 または 50 に設定します。

6. 良の結果を得るには、 低 2 時間、でき
れば一晩中実行してください。
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販売、技術サポートまたはサービスについては、フィールドサービスエンジニア（FSE）にお問い合
わせいただくか、SCIEX のウェブサイト（sciex.com）のお問い合わせ情報をご覧ください。
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SCIEX 4500MD システムのパラメータ A
次の表には、SCIEX 4500MD システムの一般的なパラメータが含まれています。各スキャンタイプ
の 初の数字はあらかじめ設定された値です。数字の範囲は、各パラメータの許容範囲です。

表 A-1 : Triple Quadrupole スキャンタイプのシステムパラメータ

アクセス ID 正イオンモード 負イオンモード

Q1 Q3 MS/MS Q1 Q3 MS/MS

CUR3 4 20

10 ～ 55

20

10 ～ 55

20

10 ～ 55

20

10 ～ 55

20

10 ～ 55

20

10 ～ 55

CAD5 0

固定

6

固定

中

低、中、高

0

固定

6

固定

中

低、中、高

CAD6 0

固定

5

固定

9

0 ～ 12

0

固定

5

固定

9

0 ～ 12

IS3 4 5500

0 ～ 5500

5500

0 ～ 5500

5500

0 ～ 5500

–4500

–4500 ～ 0

–4500

–4500 ～ 0

–4500

–4500 ～ 0

NC7 3

0 ～ 5

3

0 ～ 5

3

0 ～ 5

–3

–5 ～ 0

–3

–5 ～ 0

–3

–5 ～ 0

TEM 4 7 0

0 ～ 750

0

0 ～ 750

0

0 ～ 750

0

0 ～ 750

0

0 ～ 750

0

0 ～ 750

DP5 200

0 ～ 300

100

0 ～ 300

100

0 ～ 300

-100

–300 ～ 0

-100

–300 ～ 0

-100

–300 ～ 0

DP6 130

0 ～ 300

130

0 ～ 300

120

0 ～ 300

–60

–300 ～ 0

–60

–300 ～ 0

–150

–300 ～ 0

3 Turbo V イオン源
4 TurboIonSpray プローブ
5 QTRAP 4500MD システム
6 SCIEX Triple Quad 4500MD システム
7 APCI プローブ

SCIEX 4500MD システムのパラメータ

SCIEX 4500MD システム
240/293

システムユーザーガイド
IVD-IDV-05-6996-JA-D



表 A-1 : Triple Quadrupole スキャンタイプのシステムパラメータ (続き)

アクセス ID 正イオンモード 負イオンモード

EP 10

2 ～ 15

10

2 ～ 15

10

2 ～ 15

–10

–15 ～ –2

–10

–15 ～ –2

–10

–15 ～ –2

CEM5 1800

0 ～ 3300

1800

0 ～ 3300

1800

0 ～ 3300

1800

0 ～ 3300

1800

0 ～ 3300

1800

0 ～ 3300

CEM6 2000

0 ～ 3300

2000

0 ～ 3300

2000

0 ～ 3300

2000

0 ～ 3300

2000

0 ～ 3300

2000

0 ～ 3300

GS15 20

0 ～ 90

20

0 ～ 90

20

0 ～ 90

20

0 ～ 90

20

0 ～ 90

20

0 ～ 90

GS16 15

0 ～ 90

15

0 ～ 90

15

0 ～ 90

15

0 ～ 90

15

0 ～ 90

15

0 ～ 90

GS2 0

0 ～ 90

0

0 ～ 90

0

0 ～ 90

0

0 ～ 90

0

0 ～ 90

0

0 ～ 90

CE5 該当なし 該当なし 30

5 ～ 180

該当なし 該当なし -30

–180 ～ –5

CE6 該当なし 該当なし 53

5 ～ 180

該当なし 該当なし –40

–180 ～ –5

CXP5 該当なし 15

0 ～ 55

15

0 ～ 55

該当なし –15

–55 ～ 0

–15

–55 ～ 0

CXP6 該当なし 9

0 ～ 55

27

0 ～ 55

該当なし –17

–55 ～ 0

–12

–55 ～ 0

表 A-2 : LIT スキャンタイプのシステムパラメータ（QTRAP 専用）

アクセス ID 正イオンモード 負イオンモード

CUR3 4 7 20

10 ～ 55

20

10 ～ 55
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表 A-2 : LIT スキャンタイプのシステムパラメータ（QTRAP 専用） (続き)

アクセス ID 正イオンモード 負イオンモード

CAD 高

低、中、高

高

低、中、高

IS3 5500

0 ～ 5500

–4500

–4500 ～ 0

NC7 3

0 ～ 5

–3

–5 ～ 0

TEM4 7 0

0 ～ 750

0

0 ～ 750

DP 100

0 ～ 300

-100

–300 ～ 0

EP 10

2 ～ 15

–10

–15 ～ –2

AF2 0.100

0 または 1

0.100

0 または 1

AF3 質量速度依存

0 ～ 10

質量速度依存

0 ～ 10

EXB 質量速度依存

–165 ～ 0

質量速度依存

0 ～ 165

CEM 1800

0 ～ 3300

1800

0 ～ 3300

GS1 20

0 ～ 90

20

0 ～ 90

GS2 0

0 ～ 90

0

0 ～ 90
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表 A-2 : LIT スキャンタイプのシステムパラメータ（QTRAP 専用） (続き)

アクセス ID 正イオンモード 負イオンモード

CES 0

0 ～ 50

0

0 ～ 50

CE 10

5 ～ 180

-30

-180～-10
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イオン源パラメータおよび電圧 B
TurboIonSpray プローブのパラメータ
次の表に、TurboIonSpray プローブの推奨される操作条件を 3 通りの流量別に示します。各流量
に対して、Curtain Gas インターフェースのガス流量ができる限り多くなるようにします。 適化に使
用された溶媒組成は、水: アセトニトリル (1:1) です。これらの条件は、プローブの 適化の開始地
点を示しています。反復プロセスを使用して、フローインジェクション分析を使用するパラメータを
適化して、対象の化合物の 良のシグナル対ノイズ比を達成します。

表 B-1 : TurboIonSpray プローブのパラメータの 適化

パラメータ 標準値 動作範囲

低 中 高

LC 流量 5 µL/ 分～
50 µL/ 分

200 mL/ 分 1,000 µL/ 分 5 µL/ 分～
3,000 µL/ 分

イオン源ガス 1（ネブラ
イザガス）

20 psi ～
40 psi

40 psi ～ 60 psi 40 psi ～ 60 psi 0 psi ～ 90 psi

イオン源ガス 2（ヒータ
ーガス）

0 psi 50 psi 50 psi 0 psi ～ 90 psi

IonSpray Voltage 5500 V 5500 V 5500 V 5500 V

Curtain Gas インターフ
ェースのガス

20 psi 20 psi 20 psi 20 psi ～ 50 psi

イオン源温度 8 周囲温度
～ 200 ºC

200 ºC ～ 650
ºC

400 ºC ～ 750
ºC

大 750 ºC

デクラスタリング電位
（DP）9

正：70 V

負：–70 V

正：70 V

負：–70 V

正：100 V

負：–100 V

正：0 V ～ 400 V

負：–400 V ～0 V

プローブ垂直型マイクロ
メータ設定

7 ～ 10 2 ～ 5 0 ～ 2 0 ～ 13

プローブ水平マイクロメ
ータ設定

4 ～ 6 4 ～ 6 4 ～ 6 0 ～ 10

8 適な温度値は化合物と移動相の組成によって異なります。水分含有量が多いほど、温度を高くする必要があり
ます。ゼロ（0）は、加熱されていないことを意味します。

9 DP 値は化合物によって異なります。
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APCI プローブのパラメータ
表 B-2 : APCI プローブのパラメータ 適化

パラメータ 標準値 動作範囲

LC 流量 1,000 µL/min 200 µL/min ～ 3,000 µL/min

イオン源 ガス 1 （ネブライザガ
ス）

30 psi 0 psi ～ 90 psi

Curtain Gas インターフェース
のガス

20 psi 20 psi ～ 50 psi

イオン源温度 10 400 ºC 100 ºC ～ 750 ºC

ネブライザ電流 正：3 µA

負：–3 µA

正：0 mA ～ 5 µA

負：-5 mA ～ 0 µA

デクラスタリング電位（DP） 正：60 V

負：-60 V

正：0 V ～ 300 V

負：-300 V ～ 0 V

プローブ垂直型マイクロメータ
設定

4 目盛 0 ～ 13

プローブポジション
プローブポジションは分析感度に影響を及ぼします。プローブポジションを 適化する方法に関する
詳細は、イオン源の 適化を参照してください。

溶媒組成
ギ酸アンモニウムまたは酢酸アンモニウムの標準濃度は、正イオンで 2 mmol/L ～ 10 mmol/L
で、負イオンで 2 mmol/L ～ 50 mmol/L です。有機酸の濃度は、体積で 0.1% ～ 0.5%
（TurboIonSpray プローブの場合）、または体積で 0.1% ～ 1.0%（APCI プローブの場合）です。

広く使われている溶媒は、次のとおりです。

• アセトニトリル

• メタノール

• プロパノール

• 水

広く使われているモディファイヤーは、次のとおりです。

• 酢酸

10 温度値は化合物によって異なります。
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• ギ酸

• ギ酸アンモニウム

• 酢酸アンモニウム

次のモディファイヤーは、そのイオン混合物とクラスタの組み合わせで、スペクトルを複雑化させる
ため、あまり使用されません。また、ターゲット化合物のイオンシグナル強度を抑制する場合もあり
ます。

• トリエチルアミン（TEA）

• リン酸ナトリウム

• トリフルオロ酢酸（TFA）

• ドデシル硫酸ナトリウム
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キャリブレーションイオンと溶液 C
注意: 結果が不正確になる可能性。期限切れの溶液や、指定された保管温度で保管されていない溶液は使用しないでください。

表 C-1 : チューニング頻度

キャリブレーション 分解能の 適化

スキャンタイプ 頻度 手動/自動 頻度 手動/自動

Q1 および Q3 3～6 か月 両方 3～6 か月 両方

LIT 2 週間ごと、必要に応じて 両方 3～6 か月 自動のみ

表 C-2 : 4500MD 装置シリーズ用の推奨チューニング溶液

システム Q1 および Q3 LIT

正 負 正および負

SCIEX Triple Quad 4500MD LC-
MS/MS system

POS PPG, 2e-6 M NEG PPG, 3e-4 M 該当なし

QTRAP 4500MD LC-MS/MS
system

POS PPG, 2e-6 M NEG PPG, 3e-4 M ES Tuning Solution (1:100
dilution)
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表 C-3 : Q1 および Q3 での PPG 正イオンスキャン

MS 装置 質量

SCIEX Triple Quad 4500MD LC-
MS/MS ステム

59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

QTRAP 4500MD LC-MS/MS システム 59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

表 C-4 : Q1 および Q3 での PPG 負イオンスキャン

MS 装置 質量

SCIEX Triple Quad 4500MD LC-MS/MS
ステム

45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

QTRAP 4500MD LC-MS/MS システム 45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

表 C-5 : QTRAP 4500MD LC-MS/MS システム（Agilent）

装置/極性 質量

LIT 正 118.087 322.049 622.030 922.010 1521.972

LIT 負 112.985 431.982 601.978 1033.988 1633.949
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ツールバーアイコン D
ツールバーアイコンを追加するには、上級ユーザーガイドを参照してください。

表 D-1 : ツールバーアイコン

アイコン 名称 説明

New Subproject サブプロジェクトを作成します。Subprojects は、元々のプ
ロジェクトがサブプロジェクトを伴って作成されていた場合
にのみ、以後のプロセスにおいて作成されます。

Copy
Subproject

サブプロジェクトフォルダをコピーします。

サブプロジェクトは、現存するサブプロジェクトを持つ別の
プロジェクトからのみコピーが可能です。プロジェクトおよ
びサブプロジェクトレベルで同じフォルダが存在した場合、
ソフトウェアはプロジェクトレベルのフォルダを使用しま
す。

表 D-2 : 測定メソッドエディタアイコン

アイコン 名称 説明

Mass Spec MS タブが Acquisition Method エディタに表示されます。

Period 実験、IDA Criteria Level を追加したり、期間を削除した
りします。

Autosampler Autosampler Properties タブを開きます。

Syringe Pump Syringe Pump Properties タブを開きます。

Column Oven Column Oven Properties タブを開きます。

Valve Valve Properties タブを開きます。

DAD DAD Method Editor を開きます。Show DAD Data を参
照してください。

ADC ADC Properties タブを開きます。ACD データの表示を参
照してください。
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表 D-3 : 測定モードアイコン

アイコン 名称 説明

View Queue サンプルキューを表示します。

Instrument
Queue

リモート機器ステーションを表示します。

Status for
Remote
Instrument

リモート機器のステータスを表示します。

Start Sample キュー内のサンプルを開始します。

Stop Sample キュー内のサンプルを停止します。

Abort Sample サンプル処理の途中で、そのサンプル測定を中断しま
す。

Stop Queue すべてのサンプル処理を完了する前にキューを停止しま
す。

Equilibrate デバイスの平衡化に使用するメソッドを選択します。このメ
ソッドはキューの 初のサンプルで使用されたものと同一
でなければなりません。

Standby 装置を Standby 状態にします。

Ready 装置を Ready 状態にします。

Reserve
Instrument for
Tuning

質量分析装置のチューニングおよびキャリブレーションの
準備を行います。

IDA Method
Wizard

IDA Method Wizard を開始します。

アイコン 名称 説明

Calibrate from
spectrum

Mass Calibration Option ダイアログを開き、使用可能な
スペクトルを使用して質量分析装置のキャリブレーション
を行います。

Manual Tune Manual Tune Editor を開きます。

Compound
Optimization

FIA による注入を用いて化合物を 適化します。
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アイコン 名称 説明

Instrument
Optimization

機器のパフォーマンス確認、質量較正の調整、質量分析
装置の設定調整を行います。

View Queue サンプルキューを表示します。

Instrument
Queue

リモート機器を表示します。

Status for
Remote
Instrument

リモート機器のステータスを表示します。

Reserve
Instrument for
Tuning

装置のチューニングおよびキャリブレーションの準備を行
います。

IDA Method
Wizard

IDA Method Wizard を開始します。

表 D-4 : Explore クイックリファレンス：クロマトグラムとスペクトル

アイコン 名称 説明

Open Data File ファイルを開きます。

Show Next
Sample

次のサンプルに移動します。

Show Previous
Sample

前のサンプルに移動します。

Go To Sample Select Sample ダイアログを開きます。

List Data データを表形式で表示します。

Show TIC スペクトルから TIC を生成します。

Extract Using
Dialog

質量を選択してイオンを抽出します。

Show Base
Peak
Chromatogram

ベースピーククロマトグラフィー（BPC）を生成します。

Show Spectrum TIC からスペクトルを生成します。

Copy Graph to
new Window

有効なグラフを新規ウィンドウにコピーします。

ツールバーアイコン

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
251/293



表 D-4 : Explore クイックリファレンス：クロマトグラムとスペクトル (続き)

アイコン 名称 説明

Baseline
Subtract

Baseline Subtract ダイアログを開きます。

Threshold しきい値を調整します。

Noise Filter Noise Filter Options ダイアログを表示し、ピークの 小
幅を定義できます。この 小幅以下のシグナルが、ノイズ
として認識されます。

Show ADC ADC データを表示します。

Show Auxiliary
Traces

Select Auxiliary Trace Channel ダイアログを開きます

Show File Info データ収集に用いる実験条件を表示します。

Add arrows 有効なグラフの X 軸に矢印を追加します。

Remove all
arrows

有効なグラフの X 軸から矢印を消去します。

Offset Graph ADC データと質量分析装置データが記録された時間の
わずかな差異を相殺します。複数のグラフを重ねて比較
する際に便利です。

Force Peak
Labels

すべてのピークをラベル化します。

Expand
Selection By

グラフの一部をより詳細に閲覧するための拡大率を設定
します。

Clear ranges 拡大選択をクリアし、通常の倍率に戻します。

Set Selection 選択した部分の開始および停止ポイントを定義します。カ
ーソルで領域選択を行うことで、より正確に選択部分を定
義することができます。

Normalize To
Max

グラフを 大サイズに設定し、 も強力なピークを 大ス
ケールに視覚化します。

Show History スムージング、減算、キャリブレーション、ノイズフィルタリ
ングなど、特定のファイルで実行されたデータ処理の概要
を表示します。

Open
Compound
Database

化合物データベースを開きます。

Set Threshold しきい値を調整します。
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表 D-4 : Explore クイックリファレンス：クロマトグラムとスペクトル (続き)

アイコン 名称 説明

Show Contour
Plot

スペクトルグラフまたは XIC の形で、選択されたデータを
表示します。また、DAD で取得されたデータの場合、等高
線図上のデータは DAD スペクトルまたは XWC の形で
表示されます。

Show DAD
TWC

DAD スペクトルの TWC を生成します。

Show DAD
Spectrum

DAD スペクトルを生成します。

Extract
Wavelength

DAD スペクトルから、XWC を閲覧するための波長範囲
を 3 つまで抽出します。

表 D-5 : Explore ツールバーのクイックリファレンス：グラフの重ね表示

アイコン 名称 説明

Home Graph グラフを元のスケールに戻します。

Overlay グラフを重ねて表示します。

Cycle Overlays 重ねられたグラフ間で表示が切り替わります。

Sum Overlays グラフが 1 つに統合されます。

表 D-6 : Explore ツールバーのクイックリファレンス：フラグメント解釈ツール

アイコン 名称 説明

Show Fragment
Interpretation
Tool

Fragment Interpretation ツールが開きます。このツール
では .mol ファイルをもとに、単結合 / 非環状結合の開裂
フラグメントが算出されます。

表 D-7 : Explore ツールバーのナビゲーションアイコン

アイコン 名称 機能

Open File ファイルを開きます。

Show Next
Sample

次のサンプルに移動します。

Show Previous
Sample

前のサンプルに移動します。
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表 D-7 : Explore ツールバーのナビゲーションアイコン (続き)

アイコン 名称 機能

GoTo Sample Select Sample ダイアログを開きます。

List Data データを表形式で表示します。

Show TIC スペクトルから TIC を生成します。

Extract Using
Dialog

クリックすると、質量を選択することでイオンを抽出できま
す。

Show Base
Peak
Chromatogram

ベースピーククロマトグラフィー（BPC）を生成します。

Show Spectrum TIC からスペクトルを生成します。

Copy Graph to
new Window

有効なグラフを新規ウィンドウにコピーします。

Baseline
Subtract

Baseline Subtract ダイアログを開きます。

Threshold しきい値を調整します。

Noise Filter ピークの 小幅を定義する Noise Filter Options ダイア
ログを開きます。この 小幅以下のシグナルが、ノイズと
して認識されます。

Show ADC ADC データを表示します。

Show Auxiliary
Traces

Select Auxiliary Trace Channel ダイアログを開きます

Show File Info データ収集に用いる実験条件を表示します。

Add arrows 有効なグラフの X 軸に矢印を追加します。

Remove all
arrows

有効なグラフの X 軸から矢印を消去します。

Offset Graph ADC データと質量分析装置データが記録された時間の
わずかな差異を相殺します。複数のグラフを重ねて比較
する際に便利です。

Force Peak
Labels

すべてのピークをラベル化します。
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表 D-7 : Explore ツールバーのナビゲーションアイコン (続き)

アイコン 名称 機能

Expand
Selection By

グラフの一部をより詳細に閲覧するための拡大率を設定
します。

Clear ranges 拡大選択をクリアし、通常の倍率に戻します。

Set Selection 選択した部分の開始および停止ポイントを設定します。カ
ーソルを用いて領域を強調表示することで、より正確に選
択部分を指定できます。

Normalize to
Max

グラフのスケールを 大化します。これにより、（表示され
ているかどうかに関係なく） も強いピークがフルスケー
ルで表示されます。

Show History スムージング、減算、キャリブレーション、ノイズフィルタリ
ングなど、特定のファイルで実行されたデータ処理の概要
を表示します。

Open
Compound
Database

化合物データベースを開きます。

Set Threshold しきい値を調整します。

Show Contour
Plot

スペクトルグラフまたは XIC の形で、選択されたデータを
表示します。また、DAD で取得したデータについては、選
択したデータを等高線図に DAD スペクトルまたは XWC
形式で表示することも可能です。

Show DAD
TWC

DAD の TWC を生成します。

Show DAD
Spectrum

DAD スペクトルを生成します。

Extract
Wavelength

DAD スペクトルから、XWC を閲覧するための波長範囲
を 3 つまで抽出します。

表 D-8 : 解析タブと定量化ウィザードアイコン

アイコン 名称 説明

Set parameters
from
Background
Region

選択されたピークを使用します。

ツールバーアイコン

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
255/293



表 D-8 : 解析タブと定量化ウィザードアイコン (続き)

アイコン 名称 説明

Select Peak 選択されたバックグラウンドを使用します。

Manual
Integration
Mode

ピークを手動で解析します。

Show or Hide
Parameters

ピーク検出パラメータの表示 / 非表示を切り替えます。

Show Active
Graph

分析試料のクロマトグラムのみを表示します。

Show Both
Analyte and IS

分析試料とそれに関連するクロマトグラムを表示します。
この機能は、関連する内部標準が存在する場合にのみ使
用できます。

Use Default
View for Graph

プリセットビュー（すべてのデータを表示）に戻します。ユ
ーザーがクロマトグラムフを拡大していた場合などに使用
します。

表 D-9 : 結果表アイコン

アイコン 名称 説明

Sort Ascending
by Selection

選択したカラムを昇順にソートします。

Sort
Descending by
Selection

選択したカラムを降順にソートします。

Lock Or Unlock
Column

選択した列をロックまたはロックを解除します。ロックされ
た列は移動できません。

Metric Plot By
Selection

選択したカラムからメトリックプロットを作成します。

Show all
Samples

Results Table のすべてのサンプルを表示します。

Delete Formula
Column

数式列を削除します。

Report
Generator

Reporter ソフトウェアを開きます。
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表 D-10 : アイコンのクイックリファレンス：定量化モード

アイコン 名称 説明

Add/Remove
Samples

Results Table からサンプルを追加および削除します。

Export as Text Results Table をテキストファイルで保存します。

Modify Method wiff ファイルを開きます。

Peak Review -
Pane

ピークをペインで開きます。

Peak Review -
Window

ピークをウィンドウで開きます。

Calibration -
Pane

キャリブレーションカーブをペインで開きます。

Calibration -
Window

キャリブレーションカーブをウィンドウで開きます。

Show First
Peak

初のピークをペインまたはウィンドウに表示します。

Show Last
Peak

後のピークをペインまたはウィンドウに表示します。

Show Audit
Trail

Results Table の監査証跡を表示します。

Clear Audit
Trail

Results Table の監査証跡を消去します。この機能は使
用できません。

Statistics Statistics ウィンドウを開きます。

Report
Generator

Reporter ソフトウェアを開きます。

表 D-11 : 測定モードアイコン

アイコン 名称 機能

Start Sample クリックして、キュー内のサンプルの処理を開始します。

Stop Sample クリックして、キュー内のサンプルの処理を停止します。
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表 D-11 : 測定モードアイコン (続き)

アイコン 名称 機能

Equilibrate クリックして、質量分析装置の平衡化に用いるメソッドを選
択します、選択対象として、イオン源、LC カラム（使用して
いる場合）、すべての周辺装置が表示されます。このメソ
ッドはキューの 初のサンプルで使用されたものと同一で
なければなりません。
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動作原理 — イオン源 E
エレクトロスプレーイオン化モード
プローブの両側にそれぞれ 45 度の角度で配置されている 2 つのターボヒーターがあり、その中央
部にプローブはあります。ターボヒーターからの加熱ドライガスとスプレーの混成物が、カーテンプレ
ートのアパチャに対して 90 度の角度で発射されます。

液体溶媒でイオン化する化合物のみを、イオン源の気相イオンとして生成することができます。イオ
ン生成の効率牲および割合は、特定のイオンの溶媒和エネルギーに左右されます。溶媒和エネル
ギーの低いイオンは、溶媒和エネルギーの高いイオンよりも蒸発する可能性が高くなります。

IonSpray Voltage とターボヒーターの相互作用により、ストリームが収束され、液滴の蒸発速度が
速くなるため、結果としてイオンシグナルが増加します。加熱されたガスによりイオン蒸発効率が高
まるため、感度が向上し、処理できる液体サンプル流量が増加します。

ネブライザガスの高速流量で、IonSpray Voltage 注入口の液体サンプルストリームの液滴がせん
断されます。スプレーに印加された可変高圧を使用して、イオン源が各液滴に正味荷電を加えま
す。この電荷が液滴の拡散を助けます。単極イオンは、液体ストリームから分離されているため、高
電圧によって優先的に液滴内に引き込まれます。ただし、この分離は完全なものではないため、各
液滴に両極イオンが数多く含まれます。単極イオンが各液滴で支配的ですが、陽イオンと陰イオン
の数の差が正味電荷を引き起こします。支配的な極性の過剰イオンのみがイオン蒸発に使用さ
れ、これらのうち、実際に蒸発するのはごくわずかです。

プローブは、ペプチド類やオリゴヌクレオチドなど、複数の帯電箇所のある化合物から多価イオンを
生成できます。これは、複数の電荷により質量分析装置の質量範囲内で質量対電荷比（m/z）のイ
オンが生成される、高分子量種の分析において役立ちます。これによって、化合物の分子量を決ま
った手順によりキロダルトン（kDa）単位で求めることができます。

帯電した各液滴には、溶媒と正イオンおよび負イオンが含まれていますが、一方のイオンが支配的
な極性となります。図 E-1 を参照してください。導電媒体として、余剰電荷が液滴の表面に存在しま
す。溶媒が蒸発すると、液滴の半径が小さくなるため、液滴の表面の電界が広がります。

動作原理 — イオン源

システムユーザーガイド
IVD-IDV-05-6996-JA-D

SCIEX 4500MD システム
259/293



図 E-1 : イオン蒸発

項目 説明

1 液滴には両極性のイオンが含まれますが、一方の極性が支配的になります。

2 溶媒が蒸発すると、液滴の表面の電界が強まり、イオンが表面に移動しま
す。

3 臨界電界値に達すると、イオンは液滴から放出されます。

4 不揮発性残留物が、乾燥した粒子となって残ります。

液滴に余剰イオンが含まれ、十分な溶媒が液滴から蒸発する場合、イオンが表面から排出される
臨界電界に達します。 終的に、溶媒のすべてが液滴から蒸発して、サンプル溶液の不揮発性要
素で構成される乾いた粒子が後に残ります。

ほとんどの有機分子の溶媒和エネルギーが知られていないため、イオン蒸発に対する特定の有機
イオンの感度を予測することは難しいです。液体の表面に堆積する界面活性剤を非常に高感度に
検出することができるため、溶媒和エネルギーが重要なことは明らかです。

APCI モード
これまで液体クロマトグラフィーと質量分析の連携がうまくいかなかったのは、溶液中の比較的不揮
発性の分子を過度に分解せずに分子ガスに変換するのが困難だったためです。APCI プローブプ
ロセスでは、穏やかに噴霧されたサンプルが、加熱されたセラミックチューブ内で微細に分散された
小さな液滴となるため、サンプルが急速に蒸発し、サンプル分子の分解が抑えられます。

次の図に、反応物正イオン、プロトンハイドレート、H3O+[H2O]n に対する APCI プロセスの反応フロ
ーを示します。
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図 E-2 : APCI 反応フロー図

主要な一次イオン、N2
+、O2

+、H2O+、および NO+ は、空気中の主要な中性成分に対するコロナ生
成電子の電子衝撃によって形成されます。NO+ は通常、清浄な空中の主な構成要素ではないもの
の、コロナ放電で引き起こされる自然反応により、イオン源内にこの種の堆積する割合が多くなりま
す。

APCI プローブを通して導入されたサンプルは、ネブライザガスを使用して、加熱されたセラミックチ
ューブ内にスプレー噴射されます。チューブ内で、きめ細かく拡散したサンプルおよび溶媒の液滴
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が、熱分解を 小限に抑えながら急速に蒸発します。穏やかな蒸発により、サンプルの分子同定が
保持されます。

ガスサンプルと溶媒分子はイオン源ハウジングに送られ、そこで、セラミックチューブの端に接続さ
れたコロナ放電ニードルによって、APCI によるイオン化が誘発されます。サンプル分子は、移動相
の溶媒分子のイオン化によって生成された試薬イオンと衝突することによりイオン化されます。気化
した溶媒分子はイオン化し、正極性の試薬イオン [X+H]+ と負極性の試薬イオン [X-H]– が生成さ
れます。図 E-3 を参照してください。サンプル分子と衝突時に安定したサンプルイオンを生成するの
はこれらの試薬イオンです。

図 E-3 : 大気圧化学イオン化法

項目 説明

1 サンプル

2 一次イオンがコロナ放電ニードル周辺で生成されます。

3 イオン化によって、主に溶媒イオンが生成されます。

4 試薬イオンがサンプル分子と反応し、クラスタを形成します。

5 カーテンプレート

6 インターフェース

x = 溶媒分子、M=サンプル分子

サンプル分子は、正極性ではプロトン移動プロセスを通じて、また、負極性では電子移動またはプ
ロトン移動のいずれかによってイオン化されます。イオン源の大気圧は比較的高いため、APCI イオ
ン化プロセスのエネルギーは衝突が支配的になります。

逆相アプリケーションの場合の試薬イオンは、正極性ではプロトン化された溶媒分子、負極性では
溶媒和酸素イオンで構成されます。優性熱力学を用いて、モディファイヤーを追加すると試薬イオン
組成が変化します。例えば、酢酸塩緩衝液またはモディファイヤーを追加すると、酢酸イオン
[CH3COO]– を負極性の主な試薬とすることができます。アンモニウムモディファイヤーを追加する
と、プロトン化したアンモニア[NH4]+ を正極性の主要な試薬とすることができます。

衝突によって、プロトン化した水クラスタイオンなど、特定のイオンが継続的に均一に拡散されま
す。試薬イオンに対する溶媒クラスタ緩和効果とイオン源内の比較的高いガス圧により、イオン源
内のサンプルイオンの早期フラグメンテーションが抑制されます。その結果、イオン化プロセスによ
り、質量分析装置での質量分析用として主に分子プロダクトイオンが産出されます。

APCI イオン化領域

次の図に、APCI プローブのイオン分子反応器の一般的な位置を示します。斜線は無壁反応器を
示しています。放電ニードルとカーテンプレート間の電界により、マイクロアンペア範囲で自己放電
するコロナ放電イオン電流が生じます。放電ニードルチップ周辺のプラズマで発生する電子の放出
により、一次イオン（N2

+ や O2
+ など）が生成されます。これらの電子のエネルギーは、効果的なイ

オン化断面積によって中立分子が効率的にイオン化する前に、ガス分子と何回も衝突することで適
度な状態になります。
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図 E-4 : APCI イオン化領域

項目 説明

1 放電ニードルチップ

2 サンプルフロー

3 無壁反応器

4 カーテンプレートアパチャ

5 Curtain Gas インターフェース用ガス

6 オリフィス

7 オリフィスプレート

8 セラミックチューブ

次に、一次イオンがサンプルイオンを形成する中間イオンを生成します。選択した極性のイオンが
電界の影響を受けてカーテンプレートの方向にドリフトし、ガスカーテンを通って質量分析装置内に
流れ込みます。APCI プローブの大気圧は比較的高いため、イオン形成プロセス全体は衝突が支
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配的になります。電界強度が も大きい放電ニードルチップのすぐ近くを除き、電界によってイオン
に与えられるエネルギーは、イオンの熱エネルギーと比較すると少ない量になります。

衝突によって、特定のイオン (例: プロトン化した水クラスタイオン) が継続的に均一に拡散されま
す。イオン分子反応プロセスでイオンが得る可能性のある過剰エネルギーは、すべて熱化されま
す。衝突の安定化によって、多くの後発衝突が発生するにもかかわらず、プロダクトイオンの多くが
固定化します。プロダクトイオンと反応イオンの形成は、760 torr（大気）の作動圧時の平衡条件に
左右されます。

APCI プローブは無壁反応器として機能します。これは、イオン源から真空チャンバを通過して 終
的に検出器に達するイオンが一度も壁と衝突せず、他の分子とのみ衝突するためです。イオンは指
定イオン源の外側でも形成されますが、それらのイオンは検出されず、壁の表面と相互作用して
終的に中和されます。

プローブの温度は、APCI プローブの操作にとって重要な要素です。分子同定を温存するには、温
度を十分に高く設定して急速な蒸発を可能にします。十分に高い操作温度で、液滴は急速に蒸発
するため、有機分子が液滴から熱劣化を 小限に抑えた状態で離脱します。しかし、設定温度が低
すぎると、蒸発プロセスが遅くなり、蒸発が完了する前に熱分解または分解が生じる可能性があり
ます。 適温度を超える温度で APCI プローブを操作すると、サンプルの熱分解が生じる可能性が
あります。
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手動での化合物 適化 F
これらのデバイスは Tune and Calibrate モードではシステムを介して制御できないため、ユーザー
はオートサンプラーと注入バルブを手動で制御する必要があります。

前提条件

• 質量分析装置のチューニング、キャリブレーションが完了していること。

• LC 分離のための条件がわかっていること。

• ハードウェアプロファイルにシリンジポンプが含まれていること。

• 必要な周辺装置（該当する場合はシリンジポンプを含む）すべてと LC コンポーネントが、ハー
ドウェアプロファイルに含まれていること。

必要な資材

特定の化合物用に装置パラメータをチューニングするには、次のソリューションに従うことが推奨さ
れます。4 つの化合物の混合物は手順内の各ステップを説明するために使用されます。ユーザー
は、対象となる分析に適切な化合物を使用する際、同じ手順を適用する必要があります。

• 移動相：アセトニトリルと水（１：１）＋ 2 mM の酢酸アンモニウム ＋ 0.1%のギ酸

• LC ポンプとオートサンプラー。

• オートサンプラーバイアル

• レセルピン、ミノキシジル、トルブタミド、レシンナミンで構成された 4 化合混合物（10 ng/mL）で
す。溶液は注入および FIA に使用できます。濃度はシステムに依存します。50％ 脱イオン水
および 0.1％ ギ酸を希釈剤としたアセトニトリル 49.9％ の溶剤を使用します。他の化合物で代
用する場合は、分子量が判明済みで、Turbo V イオン源によるイオン化の対象となる場合に限
ります。

表 F-1 : 化合物と m/z 値

化合物 m/z 値

ミノキシジル 210.2

トルブタミド 271.1

レセルピン 609.3

レシンナミン 635.3
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手動での化合物 適化について
手動での化合物 適化は、分析試料のための化合物およびイオン源依存パラメータを 適化する
ために使用します。ユーザーが手動で分析試料のために 適化するとき、MS 測定メソッドは Tune
and Calibrate モードで作成されます。注入または LC を使用することができるように、選択された
サンプル導入方法に応じて、測定メソッドに LC メソッドを追加します。

も高いシグナルを与えるために 適化を行っても、常に 高のシグナル対ノイズ比が得られると
は限りません。ノイズは、いくつかのパラメータのためのシグナルに対応することができるため、目
標がシグナル対ノイズ比の 大化である場合、 適化中に検証する必要があります。

イオン源に依存するパラメータを 適化する際には、サンプル導入の方法としてフローインジェクシ
ョン分析（FIA）またはティー注入を用い、サンプル分析時に使用される流量でサンプルを導入しま
す。CAD ガスパラメータは、Source/Gas タブに示されている唯一の化合物依存性パラメータであ
り、分析試料を注入しながら、容易に 適化することができます。

イオン源に依存するパラメータを 適化する前に、イオン源の位置を 適化します。 イオン源の
適化。

スキャン種類について
この例では、Q1 MS、Q1 MI、プロダクトイオン、MRM スキャン種類を使用します。Q1 MS スキャン
種類は、対象化合物の存在を確認するために使用されます。Q1 MI スキャンは MS またはプレ衝
突セルの電圧を 適化するために使用されます。プロダクトイオンスキャン種類は、各化合物のプ
ロダクトイオンの決定に使用されます。MRM スキャン種類は、各プロダクトイオンまたはフラグメン
トの衝突エネルギー（CE）および衝突セル出口電位（CXP）を 適化するために使用されます。定
量的もしくは定性的な解析のためのこのセクションで作成したメソッドを使用します。

分析試料の手動 適化
測定メソッド作成後、Edit Ramp 機能を用いるか Tune Method Editor で手動でパラメータを編集
し、化合物依存性パラメータを 適化します。イオン源ごとに異なるパラメータは、Tune Method
Editor で手動で調整できます。使用するスキャン種類によって 適化できるパラメータが異なりま
す。

下記に挙げる順に手順に従ってください：

1. 化合物の存在を確認

2. MS 特異パラメータの 適化

3. 適化のためのプロダクトイオンを決定

4. 各プロダクトイオンの衝突セル出口電位を 適化する

化合物の存在を確認

1. プロジェクトを作成します。

2. ハードウェアプロファイルを有効にします。

3. サンプルを調製:
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a. 化合物溶液をシリンジに吸引して、シリンジから空気を抜きます。

b. 特別な接続器の付いたチューブを用いて、質量分析装置にシリンジを接続します。

c. 内蔵のシリンジポンプにシリンジを取り付けます。

4. 5 µL/分から 10 µL/分の量で溶液に化合物を注入します。

5. Navigation バーの Tune and Calibrate の下にある Manual Tuning をダブルクリックしま
す。

6. メソッドリストフィールドで、Syringe Pump Method をクリックしてください。

7. Syringe Pump Method Properties タブで、次の表に示すパラメータ値を入力します。

表 F-2 : Syringe Pump Method Properties タブ

パラメータ 値

Syringe Diameter シリンジ依存：1.0 mL シリンジを用いる場合は
4.610 mm

Flow Rate 10

Unit µL/ 分

図 F-1 : Syringe Pump Method Properties タブ

8. Start Syringe Pump をクリックします。

9. メソッドリストから MS Method を選択します。

10. MS タブで、次の表に示すパラメータ値を入力します。

表 F-3 : MS タブ

パラメータ 値

Scan type Q1 MS (Q1)

Start (Da) 200

Stop (Da) 700

Scan rate (Da/s) 200
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表 F-3 : MS タブ (続き)

パラメータ 値

Duration (min) 3

11. Start をクリックします。

12. 均等な TIC が左側に表示され、ピークが右側に表示されるまで待ってから、Stop をクリックし
てください。

13. MCA チェックボックスをオンにします。

14. Cycles フィールドに 10 と入力します。

15. Start をクリックします。
スキャンが 10 回終了すると、4 つの化合物の質量がイオンとして表示されます。

ヒント! 過去のまたは想定したイオンクロマトグラムペインが非表示の場合、Window メニュー
から対象のウィンドウを選択します。

注: 化合物のイオン強度には大きなばらつきがみられます。 適化時に必要に応じて高または
低濃度の溶液へ移動を容易にするために、 適化前にいくつかの濃度レベルを用意しておい
てください。

16. 右下のスペクトルペインを右クリックして、Open File をクリックします。

17. 目的の化合物を見つけ、 高ピークの m/z 値を記録します。これらの値は、予想される m/z
値の 0.1 Da ～ 0.2 Da の範囲内になっている必要があります。次の手順で、m/z 値を使用し
ます。

MS 特異パラメータの 適化

DP はオリフィスと地面では異なります。電位差が大きいほどデクラスタリングの量が大きくなりま
す。

DP のパラメータは分析試料信号に重大な影響を与えます。一般的な DP 値の範囲は 20 V ～
150 V です。DP 値が低すぎると、イオン強度が低くクラスターによる干渉が生じる場合があります。
DP 値が高すぎると、ソースでの分析試料のフラグメンテーションの原因となります。通常、DP は
大強度を生じる値に設定されます。

EP のパラメータは、高圧 Q0 領域全体でイオンをガイドしフォーカスするエントランス電位をコントロ
ールします。正イオンには 10 V、負イオンには–10 V が一般的に設定されています。EP は化合物
の 適化には影響をほとんど及ぼさないため、分析試料の検出限界に影響を与えることなく通常は
デフォルトのままです。

1. Tune Method Editor へ戻り、メソッドを Q1 Multiple Ions (Q1 MI) スキャン種類に変更しま
す。

2. 質量表に、適切なパラメータ値を入力します。次の表を参照してください。
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表 F-4 : 質量表パラメータ – Q1 多重イオン（Q1 MI）

化合物 Q1 質量 時間

レセルピン 609.3 1

ミノキシジル 210.2 1

トルブタミド 271.1 1

レシンナミン 635.3 1

単純例の場合はレセルピンで開始します。残りの化合物に対して、手動 適化プロセスを繰り
返します。

3. Edit Ramp をクリックします。

4. Ramp Parameter Settings ダイアログで Declustering Potential (DP) を選択します。

注: DP パラメータで開始し、ダイアログに表示される順番に他のパラメータを 適化します。順
番が異なると、パラメータが適切に 適化されないことがあります。

5. 必要な Start、Stop、および Step の値を入力します。

ヒント! 既存の値は良好な出発点となります。Edit Ramp 機能を用いて、これらの値をより効
率的になるように変更します。

6. OK をクリックします。

7. Start をクリックします。

8. XIC ウィンドウ枠の右下を右クリックして Open File をクリックし、XIC 表示を 大にします。

9. XIC をモニタリングします。

注: 対象のイオンに対して 良の信号/秒が得られる値が 適値です。

10. 対象となるイオンの 適値を記録します。

11. カーソルを質量表に移動させ、右クリックして 適化したパラメータを追加します。
表に列が追加されます。

12. 適化した値を適切な行に加えます。

13. 全質量について 適化リストが得られるまで、測定メソッドで、各質量に対してこれらのステップ
を繰り返します。

14. これらのステップを繰り返して他の MS 特異パラメータを 適化します。

表 F-5 : MS 特異パラメータ

パラメータ コメント

DP DP を 大強度が得られる値に設定します。

EP 影響が少ないため、このパラメータを 適化することは稀です。
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表 F-5 : MS 特異パラメータ (続き)

パラメータ コメント

CEP 強強度の CEP 値を選択します。

適化のためのプロダクトイオンを決定

衝突エネルギー（CE）は衝突セルへと加速しているときにプレカーサーイオンが受け取ったエネル
ギーの総数を制御します。

以前に取得されていた MS 固有の 適値を使用して、一度に 1 つの化合物についてこの手順を実
行してください。プロダクトイオンは、MRM 遷移の Q3 質量を提供します。

この例では、化合物のレセルピンが使用されます。

1. Tune Method Editor で、XIC ペインを閉じます。

2. Scan type フィールドの Product Ion (MS2) をクリックします。

3. Compound タブで、MS 特異パラメータの 適化に記載されている 適値を入力します。

4. MS タブの Product Of フィールドに 609.4 を入力します。

この値は化合物の存在を確認に記載されているレセルピンの質量割り当てです。

5. Center / Width チェックボックスがオフであることを確認します。

6. 質量表に、適切な、Start、Stop、Time の値を入力します。表 F-6 を参照してください。

表 F-6 : 質量テーブルパラメータ（プロダクトイオンスキャン）

フィールド 値

Start (Da) 100

Stop (Da) 650

Time (sec) 2

7. Edit Ramp をクリックします。
Ramp Parameter Settings ダイアログが開きます。

8. Collision Energy を選択し、求められた Start、Stop、Step の値を入力します。

注: 既存の値は良好な出発点となります。Edit Ramp 機能を用いて、これらの値をより効率的
になるように変更します。

9. OK をクリックします。

10. MCA チェックボックスをオンにします。

11. Start をクリックします。

12. XIC 右下のペインを右クリックして Open File をクリックします。
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13. 強度が 大の製品イオンを選択し、その製品イオンの m/z 値を 初の小数点まで記録します
（例：195.1）。
各化合物のために 2、3 のプロダクトイオンを 適化することを推奨します。追加的遷移を使用
して確認すること、または干渉が発見された時のために化合物を再 適化する必要を回避す
ることができます。

注: 適化に選ばれた 高のピークが水または二酸化炭素などのプレカーサーイオンによる
通常の損失を表わさないことを確認してください。プロダクトイオンの質量が低すぎないこと、ま
たカラム解析中に実際のサンプルやクラスターで移動相からの遷移妨害が生じる場合がある
ことを確認してください。

14. 残りの化合物にもこの手順を繰り返します。

各プロダクトイオンの衝突セル出口電位を 適化する

1. Tune Method Editor で、XIC ペインを閉じます。

2. 前回保存したメソッドを開きます。

3. 質量表で、化合物の Q1 および Q3 m/z 値を検証します。

4. Compound タブをクリックし、MS 特異パラメータの 適化で記録した 適な DP 値および
CE 値を入力します。

5. Edit Ramp をクリックします。

6. Ramp Parameter Settings ダイアログで Collision Cell Exit Potential (CXP) を選択しま
す。

7. 必要な Start、Stop、および Step の値を入力します。

ヒント! 既存の値は良好な出発点となります。Edit Ramp 機能を用いて、これらの値をより効
率的になるように変更します。

8. OK をクリックします。

9. Start をクリックします。

10. XIC 右下のペインを右クリックして Open File をクリックします。

11. 対象となるイオンの 適値を記録します。
良の信号が得られる値が 適値です。

12. 質量表を右クリックし、 適化したパラメータを選択します。
これにより表にカラムが追加されます。

13. 他のプロダクトイオンをモニタリングした場合は手順を繰り返します。

14. 適切な行に 適値を追加してください。

15. メソッドを保存します。

16. これまでに 適化された他の化合物について、この手順を実行します。
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イオン源とガスパラメータの手動 適化
イオン源とガスの設定を正しく行って、質量分析装置を汚染から防止し、対象の混合物がイオンとし
て 適な状態でガス相に変化するようにします。

注: 適なイオン源およびガス設定は溶媒組成と流量に関連します。

LC の状態が著しく変化するときは、イオン源とガス設定を調整しなければいけません。

イオン源とガスパラメータを 適化するために、対象の混合物に関してシリンジポンプを設定し、サ
ンプルチューブを T 字管で LC デバイスと接続します。LC ポンプの制御は、手動またはソフトウェ
アによって行うことができます。

イオン源とガス設定を手動で 適化する際、手動チューニングによりパラメータを手動で変更する間
にオートサンプラーを使用して、対象となる混合物を手動で注入することもできます。

イオン源の準備

1. マイクロメータの水平目盛を 5 に設定します。

2. マイクロメータの垂直目盛をイオン源の流量に合わせて設定します。

次の表のパラメータを使用します。

表 F-7 : Turbo VV イオン源垂直パラメータ

流量 初期垂直パラメータ

1 µL/ 分～20 µL/ 分 10

20 µL/ 分～ 250 µL/ 分 5

250 µL/ 分～ 500 µL/ 分 2

500 + µL/ 分 0

適化実行の方法によって、LC ポンプ付ハードウェアプロファイルを設定する必要がある場合
があります。

イオン源の 適化を参照してください。

イオン源パラメータの 適化

イオン源パラメータは、目的の化合物の 高のシグナル対ノイズ比のために 適化されます。
Curtain Gas インターフェース用ガスの流量は、感度を失うことなく 高値で 適化されます。 イオ
ン源の 適化を参照してください。

次の手順に従って、Curtain Gas (CUR) パラメータを 適化します。このパラメータの主な機能
は、イオン光学の汚染を防止することです。CUR パラメータは、感度を失うことなく、常に、可能な限
り高い数値で維持される必要があります。数値は、質量分析装置のタイプおよびイオン源により異
なります。

開始値よりも低くパラメータを設定しないでください。
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1. Navigation バーの Tune and Calibrate の下にある Manual Tuning をダブルクリックしま
す。

2. File > Open. をクリックします。

3. Files リストで化合物パラメータの 適化に使用する測定メソッドをクリックし、OK をクリックし
ます。
Tune Method Editor でメソッドが開きます。

4. Source/Gas タブを開きます。

5. イオン源およびガス流ガイドを使用して、流量に適切になるよう、すべてのイオン源およびガス
パラメータを設定します。

6. 稼働時間を十分長く設定して、多くのパラメータが調整されるようにします。推奨開始時間は
15 分間です。

7. Start をクリックします。
Tune Method Editor 下のペインにデータが表示されます。

8. 目的のピーク信号を記述します。

9. Curtain Gas (CUR) フィールドで、値を 5 増やします。

10. Curtain Gas (CUR) 値を、感度が失われずに 高値となるところまで上げ続けます。
ほとんどの Source/Gas パラメータと同様、2 つの値が同じ結果を示す場合には、より高い方
を使用してください。

11. 他のソース／ガスパラメータにもこの手順を繰り返してください。
これらのパラメータを 適化する際には、 高のシグナル対ノイズ比値を出す値を探してくださ
い。

拡張パラメータ
次のパラメータは必ず経験のあるオペレータが 適化を行ってください。

AF2 の 適化

AF2 パラメータは MS3 スキャンにおいて 2 番目のプレカーサーイオンのフラグメンテーションを管
理します。使用される励起エネルギーの量は、化合物およびフラグメンテーションの目標量によって
決定されます。

1. 正負イオンモードの双方において、AF2 を次のように徐々に上げます：Step 値 10 mV で 70
mV ～ 300 mV。許容範囲は 0 mV ～ 1000 mV です。

2. フラグメンテーションの理想量が得られる AF2 値を選択します。

衝突エネルギーの広がり（CES）
QTRAP 質量分析装置のユニークな機能として、オートフラグ実験を実行する機能があります。複
合スペクトルは、衝突エネルギーを 適化する必要を除去し、3 つの異なる衝突エネルギーからイ
オンでリニアイオントラップを満たすことにより入手できます。

化合物依存性パラメータでの EPI（プロダクトイオン強調モード）および MS3 実験においては、衝突
エネルギー拡散（CES）フィールドを用いて、実験で印加されるさまざまな衝突エネルギーを指定す
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ることができます。例えば、CE 値が 30 で CES 値が 15 で使用する場合、衝突エネルギーは 15、
30、45 が使用されます。
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右クリックメニュー G
Batch Editor
Batch Editor 表を右クリックしてオプションにアクセスします。

図 G-1 : バッチの右クリックメニュー

メニュー 機能

Open （開く）バッチファイルを開きます。

Import From （インポート元）ファイルからバッチをインポートします。

Save As Batch （バッチとして保存）バッチを別の名前で保存します。

Save As a
Template

（テンプレートとして保存）バッチをテンプレートとして保存します。

Hide/Show
Column

（カラムの表示 / 非表示）カラムを表示 / 非表示にします。

Save Column
Settings

（カラム設定を保存）バッチカラムの設定を保存します。
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メニュー 機能

Add Custom
Column

（カスタムカラムの追加）カスタムカラムを追加します。

Delete Custom
Column

（カスタムカラムの削除）カスタムカラムを削除します。

Fill Down （下方向へコピー）選択したセルに同一データをコピーします。

AutoIncrement （AutoIncrement）選択したセルのデータを自動的に増やします。

Delete Samples （サンプルを削除）選択した行を削除します。

Select
Autosampler

（オートサンプラーを選択）オートサンプラーを選択します。

キュー状態とデバイス状況
Queue Manager はキュー、バッチ、サンプルのステータスを表示します。キュー内の特定のサンプ
ルについての詳細情報も閲覧することができます。

ヒント! View Queue（ ）をクリックして、キューを表示します。

Queue の右クリックメニューの使い方については、キューを参照してください。

キュー状態

キューの現在の状態は、Queue Server グループに示されています。

図 G-2 : Normal モードを示すキューサーバーインジケーター

図 G-3 : チューニングモードを示すキューサーバーインジケーター

初のアイコンは、キューの状態を示しています。2 番目のアイコンは、キューが Tune モード（チュ
ーニング）と（サンプルを実行するための）Normal モードのどちらであるかを示します。アイコンとキ
ューの状態の説明は、表 G-1 を参照してください。
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表 G-1 : キュー状態

アイコン 状態 定義

Not
Ready

ハードウェアプロファイルが無効化され、キューはサン
プルの提出を受け付けていない状態です。

Stand By ハードウェアプロファイルは有効ですが、すべてのデバ
イスがアイドル状態になっています。ポンプが動作して
おらず、ガスがオフになっています。

Warming
Up

質量分析装置およびデバイスの平衡化、カラムの調
整、オートサンプラーの針の洗浄が完了し、また、カラ
ムオーブンが規定温度に達している状態です。オペレ
ータは平衡化の持続時間を選択できます。この状態か
ら、システムは Ready 状態に移ることができます。

Ready このシステムはサンプルの実行を開始する準備が完
了しており、デバイスも平衡化が完了して準備が整っ
ています。この状態では、キューは、サンプルを受け取
ることができ、サンプルが提出された後に実行されま
す。

Waiting 次のサンプルが提出されたときにシステムが自動的に
測定を開始します。

PreRun このメソッドは各デバイスにダウンロードされ、デバイス
の平衡化が起こります。この状態は、バッチ内の各サ
ンプルの測定前に行われます。

Acquiring メソッドが実行され、データ収集が行われています。

Paused システムは、測定中に一時停止されています。

機器およびデバイスステータスアイコンを表示

質量分析装置および有効なハードウェア構成での各デバイスを表すアイコンは、ウィンドウの右下
隅にあるステータスバーに表示されます。ユーザーは、LC ポンプの圧力が適切であることを確認す
るために LC ポンプの詳細な状態を表示したり、イオン源の温度を監視するために質量分析装置の
詳細な状態を表示したりすることができます。
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注: 各ステータスについて、背景色が赤色になることがあります。赤色の背景は、そのステータスに
ある間、デバイスがエラーを検出したことを示しています。

ステータスバーで、デバイスまたは質量分析装置のアイコンをダブルクリックします。
Instrument Status ダイアログが表示されます。

表 G-2 : 機器およびデバイスステータスアイコン

状態 アイコン 背景色 説明

アイドル状態
 

緑または黄色 デバイスが作動していません。背景色が黄色
の場合、デバイスは作動可能な状態になる前
に、平衡化する必要があります。背景色が緑の
場合、デバイスは作動準備ができています。

平衡化
 

緑または黄色 デバイスが平衡化中です。

待機中 緑 デバイスは、ソフトウェアまたは他のデバイスか
らのコマンド、またはオペレータによる何らかの
アクションを待っています。

実行中 緑 デバイスは、バッチを実行しています。

中止していま
す

緑 デバイスは、バッチを停止しています。

ダウンロード 緑 メソッドがデバイスに転送されています。

準備完了 緑 デバイスは作動していませんが、作動する準備
ができています。

エラー 赤 デバイスに調査が必要なエラーが発生しまし
た。

キュー
キューの表を右クリックし、オプションを表示します。
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図 G-4 : Queue Manager の右クリックメニュー

メニュー 機能

Sample Details （サンプル詳細）Sample Details ダイアログを開きます。

Reacquire （再測定）サンプルを再度測定します。

Insert Pause （一時停止を挿入）2 つのサンプルの間に秒単位で一時停
止を挿入します。この機能は本ソフトウェアのこのバージョン
では使用できません。

Delete （削除）バッチまたは選択されたサンプルを削除します。

Move Batch （バッチ移動）バッチをキュー内で移動させます。

Sort （ソート）事前に選択されたカラムでソートします。

Column Settings （カラム設定）カラムの設定を変更します。

Contour Plot ペインの右クリックメニュー

メニュー 機能

Show DAD Spectrum 新しいペインが DAD スペクトルとともに開きま
す。

Extract Wavelengths (Use Range) DAD スペクトルから、XWC を表示するための
波長範囲を 3 つまで抽出します。
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メニュー 機能

Extract Wavelengths (Use Maximum) 大波長を用いて波長範囲を抽出します。

Zoom to selection 選択した領域にズームインします。

Add User Text カーソルの位置にテキストボックスを追加しま
す。

Undo Zoom グラフが元のスケールに戻ります。

Delete Pane 選択したペインが削除されます。

Show Cross-Hair 照準が表示されます（nm/分）。

Show File Information ペインの右クリックメニュー
表 G-3 : Show File Information ペインの右クリックメニュー

メニュー 機能

Copy （コピー）選択したデータをコピーします。

Paste （貼り付け）データを貼り付けます。

Select All （全選択）ペイン内の全データを選択します。

Save To File （ファイルに保存）データを rtf ファイルとして保存します。

Font （フォント）フォントを変更します。

Save Acquisition
Method

（測定メソッドを保存）測定メソッドを dam ファイルとして保存します。

Save Acquisition
Method to
CompoundDB

（測定メソッドを CompoundDB に保存）Specify Compound
Information ダイアログを開きます。化合物データベースに保存する
ID とその分子量を選択します。

Delete Pane （ペインの削除）選択したペインを削除します。

スペクトルペイン
表 G-4 : スペクトルペインの右クリックメニュー

メニュー 機能

List Data データポイントをリストし、クロマトグラムを統合します。

Show TIC TIC を含む新しいペインを生成します。
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表 G-4 : スペクトルペインの右クリックメニュー (続き)

メニュー 機能

Extract Ions (Use Range) 選択されたペインから特定のイオンまたはイオンの集合を
抽出し、特定のイオンに対するクロマトグラムを含む新しい
ペインを生成します。

Extract Ions (Use Maximum) 選択したエリア内の も強力なピークを使用してイオンを
抽出します。

Save to Text File Microsoft Excel またはその他のプログラムで開くことがで
きる、ペインのテキストファイルを作成します。

Save Explore History 処理オプションとも呼ばれる処理パラメータに関する変更
情報を保存します。これは、wiff ファイルが Explore モード
で処理されたときに作成されたものです。処理履歴は、eph
（Explore Processing History）の拡張子で保存されます。

Add Caption ペインのカーソル位置にキャプションを追加します。

Add User Text ペインのカーソル位置にテキストボックスを追加します。

Show Last Scan 選択前のスキャンを表示します。

Select Peaks For Label このダイアログでは、ピークのラベリングを減少するパラメ
ータを選択します。

Delete Pane 選択したペインを削除します。

Add a Record スペクトルを含む記録および化合物関連データをライブラリ
に追加します。このタスクを実行するには、有効なスペクト
ルが必要です。

Search Library 制限なしまたは前回保存した制限でライブラリを検索しま
す。

Set Search Constraints Search Constraints ダイアログボックスに入力された基準
を使用してライブラリを検索します。

クロマトグラムペイン
表 G-5 : クロマトグラムペインの右クリックメニュー

メニュー 機能

List Data データポイントをリスト化し、クロマトグラムで検出されたピークを積分しま
す。

Show Spectrum スペクトルを含む新規ペインを作成します。

Show Contour Plot データセットがその点におけるデータの強度を色で表すように色分けされ
た図を表示します。一部の MS モードのみがサポートされています。
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表 G-5 : クロマトグラムペインの右クリックメニュー (続き)

メニュー 機能

Extract Ions 選択されたペインから特定のイオンまたはイオンの集合を抽出し、特定
のイオンに対するクロマトグラムを含む新しいペインを生成します。

Show Base Peak
Chromatogram

ベースピーククロマトグラムを含む新規ペインを作成します。

Show ADC Data 取得できた場合には、ADC データ追跡を含む新規ペインを作成します。

Show Auxiliary
Traces

Select Auxiliary Trace Channel ダイアログを開きます。

Show UV Detector
Data

取得できた場合には、UV データ追跡を含む新規ペインを作成します。

Save to Text File Microsoft Excel またはその他のプログラムで開くことができるテキストフ
ァイル（データを含む）をペインに作成します。

Save Explore
History

処理オプションとも呼ばれる処理パラメータに関する変更情報を保存しま
す。これは、wiff ファイルが Explore モードで処理されたときに作成され
たものです。処理履歴は、eph（Explore Processing History）の拡張子
で保存されます。

Add Caption ペインのカーソル位置にキャプションを追加します。

Add User Text ペインのカーソル位置にテキストボックスを追加します。

Set Subtract Range ペインの減算範囲を設定します。

Clear Subtract
Range

ペインの減算範囲をクリアします。

Subtract Range
Locked

減算範囲をロックまたはアンロックします。減算範囲がロックされていな
い場合には、各減算範囲は独自に移動します。減算範囲はロックにプリ
セットされています。

Delete Pane 選択したペインを削除します。

Results Table
Results Table を右クリックし、次の表に示すオプションにアクセスします。

表 G-6 : 結果表の右クリックメニュー

メニュー 機能

Full （フル）すべてのカラムを表示します。

Summary （概要）特定のカラムを表示します。

Analyte （分析試料）特定の分析試料を表示します。
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表 G-6 : 結果表の右クリックメニュー (続き)

メニュー 機能

Analyte
Group

（分析試料グループ）分析試料グループを作成します。

Sample Type （サンプルタイプ）特定タイプのサンプルまたはすべてのサンプルを表示します。

Add Formula
Column

（Formula カラムの追加）Formula カラムを追加します。Formula カラムを使用し
ている場合は、ユーザーが結果を検証することを推奨します。

Table
Settings

（表設定）表設定を編集または選択します。

Query （クエリ）クエリを作成または選択します。

結果表のデータの分析に用いたクエリはすべて検証することを推奨します。

Sort （ソート）ソートを作成するか、またはインデックスでソートします。

Metric Plot （メトリックプロット）メトリックプロットを作成します。

Delete Pane （ペインの削除）アクティブなペインを削除します。

Fill Down （下方向へコピー）選択したセルに同一データをコピーします。

Add Custom
Column

（カスタムカラムの追加）カスタムカラムを追加します。

Delete
Custom
Column

（カスタムカラムの削除）選択したカスタムカラムを削除します。

ピークレビュー
Peak Review ウィンドウまたはペインを右クリックして、表 G-7 に表示されているオプションにアク
セスします。

表 G-7 : ピークレビューの右クリックメニュー

メニュー 機能

Options （オプション）Peak Review Options ダイアログボックスを開きます。

Sample
Annotation

（サンプル注釈）Sample Annotation ダイアログを開きます。

Save Active to
Text File

（アクティブなものをテキストファイルに保存）選択したピークをテキストファイル
として保存します。

Show First
Page

（ 初のページを表示） 初のサンプルに移動します。
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表 G-7 : ピークレビューの右クリックメニュー (続き)

メニュー 機能

Show Last
Page

（ 後のページを表示） 後のサンプルに移動します。

Slide Show
Peak Review

（ピークレビューのスライドショー）スライドショーを開きます。

Update Method （更新メソッド）すべてのピークのアルゴリズムを更新します。

Revert to
Method

（メソッドに戻る）現在の定量化メソッドに基づいて再定義されたピークを選択し
ます。

Delete Pane （ペインの削除）アクティブなペインを削除します。

キャリブレーションカーブ
Calibration ウィンドウまたはペインの表を右クリックし、次の表に示すオプションにアクセスします。

表 G-8 : キャリブレーションカーブの右クリックメニュー

メニュー 機能

Exclude
(Include)

（除外する（含める））カーブからポイントを除外するには、ポイントを右クリック
し、Exclude をクリックします。ポイントを含めるには、ポイントを右クリックし、
Include をクリックします。

Exclude All
Analytes
(Include All
Analytes)

（すべての分析試料を除外する（すべての分析試料を含める））カーブからす
べての分析試料を除外するには、ポイントを右クリックし、Exclude All
Analytes をクリックします。ポイントを含めるには、ポイントを右クリックし、
Include All Analytes をクリックします。

Show Peak （ピークを表示）個々のピークをレビューします。

Overlay （オーバーレイ）2 つのグラフを重ねます。

Active Plot （アクティブプロット）どのプロットがアクティブかを判定します。

Legend （凡例）グラフの凡例を表示します。

Log Scale X
Axis*

（対数スケール X 軸）X 軸に対数スケールを使用します。

Log Scale Y
Axis*

（対数スケール Y 軸）Y 軸に対数スケールを使用します。

Delete Pane （ペインの削除）アクティブなペインを削除します。

Home Graph （ホームグラフ）グラフを元のサイズに調整します。

*対数スケールはデータポイントをより操作しやすい形で表示することができるため、すべてのポイ
ントの効果を同時にモニタリングするのに便利です。この表示の際は、一方の軸の対数ではなく
Log Scale Y Axis を Log Scale X に対して選択します。
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シンボルについての用語集 H
注: 以下の表のすべてのシンボルが、すべての機器に適用されるものではありません。

シンボル 説明

オーストラリアの監督法規の遵守マーク。本製品が、Australian
Communications Media Authority（ACMA）の EMC 要件を満たしていること
を表します。

交流

A アンペア（電流）

窒息の危険

ヨーロッパ共同体の公認代表者

生物学的危険

CE 適合マーキング

cCSAus マーク。カナダおよび米国での電気安全認証を示します。

カタログ番号

注意。起こりうる危険についての情報は、説明書を参照してください。

注: SCIEX マニュアルでは、このシンボルは人身傷害の危険を示します。
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シンボル 説明

中国 RoHS 注意ラベル。電子情報製品は特定の毒性または有害物質を含ん
でいます。中央に書かれている数字は、環境保護使用期限（EFUP）の日付で
あり、製品の操作可能暦年を数字で示すものです。EFUP の期限が切れた際
は、製品は速やかにリサイクルされなければなりません。回転矢印は、製品
がリサイクル可能であることを示します。ラベルまたは製品にある日付コード
は、製造年月日を示します。

中国 RoHS ロゴ。装置は 大濃度値を超える毒性および有害物質または元
素を含んでおらず、リサイクルおよびリユース可能な環境に優しい製品です。

使用説明書を参照してください。

圧砕の危険

TUV Rheinland of North America 用の cTUVus マーク

ユニークデバイス識別子（UDI）を取得するためにバーコードリーダーでスキャ
ンできる Data Matrix シンボル

環境の危険

イーサネット接続

爆発の危険
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シンボル 説明

眼球傷害の危険

火災の危険

可燃性化学物質の危険

壊れ物

ヒューズ

Hz ヘルツ

内部安全シンボル「注意－感電の危険あり」（ISO 3864）、別名高電圧シンボ
ル
メインカバーを取り外す必要がある場合は、感電を避けるために SCIEX の代
理店に連絡してください。

高温面の危険

実験室用診断機器

イオン化放射の危険

濡らさないでください。

雨にさらさないでください。

相対湿度は 99%以下でなければなりません。
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シンボル 説明

上部を上にしてください。

引き裂き/重篤な危険

レーザー放射線障害の危険

吊り上げ時の危険

磁気の危険

メーカー

可動部品の危険

ペースメーカーの危険。ペースメーカーを使用している人はアクセスできませ
ん。

挟み込みの危険

加圧ガスの危険

保護接地（アース）

穿刺災害の危険
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シンボル 説明

反応性化学物質の危険

シリアル番号

有害化学物質の危険

システムの輸送および保管は 66 kPa～103 kPa 以内で行ってください。

システムの輸送および保管は 75 kPa～101 kPa 以内で行ってください。

システムの輸送および保管は指定された相対湿度の 小（min）および 大
（max）レベルの間で、結露が発生しない状態で行ってください。

システムの輸送および保管は–30 °C～+45 °C 以内で行ってください。

システムの輸送および保管は–30 °C～+60 °C 以内で行ってください。

USB 2.0 接続

USB 3.0 接続

紫外線放射の危険

英国適合性評価マーク

VA ボルトアンペア（皮相電力）
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シンボル 説明

V ボルト（電圧）

WEEE.分別されていない一般廃棄物として機器を廃棄しないでください。環
境の危険

W ワット

yyyy-mm-dd

製造年月日
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警告についての用語集 I
注: コンポーネントの識別に使用されるラベルのいずれかが剥がれた場合は、フィールドサービスエ
ンジニア（FSE）にお問い合わせください。

ラベル 翻訳（該当する場合）

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM-IVD EQUIPMENT

EN61326—1、EN61326—2-6、クラス A、グル
ープ 1、ISM-IVD 機器

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

インパクトインジケータ

高感度の製品についての警告

注: インジケータがトリップしている場合、このコ
ンテナは落下したか、乱暴に取り扱われていま
す。船荷証券に注意書きを行い、損傷を確認し
てください。衝撃による損傷に関するあらゆる苦
情には通知が必要です。

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT
INDICATOR” OR “TILT INDICATOR” ON
THE WAYBILL BEFORE ACCEPTING
SHIPMENT AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

重要！

荷物を受け取る前に、トリップした「インパクトイ
ンジケータ」または「チルトインジケータ」を含む
目に見える損傷を貨物運送状に記録し、お近く
の AB SCIEX カスタマーサポートエンジニアに
すぐに通知してください。

開梱しないでください。開梱および設置について
は、お近くのカスタマーサポートエンジニアに問
い合わせてください。

MINIMUM OF SIX PERSONS REQUIRED
TO SAFELY LIFT THIS EQUIPMENT

本機器を安全に持ち上げるには 低 6 人必要
です。

注: 使用説明書を参照してください。

TIP & TELL チルトインジケータ

注: コンテナが傾斜または誤った取り扱いをされ
ていないかを示します。船荷証券に記載し、損
傷がないか点検してください。傾斜に関するあら
ゆる苦情には、通知が必要です。
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ラベル 翻訳（該当する場合）

TiltWatch PLUS

ShockWatch

チルトインジケータ

注: コンテナが傾斜または誤った取り扱いをされ
ていないかを示します。船荷証券に記載し、損
傷がないか点検してください。傾斜に関するあら
ゆる苦情には、通知が必要です。

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

警告： 初にボトルキャップが確実に固定され
ていることを確認せずに、操作しないこと。

注: この警告は、イオン源排気排出ボトルに添
付されています。

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

警告：ユーザーは内部部品の修理を行わない
でください。修理が必要な場合は、資格のある
サービス担当者にお問い合わせください。

注: 使用説明書を参照してください。
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守/技術専門要員を世界中に配置していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報について
は、SCIEX web サイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する 新のガイダンスについては、sciex.com/
productsecurity を参照してください。

ドキュメント
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。 新バージョンを
ダウンロードするには、https://get.adobe.com/reader にアクセスします。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたはソフトウェアイ
ンストールガイドを参照してください。

ハードウェア製品のドキュメントを検索するには、システムまたはコンポーネントに付属の カスタマ
ーリファレンス DVD を参照してください。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。
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